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1.1

1.2

1.3

Introduction

About This Guide and Related Documentation

This document is intended for MOTOTRBO radio network administrators as well as
dispatchers responsible for the TRBOnet dispatch console operations. It provides
guidance on the installation, configuration, and maintenance of the TRBOnet Server
and Dispatch Console applications.

About TRBOnet

TRBOnet is a suite of professional applications for MOTOTRBO digital two-way radio
networks. TRBOnet manages voice and data communication paths across network
endpoints. It provides a unified graphical dispatcher workbench interface for the
entire range of workforce fleet management tasks.

Contacts
Region Phone Email & Support

EMEA +44 203 608 0598 .
info@trbonet.com — general and
commercial inquiries

Americas +1872 222 8726 support@trbonet.com — technical
support
http://kb.trbonet.com — online

APAC +61 28 607 8325 knowledge base
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2 Hardware and Software Requirements
TRBOnet Server/Agent with IP connection only ‘
Voice Channels | 4 8 16 24 24+
CPU Intel Core i3 Intel Core i5 Intel Core i7, 4 Cores Intel Core i7, 6
Cores
Contact
Memory 2 GB 4 GB 4GB 8 GB technical
HDD 300 MB for installation files, +1 MB per 1 minute of voice recording support
Sound Card No

Supported OS

Windows 7/8.x/10, Windows Server 2008/2012/2016

Note:

Windows Server 2008/2012/2016 requires Desktop Experience
Role/Feature installed.

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

TRBOnet Server /Agent with Control Stations

Control Stations 1 2+

CPU Intel Core i5

Memory 2 GB

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording
Multi-channel Sound Card required;
Recommended:

Sound Card Integrated sound card can be used. 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Additional Devices

Cable connector Motorola PMKN4016

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

Dispatch Console ‘

CPU Intel Core i3

Memory 4 GB

HDD 70 MB for installation files

Sound Card Yes

Display 1280x1024 minimum resolution, 1600x900 recommended resolution

Additional Devices

Speakers and microphone, or headset; Imtradex devices are recommended

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x

TRBOnet Enterprise — User Manual
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System Architecture Overview
TRBOnet Server, Agent and Console

The TRBOnet software is designed as a client-server architecture,

where TRBOnet Server is PC-based and runs as a Windows service on a network
computer, stores data in an MS SQL database, and allows client connections from
Web Consoles, Dispatch Consoles, and Mobile Clients. The TRBOnet service can be
located on a dedicated remote PC, a local PC (along with the Dispatch Console), or
on a virtual machine.

In addition, remote software agents, such as TRBOnet Agent, and/or hardware
agents, such as TRBOnet Swift A200, can be connected to TRBOnet Server providing
additional voice and data communications paths to and from remote sites. Such
configurations can be used when radio equipment can't be connected directly to
TRBOnet Server due to IP network limitations (see section 3.3, IP Backend Network

Requirements).
TRBOnet Dispatch Console is a PC-based voice dispatch and data application for
MOTOTRBO professional digital two-way radio systems.

TRBOnet Server

TRBOnet Agent

FEE

Local

Radio Infrastructure
WAN/LAN

-

Remote ]

Radio Infrastructure L

TRBOnet
= Web Console

LS

TRBOnet
Dispatch Console
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3.2
3.2.1

3.2.2

MOTOTRBO Radio Systems
Single Site conventional system

A Single Site conventional system is a digital conventional two-way MOTOTRBO
system that includes one digital repeater and allows you to transmit voice and data
via two conventional channels. Radio groups and radio units are assigned to these
conventional radio channels.

IP Site Connect

An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO
system that provides two wide-area channels to increase your communications RF
coverage area. It is possible to connect up to 15 repeaters (each geographical
location of a repeater is called a "site") into one system using an IP connection,
which allows increasing the coverage area for voice and data transmissions. The
main objective of an IPSC system is to provide a stable connection between the
radio units and control centers regardless of the distance.

1% Z% 3%
L & o L & @ L & o
L & ®, ?

Master Repeater 1 Peer Repeater 2 Peer Repeater 3

TRBOnet
Server

=

LAN/WAN

L\ LE\ LEQ

Dispatcher 1 Dispatcher 2 Dispatcher 3
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3.2.3

Capacity Plus

Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-way
MOTOTRBO system that is designed for high volume communications at a single
site location. The system is designed to provide communications among a large
number of users within a building, a set of buildings, or a single geographical region.
This system type allows you to effortlessly increase the number of channels for both
voice and data transmission between the radio units and control centers. As this
system type is trunked instead of standard conventional, radio units are always
automatically forwarded to a free channel rather than being programmed to remain
on a single slot, thereby utilizing/sharing the available unused/free RF resources
(channels) among different users. The main objective of Capacity Plus is to support
more simultaneous voice and data transmissions within one capacious system.

Paa=——uuN
Dispatcher 1

LFE\
Dispatcher 2

E Voice Repeater 3

LR
Dispatcher 3

e

Master Voice Repeater 1

Voice Repeater 2

Data Repeater 4

Data Repeater 5

TRBOnet
Server
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3.2.4 Linked Capacity Plus (LCP)

Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked
multisite two-way MOTOTRBO system that enables you to accommodate both high
volume and wide area communications. This system design allows you to connect
via IP up to 15 Linked Capacity Plus sites located in one geographical region (for
example, City of Charlotte) or in larger geographically separated territories (for
example, covering the Florida Keys from Miami to Key West). This system type allows
you to increase the RF coverage area and the number of channels for voice and data
transmission between the radio units and control centers. The main objective of
Linked Capacity Plus is to support more simultaneous voice and data transmissions
regardless of the distance.

L\

Dispatcher 1

E Router + Switch

P-EE0
Dispatcher 2

E TrEer LAN/WAN

] Router + Switch

L\

Dispatcher 3

E] Router + Switch

Server
Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Control Control Control
Station 1 Station 2 Station N

se2 /7 :Q;

It
i1
"
4

"
&
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3.2.5

Connect Plus

Connect Plus is a digital trunked multisite two-way MOTOTRBO system that enables
you to accommodate high volume, wide area communication that's required for
your business allowing you to connect via IP multiple sites located in one
geographical region or in larger geographically separated territories. This system
type allows you to increase the RF coverage area and the number of channels for
voice and data transmission between the radio units and control centers. Radio units
are always automatically forwarded to the control channel. The main objective of
Connect Plus is to support more simultaneous voice and data transmissions
regardless of the distance as well as to provide a more structural addressing of the
transmissions provided by XRC controller and XRT gateway.

Dispatcher 1 XRC 9000 XRC 9000
. ey B e
'..“ %‘ "," .‘\‘ % ,.""
Voice Repeater 1 Talk Group 1 Voice Repeater 3 Talk.‘(-S-F(')'up 3
Duspatcher 2 Data Repeater 2 % % Data Repeater 4 % Q/
E m Talk GrOUpz m TalkGrOUp4
= — —
P2
Dispatcher 3 XRT 9000
Router 1 m Router 2

EW
LTSN

TRBOnet

Server* * TRBOnet Server requires connections to only one XRT 9000 Controller and one XRC 9000 Controller in the system
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3.2.6 Capacity Max

Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the DMR
Tier Il Mode of Operation, it delivers smooth scalability, low cost of ownership and
reliable operation.

Il Czpacity MAYX companents TREOnet companents

Application Server Capacity MAX System Server

Dispatch Position
Trunked Controller

TREON

RBOnet Dispatch

MNIS Data Gateway MNIS VRC Gateway

Application network CMSS network

. Router
Dispatch position

BOnet Dispatch

Console

~

[ 3™ party network

3.3 IP Backend Network Requirements

Before planning any IP connected MOTOTRBO system, read System Planner (chapter
4.6.3.2 Characteristics of Backend Network).

If the

Delay/Latency

The amount of time it takes for voice to leave the source repeater and arrive at
the destination repeater. The delay should be less than 60 ms. It can be up to
90 ms, but requires changes in CPS for both radio units and repeaters.

Jitter

The variation of the packet inter-arrival time. It should be less than 60 ms.
Packet Loss

In the case of voice, the ongoing call ends if six consecutive packets do not
arrive within 60 ms of their expected arrival time. In the case of data, the
repeater waits for the expected number of packets (as per the data header)
before ending the call.

Bandwidth

Refer to System Planner for bandwidth calculations, but roughly, it requires 96
kbps for each repeater connection and should be summed up for all repeaters.

IP backend network does not satisfy MOTOTRBO requirements, it will degrade

audio quality significantly, including dropped voice calls.

TRBOnet Enterprise — User Manual
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3.3.1

4.1

4.2

4.3

Linked Capacity Plus Specific Requirements

¢ Addresses and Ports
A static IP Address and UDP Port for the master repeater must be made
available to all peer devices on the Linked Capacity Plus system.

= When a peer device registers with the master repeater, the network supplies
the return IP address and UDP port of the peer device to the master
repeater. The IP address and UDP port must then be made available to all
other MOTOTRBO™ LCP devices on the system.

TRBOnNet Enterprise and Dependencies Installation

TRBOnet runs on Microsoft Windows-based PCs. For the TRBOnet Enterprise
Compatibility Table, see

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ltemID=73

Installing Microsoft SQL Server
Download and install Microsoft SQL Server 2008 R2 or higher.

You can download and install either a full-featured MS SQL Server or an Express
edition of MS SQL Server. The Express edition of MS SQL Server is free, however, it
has some technical restrictions (maximum database size of 10 GB, RAM usage, and
other restrictions).

For example, Microsoft SQL Server 2008 R2 SP2 - Express Edition (which is free) is
available at:
http://www.microsoft.com/en-us/download/details.aspx?id=30438

Note: We recommend that you download a version of SQL Server with
Tools.

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the
defaults for the setup.

See also section 5.2.1.1, Windows Authentication on page 15.

Installing .NET Components

Windows 8 and later, as well as Windows Server 2012 and later, include the required
.NET 4.6 components as part of the operating system.

The .NET Framework redistributables are available from Microsoft at:
https://www.microsoft.com/en-us/download/search.aspx?g=.net%20framework

Installing TRBOnet Enterprise

e Contact Neocom Software to obtain the latest installation package of the
TRBOnet Enterprise software, unzip, and run the setup file as a local
administrator.

e When the TRBOnet Enterprise Setup wizard appears, click Next.

¢ On the End User License Agreement page, accept the terms of the license,
and then click Next.


http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73
http://www.microsoft.com/en-us/download/details.aspx?id=30438
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework
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Choose Setup Type .
Choose the setup type that best suits your needs

TRBOnet Dispatch Console
This is @ dispatcher computer and only Dispatch Console must be installed

TRBOnet Server and Dispatch Console

This is a Server computer and you need to install Server software and
Dispatch Console

= Custom
E Allows users to choose which program features will be installed and where
2 they will be installed.

Neocom Software

< Back Next > Cancel

e On the Choose Setup Type page, click one of the following options:
* TRBOnet Dispatch Console

Choose this option to install only TRBOnet Dispatch Console on your
computer.

TRBOnet Server and Dispatch Console

Choose this option to install both TRBOnet Server and

TRBOnet Dispatch Console at once on your computer.

Custom

Choose this option to select from the list one or more components to be

installed.
Custom Setup '
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

(= ~ | Dispatch Console TREOnet Enterprise 5.2 Agent
e () 7 | Server Instance

Agent Instance |

This feature requires 199MB on
your hard drive.

Location:  C:'Program Files (x85)\Neocom Software|TRBOnet

Browse...
Enterprise\

Neocom Software

Reset Disk Usage < Back Cancel

For example, you may install only TRBOnet Server Instance:

Custom Setup r
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features wil be installed.

e X _~ | Dispatch Console TRBOnet Enterprise 5.2 Server
(=T
b X

~ | Agent Instance

This feature requires 209MB on
your hard drive.

Location: C:\Program Files (x86)Neocom Software\TREOnet

Browse...
Enterprise}

Neocom Software

Reset Disk Usage < Back Cancel

o Accept the defaults for the rest of the setup and complete the installation.

TRBOnet Enterprise — User Manual
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5 TRBOnet Server

To start TRBOnet Server, click the corresponding shortcut on the desktop,
or click Start > All Programs > Neocom Software > TRBOnet Server x.x

5.1 License Information

neocom
software

The TRBOnet software requires a valid license in order to operate. Depending on the
License Type (see next section), the license can be obtained via TRBOnet's website or
from a Neocom representative.

5.1.1 License Types

There are three license types available for TRBOnet Enterprise:

License .
Commercial
Type

Validity 60 days By Request Permanent (non-expiring)

Quantity of Up to 2 control stations

Control or 1 IP repeater )

Stations and | connection By Request According to Customer order

Radio Units | 10 Radio Units

Features Limited functionality By Request According to Customer order
Assigned to server's Assigned to server's Hardware ID.
Hardware ID. Assigned to the serial numbers of
For more details on master repeaters and control

How to It can be downloaded Hardware ID, see stations. To retrieve serial

obtain from the web page. the article at numbers, use Control Station's
http://kb.trbonet.com/ | codeplug (do not rely on a serial
public.pl?Action=Public | number printed on the device's
FAQZoom;ltemID=31. label).

For more information on the license and renewals, contact our technical support at info@trbonet.com

To see how the Hardware ID and control stations and/or repeaters are assigned in
your license, open the INFO file delivered with the license file (for example, in

Notepad):

License ID: aada3405-4e5f-4254-

License generated by: John Smith
License generation date: 7/20/2016

TRECnet Support iz active up to: 7/20/2017
TRECOnet Enterprise (4.0.0.138)

Product:

License for: Neocom Software Ltd
Licensed instance: [Defaulrt]

Server limitations

EIVer Rardware Keys:
42B1-BA64-D473-D6ES-DFAC

Remote Agent connections: 5
System types: Unlimited

Agent limitations
Agent hardware keys: Any

Humber of master radios or master repeaters: 5

|—!

843f-aZballeTc475S

"

/

Fa=ter radicos

master repeaters serial numbers:

484TNL2887; ¢84TNL2ZBEE;

484TNL2889; 4B4TNL2B90; 4B4TNL2B8I]]

Total number of peers in IP Site Connect or Capacity Plus systems: 10
Serial numbers of peers used in IP 3ite Connect or Capacity Plus systems: Unlimited

Limitation for Client connections
Remote Dispatch connections: 10
Number of Remote Dispatch accounts: 10

Subscriber radios limitations
Humber of subscriber radios: 10

1. Your license is assigned to the Hardware ID.

11
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5.1.2

5.1.3

5.14

12

2. Your license is assigned to the serial numbers of master repeaters and control

stations.

Moving TRBOnet Server to a Different Server PC

If there is a need to use TRBOnet Server on a different server PC, please contact your
Neocom sales representative for further instructions.

Using Spare Repeaters

If the plan is to use spare repeaters, for example, as replacement for damaged ones,
communicate the total number of repeaters when ordering a license.

For example, 3 repeaters will be actively used with TRBOnet Server and 1 spare
repeater. Communicate the following repeaters limitation: 3 active 1 spare and
provide the serial numbers of all 4 repeaters when placing an order (also include the

spare repeater’s serial number).

License Manager

¢ In the Configuration pane on the left, select License.
In the right pane, you can see the text of your current license.

Configuration

u Service

G Network.

& Redundancy

Database

(@ Reports

£F Service Management

}' Advanced settings
)\ Geocoding Servers
@ Radio Networks

5= Remote Agents

[ Friendly Servers

’E Telephony

| Data Sources

3% Modbus TCP

24 Email

£ SMS

e
Set Defaults

To apply the new license:

License

License is valid a
License ID: 6b6b2281-C76 1-4747-9eec-8b61260d7382h

Hardware ID: 4281-BA64-D473-D6E3-DFAC

License generated by: Marina Eidelman

License generation date: 03-Mov-2016

TREOnet Support is active up to: 20-Jul-2017

Product: TRECnet_Enterprise (4.0.0.138)

License for: demo

Active instance: [Default]

Licensed instance: [Default]

Demo License
Expiration date: 20-Jul-2017

Server limitations

Server hardware keys:
42B1-BAG4-D473-DSEB-DFAC
Remote Agent connections: 5
System types: Unlimited

Agent limitations
Agent hardware keys: Any
Mumber of master radios or master repeaters: 5

License Manager Send Email Copy to Clipbeard

Apply OK Cancel

1. Click the License Manager link in the right pane.
The License Manager wizard appears.

2. Click Next.

3. Click the ellipsis (...) button on the right-hand side of the License file box.
The Open dialog box appears.

4. Locate the license file you received from our technical support and click Open.
The full path of the license file appears in the License file box.

5. Click Next.

6. Click Finish to close the wizard.

7. Click Apply and then confirm to restart TRBOnet Server.

TRBOnet Enterprise — User Manual
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Note: To use a single license for multiple TRBOnet software
instances, you need TRBOnet License Server. For detailed
instructions on how to use TRBOnet License Server, refer to
TRBOnet License Server Configuration Guide.

5.2 TRBOnet Server Database

¢ In the Configuration pane, select Database.

Configuration Database Version: 5.3.5.1890
' service
O Metwork SQL Server: (local)\SQLEXPRESS v

# Redundancy Database: TRECnet -

= Authentication: Windows v

i@ Reports

[} Service Management
/ Advanced Settings
----- * Geocoding Servers

Q Radio Networks v Specify the path for database archives
[l Remote Agents

il Friendly Servers Path: D:Temp TREONet
B Telephony W] Use custom folder for audio files
l‘ ;::I Sources Path: D:\TemplAudio
[ sMs i Use custom folder to store file attachments
E License Path: D:\TemplAttach
Test Connection
Upgrade Database
Create Database
Set Defaults Apply oK Cancel

¢ In the Database pane, specify the following database-related settings:

SQL Server

Enter the location of the Microsoft SQL Server name and instance. For
example, in the screenshot above, the default instance name of Microsoft
SQL Server Express installed on the local computer is shown.

Database
Enter the name of the TRBOnet database.

Authentication

Select the authentication method for the TRBOnet database. The default
method is Windows Authentication. See also section 5.2.1, Database
Authentication Methods (page 15).

Login and Password
Enter a valid SQL Server login and password if the SQL Server
Authentication is selected for the database.

Specify the path for database archives

Select this option, and in the corresponding Path box enter the full path of
the custom folder for database backups. Or, click the ellipsis (...) button and
in the Browse For Folder dialog box locate the appropriate path.

Use custom folder for audio files

Select this option, and in the corresponding Path box enter the full path of
the custom folder for audio recordings of the voice calls/sessions. Or, click
the ellipsis (...) button.

13
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Path to Audio Files

Root Folder:
D:\audio

File Format:

“oYEAR %\ %MONTH %\ DAY %

Channel Name SystemID System Name Call Tvpe Source Source Type
Source ID Recipient Recipient Type Recipient ID

Example:
D:\Audio\2017Y05423 oo wav

oK Cancel

¢ In the Path to Audio Files dialog box, select the Root Folder, and in the
File Path Template box enter the information (by clicking the
appropriate links below: Year, Month, Day, etc.) that will be used to
generate the file/path name.

Note: If you don't specify folder paths for the database archives
and audio files, TRBOnet Server will use the following
default paths:
%ProgramData%\Neocom Software\TRBOnet Enterprise\Backups -
for database archives.
%ProgramData%\Neocom Software\TRBOnet Enterprise\Audio -
for audio.

Use custom folder to store file attachments
Select this option, and in the corresponding Path box enter the full path of
the custom folder where text message attachments will be stored. Or, click
the ellipsis (...) button and in the Browse For Folder dialog box locate the
appropriate path.
When you finish configuring the required database parameters, click
Create Database.

After you create or upgrade a database, click Apply and then confirm to
restart TRBOnet Server.
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5.2.1 Database Authentication Methods

5.2.1.1 Windows Authentication

e From the Authentication drop-down list, select Windows.

Configuration

ﬂ' Service

0 Metwork

@ Redundancy

Database

(@ Reports

LF Service Management
/ Advanced Settings
)\ Geocoding Servers
(@ Radio Networks

| Remote Agents

[ Friendly Servers

ﬁ Telephony

'} Data Sources

=4 Email

B8 sMs

E License

Set Defaults

Database
SQL Server: {local)\SQLEXPRESS
Database: TREOnet
Authentication: Windows
Windows
SQL Server

Version: 5.3.5.1890

-
-

<>

K| Specify the path for database archives
Path: D:\Temp\TRBOnet

i Use custom folder for audio files

Path: D:{TemplAudio

i Use custom folder to store file attachments

Path: D:\TemplAttach
Test Connection
Upgrade Database -
Create Database >
Apply oK Cancel

To provide access permissions for TRBOnet Server to connect to MS SQL Server,
create an account with sysadmin privileges.

During the installation process, MS SQL Server 2008 automatically grants sysadmin
privileges to the NT Authority\SYSTEM account.

In the case of MS SQL Server 2012 and higher versions, add the

NT Authority\SYSTEM account to the Administrators group during the installation
process. If the database owner privileges are required to work with TRBOnet
Database, you need to assign the sysadmin role to the Local System account. For
instructions on how to install and configure MS SQL Server 2012, see Appendix B:
Configuring SQL Server 2012 for Local System Account.

5.2.1.2 SAQL Server Authentication

e From the Authentication drop-down list, select SQL Server.

Configuration
u Service
0 Metwork
@ Redundancy
Database
-b‘ Reports
L} Service Management
,f Advanced Settings
)\ Geocoding Servers
(@ Radio Networks
5| Remote Agents
[ Friendly Servers
ﬁ Telephony
'} Data Sources
24 Email
B8 sMs

E License

Set Defaults

Database
SQL Server: {local)\SQLEXPRESS
Database: TREOnet
Authentication: SQL Server
Login: sa
Password: | TTEEERE

w! Spedify the path for database archives
Path: D:\Temp\TRBOnet

i Use custom folder for audio files

Path: D:{TemplAudio

R Use custom folder to store file attachments

Path: D:\TemplAttach
Test Connection
Upgrade Database -
Create Database v
Apply oK

Version: 5.3.5.1890

-
-

-

Cancel
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5.3

16

To connect to SQL Server using SQL Server Authentication, create an SQL login

with sysadmin privileges in the SQL Server in use. For detailed instructions on how
to create an SQL login, see
http://technet.microsoft.com/en-us/library/aa337562.aspx

TRBOnet Server Service

¢ In the Configuration pane, select Service.

Configuration Service
& B
G Network.

& Redundancy

The TRBOnet Server service is not installed!

Itis recommended to run TRBOnet Server as a Windows service: it

Database

will start automatically after a reboot and run even when no user is

I} Reports logged on. Click the Install Service button belowto install the

I'F Service Management TRBOnet Server service.

}’ Advanced settings
LA Geocoding Servers
@ Radio Networks

Service logon type:
(@) Logon as Local System (Recommended)

: () Logon as User
5| Remote Agents

52 Friendly Servers

oK Cancel

78 Telephony
i} Data Sources
Modbus TCP Install Service
24 Email
0 5M5
E License
lj;_.)_i\'iev.' Log Entries Export Configuration Import Confiquration
Set Defaults Apply

¢ In the Service pane, specify the following service-related parameters:

= Choose the required logon type:

Logon as Local System
Choose this option to use an account with local system administrator
privileges to run the service as a Windows service (Recommended);

Logon as User
Choose this option to use a different account to run the service as a
Windows service. This account must allow the user to run services in
Windows, have read and write access to the Neocom Software folder and
subfolders in the "%ProgramFiles%" (or, "%ProgramFiles(x86)%" for 64-
bit OS) and "%ProgramData%" folders. For example, using such an

account may be required in the following cases:
1.

Click Install Service.

An Active Directory domain network is used, and the current Windows
user is not allowed to use a Local System account to launch services on
the local PC due to domain policy restrictions.

. MS SQL Server is installed on a remote PC, and Windows
Authentication (see section 5.2.1.1, page 15) has been selected to
connect to the database.

= Click the Start Service link that appears in the right pane.
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Note: If the area, where TRBOnet Enterprise is installed, observes
daylight saving time, it is recommended that, when the
local time is set one hour back, you should stop the service
(Stop Service link) immediately before the time change (for
example, at 2:59) and start it again after an hour (for
example, at 2:59 according to the new time). This procedure
is required to prevent database corruption.

5.4 Network Parameters

¢ In the Configuration pane, select Network.

Configuration Network
' service
G Network Network interface: v @
# Redundancy Command port: 4021 s

Database ) -

2 Reports First VoIP port: 4022 -
L} Service Management VoIP protocol: Tep h
/’ Advanced settings Data protocol: Tcp T

LA Geocoding Servers

& Radio Networks Use broadcast mode for audio
5= Remote Agents Broadcast port:

5| Friendly Servers
2 i Use proxy server
'B Telephony Confiqure

J Data Sources

Encrypt data over netwark

:.% Modbus TCP

24 Email

1 SMS
E License
Set Defaults Apply 0K Cancel

¢ In the Network pane, specify the following network-related parameters:

Network interface
From the drop-down list, select the network interface that will be used to

communicate between the Server and Dispatch Consoles. Click “ to
refresh the list of network interfaces available on your PC.

Note: If both TRBOnet Server and Dispatch Console are installed
on the same PC, then select 127 .0.0.1 (Loopback
Pseudo-Interface).

Command port

Enter the port number to be used by a Dispatch Console to connect to the
Server (4021, by default).

First VolP port

Enter the number of the first VolP port for audio communications between
the Server and Dispatch Consoles (4022, by default). Each additional
Dispatch Console will establish a connection on the next available port
number.

VolP protocol
From the drop-down list, select the VolP protocol type for communications
between the Server and Dispatch Consoles:

e All - UDP will be used first; if unavailable, TCP will be used:;
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e TCP - slower but more reliable (set by default);

e UDP - faster but data packets can be lost; some routers may drop
UDP packets.

= Data protocol
From the drop-down list, select the protocol to exchange data other than
voice between the Server and Dispatch Consoles (TCP, by default).

= Use broadcast mode for audio
Selecting this option will help to optimize network load and minimize
transmission delays. The "load" on the network will be reduced as the
Server will utilize a single audio transmission to a group of Dispatch
Consoles instead of sending multiple audio streams to each individual
Dispatch Console. This method of transmission will also minimize the
transmission delays if there's a large number of Dispatch Consoles or the
Server is busy processing other features.

Note: When the broadcast mode is set, a Dispatch Console
cannot run on the same machine as TRBOnet Server, and a
warning message will appear when you select this option.

¢ Broadcast port
Enter the port number to be used to broadcast audio (5000, by default).

= Use proxy server
Select this option to enable an alternative proxy server for TRBOnet
Dispatch Software to access Internet.

e Click the Configure link to specify the alternative server settings:

Configure the proxy server *

Use an alternative server

Settings

Address:  |177.71.134.70

Paort: 30

Authentication
Use authentication

L
Conce

¢ Use an alternative server
Select this option to enable an alternative proxy server.

v Address
Enter the proxy server IP address.

v Port
Enter the proxy server port number.

e Use authentication
Select this option to use authentication to connect to the alternative
proxy server.
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5.5

5.6

v' Login
Enter the login for the authentication, if needed.
v Password
Enter the password for the authentication, if needed.
e After you configure the proxy server settings, click OK.

* Encrypt data over network
Select this option to guarantee the security of data transfer between
TRBOnet Server and Dispatch Console, and/or TRBOnet Agent. It is
recommended that this option be used when a connection between system
components is established via the Internet or other public networks.

Reports

¢ In the Configuration pane, select Reports.

Configuration Reports Version: 5.2.0,1312
§ Service ~
& Network /! 5ave scheduled reports
& Redundancy Path: D:\Reports
Database
- Format: pdf -
3

LF Service Management

}' Advanced settings

N Geocoding Servers

Radio Networks

Digital Systems

L} Services

I:B Capadity Plus 1

i ¢ Control Station #1
‘.. [A] Analog Control Station:

[ Friendly Servers

’E Telephony
| Data Sources
COM parts v
£ >
Set Defaults Apply OK Cancel

¢ In the Reports pane, select the Save scheduled reports check box and specify
the following parameters:

= Path
Click the ellipsis (...) button and locate the folder on the PC where you wish
to save reports generated by the TRBOnet software.

* Format
From the drop-down list, select the format for the reports (PDF or Excel).
Backup Configuration

TRBOnet Server supports a redundant (secondary/backup) configuration which
allows automatic switching from the primary to the redundant (secondary/backup)
server in case of failure of the primary server. Dispatch Console operation will not be
interrupted.

¢ In the Configuration pane, select Redundancy.
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Configuration
qf Service
G Network
¢
Database
_D\ Reports
L} Service Management

Redundancy

w1 Redundant server mode
Redundancy Mode:

Main servers:
TP Address

Passive

/’ Advanced settings 1 W 10.10.234.152 4021
)\ Geocoding Servers

@ Radio Networks

52| Remote Agents

[ Friendly Servers

7@ Telephony

}' Data Sources

2% Modbus TCP

24 Email

B SMS

[ vicense

Add Edit Delete Test A Y

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, select the Redundant server mode option.

¢ Redundancy Mode
Select a mode for the redundant server from the drop-down list.

For details, see sections Passive Mode and Active Mode on page 373.

e To add a main server, click Add.

Server Properties X

IP Address: | 10.10.234.163|

Fort: 4021

A4k

oK Cancel Test

e IP Address
Type the IP address of the main server.

e Port
Enter the same port number as specified for the Command port.

Note: For more details on Redundant Server configurations, see
Appendix G: Redundant Server (page 372).

5.7  Service Management

The Service Management pane allows you to specify various parameters for the
Presence, Location, Telemetry, TMS, and Indoor services.

¢ In the Configuration pane, select Service Management.
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Configuration
@ Service
G MNetwork
& Redundancy
Database
!.'9 Reports
{:} Service Management

Service Management Version: 5.3.0.1661

Presence service

Auto request presence timeout: ] minutes

ARS refresh interval: 1440 minutes

Ak 4K

Ignore unregistered Radios

X Advanced settings
..... * Geocoding Servers
B Radio Networks
Remote Agents
E Friendly Servers
@ Telephony
l Data Sources
24 Email
[ sMs

E License

Location service

GPS restart by inactivity timeout: | 5 minutes

Ab 4b

Dispatch Console update interval: | 1 seconds

& Automatic error correction
Configure
Send the latest GPS data to dispatchers on alert

For the last:
GPS points:
Telemetry service
Request for the status of GPIO when a radio unit is powered on
Text Messaging service

Text Message Format: Sender and Text -

Max. message length: 140 s chars

Split long message into multiple messages
Indoor service

i Remove offine radio from beacon

Ignore beacon position on alarm if GPS is fixed {only K-TERM)

Set Defaults Apply oK Cancel

¢ In the Service Management pane, specify the following service-related
parameters:

5.7.1 Presence Service

The Presence service group includes the following registration-related parameters:

e Auto request presence timeout
Enter the time interval that will be used by the server to regularly check the
online subscriber radios if there has been no activity. The server considers a
radio to be inactive (or, offline) if the radio does not send any GPS, Text, ARS,
or Voice messages.

If you do not have a dedicated channel for data revert, use the following table:

Number of Presence timeout Number of Presence timeout
radio units (minutes) radio units (minutes)

up to 10 5 30 to 40 17

10 to 20 9 40 to 50 21

20 to 30 13 over 50 120

If there is a dedicated data revert channel in the system, you may set this
parameter to a somewhat lower value than indicated in the table.

If the DDMS service is enabled, set the value of this
parameter to the value of the DeviceRefreshTime
parameter in MOTOTRBO DDMS.

Note:

¢ ARS refresh interval
Enter the value of the parameter that determines how often a radio unit will
send ARS packets. It is recommended that a value of 30 minutes be used for
this interval. This value may be changed depending on the system load.
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Notes: For all radio systems (except for Connect PLUS and Capacity
MAX), the ARS service must be enabled on the subscriber
radio channels (MOTOTRBO CPS, Channels>Channel>ARS).

If the DDMS service is enabled, set the value of this
parameter to the value of the PersistenceTO parameter in
MOTOTRBO DDMS.

See also Appendix F: NAI VOICE & DATA Support.

e Ignore unregistered Radios
Select this option so that unregistered radio units will be ignored and thus
won't appear in Dispatch Console.

5.7.2 Location Service

The Location Service group includes the following location-related parameters:

¢ Dispatch Console update interval
Enter the time interval that will be used to send GPS data packages from the
Server to Dispatch Consoles. The lower the value, the more data traffic will be
present on the network. Adjust this value based on the network bandwidth.
The lower the bandwidth, the higher the update interval.

¢ Automatic error correction
Select this option to enable automatic error correction to detect and correct
invalid GPS data.

Click the Configure link to specify the GPS parameters to be corrected:

Automatic error correction X

In some real world situations, speed and location values from the GPS
receiver may be erratic or unreliable. Use the settings below to apply
automatic error correction to the GPS data feeds.

Discard GPS data if

km/h

\f Location accuracy worse than: 50 meters

4B AH 4

‘f GPS time error greater than: 30 minutes

Coordinates have duplicates

Consider speed zero if less than:

Defaults oK Cancel

Discard GPS data if

= Speed greater than
Select this option and enter the maximum possible speed of your vehicles.

As a result, the coordinates with speeds that exceed the maximum limit will
be discarded.

= Location accuracy worse than
Select this option and enter the largest distance for the accuracy of the GPS
receiver. As a result, the coordinates with distances that exceed the
maximum limit will be discarded.
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5.7.3

5.7.4

= GPS time error greater than
Select this option and enter the largest allowable time error, in minutes. As
a result, the coordinates with time errors that exceed the maximum limit will
be discarded.

= Coordinates have duplicates
Select this option to remove duplicate coordinates from the GPS data.

= Consider speed zero if less than
Select this option and enter the low-speed threshold. Speeds below this
threshold will be considered as zero by the server.

¢ Send the latest GPS data to dispatchers on alert
Select this option so that dispatchers receive the latest GPS data when an alert
occurs. Then choose one of the following options:

= For the last X minutes
Choose this option and enter the time, in minutes, to be used as the last
time period for the latest GPS data.

= GPS points
Choose this option and enter the number of GPS points to be used for the
latest GPS data.

Telemetry Service

The Telemetry Service group includes the following telemetry-related parameters:

¢ Request for the status of GPIO when a radio unit is powered on
Select this option to enable the server to request the status of a radio unit's
telemetry information when the radio is powered on.

Text Messaging Service

The Text Messaging Service group includes the following message-related settings:

e Text Message format
From the drop-down list, select one of the pre-defined formats for text
messages, or select the Custom format.

e Custom Format
Enter your own format for text messages in this box if you have selected
'‘Custom’ from the list above. The Custom Format will default to
{Sender} | {Text}. There are four choices: {Sender}, {Text}, {Date}, and {Time}.
Another example would be: {Date} | {Time} | {Text}.

¢ Max. message length
Enter the maximum number of characters that TRBOnet will send per text
message. The recipient of the text message may not be able to receive the
maximum number of characters due to its design limitations. Therefore, it may
only display a partial text message.

¢ Split long message into multiple messages
Select this option to allow single messages to be split into multiple messages
based on the Max. message length setting.
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Indoor Service

The Indoor Service group includes the following indoor-related parameters:

5.7.5
5.8
24

Remove offline radio from beacon
Select this option so that an offline radio is not shown on its associated
beacon.

Ignore beacon position on alarm if GPS is fixed (only K-TERM)
Select this option so that beacon positioning is ignored in case of alarm when
a radio transmits valid GPS data.

Note: This feature relates only to K-TERM beacons.

Advanced Settings

In the Configuration pane, select Advanced Settings.

Configuration Advanced settings Version: 5.2.0.1316

q Service

G Network.

& Redundancy
Database

Q Reports

Language: English -

Logging level: Mormal -
Administrator Account: Enabled -
Resetpassword

TMA - TRBOnet Audio File -

£F Service Management
L2\ Geocoding Servers

Audio Recording format:

Audio Recording codec: G.711 p-Law /3000 -

@ Radio Networks

Eif Friendly Servers Measurement system: Metric -
E Telephony Latitude/Longitudeformat: Degrees, Minutes, Seconds A
i}* Data Sources

w88 Modbus TCP TX Passive timeout: Unlimited > hours

4 Email Voice Mail timeout: Unlimited > hours

B0 5MS - -

B3 License Text Message Passive timeout: Unlimited + hours

Set Defaults Apply OK Cancel

In the Advanced Settings pane, specify the following advanced parameters:

= Language
From the drop-down list, select the interface language for TRBOnet Server.

* Logging level
From the drop-down list, select the logging level that determines the
granularity of log messages in the System Log. The choices are: None, Low,
Normal, and High.

Note: This information is used by technical support for
troubleshooting purposes, so it is recommended that this
value be kept unchanged (Normal).

= Administrator Account
From the drop-down list, select either Enabled or Disabled. If you select
Disabled, the administrator won't be able to log in to the Dispatch Console.

¢ Reset password
Click this link to reset the administrator password to the default value.
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Audio Recording format

From the drop-down list, select the format to be used to store audio
recordings. The available formats are WAV and TNA.

Note: The TNA format is a proprietary audio format that contains
additional information about radio calls, such as radio ID,
start time, end time, and other parameters. This format
provides more details about call participants and allows
easy navigation within recorded audio files.

Audio Recording codec
From the drop-down list, select the audio codec to be used to compress the
audio files.

Measurement system
From the drop-down list, select either Metric or US units.

Latitude/Longitude format
From the drop-down list, select the format of Latitude/Longitude pairs.

TX Passive timeout

Enter the time that text and voice messages will be stored and later sent
when the channel becomes available (no longer busy). "Unlimited" is
recommended.

Voice Mail timeout
Enter the time duration where TRBOnet Server will continue to try to send
Voice Mail messages to a recipient. "Unlimited" is recommended.

Text Message Passive timeout
Enter the time duration where the TRBOnet Server will continue to try to
send Text messages to a recipient. "Unlimited" is recommended.

5.8.1 Geocoding Servers

Geocoding servers resolve GPS coordinates to street addresses for reporting
purposes and other needs, for example, 'GPS activity for period' reports. Online
geocoding services, such as Google or Nominatim, can be used and are the standard
default services in TRBOnet. However, their use may be limited by the number of
requests. Furthermore, you can add custom geocoding servers to the system.

You can configure geocoding servers in three ways depending on whether the
Server and/or Dispatch Console have Internet access and on your local geocoding
server settings:

1. The Dispatch Console has Internet access and the Server has no Internet
access. The Server can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Dispatch Console.

2. The Server has Internet access and Dispatch Console has no Internet access.
The Dispatch Console can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Server (follow the
instructions below).

3. You have your own Geocoding server in the local network. In this case, you can
configure data resolving in both the Server and the Dispatch Console.
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5.8.1.1 Configuring Geocoding Servers

26

¢ In the Configuration pane, select Geocoding Servers.

Configuration Geocoding Servers
q Service
G Network Use MapPuoint location resolving
& Redundancy
Database

(2 Reports
LF Service Management
)’ Advanced settings Server Name
W\ ] Google
@ Radio Networks W Nominatim

5= Remote Agents
5= Friendly Servers

ﬁ Telephony
| Data Sources
2% Modbus TCP
1 Email
[ 5Ms
5 Licenee Add Delete A |V
|:| Request a place name upon receiving GPS coordinates
Set Defaults Apply OK Cancel

¢ In the Geocoding Servers pane, specify the following geocoding-related

parameters:

= Use MapPoint location resolving

Select this option to get street addresses from MapPoint, and enter the
MapPoint Application ID. MapPoint is a service from Microsoft that is

used to transform coordinates into street addresses.

= Google and Nominatim

These are pre-configured geocoding servers, which allow resolving GPS
coordinates to street addresses and street addresses to GPS coordinates.

Note: These geocoding servers can't be deleted from the system.

= Click Add to add a geocoding server to the system.

Map Server for Geecoding x

Server Name: |MyGeocoding Server |

Get address by coordinates

hitp://127.0.0 1 reverse Hormat =aml&izt={at tlon={on}4z00m=1Baadressdetails=1 |

Test

Get coordinates by address

‘Hl'tp +//127.0.0.1/search?g={address}&format =xml

Test

Canl

e Server Name
Enter the name of your geocoding server.

¢ Get address by coordinates

Select this option to resolve GPS coordinates to street addresses.
In the box below, enter the server address with the appropriate

parameters.
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Note: Keep in mind that the {lat} and {lon} variables are
mandatory to allow TRBOnet Dispatch Console to retrieve
GPS coordinates from the radio unit.

Click Test to check the connection to the geocoding server. Enter a pair
of GPS coordinates and see if the resolved street address appears.

¢ Get coordinates by address
Select this option to resolve street addresses to GPS coordinates (for
example, for the Search by Address feature).
In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {address} variable is mandatory to
allow TRBOnet Dispatch Console to search map objects by
address.

Click Test to check the connection to the geocoding server. Enter an
address and see if you get the list of map objects corresponding to the
address entered.

Use the Up (\* ) and Down (¥ ) buttons to move the selected geocoding
server up and down in the priority list of geocoding servers. When
requesting GPS data via the geocoding servers configured in TRBOnet
Server, GPS data is requested from the geocoding servers according to the
priority level. The geocoding server at the top of the list has the highest
priority level. In case the first geocoding server is unavailable, data will be
requested from the second geocoding server in the list, and so forth down
the list of geocoding servers.

The administrator must ensure that the geocoding servers in the list are
able to resolve GPS data.

Request a place name upon receiving GPS coordinates

Select this option to resolve GPS coordinates to street addresses
immediately by a GPS event. Note that street addresses and GPS
coordinates are automatically (without user intervention) stored in the
TRBOnet database to optimize the response time for street address
requests (for example, GPS reports) and to reduce geocoding server load.
These street addresses and GPS coordinates will be stored without user
intervention whenever GPS are resolved to street addresses via a request to
a Geocoding Server.

5.9 Radio Networks

By enabling the Radio Networks feature, the TRBOnet Server is able to be connected
to a radio system. Otherwise, you should use Remote agents.

¢ In the Configuration pane, select Radio Networks.

¢ In the Radio Networks pane, select Enable Radio Networks.
Or, in the Configuration pane, right-click Radio Networks and choose
Use Radio Networks.
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Configuration Radio Networks Version: 5.2.0.1312

d’: Service -
& Network
& Redundancy
Database
_b\ Reports

W/ Enable Radio Networks

£} Service Management
)’_ Advanced settings
N Geocoding Servers
.
9 TRBORet Cloud
Q) Digital Systems
LF services
I:B Capadity Plus 1
iy Control Station #1
i..[5| Analog Control Station:
il Friendly Servers
E Telephony
«} Data Sources

< >

Set Defaults Apply Ok Cancel

¢ In the Configuration pane, you can select TRBOnet Cloud.

Note: TRBOnet Cloud is a customizable feature. Please contact
your regional Business/Sales Managers for further details.

¢ In the Configuration pane, select Digital Systems.

¢ In the Digital Systems pane, select or make sure Enable Digital Systems is

selected.

Configuration Digital Systems
o Service ~
0 MNetwork ! Enable Digital Systems

@ Redundancy

Database CAI Network: 12 -

(=]

i Reports CAI Group Metwork: 225 b

L} Service Management

,f_ Advanced settings
..k Geocoding Servers
.| Radio Metworks

Yoot s e

Registered Digital Systems
.. Name

Repeater #1

1P Address
10.10,102.131

Radio ID
54250

Control Station #1
TREOnet Swift Agent#1

192,168.98.2
10.10.110.191

54250
54250

I Services

‘B Repeater #1

¢ Control Station #1

I TREOnet Swift Agent#1
i..[%| Analog Control Stations

5l Remote Agents

[ Friendly Servers
E Telephany

|’ Data Sources
212 Modbus TCP

Add Delete Test
4 Email w

Set Defaults Apply OK Cancel

¢ In the Digital Systems pane, specify the following parameters:

= CAIl Network
The CAl (Common Air Interface) Network is a value that is combined with
the Radio ID to produce the individual radio's air interface network IP
address. All radios must use the same CAI Network ID to be able to
exchange data. It is recommended that the default value of 12 is used.
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The CAl Group Network is a value that is combined with the Group ID to
produce the group's air interface network IP address. The CAl Group
Network ID forms the first or most significant byte of each group's network
IP address. All radios must use the same CAI Group Network ID to be able
to exchange data (225, by default).

Note: The values of these two parameters must match those
configured for the radio units via the MOTOTRBO CPS.

Digital Systems

Configuration
Q Service
G Metwork

@ Redundancy

Database

(2 Reports
L} Service Management
,’_ Advanced settings

A Geocoding Servers
.| Radio Networks
£5) TRBONet Cloud
() Digital Systems
F Services
: :e Capadity Max
:ﬂ Capacity Plus #1

)’: Advanced settings

£} MNIS data service

Set Defaults

,{ Advanced setting

>

v

Digital Systems

&/ Enable Digital Systems

CAI Network: 12

CAI Group Network:

225

Registered Digital Systems

+or | Mame

T TIrrrErl

IP Address

Capadity Max
il Capadity Plus #1
LCP #1
W Ipsc
Tetra #1
Control Station #1
¥ TRoonet switazmo L

10.10.1388.35
192,168.10.100
10,10,101,137
10.10.177.200
192,168.10,2
10.10.135.126

2

\

Delete

Add MOTOTRBO System
Add Capacity MAX

Add DIMETRA Express

oK

Add Control Station

Add TREOnet Swift Agent
Add Friendly FS-1000 Station
Add XRC-8000 Centroller
Add XRT-2000 Controller
Add SELEX Repeater

Add KAIROS Repeater

Add WAVE Controller

Version: 5.3.5.1855

Ar 4

Radio ID
64250
64250
64250
64250

27
64250

Test

Cancel

All radio systems based on MOTOTRBO services are represented in the
Registered Digital Systems table, including their Name, IP Address, and Radio ID

(N:

e To add a radio system, click Add and select the appropriate system type from

the drop-down menu (2).
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5.9.2 Services

¢ In the Configuration pane, under Digital Systems, select Services:

30

Configuration

o service

O Network

@ Redundancy

Database

_l} Reports

£} Service Management

)’_ Advanced settings
N Geocoding Servers
.| Radio Networks

ﬂ} Digital Systems

I:B Repeater #1

% Privacy
¥ DDMS service

Audio Paths
Control Station #1

. Advanced settings

IS data service
}: Advanced settings

}' Advanced settings

j’ Advanced settings

... TRBOnet Swift Agent#1

i Redundancy
... [%] Analog Control Stations
F:l Remote Agents
[ Friendly Servers
%8 Telephany
I Data Sources
£2 Modbus TCP
4 Email
[0 5Ms

E License

Set Defaults

Services

Port: 4005

i Telemetry service (TLM)

Port: 4008

W Text Messaging service (TMS)
Port: 4007

W Location service (GPS { Indoor)

Text Messaging service DMR

Indoor service (K-TERM)

Indoor LAN Service (K-TERM)

Tallysman Sprite service

FS 5000 location service (GPS)

Swift.Tracker v. 1 service

/! Automatic Registration service (ARS)

4

Swift. Tracker v. 1 service (IP channel)

W swift. Tracker v. 2 service
Port: 4104

4

Swift. Tracker v. 2 service (P channel)

Extended Text Messaging service

Telemetry service Movox

G45 R5232 service

Zebra printer service

Forward Data service

Configure

Apply oK Cancel

¢ In the Services pane, specify the following Digital System Services-related
parameters:

= Automatic Registration Service (ARS)

Select this option to enable the ARS service for the radios. When the radio
powers up, it automatically registers with the server. This feature is used
with data applications, that is, any data traffic on this channel is associated
with an application server such as MOTOTRBO Text Messaging or

MOTOTRBO Location Services.

Port

Enter the local port number for the ARS service (4005, by default).

TRBOnet Enterprise — User Manual



TRBOnet Server

neocom
SOF ware
Telemetry service (TLM)

Select this option to enable the Telemetry service, which is the wireless
transmission and reception of measured quantities for remotely monitoring
environmental conditions or equipment parameters.

e Port
Enter the local port number for the Telemetry service (4008, by default).

Text Messaging service (TMS)
Select this option to enable the Text Messaging service which is used to
exchange text messages between the radios and the dispatchers.

e Port
Enter the local port number for the Text Messaging service (4007, by
default).
Location service (GPS / Indoor)
Select this option to enable the Location service. The radio can send its
coordinates when it is in Global Positioning or iBeacon coverage area.
e Port
This is the local port number for the Location service (4001), which
cannot be modified.

Text Messaging service DMR

Select this option to enable the DMR-based Text Messaging service.

e Port
Enter the local port number for the DMR-based Text Messaging service
(5016, by default).

Indoor service (K-TERM)
Select this option to enable the Indoor Location service.

e Port
Enter the local port number for the Indoor service (3022, by default).
Indoor LAN Service (K-TERM)
Select this option to enable the Indoor LAN service.
e Port
Enter the local port number for the Indoor LAN service (3001, by default).
Tallysman Sprite service
Select this option to enable the service for autonomous event and
aggregated event reporting to provide significant reduction in GPS data
overhead.
e Port
Enter the local port number for the Tallysman Sprite service (4004, by
default).
FS 5000 location service (GPS)

Select this option to enable the FS 5000 location service, which is a service
for transmitting GPS data packages. This service uses FS 5000 Option Board.
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e Port
Enter the local port number for the FS 5000 location service (4004, by
default).

Swift.Tracker v.1 service
Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TROO1 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service (4004, by
default).

Swift.Tracker v.1 service (IP channel)

Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TROO1 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service with an IP
channel (4080, by default).

Swift.Tracker v.2 service

Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TROO1 device (version
2).

e Port
Enter the local port number for the Swift.Tracker v.2 service (4104, by
default).

Swift.Tracker v.2 service (IP channel)

Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TROO1 device (version 2).

e Port
Enter the local port number for the Swift.Tracker v.2 service with an IP
channel (4180, by default).

Extended Text Messaging service

Select this option to enable the Extended Text Messaging service to include
sending detailed preconfigured templates with the help of TRBOnet
Dispatch Software.

e Port
Enter the local port number for the Extended Text Messaging service
(4010, by default).

Telemetry service NOVOX
Select this option to enable the Telemetry service based on NOVOX devices.

e Requests port
Enter the local port number to listen for requests (8090, by default).

e Events port
Enter the local port number to listen for events (8091, by default).
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G4S RS232 service

Select this option to enable the custom developed G4S RS232 service.

e Port
Enter the local port number for the G4S RS232 service (4004, by default).

Zebra printer service

Select this option to enable the service for printing Job Tickets. A Zebra
printer is connected to a radio via Bluetooth. The radios should be
Bluetooth-enabled.

e Port
Enter the local port number for Zebra printer service (4072, by default).

Forward Data service
Select this option to enable the Forward Data service. This feature is used to
forward "raw data" via the COM port from one device to another.

e Port
Enter the local port number for Forward Data service (4011, by default).

5.9.3 Adding a MOTOTRBO Repeater

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add MOTOTRBO System.

Configuration Digital Systems Version: 5.3.5.1855
ﬂ’ Service ~
& Network /] Enable Digital Systems
& Redundancy
Database CAI Network: 12 :
i Reports CAI Group Network: 225 :

L} Service Management
,’_ Advanced settings
N Geocoding Servers
.| Radio Networks
-{§) TREONEt Cloud
QTR
LA} Servicl B
- [2] Analog Co &

Registered Digital Systems

.o Name 1P Address Radio ID

Add MOTOTRBO System
Add Capacity MAX

Add DIMETRA Express
Add Control Station

F:l Remote Agent
5l Friendly Serve
ﬂ Telephony o
- ndvanced

e Add TREOnet Swift Agent
~ZR Internal PE . .
32 Advan g Add Friendly F5-1000 Station

e ogp  Add XRC-9000 Controller
SetDefy Apply OK Cancel

ogp  Add XRT-9000 Controller

oqp  Add SELEX Repeater

P
o Add KAIROS Repeater
P
o Add WAVE Controller

Set Defaults

¢ In the Repeater pane, specify the connection parameters.
To ensure your connection parameters match the actual configuration of your
radio network, you may need to use Motorola CPS or Config Advisor tools to
determine the values. Contact your radio network administrator, if you do not
have this information.
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Configuration
ﬂ’ Service
0 MNetwork
@ Redundancy
Database
2 Reports
L} Service Management
)’_ Advanced settings
A Geocoding Servers
.| Radio Networks
) Digital Systems
-4} Services
Repeater #1

Advanced settings
Privacy

Slot #1

Slot #2

Local Slots

Repeater #1

System Name: Repeater #1
TRBOnet Peer ID: 100
TREOnet Radio ID: 54250
TRBOnet Local Port: 50000
Master Repeater Connection Info:
Master IP Address: 10.10.102.131

Master UDP Port: 50011

Authentication Key: 99995

System Type: IP Site Connect

System Identifier: Departmentl

Use NAI Voice
Use MAI Data (MNIS and DDMS)

-l Control Station #1
=| Analog Control Stations
=l Remote Agents

il Friendly Servers ]

Set Defaults Apply oK Cancel

System Name
Enter a name of the repeater. This name will be displayed in the Dispatch
Console.

TRBOnet Peer ID
Enter a Peer ID for TRBOnet Server. The Peer ID must be unique among the
repeaters in the radio system.

Note: Motorola recommends that this value be less than 200.

TRBOnet Radio ID

Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system (for Capacity Plus and Linked Capacity
Plus systems, the maximum value is 65535).

TRBOnet Local Port

Enter the local port number that will be used by TRBOnet Server to
establish a connection to the repeater. Use unique port numbers for each
repeater connection if there are several repeaters connected.

Master IP Address
Enter the Ethernet IP address of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master IP.

Master UDP Port
Enter the UDP port number of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master UDP Port.

Authentication Key
Enter the repeater's authentication key (if any).

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Authentication Key.
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System Type

From the drop-down list, select the type of the radio system
('IP Site Connect’, 'Capacity Plus’, 'Linked Capacity Plus’, or
‘Extended Range Direct Mode').

Test

Click this button to check the connection to your master repeater. If the test
is successful, you'll see the information on the repeater you are connected
to, such as the serial number, firmware version, and other relevant
information.

System Identifier

Enter the system identifier if a Capacity Plus or Linked Capacity Plus system
is used with one or more control stations. Use the same system identifier as
you have specified for the corresponding control stations.

Use NAI Voice

Select this option to connect to the repeater via NAI (Network Application
Interface) for Voice transfer. For more details about NAI, see Appendix F:
NAI VOICE & DATA Support (page 362).

Use NAI Data (MNIS and DDMS)

Select this option to connect to the repeater via NAI (Network Application
Interface) for Data transfer. For more details about NAI, see Appendix F: NAI
VOICE & DATA Support (page 362).

¢ MNIS
MOTOTRBO Network Interface Service is a Windows application which
acts as a data gateway between the data applications and the radio
system. Data messages are routed through the MNIS.

o DDMS
Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the
data to the server.
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5.9.3.1 Advanced Settings

36

¢ In the Configuration pane, under the corresponding Repeater, select
Advanced settings.

Configuration Advanced settings

U’ Service -
0 MNetwork Voice Call Hang Time (ms):
¥ Redundancy Group Call: 3000
Database .
];5 Reports Private Call: 4000
£} Service Management Emergency Call: 4000
)’_ Advanced settings X
* Geocoding Servers i 120
.| Radio Networks TX Timeout: &0 > | seconds
Q) Digital Systems
AL} Services Phone System: Motorola Phone System
o Repeater #1
)9'_ Advanced settings
Privacy
LI Slot #1
.0 Sot #2
: Local Slots
- gigy Control Station #1
=| Analog Control Stations
3=l Remote Agents
3 Friendly Servers v
Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following repeater-related
advanced settings:

Voice Call Hang Time (ms):

Group Call

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

Note: The values of the above three parameters must be taken
from the corresponding parameter values programmed for
the repeater via MOTOTRBO CPS in General Settings.

TX Preamble

Enter the value of the TX Preamble. The TX Preamble is a string of bits
added in front of a data or control message (Text Messaging, Location
Messaging, Registration, Radio Check, Private Call, and other message
types) before transmission. The acceptable range is 0 - 8640 ms. The
recommended value is 120 ms.
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= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

= Phone system
From the drop-down list, select the system for phone calls:

¢ Motorola Phone System
This system uses a special call type with the parameters specified for a
radio unit in MOTOTRBO CPS. The Motorola Phone System is
recommended for IP Site Connect mode to minimize Radio response
time. For more details on programming Motorola Radios, see Appendix
E: SIP Setup for Motorola Phone System (page 359).

¢ TRBOnet Phone System (TX Interrupt)
This is a phone call system based on the private call type using TX
Interrupt feature. This phone system is available for radio systems with
control stations.
= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

Note: This feature is available only when the MNIS Data Service is
enabled for the repeater.

5.9.3.2 Privacy

¢ In the Configuration pane, under the corresponding Repeater, select Privacy.

Configuration Privacy Wersion: 5.3.5.1872
d’: Service -
G Network Frivacy Type: Enhanced -

& Redundancy
Database X

~ Enhanced Privacy Keys:

i Reports

L} Service Management Alghoritm i} Name Value

)’_ Advanced Settings ?ARC4 (40bit)y - 1

(RN Geocoding Servers ARC‘E (‘whb";)

AES (256 bit]
.| Radio Networks AES (256 bif) Legacy
£5) TREOnet Cloud

@ Digital Systems

L3 Services

o Repeater 1

W Advanced Settings

L. Slot #2
i-L17 Local Slots

... [®] Analog Control Stations Add i @ File
Faz| Remote Agents v
Set Defaults Apply QK Cancel

¢ In the Privacy pane, specify the following privacy-related settings:
= Privacy Type
From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

= Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.
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Enhanced Privacy Keys
Here you add enhanced privacy keys when the Enhanced privacy type is
selected.

e Click Add and specify the required Algorithm, ID, Name, and Value for
the privacy key being added.
v" Algorithm
From the drop-down list, select one of the enhanced algorithms if you
are going to use additional encryption.

5.9.3.3 DDMS Service

The DDMS, or Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the data to the

server.

¢ In the Configuration pane, under the corresponding Repeater, select
DDMS service.

Configuration DDMS service
- £5) TREOnet Cloud A
Q) Digital Systems
4} Services
I:B Capacity Max
tﬂ Capadity Plus #1
[, .. Advanced Settings
Privacy
-
. Advanced Settings
MNIS data service
)’_ Advanced Settings
T Audio Paths

g LCP 1
g 1Psc

-~y Control Station #1
- ) TRECnet Swift A200
| Analog Control Stations
5l Remote Agents

il Friendly Servers add Delete g
‘B Telephony v

Set Defaults Apply oK Cancel

Version: 5.3.5.1874

W] Use DOMS service
Local port: 0
127.0.0.1

Service IP Address: Test

Service port: 3000

AF 4B A4

Authentication Port: | 5055
Redundant services:

Service IP Address | Service port
1 M 10.10.101.207 3000 0

Local port

4k

¢ In the DDMS service pane, specify the following DDMS service-related
settings:

38

Use DDMS service
Select this option to enable the DDMS service for the server.

Local Port

Enter the number of the local port to be used on a PC with TRBOnet
Dispatch Software for DDMS service.

Service IP Address

Enter the IP Address of the PC with the DDMS service installed and running.

Service port
Enter the service port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces >Watcher Settings>PortWatcher.
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Authentication Port
Enter the authentication server port number.

Note: This value is programmed for a DDMS service via

MOTOTRBO DDMS Administrative Client, in
Interfaces >Authentication Server Settings >
AuthenticationServerPort.

Redundant services
Here you see the list of redundant DDMS services for failover purposes.

Click Add and specify the required parameters for the DDMS service
being added.

Click Test to test if the selected DDMS service is available.

Use the Up (\* ) and Down (Y ) buttons to move a selected DDMS
service up and down in the priority list of DDMS services.

Advanced Settings

¢ In the Configuration pane, under DDMS service, select Advanced Settings.

Configuration
9 TREOnet Cloud A
. 4J) Digital Systems

L} Services
= tﬁ Capadty Max
.. tﬁ Capadity Plus #1

- LCP 1

..ol Repeater #1
)’ Advanced Settings
Privacy
DOMS service
- Advanced Settings
MNIS data service
L[ Slot #1

0T Slot #2
\..CI7 Local Slots

--gligy Control Station #1
- TREOnet Swift A200
... [2| Analog Control Stations
55| Remote Agents Add
F+-| Friendly Servers hd

Advanced Settings Version: 5.3.5.1374

Radio ID list: 1-200 2

Events: all -

Specify external sites:

Site ID Presence Voice Data

Set Defaults Apply CK Cancel

¢ In the Advanced settings pane, you can specify settings that relate to the
connected DDMS service:

Radio ID list
Enter a list of the radios to receive data from according to the following
rules:

Note:

To receive data from all radios in the system, leave this box blank.

To receive data from multiple radios, separate each Radio ID by a
comma, for example, 105,106,111, and so on.

To receive data from a range of radios, enter the range using the
following example: 105-111.

In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".
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= Events
In the drop-down list, select the events to be monitored.

= Specify external sites
This is the list of sites that is used when the corresponding system has a
MOTOROLA System Bridge to the current Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and
selecting the appropriate data types (Presence, Voice, and/or Data).

5.9.3.4 MNIS Data Service

The MNIS, or Motorola Network Interface Service, is a Windows application which
acts as a data gateway between the data applications and the radio system. Data
messages are routed through the MNIS.

¢ In the Configuration pane, under the corresponding Repeater, select
MNIS data service.

Configuration MNIS data service
U Service ~
& Network /] Use Data Gatenay
‘;5 Redundancy /] Service is on a local host
Datzbase
2 Reports IP Address: 172.16.10.2 e
[} Service Management /] Control port: 5000 b Test
A Advanced settings MNIS Service: &2
A Fiencodlng — Redundant services:
B IP Address Control part Local port
Q) Digital Systems
L LF services
na Repeater #1
)f: Advanced setti
. Privacy
DMS service
INIS data ser
/’: Advanced :
0 Audio Paths —
L4 >
Set Defaults Apply OK Cancel

¢ In the MNIS data service pane, specify the following MNIS data service-
related settings:

= Use Data Gateway
Select this option to enable the MNIS data service for the server.

= Service is on a local host
Select this option if the MNIS data service will be used on the local PC.

= |P Address
Enter the IP Address used by the MNIS to communicate with the PC.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, and can be
retrieved from General>Tunnel Network>Tunnel IP Address.

= Control port
Enter the number for the MNIS control port.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, in
Advanced>Network>MNIS Control Interface TCP Port.
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= MNIS Service

Select this option, and from the drop-down list select the available MNIS
service.

= Redundant services
Here you see the list of redundant MNIS data services for failover purposes.

e Click Add and specify the required parameters for the MNIS data service
being added.

e Click Test to test if the selected MNIS data service is available.

e UsetheUp (2 )and Down (Y ) buttons to move a selected MNIS data
service up and down in the priority list of MNIS data services.

Advanced Settings

¢ In the Configuration pane, under MNIS data service, select
Advanced Settings.

Configuration Advanced settings
q Service ~
O Netwark Add network routes to the Windows routing table
@ Redundancy
Database
"73 Reparts Send data to group over control port

LF Service Management S - 16777215

,f_ Advanced settings
.\ Geocoding Servers
.| Radio Metworks
g} Digital Systems
L} Services
..ol Repeater #1
- Advanced settings

Radio Range: 1

" Privacy

F DDMS service

)’_ Advanced settings

F MMNIS data service

)’_ Advanced settings

----- Audio Paths w

Set Defaults Apply CK Cancel

¢ In the Advanced settings pane, you can specify settings that relate to the
remote MNIS data service:

= Add network routes to the local Windows routing table
Select this option to allow TRBOnet Server to add network routes to the
local Windows routing table so that data can be sent to the remote MNIS
data service.

= Add port forwarding rules to the remote MNIS service
Select this option to allow TRBOnet Server to add forwarding rules to the
remote MNIS data service.

= Send data to group over control port
Select this option so that data will be sent via the specified control port.

= Radio Range
Specify the range of radios to be monitored by the MNIS service.
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5.9.3.5 Slots

Note: The slots are available only when IP Site Connect is selected in the
Repeater pane.

¢ In the Configuration pane, under the corresponding Repeater, select Slot #1

or Slot #2.
Configuration Slot #1 Version: 5.3.5.1897
d’: Service ~
0 Network Wl slot #1
@ Redundancy Name: Slot 1
= Database Messaging Delay: Normal v
i Reports

Use the slot for RX Data only (GPS Revert or Data Revert)

Use Privacy

£ ¥ Service Management
\)’: Advanced Settings
L..A Geocoding Servers

.| Radio Networks & Allow interruption
9 TREOnet Cloud i Always transmit when the PTT is pressed (Tmpolite™ channel access)
ﬂ} Digital Systems /! Data Call Confirmed

-4 ¥ Services

P5C1

Advanced Sett
2 Privacy

Slot £2

Local Slots

Private Call Confirmed
V! Emergency Alarm Ack
/! Emergency Calljalarm Indication

- cP1
... [7| Analog Control Station:
35 Remote Agents

EA mriandh: 2arare
< >

W

Set Defaults Apply oK Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

= Messaging Delay
From the drop-down list, select the inter-repeater messaging delay based
on the IP network configuration.
e Normal
The inter-repeater messaging delay is 60 ms.
e High
The inter-repeater messaging delay is 90 ms.
= Use the slot for RX data only (GPS Revert or Data Revert)
Select this option to configure the slot so that it will only receive data, thus
having no transmission capability.

= Use Privacy
Select this option to use Privacy for the slot.

Note: This option is available only if the Basic or Enhanced
Privacy Type have been selected in Repeater's Privacy
settings.

= Privacy Key
From the drop-down list, select the privacy key.
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Note: This option is available only if the Enhanced Privacy Type
has been selected in Repeater's Privacy settings).

Allow interruption
Select this option to allow interrupting dispatcher transmissions by radios
that are Transmit Interrupt capable.

Note: This feature is available only when the Use NAI Voice
option is cleared in the Repeater pane.

Always transmit when the PTT is pressed (“Impolite” channel access)
Select this option so that when the PTT button is pressed, the dispatcher
will start transmitting regardless of whether the channel is free or not (that
is any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

Data Call confirmed
Select this option to enable data packets in data calls (ARS, GPS, and Text
Message) on the current slot to be confirmed.

Note: This feature is available only when both the Use NAI Voice
and Use NAI Data (MNIS and DDMS) options are cleared
in the Repeater pane.

Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed. By
default, Private calls are unconfirmed.

Emergency Alarm Ack
Select this option so that the Dispatch Console is allowed to acknowledge
an emergency alarm received via this slot.

Emergency Call/Alarm Indication
Select this option so that audio and visual indication is given for an
emergency call/emergency alarm received via this slot.

5.9.3.6 Local Slots

While on a local slot, voice or data are not transmitted between sites in IPSC
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive
information from local slots, but cannot transmit by IP connection to such slots.

Note:

Local slots are available only when IP Site Connect is selected, and
the Use NAI Voice option is selected in the Repeater pane.

If the Use NAI Voice option is cleared, local slots will be available
only through dedicated control stations.

¢ In the Configuration pane, under the corresponding Repeater, select
Local Slots.
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Configuration Local Slots
U Service ~
Load P Map
0 MNetwork S
@ Redundancy Name
Database i/ Local Brine's|
(@ Reports

I} Service Management
/’_ Advanced settings
..k Geocading Servers
.| Radio Metworks
Q) Digita! Systems
L} Services
1:3 Repeater #1
¥ advanced settings
Privacy
DDMS service
MNIS data service
\}: Advanced settings
Slot #1
Slot #2
+..C17 Local Slots
-1 Control Station #1 v

Add Remove

Set Defaults Apply

Peer ID Peer Slot

1002 Slot #1
Configure
oK. Cancel

In the Local Slots pane, specify the following Local Slot-related settings:

= To add a Local Slot to the system, click Add.

= Select the option in the first column to enable the selected local slot.

= Enter a Name for the local slot. This name will be displayed in the Dispatch

Console.

= Enter the Peer ID of the repeater.

Note: This value can be taken from the repeater's configuration in
MOTOTRBO CPS, in General Settings>Radio ID.

= From the drop-down list, select the Peer Slot.

= To configure the selected local slot, click Configure:

T Configuration
Name: _ocal Brine's
Messaging Delay: Mormal b

Use the slot for RX Data only(GPS Revert or Data Revert)

Use Privacy

Always transmit when the PTT is pressed ("Impolite” channel access)

Private Call Confirmed
/] Emergency Alarm Ack
¥4 Emergency CallfAlarm Indication

OK Cancel

hed

= Specify the desired local slot settings similar to those for a common

repeater slot.

5.9.3.7 Audio Paths

44

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Capacity Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.
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Note: Audio paths are available only when Capacity Plus or Linked
Capacity Plus are selected.

¢ In the Configuration pane, under the corresponding Repeater, select

Audio Paths.

Configuration

Audio Paths

G Network
& Redundancy Losd Groups Map
Database Call Type Group ID Site ID
2 Reports ]| Group call 10 Wide
L ¥ Service Management W Group Call 20 Wide
," Advanced settings W] Private Cal
(RN Geocoding Servers K71 allcall
.| Radio Networks
..{Z) Digital Systems
L} Services
.o TP Site Connect
- Advanced setti
" Privacy
¥ DDMS service
INIS data ser
. Advanced :
Audio Pams/
< g Control Station #1 Add Delete Configure
Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:

= To add an audio path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

= Enter the Site ID of the site the audio path will belong to in a Linked
Capacity Plus system. Or, leave zero value in this column. In this case, the
Site ID will be displayed as Wide, meaning that the audio path will belong
to all sites in the system.

= To configure the selected audio path, click Configure.

= Specify the desired audio path settings similar to those for a common

repeater slot.

Adding a Capacity MAX System

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add Capacity MAX.

Note that a Capacity Max system can only be integrated with TRBOnet PLUS
software. For more information on how to configure and deploy a Capacity MAX
system, see TRBOnet PLUS MOTOTRBO Capacity MAX Deployment Guide.
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5.9.5 Adding a DIMETRA Express system
¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.
¢ In the drop-down menu, click Add DIMETRA Express.

For more information on how to configure and deploy a DIMETRA Express system,
see TRBOnet DIMETRA Express Deployment Guide.

5.9.6 Adding a Control Station

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add Control Station.

Configuration Control Station #1
o service ~
& Network Name: Control Station 1|
@ Redundancy Radio ID: 54250 :
Database
I>‘ Reports IP Address: 192.168.98.2 @ Test

L¥ Service Management Mode: 1P Site Connect -
)’ Advanced settings

s System Identifier: Department 1
L.k Geocoding Servers P
- Radio Networks Use the radio for RX Data only (GRS Revert or Data Revert)
Digital Systems Playbackdevice: | Speakers (Logitech USB Headset) v
} Services
ontrol Station #1 Recorder device: Line In (2- High Definition Audio Device) A
H f Advanced setti
. [] Analog Control Station:
5= Remote Agents
5l Friendly Servers
'ﬁ Telephony
L Data Sources o
< >
Set Defaults Apply OK Cancel

¢ In the Control Station pane, specify the following control station-related
parameters:

* Name
Enter a name for the control station. This name will be displayed in the
Dispatch Console in the Voice Dispatch Radio Interface pane. It will be the
name at the top of the PTT box.

= Radio ID
This is the Radio ID of the radio unit connected as a control station.

(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).

Note: This box is populated automatically once you have
successfully tested the control station by clicking the Test
button.

= |P Address

Enter, or select from the list, the IP Address of the control station network
interface.

Note: This value is can be taken from the radio's configuration in
MOTOTRBO CPS, in Network>Accessory IP.
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Click this button to check the connection to the control station. If the test is
successful, you'll see the information on the control station you are
connected to, such as radio ID, serial number, firmware version, and other
relevant information.

Mode

From the drop-down list, select the connection mode for the control station
being configured. For more details, see section 5.9.6.1, Control Station
Connection Modes (page 47).

System Identifier

Enter the system identifier with which the control station is used within a
Capacity Plus or Linked Capacity Plus system. Note that the system
identifier should be the same for all control stations used in a (Linked)
Capacity Plus system.

Use the radio for RX data only (GPS Revert or Data Revert)
Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

Playback device
From the drop-down list, select the playback device on the PC that will be
used to transfer audio data to the connected control station.

Recorder device

From the drop-down list, select the recording device on the PC that will be
used to receive audio data from the control station connected via a line-in
jack.

5.9.6.1 Control Station Connection Modes

Single Control Station

The Single Station mode is the simplest connection mode for receiving and
transmitting voice and data through a conventional channel using one control
station at this particular frequency.

AN
AN

B =
LN

L

TRBOnet Dispatch Console
Server
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IP Site Connect

The IPSC is a digital conventional two-way MOTOTRBO system that allows you to
extend the area of your communications by providing 2 wide area channels per
repeater. It is possible to connect up to 15 repeaters in one system using IP
connection.

The Server Connection Modes are as follows:

1. TRBOnet Server is connected to a repeater with two time slots in the "IP
Site Connect" mode. The Server can transmit and receive over IP.

2. TRBOnet Server has no IP connection to a repeater. Two control stations
are required to transmit and receive voice and data, that is, one control
station per time slot.

Common Channel

The Common Channel is a mode where it is possible to use multiple simplex base
stations operating at the same frequency with overlapping communication zones.

This mode allows the customer to provide radio coverage to large areas when there
is only one frequency and additional frequencies are unavailable. While in this mode,
the coverage area is being extended only for the dispatcher, and specifically when
operating at one and the same frequency. When a radio unit initiates a call, the
signal that can potentially be received by several base stations will be filtered on the
server side so that repeated audio playback and recording is prohibited.

The signal filtering is performed based on the "first packet", that is, only the signal
coming first to the server is played back and recorded, while the remaining signals
are discarded.

When a dispatcher initiates a call to a specific base station, the signals received by
the neighboring base stations will be discarded to prevent dispatchers from listening
to their own call at the time of transmission. The dispatcher is not recommended to
place a simultaneous call to all base stations to avoid interference to the subscribers.

The recommended way to use this mode is as follows: each base station is
configured with its own color code, and radio units are equipped with option boards
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having a Geo-roaming feature, and each geographic area is assigned its own radio
channel with the corresponding color code.
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AN 7 All control stations in the system

S operating the same frequency.

Dlspatch Console

Capacity Plus/Linked Capacity Plus

Capacity Plus is a digital trunked two-way MOTOTRBO system that allows you to
accommodate high volume communication. It is designed to organize stable
connection in a few groups within one building or a set of buildings. This system
type allows you to increase the number of channels for voice and data transmission
between the subscribers and control centers. The subscribers are always
automatically forwarded to a free channel. The main objective of Capacity Plus is to
support more simultaneous voice and data transmissions within one capacious
system.

In the Capacity Plus mode you can configure voice and data control stations to
transmit and receive data over the air as it is displayed in System Planner. Keep in
mind that two data control stations are required per each data repeater — one per
time slot. TRBOnet Dispatch Software provides you an option to utilize an IP
connection to receive voice and data.
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5.9.6.2 Advanced Settings

¢ In the Configuration pane, under the corresponding Control Station, select
Advanced Settings.

Configuration Advanced settings
o service "
O Metwork i Automatically reset alarm mode
¢ Redundancy i Automatically handle call alert
= Database /1 Emergency CalljAlarm indication
i Reports

Use front microphone

£F Service Management

}' Advanced settings
)\ Geocoding Servers

.| Radio Metwarks

| igital Systems TX Timeout: 60 < | seconds

¥ Services

Always transmit when the PTT is pressed ("Impolite”™ channel access)
Use serial port for FTT key up

Contral Station #1 Signaling System: None ~ | Configure

¥ Advanced settings Allow CSBK Data

L Analog Control Stations
5= Remote Agents
I Friendly Servers
ﬁ Telephony

|' Data Sources

2}t Modbus TCP

24 Email b

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following control station-related
advanced settings:

= Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

= Automatically handle call alert
Select this option to automatically redirect call alerts from the control
station radio to the Dispatch Console.

= Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the control
station radio when an emergency Call/Emergency Alarm is received.

= Use front microphone (for PTT key up)
Select this option to use a remote control of the PTT button via a remote
speaker microphone on the radio.

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

= Use serial port for PTT key up
Select this option to use a remote control of the PTT button via the serial
port of the PC, and select the serial port from the drop-down list.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, the ongoing
transmission will be interrupted after this TX Timeout expires.

= Signaling system
From the drop-down list, select the signaling system.
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¢ MDC-1200 signaling is a Motorola data system using audio frequency

shift keying (ASFK) using a 1,200 baud data rate. A general option setting
for the system is to enable or disable an acknowledgement (ACK) data
packet.

SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Configure Select 5 x

Voice Calls

Private Cal Encoder:

Group Call: Encoder:

Call Type Telegram ID Source 1D
\
[
[
[
\
[

[i!
All Call: Encoder:
[

Check Radio
call Alert
Enable Radio

Disable Radio

Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.

Click the Configure link and specify desired Quick Call | settings.

Quick Call | x
Preamble: Js00] : ms
Tone 1: 1000 S ms
Tone 2: 1000 s oms
Long Tone: 4000 ms
Pause: 200 Sims
Defaults oK G |

Quick Call II. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.

Quick Call Il MOTOTRBO
When this system is selected, the parameters are configured on the radio
unit via the MOTOTRBO CPS.

Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

5.9.6.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a radio
system be registered in its configuration. If an audio path is not registered, the
TRBOnet operator will not be able to receive and transmit to the corresponding talk

group.
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Note: Audio paths are available only when one of the following modes is
selected: Capacity Plus, Linked Capacity Plus, Connect Plus, or
Capacity MAX.

¢ In the Configuration pane, under the corresponding Control Station, select
Audio Paths.

Configuration Audio Paths
j’ Advanced settings -
..\ Geocoding Servers Site ID: 1 =
.| Radio Networks Cal Type Group ID Site
. ﬂ} [\)i’gital S;t'sbems i Group Call 10 Wide
L Services W] | Group cal 20 Wide
o} IP Site Connect i
LY Control Station #1 Private Cal
}f Advanced settings | e cal
. o 2. cio Paths
--IfF) TRBOnet Swift Agent#1
% Controller #1
% Controller #1
:é Selex #1
... [%] Analog Control Stations
5 Remote Agents
[ Friendly Servers
‘@ Telephony
- )’_ Advanced settings
- ﬂ' Enberna\ PBX Server Add Delete
L. Advanced settings 7
Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
* To add an audio path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

= In the Site column, select either Local or Wide. The value Wide means that
the audio path will be to all sites in the system and not just to the local site.

5.9.7 Adding a TRBOnet Swift Agent

The TRBOnet Swift Agent functions as a gateway to receive and transmit voice and
data.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add TRBOnet Swift Agent.

52 TRBOnet Enterprise — User Manual



TRBOnet Server

neocom
SOoftware

Configuration
U Service
G MNetwork
@ Redundancy
Database
2 Reports
I} Service Management
/’_ Advanced settings
..k Geocading Servers
.| Radio Metworks

TRBOnet Swift Agent#1

Name:;
Radio ID:
1P Address:
Port:

Mode:

System Identifier:

TREOnet Swift Agent#1

64250
10.10.110.191
8002

Single Control Station

Department2|

Ak A4

Test

0 Dl‘gltal Systems Use the radio for RX Data only (GPS Revert or Data Revert)

Y

Repeater #1 VoIP port: 4000 =t

¢ Control Station #1
TRBOnet Swift Agent#1
,f: Advanced settings
: @ Redundancy
e [ Anzlog Control Stations
5l Remote Agents
[ Friendly Servers
E Telephany
|’ Data Sources v

Audio Format: PCM & kHz 16 bit -

Set Defaults Apply oK Cancel

¢ In the TRBOnet Swift Agent pane, specify the following Swift Agent-related
parameters:

Name
Enter a name for the Swift Agent. This name will be displayed in the
Dispatch Console.

Radio ID

This is the Radio ID of the control station connected to the Swift Agent.
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).

Note: This box is populated automatically once you have
successfully tested the Swift Agent by clicking the Test
button.

IP Address
Enter the IP Address of the Swift Agent network interface.

Port
Enter the port number of the Swift Agent connection (8002, by default).

Test

Click this button to check the connection to the Swift Agent. If the test is
successful, you'll see the information on the Swift Agent you are connected
to, such as Serial number, Firmware version, and other relevant information.

Mode

From the drop-down list, select the connection mode for the Swift Agent
being configured. For more details, see section 5.9.6.1, Control Station
Connection Modes (page 47).

System ldentifier

Enter the system identifier if the control station is used with a Capacity Plus
or Linked Capacity Plus system. Note that the system identifier should be
the same for all control stations used in the radio system.
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Use the radio for RX data only (GPS Revert or Data Revert)

Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

VolP port

Enter the port number for audio communications (4000, by default).

Note: This setting is used for older firmware versions of TRBOnet
Swift Agent.

Audio Format
From the drop-down list, select the format to transmit audio data.

5.9.7.1 Advanced Settings
¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,

select Advanced Settings.

Configuration Advanced settings

U‘ Service ~
0 Metwork
@ Redundancy
Database
& Reports

/] Emergency CallfAlarm Indication
Always transmit when the PTT is pressed ("Impolite” channel access)

TX Timeout: &0 - | seconds
L} Service Management

}f Advanced settings
N Geocoding Servers
.| Radio Metworks
Q) Digital Systems

FTT Mode: Keylp / DeKey -

Signaling System: None ¥ | Canfigure

Repeater #1
¢ Control Station #1
TRBOnet Swift Agent#1
« Advanced settings
: Redundancy
L Anzlog Control Stations
[l Remote Agents
[ Friendly Servers
E Telephony
|’ Data Sources v

Set Defaults Apply Ok Cancel

¢ In the Advanced Settings pane, specify the following Swift Agent-related

54

advanced settings:

= Automatically reset alarm mode

Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the Control
Station radio when an Emergency Call/Emergency Alarm is received.

= Always transmit when the PTT is pressed ("Impolite” channel access)

Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.
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= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

*= PTT Mode
From the drop-down list, select the mode of pressing the PTT on the radio.

= Signaling system
From the drop-down list, select the signaling system.

MDC-1200 signaling is a Motorola data system using audio frequency
shift keying (ASFK) using a 1,200 baud data rate. A general option is to
enable or disable an acknowledgement (ACK) data packet.

SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.

Click the Configure link and specify desired Quick Call | settings.

Quick Call II. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.
Quick Call Il MOTOTRBO

When this system is selected, the parameters are configured for the
radio units via the MOTOTRBO CPS.

5.9.7.2 Redundancy

A Redundant TRBOnet Swift Agent will be used when a connection to the Main
TRBOnet Swift Agent is lost.

¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,
select Redundancy.
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Configuration Redundancy

U Service ~
0 Network Redundant agents:

# Redundancy IP Address Port Local Port

Database
2 Reports
I} Service Management
/’_ Advanced settings
..k Geocading Servers
.| Radio Metworks
i Digital Systems
L} Services
I:B Repeater #1
{gy Control Station #1
I TRBOnet Swift Agent#1
/ Advanced settings
e [ Anzlog Control Stations
5l Remote Agents
[ Friendly Servers

7§ Telepheny Add Delete Test
|’ Data Sources W

1 M 10.10.0.210 8002 i

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, specify the following Redundant Agent-related
settings:

= Click Add and specify the desired parameters for the Redundant Agent
being added.

IP Address
Enter the IP Address of the Swift Agent that will be used as a Redundant
Swift Agent.

Port
Enter the port number that will be used for connections between the
server and the Redundant Swift Agent (8002, by default).

Click Test to check the connection to the Redundant Swift Agent.

If the test is successful, you'll see the information on the Swift Agent you
are connected to, such as Serial number, Firmware version, and other
relevant information.

Local Port

Enter the port number that will be used for connections from the
Redundant Swift Agent. The value 0 (default) means that a random port
will be used.

5.9.8 Adding an XRC Controller

The XRC Controller is a site controller that provides a channel for transferring data
between sites and managing data flow.

56

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add XRC-9000 Controller.
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Configuration

.| Radio Networks
£5) TREONet Cloud

Q) Digital Systems

: Services

BP9 TREONet Swift A200
(- Controller #1

)’ Advanced Settings
: gﬁ Redundancy

...[®] Analog Control Stations

5= Remote Agents

5= Friendly Servers

7@ Telephony

}' Data Sources
{ Email

i sMs

Set Defaults

Confroller #1

Name: Controller #1
IP Address: 10.10.100. 100

System Identifier: Connect Plus 1

Apply

Version: 5.3.5.1872

Test

oK Cancel

¢ In the Controller pane, specify the following XRC controller-related

parameters:

= Name

Enter a name for the XRC controller. This name will be displayed in the

Dispatch Console.
= |P Address

Enter the IP Address of the XRC controller network interface.

= (lick Test to check the connection to the controller.

= System ldentifier

Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

5.9.8.1 Services

¢ In the Configuration pane, under the corresponding XRC Controller, select

Services.

Configuration

.| Radio Networks

..£5) TREONet Cloud

() Digital Systems
L Services

- Advanced Settings
----- " Redundancy

...[®] Analog Control Stations

52| Remote Agents

5| Friendly Servers

E Telephony

} Data Sources
4 Email

[ sMs

Set Defaults

Services
1
Controller port: 4005
Local port: 1]

W] Location service {GPS { Indoar)
Controller port: 4001

Local port: 4001
Use adaptive location trigger

W/ Text Messaging service (TMS)

Controller port: 4007
Local port: 4007
Dispatcher ID: 54250

Multi Gate Connection

Apply

Ar4r

Ab 4

AR Ar 4

Version: 5.3.5.1872
Ll

oK Cancel

¢ In the Services pane, specify the following XRC controller-related services:
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Automatic Registration service (ARS) provides an automated data
application registration for the radio. When the radio powers up, it
automatically registers with the server. This feature is used with data
applications, that is any data traffic on this channel is associated with an
application server, such as MOTOTRBO Text Messaging or MOTOTRBO
Location Service. This option is selected by default and cannot be cleared.

¢ Controller port
Enter the controller's port number for ARS service (4005, by default).

¢ Local port
Enter the local port of the PC with TRBOnet Dispatch Software. The value
0 (default) means that a random port will be used.

Location service (GPS)

Select this option to enable Location service on the controller. The radio can
send its coordinates when it is in Global Positioning coverage area. GPS
settings can be configured in the Service Management pane (see section
5.7.2, Location Service).

e Controller port
Enter the controller's port number for Location service (4001, by default).

e Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4001, by
default).

¢ Use adaptive GPS trigger
Select this option to use the adaptive GPS polling interval.

Text Messaging service (TMS)
Select this option to enable text message transmission on the controller.

e Port
Enter the controller's port number for Text Messaging service (4007, by
default).

e Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4007, by
default).

¢ Dispatcher ID
Enter the Dispatcher ID. The Dispatcher ID should belong to TRBOnet
Server account in a Connect Plus system.

Multi Gate Connection
Select this option to use a multi-gate connection and enter the
corresponding Subscribe ID.

5.9.8.2 Advanced Settings

¢ In the Configuration pane, under the corresponding XRC Controller, select
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Advanced Settings.
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Configuration

.| Radio Networks
£5) TREONet Cloud

Q) Digital Systems

gy Control Station #1

.40 Controller #1

i @ Redundancy

5= Remote Agents
5= Friendly Servers
7@ Telephony

}' Data Sources
4 Email

i sMs

Set Defaults

I TREOnet Swift A200

...[®] Analog Control Stations

Advanced Settings

Radio ID list: 100-200

Specify external sites:

Site ID Presence
M 251 M
M 252 M

Add Delete

Version: 5.3.5.1872

?

Data

R

oK Cancel

¢ In the Advanced Settings pane, specify the following XRC controller-related

services:
= Radio ID list

Enter a list of the radios to receive data from according to the following

rules:

e To receive data from all radios in the system, leave this box blank.

e To receive data from multiple radios, separate each Radio ID by a

comma, for example, 105,106,111, and so on.

e To receive data from a range of radios, enter the range using the
following example: 105-111.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".

= Specify external sites

This is the list of Connect Plus sites that is used when the corresponding
Connect Plus system has a MOTOROLA System Bridge to the current

Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and
selecting the appropriate data types (Presence, Voice, and/or Data).

5.9.8.3 Redundancy

A redundant XRC controller will be used when a connection to the main XRC

controller is lost.

¢ In the Configuration pane, under the corresponding XRC Controller, select

Redundancy.
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Configuration Redundancy
A Geocoding Servers -
.| Radio Networks

Digital Systems

Redundant controllers:
IP Address Contraller part Local port

1 ] 192.168.0.255 4005 0

NS

:B Repeater #1

gy Control Station #1

I TREOnet Swift Agent#1
g5 Controller #1

}t Advanced settings

R ﬁ! Redundancy
L Analog Control Stations
95 Remote Agents
[ Friendly Servers
78 Telephony
V' Data Sources
21t Modbus TCP
{ Email
[ sMs

= License Add Delete Test

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, specify the following redundant XRC controller-
related settings:

= Click Add and specify the desired parameters for the redundant XRC
controller being added.

IP Address
Enter the IP Address of the XRC controller that will be used as a
redundant XRC controller.

Controller Port
Enter the port number of the redundant XRC controller for incoming
connections (4005, by default).

Click Test to check the connection to the redundant XRC Controller.

If the test is successful, you'll see the information on the XRC controller
you are connected to, such as serial number, firmware version, and other
relevant information.

Local Port

Enter the port number that will be used for incoming connections from
the redundant XRC controller. The value 0 (default) means that a random
port will be used.

5.9.9 Adding an XRT Controller

The XRT controller functions as a voice gateway connected to each XRC controller in
a Connect Plus system.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add XRT-9000 Controller.
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Configuration Controller #1
L.\ Geocoding Servers A
.| Radio Networks System Name: Controller #1
Q) Digital Systems Radio ID: 54250 :
L} Services R =
Repeater #1 e bacalFort: 0 hd
& Control Station #1 XRT-9000 Controller Info:
TREOnet Swift Agent#1 Controller IP Address: 192.168.0.225 -
RO =
Contraller #1 Controller TCP Port: 10001 : Test
- Advanced settings
Redundancy User Name: Admin
Controller #1 Password: LLTTTS
Privacy System Identifier: Connect Flus 1
¥ Data Path
.00 Audio Paths Monitor Voice sessions (without audio)
‘.. Redundancy
... [2] Analog Control Stations
=l Remote Agents
il Friendly Servers
ﬁ Telephony
i} Data Sources %
Set Defaults Apply OK Cancel

¢ In the Controller pane, specify the following XRT Controller-related
parameters:

System Name
Enter a name for the XRT Controller. This name will be displayed in the
Dispatch Console.

Radio ID
Enter the individual virtual radio ID. The virtual Radio ID is required to do
the following:

e Make all types of voice calls from XRT Controller to radios, dispatchers
and groups.

e Send commands (for example, Remote Monitor).

Start Local Port
Enter the local port of the PC with TRBOnet Server. The value 0 (default)
means that a random port will be used.

XRT Controller Info:

Controller IP Address
Enter the IP Address of the XRT controller network interface.

Controller TCP Port
Enter the port number of the XRT controller to be used for connections via
TCP (10001, by default).

Click Test to check the connection to the XRT controller.

User Name
Enter the user name. For the user name, refer to the XRT controller
configuration.

Password
Enter the password for the user. For the password, refer to the XRT
controller configuration.

Note: The user name and password should belong to the same
TRBOnet Connect Plus account and be appropriately
configured.
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= System ldentifier

Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

= Monitor Voice sessions (without audio)

This is the Billing feature. Select this option to monitor only PTT press
events.

5.9.9.1 Privacy

¢ In the Configuration pane, under the corresponding XRT Controller, select

o
Privacy.
Configuration Privacy Version: 5.3.5.1872
- Q TRECnet Cloud A
= ﬂ} Digital Systems Privacy Type: Enhanced -
-4} Services
:B Lep =t Enhanced Privacy Keys:
o} IPSC
~lgh Control Station =1 | Aahortn 2 Name i
B TREOnet Swift A200 ARC4(40bit) [wi1l

- pa5 Controller #1 ARC4 (40 bit)

P AES (256 hit)
AES (256 bit) Legacy
}: Advanced Settings

L. Redundancy
E":T. Controller #1

i [l Privacy

L} Data Path

1.1 Audio Paths

----- @ Redundancy
=| Analog Control Stations
5 Remote Agents

[ Friendly Servers

Add Remove @ File
IR Telephony v

Set Defaults Apply oK Cancel

¢ In the Privacy pane, specify the following Privacy-related settings:
= Privacy Type

From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

= Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.
= Enhanced Privacy Keys

Here you add enhanced privacy keys when the Enhanced privacy type is
selected.

e Click Add and specify the required Algorithm, ID, Name, and Value for
the privacy key being added.
v Algorithm

From the drop-down list, select one of the enhanced algorithms if you
are going to use additional encryption.

5.9.9.2 Data Path
The Data Paths are used to transmit data in a Connect Plus system.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Data Path.
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Conﬁgurahnn Data Path

----- A Geocoding Servers -

.| Radio Networks Data Service:
il Systems Radio ID:

Services
:B Repeater #1
-y Control Station #1

-B7) TRBOnet Swift Agent#1
g5 Controller #1

- Advanced settings
Redundancy

g Controller %1

Audio Paths
‘. @ Redundancy
... [2] Analog Control Stations
55| Remote Agents
5l Friendly Servers

ﬁ Telephony
V' Data Sources v

Set Defaults

iAutodetect -

64251

Apply oK Cancel

¢ In the Data Path pane, specify the following data path-related settings:

= Data Service

From the drop-down list, select the data service to be used to transfer data.

= Radio ID

Enter the Radio ID of the data service.

5.9.9.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive voice calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Connect Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the

corresponding talk group.

¢ In the Configuration pane, under the corresponding XRT Controller, select

Audio Paths.

Cunﬁguratlun Audio Paths
..... )\ Geocoding Servers [}
.| Radio Netwarks
@ Dlgltal Systems
L} Services
:B Repeater #1
-ty Control Station #1
I TRBOnet Swift Agent#1
-5 Controller #1
}' Advanced settings
@ Redundancy
*RT

g Controller #1

Call Type
W Group Call
W Group Call
W Private Call
V1 ancal

Audio Paths
@ Redundancy
=| Analog Control Stations
55 Remote Agents
[ Friendly Servers

ﬁ Telephony Add
} Data Sources ©

Set Defaults

Source 1D Target ID
10
20

64250

Delete Configure

Apply QK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an Audio Path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.
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= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Source ID for Private Calls. In general, this is TRBOnet's Radio ID.
If more than one Radio ID is specified in a Connect Plus system (for
example, for different dispatchers), the corresponding talk paths should be
added for all of them.

= Enter the Target ID for Group Calls. This is the Radio ID of the talk group to
make a call to. The Target ID is not applicable for Private Calls and All Calls.

5.9.9.4 Redundancy

A Redundant XRT Controller will be used when a connection to the Main XRT
Controller is lost.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Redundancy.

Configuration Redundancy
N Geocoding Servers [}

7 Radio Networke Redundant controllers:
0 Digital Systems .‘Eonh'oller F .-'-\ddreis Contraller TCP Port Start Local Port
L} Services 1 |M 19

:B Repeater #1

figh Control Station #1
I TREOnet Swift Agent#1
% Controller #1

}! Advanced settings

: .. g Redundancy

g Controller #1

I Privacy

Data Path

" 10001 0

; Audio Paths
(- Redundancy

=| Analog Control Stations

55 Remote Agents

[ Friendly Servers

I8 Telephony Add Delete Test
|* Data Sources R4

Set Defaults Apply QK Cancel

¢ In the Redundancy pane, specify the following Redundant XRT Controller-
related settings:

= Click Add and specify the desired parameters for the Redundant XRT
Controller being added.

= Controller IP Address
Enter the IP Address of the XRT Controller that will be used as a Redundant
XRT Controller.

= Controller TCP Port
Enter the port number of the Redundant XRT Controller to be used for
connections via TCP (10001, by default).

= Start Local Port
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0
(default) means that a random port will be used.

= (lick Test to check the connection to the Redundant XRT Controller.
If the test is successful, you'll see the information on the XRT Controller you
are connected to, such as Serial number, Firmware version, and other
relevant information.
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5.9.10 Adding a Selex Repeater

The Selex repeater is configured as a stand-alone repeater which supports
connections to MOTOTRBO™ radios to transmit voice and data in digital, analog,
and mixed modes.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add SELEX Repeater.

Cnnﬁguratlnn Selex #1
----- ..k Geocoding Servers ~
.| Radio Networks Mame: Selex #1
m' Digital Systems Radio ID: 54250 :

L} Services
i :a Repeater #1
‘-l Control Station #1
..I) TREONet Swift Agents1
% Controller #1
% Controller #1

)’_ Advanced settings
; slot #1
.7 Slot #2

-[2] Analog Control Stations
5= Remote Agents
I Friendly Servers
ﬁ Telephony
} Data Sources
2} Modbus TCP
24 Email b

Repeater Mode: Digital -

Set Defaults Apply oK Cancel

¢ In the Selex pane, specify the following Selex Repeater-related parameters:

Name
Enter a name for the Selex Repeater. This name will be displayed in the
Dispatch Console.

Radio ID

Enter the Radio ID for the Selex Repeater (for Capacity Plus systems, the
maximum value is 65535).

The Radio ID is an individual ID that uniquely identifies the radio. This ID is
used by other calling radios when addressing the radio, for instance, when
making a private call or sending a text message.

Repeater Mode
From the drop-down list, select the mode. The available modes are Digital,
Analog, Mixed, and Tier lll.

5.9.10.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Selex, select Advanced
Settings.
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Configuration Advanced settings

----- A Geocoding Servers -

.| Radio Netwaorks Keep Alive Interval: 10 seconds

Ak 4k

TX Timeout: 60 seconds

Services
:B Repeater #1
-y Control Station #1
-B7) TRBOnet Swift Agent#1
55 Controller %1
% Controller #1

j Selex #1
. Advanced settings
Slot #1

i Slot #2

... [®] Analog Control Stations
5 Remote Agents

[ Friendly Servers

78 Telephony

V' Data Sources

2% Modbus TCP

24 Email he

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Selex Repeater-related
advanced settings:

= Keep Alive Interval
Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Selex repeater (10, by default).

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, by default).

5.9.10.2 Slots

The Selex repeater has two available slots (in Digital or Mixed mode) to transmit
voice and data.

¢ In the Configuration pane, under the corresponding Selex, select Slot #1 or

Slot #2.
Configuration Slot #£1
,J\ Geocoding Servers -
.| Radio Metwarks o/ slot #1
. @ Digital Systems Name: Slot 1
L} Services TREOnetIP Addresst  |10,10.100.98  ~ @ Port 6080 -
:B Repeater #1 =
g Control Station =1 SELEX IP Address: 10.10.9.30 ¥ Port: 6080
I TRBOnet Swift Agent#1 Test
% Controller #1
35 Controller 1 Use the gateway for RX Data only (GPS Revert or Data Revert)
: :é Selex #1 Use Encryption
- Advanced settings Always transmit when the FTT is pressed ("Impalite™ channel access)
: Slot #1 W] Data Call Confirmed
-0 Slot 22 w1 Private Call Confirmed
... [2] Analog Control Stations
5= Remote Agents
| Friendly Servers
E Telephony
}' Data Sources
2% Modbus TCP
{ Email ©
Set Defaults Apply QK Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.
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TRBOnet IP Address

Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.

Use the gateway for RX data only (GPS Revert or Data Revert)
Select this option to configure the channel so that it will only receive data,
thus having no transmission capability.

Use Encryption
Select this option to encrypt voice and data traffic over IP.

Always transmit when the PTT is pressed (“Impolite” channel access)
Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

Data Call Confirmed
Select this option to enable individual packets in data calls (ARS, GPS, and
Text Message) on the current slot to be confirmed.

Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed.

5.9.10.3 Tier lll and Audio Paths

The Selex repeater can be used in a Tier lll mode. To configure this mode, do the
following:

e While in the Selex pane, select Tier Ill from the Repeater Mode drop-down
list.

¢ In the Configuration pane, under the corresponding Selex, select Tier IlI.

Cnnﬁguratlnn Tier IT1
----- )\ Geocoding Servers -
.| Radio Networks
0 Dlgltal Systems

L ¥ Services
: I:B Repeater #1
iy Control Station #1
I TREONet Swift Agent#1
% Controller #1
ﬁ Controller #1
I:ﬂ Selex #1
: }' Advanced settings

.3 Audio Paths

=| Analog Control Stations
55 Remote Agents
[ Friendly Servers
’E Telephony

|’ Data Sources
1 Modbus TP
4 Email hd

MName:

TREOnet IP Address: 10,10,100.99 v ¢ Port: | 5080

SELEX IP Address:

Ar 4

10.10.9.30 v |Port: | 6080

Test

Use Encryption

Always transmit when the PTT is pressed ("Impolite” channel access)

k] Private Call Confirmed

Set Defaults Apply oK Cancel
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¢ In the Tier lll pane, specify the following Tier lll-related parameters:

= Use Encryption
Select this option to encrypt voice and data traffic over IP.

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.
= To configure Audio Paths:
¢ In the Configuration pane, under the corresponding Selex, select
Audio Paths.

Note: Make sure the Tier lll mode has been selected as a
Repeater Mode for the Selex repeater.

Configuration Audio Paths
L.k Geocoding servers A
.| Radio Metworks Call Type Group ID
Q) Digital Systems ! Group Call 10
L. LF services ¥4 Group Call 20
: :B Repeater #1 W Private Cal
gl Control Station 1 i &l cal
B3 TREOnet Swift Agent#1
% Controller #1
% Controller #1
-

y Selex =1

i ,’_ Advanced settings
I Tier 111

.m0 Audio Paths

=| Analog Control Stations
55 Remote Agents
[ Friendly Servers
E Telephony
| Data Sources
2} Modbus TCP
4 Email e

Add Delete

Set Defaults Apply oK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an Audio Path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is a radio ID of the talk group to make a call to.
The Group ID is not applicable for Private Calls and All Calls.

5.9.10.4 Analog channel

The Selex repeater can also use the Analog channel.

¢ In the Configuration pane, under the corresponding Selex, select Analog.
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Note: Make sure the Analog or Mixed mode have been selected
as a Repeater Mode for the Selex repeater.

Cnnﬁguratlnn Analog

----- LA Geocoding Servers A

.| Radio Metworks

- @ Digital Systems MName: Analog
L} services TREOnet IP Address: 10,10, 100,99 ~ g Port: 6080
'ﬁ Repeater #1 SELEX IP Address: 10,10.9.30 v Port: @030 2
iqleh Control Station #1 e -
..I) TREONet Swift Agent#1 -

% Controller #1
% Controller #1
I:ﬂ Selex #1
----- / Advanced settings {Always transmit when the PTT is pressed (“Impalite" channel access):

L. Analog
-[2] Analog Control Stations
55 Remote Agents

[ Friendly Servers
’E Telephony
|’ Data Sources
1 Modbus TCP
24 Email
5 sMs v

Set Defaults Apply oK Cancel

¢ In the Analog pane, specify the following Analog channel-related settings:

= Name
Enter a name for the Selex repeater in the analog mode. This name will be
displayed in the Dispatch Console.

* TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

= SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

= Click Test to check the connection to the repeater.

= Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

5.9.11 Adding a Kairos Repeater

The Radio Activity Kairos repeater is configured as a stand-alone repeater which
supports connections to MOTOTRBO™ radios to transmit voice and data in digital,
analog, and mixed modes.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add KAIROS Repeater.
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Configuration Kairos #1
.| Radio Metworks L
..4) TREOnet Cloud Name: Kairos 71
Q) Digital Systems TP Address:
L} Services
I:B Capadty Max
L) Capadity Plus #1 Password: sennse
lﬁ LCP #1 Test
g} TPSC
¢k Control Station #1 Radio ID: 54250 =
5 Kairos #1
/’ Advanced setti
II0 Slot #1
II Slot #2
Ly Analog
- [&|] Analog Control Station:
5= Remote Agents
5 Friendly Servers
ﬂ Telephony "
' >

Version: 5.2.5.1409

10,10, 155,130 -

User Name: kairos

Repeater Mode: Mixed (Analog and Digital) i

Set Defaults Apply oK Cancel

¢ In the Kairos pane, specify the following repeater-related parameters:

Name
Enter a name for the Kairos repeater. This name will be displayed in the
Dispatch Console.

IP Address
Enter the IP Address of the Kairos repeater network interface.

User Name
Enter the user name. For the user name, refer to the Kairos repeater
configuration.

Password
Enter the password for the user. For the password, refer to the Kairos
repeater configuration.

Radio ID
Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system.

Repeater Mode
From the drop-down list, select the mode. The available modes are Digital,
Analog, and Mixed.

5.9.11.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Kairos, select Advanced
Settings.
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Configuration Advanced settings Version: 5.2.5.1409
L} Service Management A
)’_ Advanced settings
A Geocoding Servers
.| Radio Networks
-{§) TREONet Cloud
Q) Digital Systems
L} Services
o} Capacity Max
‘a Capadity Plus #1
B Lep #1
g IPSC
-~y Control Station #1
Kairos #1
Slot #1
I Slot #2
T4 Analog
5| Analog Control Stations

< >

Keep Alive Interval: 10 seconds

TX Timeout: 60 seconds

Voice Call Hang Time (ms):
Group Call: 3000
Private Call: 4000

Emergency Call: 4000

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Kairos Repeater-related
advanced settings:

Keep Alive Interval
Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Kairos repeater (10, be default).

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, be default).

Voice Call Hang Time (ms):

5.9.11.2 Slots

Group Call

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

The Kairos repeater has two digital slots (in Digital mode) and one analog slot (in
Mixed or Analog mode) to transmit voice and data.

¢ |n the Configuration pane, under the corresponding Kairos, select Slot #1 or
Slot #2 (or Analog, if you have selected Mixed or Analog mode).
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Configuration slot #1 Version: 5.2.5.1409
N Geocoding Servers ~
.| Radio Networks v/ slot #1
..£5) TREORet Cloud Name: Slot 1
-Q Digital Systems Audio Codec: G.711 p-Law/3000 -
fL} Services
: ]ﬁ Capadty Max Audio port KAIROS: 40000 z
:ﬁ Capadty Plus #1 Audio port TRECnet: 40000 z
g LCP 1
B s Data port KAROS: 40001 =
Ieh Control Station #1 Data port TREORet: 40001 :
gl Kairos #1
- Advanced setti
Slot #1
Slot 22
frrh Analog
.. [7] Analog Control Station:
52| Remote Agents
52 Friendly Servers w
< >
Set Defaults Apply oK Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

* Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

= Audio Codec
From the drop-down list, select the audio codec to be used to compress the
audio files.

= Audio port KAIROS/ Audio port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet audio ports.

= Data port KAIROS/ Data port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet data ports.

Note: Use the matching port numbers for KAIROS and TRBOnet.
The default audio and data port numbers are 40000 and
40001 for Digital slot 1, 40002 and 40003 for Digital slot 2,
and 40004 and 40005 for the Analog slot.

5.9.12 Adding a Wave Controller

Before creating a connection to the Wave controller, make sure the Wave server is
configured to allow 3rd party applications to connect with a Neocom Software-
specified license key.

¢ In the Digital Systems pane, click Add.
Or, in the Configuration pane, right-click Digital Systems.

¢ In the drop-down menu, click Add WAVE Controller.
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Privacy
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L Slot #2
Local Slots
iy Control Station #1
I TRBOnet Swift A1C
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P ave Server 1
=| Analog Control Station:
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Name: Wave Server 1
Connection:
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Controller IP Address: 10.10.150,110 -
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Password:
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)’ Advanced settings
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/’_ Advanced settings
External PBX Server

; )’_ Advanced settings ,,
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Test

< >

Set Defaults Apply oK Cancel

¢ In the Wave Controller pane, specify the following Wave controller-related
parameters:

Name
Enter a name for the Wave controller. This name will be displayed in the
Dispatch Console.

Use proxy for connection
Select this option to use a proxy server to connect to the Wave controller.

Controller IP Address
Enter, or select from the list, the IP Address of the Wave controller.

Controller Port
Enter the port number of the Wave controller.

Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Wave controller.

User Name
Enter the user name. For the user name, refer to the Wave server
configuration.

Password
Enter the password for the user. For the password, refer to the Wave server
configuration.

Profile
From the drop-down list, select the profile to be used on the Wave server.

Test
Click this button to check the connection to the Wave controller.

5.10 Analog Control Stations

TRBOnet Dispatch Software allows using analog radios as control stations.

¢ In the Configuration pane, select Analog Control Stations.

¢ In the Analog Control Stations pane, select Enable Analog Control Stations.
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Configuration
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I:B Repeater #1
-y Control Station #1
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% Controller #1
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Delete

Set Defaults Apply

5.10.1 Adding an Analog Control Station
¢ In the Analog Control Stations pane, click Add.

Serial Port

COM1

OK Cancel

Configuration Control Station Al Version: 5.3.5.1855
..\ Geocoding Servers A
.| Radio Metworks Name: Control Station A1
Digital Systems
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-y Control Station #1
- TRBOnet Swift Agent#1
i % Controller #1
% Controller #1
=

Serial port: ComM1

-y Selex #1 TX Timeout: &0
L Advanced setti
/’- vanced setings Mic delay time: 1]
L. Analog
... [®] Analog Control Stations
Lol Control Station Al
| Remote Agents Extended protocol: MNone

[ Friendly Servers

E Telephony Signaling System: Quick Call T
I Data Sources Configure
352 Modbus TCP
4 Email W
Set Defaults Apply

-

Always transmit when the FTT is pressed ("Impolite” channel access)

seconds

5 | miliseconds

oK Cancel

¢ In the Control Station pane, specify the following Analog Control Station-

related settings:

= Name

Enter a name for the analog control station. This name will be displayed in

the Dispatch Console.
= Playback device

From the drop-down list, select the playback device on the PC that the

control station is connected to.

= Recorder device

From the drop-down list, select the recording device on the PC that the

control station is connected to.

= Serial port

From the drop-down list, select the serial port the control station is

connected to on the PC.
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Always transmit when the PTT is pressed ("Impolite” channel access) -
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

Mic delay time
Enter the time, in milliseconds, to be used as a delay time interval between
pushing the PTT and starting voice communication.

Extended protocol

From the drop-down-list, select either None, if your radio does not support
the extended protocol, or IC-F1721D v1.01 if the radio supports the
extended protocol.

Signaling System

From the drop-down-list, select the signaling system (Quick Call I or
Quick Call I1). Click the Configure link and specify desired Quick Call
settings. Selecting the signaling system is available only if None is selected
in the Extended Protocol list.

5.10.1.1 Serial Port

Note: The serial port settings are available only when the
extended protocol IC-F1721D v1.01 is selected for the
analog control station.

¢ In the Configuration pane, under the corresponding Control Station, select
Serial Port.

Cnnﬁguratlnn Serial Port

----- ..k Geocoding Servers "
.| Radio Networks Baud Rate: 19200 -
. g Digital Systems P s -
L} Services
g} Repeater #1 Parity: None -

“flgh Control Station #1
..I) TREONet Swift Agents1
&5 Controller #1 Handshake: Mane M
% Controller #1

: ) Selex #1

Stop Bits: 1 -

; . Advanced settings
L Analog

-[%] Analog Control Stations

ek Control Station A1
55| Remote Agents
[l Friendly Servers
E Telephony

|* Data Sources

8¢ Modbus TCP v

Set Defaults Apply oK Cancel
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¢ In the Serial Port pane, specify the same serial port settings as those on the
radio device connected to the serial port.

5.11 Remote Agents
The Remote Agent is TRBOnet Agent installed on a remote PC.

¢ In the Configuration pane, select Remote Agents.

Configuration Remote Agents
.| Radio Metworks ~
igital Systems Registered remote Agents:
Services Agent Name 1P Address Port Redundancy
-:B Repeater 71 W1 Agent: 1 10.10.110.190 4020 Mo
-l Control Station #1
-E7) TRBOnet Swift Agent#1
55 Controller #1
% Controller #1
é Selex #1
L advanced settings
11 Analog
... [2] Analog Control Stations
gl Control Station A1
! Serial Port
5= Remote Agents
b Agent: 1
& Redundancy
[ Friendly Servers

78 Telephony Add Delete Test
| Data Sources v
Set Defaults Apply oK Cancel

¢ |n the Remote Agents pane, click Add.

Configuration Agent: 1
.| Radio Networks ~
- g Digital Systems Agent Name: Agent: 1

Services
o) Repeater =1
-l Control Station #1 Port: 4020 = Test
-E7) TRBOnet Swift Agent#1
% Controller #1
: % Controller #1
gy Selex #1
f }! Advanced settings
11 Analog

... [2] Analog Control Stations

. gigh Control Station A1
: Serial Port

5= Remote Agents

IP Address: 10.10.110, 150

Service Name

9 Agent: 1
i@ Redundancy
I Friendly Servers

’E Telephony T = 5
Load sarvices Irom agent
| Data Sources w oad services from agen
Set Defaults Apply oK Cancel

= In the Agent pane, specify the following parameters:

e Agent Name
Enter a name for the remote agent. This name will be displayed in the
Dispatch Console.

e IP Address
Enter the IP address of the remote agent.

o Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the remote agent.

e Click Test to check the connection to the remote agent.
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e Use all services
Choose this option so that all available services will be used on the

remote agent.

¢ Use only specified services
Choose this option and click the Load services from agent link to load
services available on the remote agent.

5.11.1 Redundancy

A Redundant remote agent will be used when a connection to the Main remote
agent fails.

¢ In the Configuration pane, under the corresponding Agent, select
Redundancy.

Configuration Redundancy
.| Radio Metworks
.. @ Digital Systems

Services
o Repeater #1 1 W Backup Agent 1 10.10.110. 192 021

-y Control Station #1 z W Backup Agent 2 10.10.110.101 4022
- TRBOnet Swift Agent#1

% Controller #1

% Controller #1

Redundant agents:
Mame 1P Address Port

4k

y Selex =1
: ,f_ Advanced settings
Ly 11 Analog
... [%] Analog Control Stations
* i Control Station A1
L. Serial Port
55 Remote Agents
9 Agent: 1
ar
[ Friendly Servers
ﬁ Telephony Add Edit Delete Test A
}* Data Sources &7

Set Defaults Apply QK Cancel

¢ In the Redundancy pane, click Add.

Remote Agent X
Agent Name: Backup Agent 2
IP Address: 10.10.110,101

Port: 4022

(@ Use all services

_) Use only spedified services

Load services from agent

oK Cancel

¢ In the Remote Agent dialog box, specify the following parameters:

e Agent Name
Enter a name of the redundant remote agent.

o |P Address
Enter the IP address of the redundant remote agent.
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e Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the redundant remote agent.

e Click Test to check the connection to the redundant remote agent.

e Use all services
Choose this option so that all available services will be used on the
redundant remote agent.

e Use only specified services
Choose this option and click the Load services from agent link to load
services available on redundant the remote agent.

e Click OK to add a redundant remote agent to the system.
5.12 Friendly Servers

The Friendly Servers are used to transmit voice over IP between dispatchers
connected to different servers.

¢ In the Configuration pane, select Friendly Servers.

Configuration Friendly Servers
.| Radio Metwarks -
. g Digital Systems Registered Friendly Servers:

¥ Services Name IP Address Port
o Repeater #1 ¥ Region Server # 1 10.10.101. 167 4021

-y Control Station #1 W/ Regio Server # 2 10.10.101,198 4022
I TRBOnet Swift Agent#1

% Controller #1
%

=| Analog Control Stations

fghely Control Station A1
LA serial Port

2| Remote Agents

5
’E Telephony
" Data Sources
%% Modbus TCP Add Edit Delete Test
4 Email hd
Set Defaults Apply oK Cancel

e In the Friendly Servers pane, click Add.

Server X
Name: Region Server # 1
IP Address: 10.10.101. 167
Port: 4021 2

oK Cancel

* In the Server dialog box, specify the following parameters:

e Name
Enter a name for the friendly server. This name will be displayed in the
Dispatch Console.

e |P Address
Enter the IP Address of the server.
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Port

Enter the local port number on the PC to connect to the friendly server.
Click Test button to check the connection to the friendly server.

Click OK to add the friendly server to the system.

5.13 Telephony

TRBOnet Server has its own built-in SIP server to support VolP communications
between the radios as well as other SIP-compliant clients. In addition, you can add
an external PBX server to the TRBOnet Server configuration.

¢ In the Configuration pane, select Telephony
¢ In the Telephony pane, select Use Telephony.

Configuration Telephony
: ... Slot #1 "
I Slot #2 ! Use Telephony
--L07 Local Slots
-l Control Station #1
-I) TREOnet Swift Agent#1
% Controller #1
% Controller #1
:é Selex #1
i..[7] Analog Control Stations
5= Remote Agents

SIP Server
W] Internal PEX Server

| Friendly Servers
'ﬂ Telephony

..... }' Advanced settings

Internal PBX Server

}' Advanced settings

l Data Sources
2} Modbus TCP

{ Email
5 sws i

= License ha

Set Defaults Apply

oK Cancel

5.13.1 Advanced Settings

¢ In the Configuration pane, under Telephony, select Advanced Settings.

Cnnﬁgurahnn Advanced settings Version: 5.3.0.1670

/ Advanced setti A
| Privacy Max Ring Time: 30 : seconds
-
-

Slot 1 Man Call Time: 10 minutes

Local Slots Public Address: 77.232.61.122

-l Control Station #1 Phone owner address: Take from database
- TRBOnet Swift ALC

-7} Repeater #1

i...[®| Analog Control Station:

-

Configure

55 Remote Agents
52 Friendly Servers
‘& Telephony
Advanced settings
ZR Internal PEX Server
)’_ Advanced settings
2 External FBX Server
)9'_ Advanced settings
& Redundancy v
£ >

Set Defaults Apply OK Cancel

¢ In the Advanced Settings pane, specify the following parameters:

Max Ring Time
Specify the maximum ringing time, in seconds.
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= Max Call Time
Specify the maximum call time, in minutes.

= Public Address
This is the public IP address of your PC. To detect the public address, click
the ellipsis (...) button.

Public |P Address x

Detect public IP Address over STUN server

STUN Server: stun.ekiga.net -

-
-

Port: 3478
IP Address detected:  77.232.61.122

oK Cancel

e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

= Phone owner address
From the drop-down list, select 'Take from database'. This will enable
determining the street address of a caller.
Click the Configure link.

Address format X

Address format:

, SHOUSE_NUMBER %, %%STREET_NAME %] -
Availablefields:

%HOUSE NUMBER% S%FLAT NUMBER% %STREET NAME%: SCOMMUNITY NAME%
FoSTATE NAMEY 5ePOSTCODEYs 3COUNTRY NAMEY 3EXTRA INFO%:

oK Cancel

e Add the required fields to the address information.
5.13.2 Internal PBX Server

¢ Make sure the Internal PBX Server option is selected in the Telephony pane.

¢ In the Configuration pane, select Internal PBX Server.
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Configuration Internal PBX Server
i Slot %1 A
Slot #2
--L17 Local Slots
-flgh Control Station #1
-Z) TRBOnet Swift Agent#1
% Controller #1
&3 Controller #1 SIP ID: 1234
ré Selex #1

Analog Control Stations
Ei Remote Agents
[ Friendly Servers
’ﬂ Telephony

----- /’ Advanced settings

% Internal PEX Server
)f Advanced settings
" Data Sources
2% Modbus TCP

{ Email

[ sMs

E License he

Set Defaults Apply oK Cancel

-

Local IP: 10.10.100.99 v | Port: |5080 o

Dispatch Center

SIP User: 1234

¢ In the Internal PBX Server pane, specify the following parameters:

= Local IP
Enter the IP address of the PC with TRBOnet Server.
= Port

Enter the local UDP port number for the SIP service (5060, by default).
Dispatch Center

= SIPID
Enter the SIP ID that will be used by the Dispatch Center.

= SIP user
Enter the SIP user name that will be used by the Dispatch Center.

5.13.2.1 Advanced Settings

¢ In the Configuration pane, under Internal PBX Server, select
Advanced Settings.

Configuration Advanced settings

Services ~
: o) Repester 21 Packet time (ms): &0 s
g Control Station #1
B TRBOnet Swift Age
% Contraller #1 Registration Interval (sec): 3600
% Controller 21 DTMF Send Mode: RFC 2833
.. [%| Analog Control Station:
5= Remote Agents
5= Friendly Servers
IR Telephony

/ Advanced settings
& Internal PBX Server
8 External PBX Server
| Data Sources
3% Modbus TCP

4 Email
i) sM5 v
<l >

Codecs: PCMU,PCMA, G723, SPEEX, SPEEX-WE,AMR... +

First VoIP paort: Default

A4 4k 4]

Use VoIP parts: All

Set Defaults Apply 0K Cancel

¢ In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings:

= Packet time
Enter the packet length, in milliseconds.
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Codecs
In the drop-down list, select/unselect the codec(s) to be used for audio
compression.

Note: For the best user experience, we strongly recommend that
SPEEX-WB codec be used.

Codecs: SPEEX-WE -
i/ SPEEX/18000 {a
SPEE¥/5000
6.711 p-Law/8000
6.711 A-Law/5000
OPUS/8000
OPUS/16000
.729/8000
AMR,/3000
AMR,/16000 -

Registration Interval (sec)

Enter the time interval, in seconds, to check the SIP registration status of
subscribers.

DTMF Send Mode

Enter mode for sending DTMF tones. The available modes are RFC 2833,
SIP INFO (DTMF relay), and SIP INFO (DTMF).

First VolP port

Enter the number of the first VolP port for audio communications. The
default value is specified in Network Parameters.

Use VolP ports
From the drop-down list, select which VolP ports will be used (all, even, or
odd).

5.13.3 External PBX Server

You can enable an external PBX server to use the SIP Interconnect feature. This
feature enables calls from the radio to the phone and vice versa. The dispatcher can
make a call from the Dispatch Console to a phone as well as redirect a phone call to
a subscriber radio.

¢ In the Telephony pane, click Add.
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Configuration External PEX Server
/’_ Advanced settings A
B Privacy
Slot #1

L Slot %2
Local Slots Address: yourprovider.com upr -

Provider options

-

~4l¢h Control Station #1 Port: 5060 - T
- IZ) TRBOnet Swift Agent#1
&5 controler 21 Local IF: 10,10.100.99 ~ @) Port: | 5061 3
% Controller #1
:é Selex #1 Dispatch Center
... [%] Analog Control Stations
5= Remote Agents
[ Friendly Servers SIP User: User 123
‘@ Telephony
- )’_ Advanced settings
IR Internal PEX Server TestCal
}' Advanced settings
.. g External PBX Server
/ Advanced settings
V' Data Sources e

SIP ID: 57068

Password:

Set Defaults Apply oK Cancel

¢ In the External PBX Server pane, specify the following parameters:

Use External PBX Server
Select this option to enable an external PBX server.

Provider options

Address

Enter your SIP provider address, and select the protocol from the drop-
down list on the right of the address (for more details, contact your SIP
provider).

Port

Enter the port number of the SIP provider (5060, by default).

Click Test to check the connection to the provider.

Local IP
Enter the IP address of the PC with TRBOnet Server.

Port
Enter the local port number to make connections from.

Dispatcher Center

Note: This information is provided by the SIP provider.

SIPID
Enter the SIP ID that will be associated with TRBOnet Server to make and
receive calls.

SIP user
Enter the SIP user name for the login.

Password
Enter the password for the login.

Test Call
Click this button to make a test call.

Note: To make a test call, make sure that the TRBOnet Server
service is not running.
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5.13.3.1 Advanced Settings

¢ In the Configuration pane, under External PBX Server, select
Advanced Settings.

Configuration Advanced settings Version: 5.3.0. 1698
Ll Privacy "
Slot 21 Packet time (ms): &0 -
Slot %2 Codecs: G7111,G711a,0PUS, OPUS-WB,G729,5PE...
Local Slots o =
g Control Station =1 Registration Interval {sec): 3600 -
.. TRBOnet Swift Agent #1 DTMF Send Mode: RFC 2833 -
- [2] Analog Control Stations Do not register users on a PBX server (SIP trunk)
5 Remote Agents
= Do not register internal users on a PBX server
[ Friendly Servers
R Telephony Configure user's authorization
M hdvanced settings First VolP port: Default -
- E Internal PBX Server i
L2 advanced settings = A M

3 External PBX Server Available SIP numbers: 5555-6666 -
/ Advanced settings
L. Redundancy

‘" Data Sources

24 Email

i..pem Incoming Mail Server v

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following External PBX Server-
related advanced settings:

= Packet time
Enter the same value as specified in the phone system;

= Codecs
In the drop-down list, select/unselect the codecs specified in the phone
system.

Note: For more details on Phone System configuration, see
Appendix E: SIP Setup for Motorola Phone System
(page 359).

= Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status of

subscribers.

= Do not register users on a PBX server (SIP trunk)
Select this option so that radios will use the SIP trunk system to get
extensions.

= Configure user’s authorization
Click this link to set up user authorization for the systems with enhanced
authorization parameters. It is recommended to be used when Radio ID is
equal to SIP ID. In case when Voice is transmitted via Radio Channel, Radio
ID is used. When voice is transmitted via a GSM channel, the SIP ID is used.
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SIP Authorization users X
SIFID User Mame

I 010101 iUser # 1
Add Delete

apidd X oK Cancel

e Click Add to add a new user authorization.

e SIPID
Enter the SIP ID for the new user.

e User Name
Enter the User Name for the new user;

e C(lick OK to save the new user authorization.

= First VoIP port
Enter the number of the first VolP port for audio communications. The

default value is specified in Network Parameters.

= Use VolIP ports
From the drop-down list, select which VolP ports will be used (all, even, or
odd).

= Auvailable SIP numbers
Enter the range of SIP phone numbers available on the PBX server.

5.13.3.2 Redundancy
A Redundant PBX Server be used when a connection to the main PBX Server fails.

¢ In the Configuration pane, under External PBX Server, select Redundancy.

Ezpasgon FaiTEETE Version: 5.3.0.1670
bl privacy
Slot #1 Redundant PEX Servers:
I Slot 22 PBX Server Address  PBX Server Port TRECnet Local Port
Local Slots 123.321.102.201 5060 5061

iy Control Station #1

I TREOnet Swift A1C
nﬁ Repeater #1

- [&|] Analog Control Station:

55 Remote Agents

[ Friendly Servers

ﬂ Telephony

/ Advanced settings

& Internal PBX Server
)’_ Advanced settings

a External PBX Server
,’_ Advanced settings

# Redundancy ¥4} Reregister users when changing PEX server
} Data Sources "
Add Delete Test
< >
Set Defaults Apply OK Cancel

¢ In the Redundancy pane, click Add.

= PBX Server Address
Enter the IP address of the redundant server.
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= Check the corresponding port numbers (PBX Server Port and TRBOnet
Local Port).

= Select the check box beside the server address.

= Register users when changing PBX server

Select this check box so that phone users will be registered when the PBX
server is switched to the redundant server.

5.14 Data Sources

The Data Sources feature allows receiving data from third-party applications and
devices.

TRBOnet Dispatch Software can work with the following two data source types:
1. Physical or virtual devices connected via a COM port
2. PCs running third-party applications connected via TCP/IP

To allow TRBOnet Dispatch Software to receive data from a third-party application
or device:

¢ In the Configuration pane, select Data Sources.

Configuration Data Sources
:a Repeater #1 -
- ligh Control Station #1

I TREONet.Swift Agent #1
% Controller #1

% Controller #1

... [®] Analog Control Stations

2| Remote Agents

[ Friendly Servers
‘& Telephony
,f_ Advanced settings
. ﬁ Internal PBX Server
.. 3 External PBX Server
,f Advanced settings
I/ Data Sources
" COM ports
B 1ep e
:.% Modbus TCP

4 Email
[ sMs v

Set Defaults Apply QK Cancel

¢ In the Data Sources pane, select the Enable Data Sources option.
5.14.1 COM Ports

To manage physical or virtual devices connected to the TRBOnet Server PC via COM
port:
¢ In the Configuration pane, under Data Sources, select COM ports.
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/®

Configuration
I:ﬁ Repeater #1 -
il Contral Station #1
I TREOnet.Swift Agent #1
% Controller #1
% Controller #1

... [%] Analog Control Stations

55 Remote Agents

[ Friendly Servers

‘& Telephony

. /’_ Advanced settings

'8 Internal PEX Server

.. a External PEX Server
/ Advanced settings

}* Data Sources

COM ports

: B rcpp

%% Modbus TCP

4 Email

1) 5Ms he Add

< >

COM ports

Mame Baud Parity
W] coMi 8600 Mone
W comz s600 Mone

Data... Handsh... StopBits | TextE...
8 Mone 1 ASCIT
8 Mone 1 ASCIT

Delete Edit

Set Defaults Apply oK Cancel

¢ In the COM ports pane, click Add to add a new device.

COM Port X

Serial port name:

Baud rate:

Parity-checking protocal: Mone -
Stop bits per byte: 1 -
Data bits per byte: 8 -
Handshaking protocol : Mone -
Protocol: Text -
Text Enceding: ASCIT -
Message delimiter: LINE FEED Ox0A(\n) -

Cancel

¢ In the COM Port dialog box, specify the following parameters:

Serial port name
From the drop-down list, select the COM port on the PC with TRBOnet
Server to which the device is connected to.

Baud rate
From the drop-down list, select the baud rate at which the data is
transmitted.

Parity-checking protocol

From the drop-down list, select one of the values that represent the parity-
checking protocol.

Stop bits per byte

From the drop-down list, select the standard number of stop bits per byte.

Data bits per byte
From the drop-down list, select the standard length of data bits per byte.

Handshaking protocol
From the drop-down list, select the handshaking protocol for serial port
transmission of data.

Text Encoding
From the drop-down list, select the Text Encoding type.
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Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

= Message delimiter
From the drop-down list, select the type of delimiters in the data.

Note: The Message delimiter types selected in the TRBOnet
Server and in the connected application must be the same
to avoid incorrect text display and incorrect data parsing.
= Click OK to save settings and close the dialog box.
5.14.2 TCP/IP
To manage PCs running third-party applications:

¢ In the Configuration pane, under Data Sources, select TCP/IP.

Configuration TCP/IP
I TREONet.Swift Agent #1 A
% Controller #1 Mame Remote IP Port Mode Encoding
% Controller #1 & Terminal 1 11002 Client UTF8

- [E] Analog Control Stations V| Terminal2  10.10.102.216 11002 Server  UTF8

2| Remote Agents
I Friendly Servers
‘& Telephony
,f_ Advanced settings
. E Internal PEX Server
.. a External PBX Server
f Advanced settings
V' Data Sources
.. COM ports
B 1cppp
%% Modbus TCP
24 Email
5 5Ms

[ vicense

£ >

Add Delete Edit

Set Defaults Apply oK Cancel

e In the TCP/IP pane, click Add to add a TCP/IP connection.

External Connection x
Name: Terminal 2
Mode: Server (TREOnet connects to App) -
Remote IP: 10.10.102.216]
Port: 11002 5
Protocol: Text -
Text Encoeding: | UTF8 -

[] Ignere the following data

During: min
Do not consider the following substring:
Concel

¢ In the External Connection dialog box, specify the following parameters:

= Name
Enter a name for the TCP/IP connection.
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Mode

From the drop-down list, select the connection mode. The connection
mode depends on the type of the application installed on the connected
PC:

¢ Client
In this case, the application connects to TRBOnet Server which sends the
data to the application.

e Server
In this case, TRBOnet Server accepts connections from the application
and receives the data.

Remote IP
Enter the IP address of the application server.

Note: Available only when the Server connection mode is
selected.

Port

In the case of the Client connection mode, select the local port of the PC
with TRBOnet Server PC.

In the case of the Server connection mode, select the port of the PC where
the third-party application is installed.

Text Encoding
From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

Ignore the following data
Select this option so that the following messages arriving during the
specified time period will be ignored.

e During
Specify the time period, in minutes, so that similar messages that arrive
during this time period will be ignored.

e Do not consider the following substring
Enter a regular expression that will be used to filter messages upon
arriving and before being processed. For example, the following regular
expression \d{2}:\d{2}:\d{2} means that if a message contains a
substring like 11:01:54, then this substring will be dropped before
processing the message.

5.15 Email Settings

TRBOnet Dispatch Console allows processing emails as follows:

1.

Receive emails from email servers and forward them to a particular radio or

talk group (via a POP3 or IMAP server);

2. Send emails from radios to a particular email address (SMTP Server).
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Note: Microsoft Exchange Server can be used as SMTP and POP3/IMAP
servers.

¢ In the Configuration pane, select Email.

¢ In the Email pane, select Enable Email Server.

Configuration Email
gy Control Station #1 -
- TRBOnet.Swift Agent #1
% Controller #1

% Controller #1
... [®] Analog Control Stations
55 Remote Agents

Vgn

[ Friendly Servers

‘& Telephony

. /’_ Advanced settings
'8 Internal PEX Server
.. g External PEX Server
| Data Sources

.. coM parts

- A= 1epe

%% Modbus TCP

{ Email

-rers Incoming Mail Server

L Qutgaing Mail Server
a5 sM5 A
< >

Set Defaults Apply oK Cancel

5.15.1 Incoming Mail Server

The Incoming Mail Server is used to synchronize the Incoming Emails folder located
on a mail server with your local PC. If you are using a POP3 server, all incoming
emails can be downloaded from the mail server to the local PC to be then forwarded
as text messages to radios or talk groups.

¢ In the Configuration pane, under Email, select Incoming Mail Server.

Configuration Incoming Mail Server Version: 5.3.0,1711

L Analog Control Stations -
55 Remote Agents
3l Friendly Servers
‘@ Telephony
)9'_ Advanced settings
Z Internal PEX Server
: }' Advanced settings
a External PBX Server
/ Advanced settings
“ @ Redundancy
I Data Sources
. COM ports
B =
24 Email
=
Lo Qutgaing Mail Server
[ SMS

E License

< >

Set Defaults

Enable

Server: |imap.gmai\.com |
This server requires a secure connection {S5L)

Port: 993 =

Protocol: IMAP -

Check for new messages
EVEry: 15 +-| seconds

Connect using

(O) Anonymous access
(O) windows authentication
(®) Uselogin and password

Login: |testedsaa |

Password: | “““““ |

Check New Emails Now

Apply oK Cancel

¢ In the Incoming Mail Server pane, specify the following incoming mail-

related parameters:

= Enable

Select this option to enable Incoming Mail Server.

= Server

Enter the server hostname or IP address.
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= This server requires a secure connection (SSL)
Select this option to enable a secure connection. Note that a dedicated port
will be used to connect to the mail server via SSL.

Note: The port number will automatically change when you select
this option. For example, from 110 to 995 for POP3, and
from 143 to 993 for IMAP.

* Port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected protocol and whether a secure connection is
required.

= Protocol
From the drop-down list, select either IMAP or POP3. Note that if you
select POP3, all email messages will be deleted from the server once you
have downloaded them. In the case of IMAP, all new messages will be
marked as read once you have downloaded them.

Note: The port number will automatically change when you
change the protocol.

= Check for new messages every X seconds
Enter the time interval to check for new email messages (60, by default).

= Connect using
Choose one of the following options:

e Anonymous access
Choose this option to use an anonymous access to the incoming mail
server.

e Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

¢ Use login and password
Choose this option and specify the credentials for the mailbox:

v Login
Enter the incoming mail server login.

v Password
Enter the incoming mail server password.

= Check New Emails Now
Click this button to synchronize the Incoming Emails folder and check for
new emails.

5.15.2 Outgoing Mail Server

The SMTP Server is used to send emails from users to mail servers as well as
between mail servers to deliver emails to the final destination.
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For example, the Administrator can enable email notifications from TRBOnet
Dispatch Console to particular email users when alarms occur on selected radios. In
this case, the radio sends an alarm to TRBOnet Server which in turn converts this
alarm to text and then forwards it as an email message to particular email addresses
(for example, to admin@yourcompany.com).

¢ In the Configuration pane, under Email, select Outgoing Mail Server.

Configuration Qutgaing Mail Server Version: 5.3.0,1711

i..[#] Analog Control Stations ~

2| Remote Agents
I Friendly Servers
’ﬂ Telephony

,’_ Advanced settings
: Internal PEX Server
)f Advanced settings
3 External PBX Server
/ Advanced settings
i Redundancy
7 Data Sources
f COM ports
A 1eppp
24 Email

%

-rers Incoming Mail Server
.4 Outgoing Mail Server
5 5Ms

Enable

Sender Email: | |

SMTP Server: |smm.gmall.com |

Encryption: Implicit {S5L) -

SMTP Server Port: 455 =
Connect using

(O Anonymous access

(C) Windows authentication

(®) Use SMTP user name and password

User name: |besbed383 |

Password: | “““““ |

Type: Auto -

E License

2 £ Send Test Message 4

£ >

Set Defaults Apply OK Cancel

¢ In the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters:

= Enable
Select this option to enable Outgoing Mail Server.

= Sender Email
Enter the email address (optional) of the sender.

= SMTP server
Enter the server hostname or IP address of the SMTP server.

= Encryption
From the drop-down list, select the encryption protocol (SSL, TLS) if a
secure connection is required, or select None if not. Note that three
different dedicated ports will be used to connect to the mail server: via SSL,
TLS, or with no encryption.

Note: The port number will automatically change when you select
the encryption protocol. For example, from 25 (no
encryption) to 465 for SSL, and to 587 for TLS.

= SMTP server port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected encryption protocol.

= Connect using
Choose one of the following options:
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e Anonymous access
Choose this option to use an anonymous access to the SMTP server.

¢ Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

e Use SMTP user name and password
Choose this option and specify the credentials for the mailbox:

v User name
Enter the SMTP server user name.

v Password
Enter the SMTP server password.
v Type
From the drop-down list, select the SMPT login type.

= Send Test Message
Click this button to send a test message from the Sender Email address.

5.16 SMS Settings

TRBOnet Dispatch Console allows sending SMS notifications to a cell phone when
alarms and other events occur on selected radios (for example, DTMF commands
from radios, Telemetry, Radio State, and other events).

¢ In the Configuration pane, select SMS.
e In the SMS pane, select Enable SMS Server.
¢ In the Configuration pane, under SMS, select SMS.

Configuration SMS

; % Controller #1 A

. Sender: |

i..[7] Analog Control Stations
95 Remote Agents Connection to G5M via: | Vianett service (www.vianett.com) ~
5l Friendly Servers
'ﬂ' Telephony Login: |Iogin@:yourcompany.com ‘

Advanced settings Password: | ======= ‘
; Internal PBX Server
g External PBX Server Send Test MMS Send Test SMS
}' Data Sources
.. COM parts
LS Top e
2}t Modbus TCP
4 Email

rers Incoming Mail Server
L..r Qutgoing Mail Server
B sms
..... i sMs

E License
< >

Set Defaults Apply oK Cancel

¢ In the SMS pane, specify the following SMS-related parameters:

= Sender
Leave this box blank.

= Connection to GSM via
From the drop-down list, select the type of connection.
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e COM port GSM modem
Select this item if you are using a GSM Modem connected via COM port.
In addition, select the COM port the modem is connected to, and enter
the SIM Card Pin Code.

¢ Gemalto Cinterion EHS6T LAN
Select this item if you are using a Cinterion EHS6T GSM modem
connected via LAN. In addition, enter the IP address of the modem, and
enter the SIM Card Pin Code.

e Vianett service
Select this item to use an account on Vianett service.
For more details on Vianett service, see www.vianett.com

e SMS Broadcast
Select this item to use an account on SMS Broadcast service.
For more details on SMS Broadcast service, see
www.smsbroadcast.com.au

¢ Clickatell
Select this item to use an account on Clickatell service.
In addition to the Login and Password, you'll have to specify the API ID.
For more details on Clickatell service, see www.clickatell.com

Login
Enter the login for the selected service account.

Password
Enter the password for the selected service account.

Send Test MMS
Click this button to send a test MMS from the selected service account to a
recipient's phone number.

Note: This button is available when connected via Vianett service
only.

Send Test SMS
Click to send a test SMS from Vianett account to recipient phone number.

Note: This button is available when connected via Vianett, SMS
Broadcast, or Clickatell services.
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6.1

TRBOnet Dispatch Console

The key features of TRBOnet can be configured by the Administrator in TRBOnet
Dispatch Console after initial installation and configuration.

Connecting to Server

Launch TRBOnet Dispatch Console using the desktop or Start menu shortcut.

The default Administrator credentials are admin for the login and admin for the

password.

Connect to:
Address:
Port:

Authentication:
Method:
User Name:

Password:

|:| Connect on startup

Connect to TRBOnet Server

127.0.0.1

4021 = Configure

TRBOnet Authentication

Connect to:

= Address
Enter the IP address of the TRBOnet Server to connect to.

Note: This is the Network interface parameter of TRBOnet Server
configured in section 5.4, Network Parameters (page 17).

* Port
Enter the local port of the TRBOnet Server PC to accept connections from
the Dispatch Console.

Note: This is the Command port parameter of TRBOnet Server
configured in section 5.4, Network Parameters (page 17).

Authentication:

= Method
From the drop-down list, select the Authentication method:

TRBOnet Authentication

Select this method to log on as a User registered in the TRBOnet

Dispatch Console Users list.

Windows Authentication

Select this method to log on using the PC name. The system
automatically shows the PC name as a User Name.

Note: The Windows user must be registered in the TRBOnet
Dispatch Console Users list.

= User Name
Enter the User Name registered in the TRBOnet Dispatch Console Users list.
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6.2

Password

Enter the user password.

Connect on startup

Select this option to launch the Dispatch Console without having to type
the User Name and Password every time. Use this option if you regularly
connect to the same TRBOnet Server and your workstation is in a secure
location.

Main Window Elements

When the TRBOnet Dispatch Console application is initially launched, the default
Dispatch Console window will be displayed with the Voice Dispatch tab being
active.

Voice Dispatch

4|

Eil=h & XV |

© | Firemen
) 1m
(%) 125 Pets)
e 2.
® 2 0}
(%) Radio 200
(%) Radio201

PRI

10000040

Radio Interface | Recent Cals/Events

150

Wednesday, April 25, 2018
11:17 am

Radio Interface

= Repeater #1: Slot #1 e8]

3 Telephony

—
ey

Session: Session:

2 3

-

Sender:

Sender:
@ \

4 5 s
7 s 9
Radio Bridge
= 0 #
Unknown e
iy Grove g

3 Recent Calls/Events
ES Playback | Save~ () Print | 11 Pause ¥ Clear ~ & Reload | ‘[ Filter By Radio | = Grouping /' Auto Filter (€ Default Settings || &7 Details \shuwwom [Z] Add Note =
Text Messages
Date | Radio System | Sender | Recipient | Message | Details | bote |
~ 14Nov-2016 12:21:24  Repeater #LiSlot #1125 Al All call from *125' (00:02) Members: 125 o
i Voice Recording 14-Nov-2016 12:21:19  Repeater #1: Slot 1 235 Al All Call from *235' (00:03) Members: 235
S 11Nov-2016 17:52:44 235 Al Reset Geofending Alarm
(5 Repons S 11Nov-2016 17:52:38 235 Al eadm Ieft allowed region Route 1
- F 11N0v-2016 17:52:38 235 Al Geofencing Alarm [GPS Date: 11-Nov-20..,
Event Viewer 5% 11Nov-2016 17:52:38 235 Al Radio left allowed region ‘Route 1 -
|« | <] Record tofeas v [w|m| 4| ) »
o Abccation Recent Cali/Events | RecentCals. | Requestto Talk | Rado state | AcwveTasis | Acy | user Actvity | Map | Cameras

(3127001 &3 By B | B Dispatcher1 | [ Licensed to: demo Demo License

The main user interface elements are as follows:
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Note:

Main menu

Radio list pane
Modules tab pane
Radio Interface pane
Activity Monitor panel

Quick Panels pane

The look of the Dispatch Console windows may have been

customized for your specific operation.
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6.3

6.3.1

6.3.2 View

The View menu contains the following items:

Main Menu

The TRBOnet Dispatch Console main menu allows the user to manage the main
Dispatch Console options. The main menu is located in the upper left corner of the
main window.

The File menu contains the following items:

File > Connect to TRBOnet Server
Choose this menu item to connect to a different TRBOnet Server, or to use
different credentials for the current connection.

For more details, see section 6.1, Connecting to Server (page 95).

File > Exit
Choose this menu item to exit TRBOnet Dispatch Console.

e View > Show Navigation Pane

Choose this menu item to toggle the display of the Navigation pane on the
left of the main window. The Navigation pane includes two panes: the Radio
list pane and the Modules tab pane (see section 6.2, Main Window Elements).

e View > Show Touch Keyboard Button

Select this menu item to display a Touch Keyboard button on the bottom of
the Modules pane. Clicking this button will bring up a virtual keyboard on the
screen.

View > Show Modules
Choose this menu item, and in the drop-down menu select/unselect the
modules to display in the Modules tab pane.

View > Configure PTT Boxes
Choose this menu item to configure the view of PTT boxes.

Configure PTT Boxes X

Radio Interface

Type Mame View Mode Available Calls

Channel Intercom Normal -
Channel Control Station #1 Normal Al

Group Group 1 MNormal Firemen

Group Group 2 Mormal Police -

-

Create  [=hEdit Delete
dhreste Bhadt X okte Conce

In the Configure PTT Boxes dialog box, specify the following PTT box
parameters:
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Type
In this column, the box type (for example, Channel, Group, Radio or All Call)
is displayed.

Note: The 'Channel' type means that the PTT box has been
automatically created by the radio systems connected to
TRBOnet Server and it can only be partially edited. The Edit
link is grayed out when a PTT box of this type is selected.

Name
Enter a name for the selected box. This name will be displayed in the title of
the PTT box.

View Mode
From the drop-down list, select the view mode:

¢ Invisible
Select this mode so that the PTT box will not be displayed.

e Normal
Select this mode so that the PTT box will be displayed in Normal view
mode:

/_ Control Station #1 E
Channel 1
[

Session:

Free channel

Sender:

RX [TX

¢ Minimized
Select this mode so that the PTT box will be displayed in Minimized view
mode:

( Control Station #1  [+)] [4¢] _J

Note: Hover the mouse pointer over the Minimized PTT box to
view the PTT box in the Normal view mode.

Available Calls
From the drop-down list, select target radios or radio groups for the PTT
box.

Create virtual channel boxes

To create a virtual PTT box, click the Create link in the lower-left corner of
the Configure Voice Boxes dialog box.
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Virtual Channel X
Name: Group Call
Call Type: Call Target:
O alcal (® Select by Dispatcher

(®) Group Call () Selected from list

() Private Call | j

Execute call on channels:
(") Execute call on all available channels

(®) Execute call only on selected channels

W Control Station #1

I Intercom

I¥ Local Brine's
Repeater #1: Slot #1
™ Repeater #1: Slot #2

Cancel

In the Virtual Channel dialog box, specify the following virtual channel
parameters:

Name
Select this option and enter a name for the virtual channel.

Choose a Call Type for the channel.

Call Target

(available only when Group Call or Private Call is selected as the Call Type)
Choose Select by Dispatcher to allow the dispatcher to select a Call Target.
Or, choose Selected from list and from the list below select the desired
group (if the Group Call type is chosen) or individual radio (if the Private
Call type is chosen).

Execute call on channels

(available only when All Call or Group Call is selected as the Call Type)
Choose Execute call on all available channels,

or Execute call only on selected channels and in the list below select the
available channels.

e View > Configure Active Calls panel
Choose this menu item to configure call types and advanced settings for the
Active Calls panel. This menu item is available if View > Show Active Calls
Panel is selected.

= Call Types

On this tab, you can select which call types to display in the Active Calls
panel:
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Active Calls X
£al 358 | advanced

[~ Show All Call
[ Show Group Calls
[+ Show Emergency Calls
[ Show Private Calls
[+ Show Remote Monitor
[ Show Intercom All Calls

[ Show Intercom Private Calls

Cancel

= Advanced
On this tab, you can set following options:

¢ Show Visible Channels
Select this option to display Visible channels in the Active Calls panel.

¢ Show Hidden Channels
Select this option to display Hidden channels in the Active Calls panel.

Note: For the visibility of channels, see Configure PTT boxes,
View Mode.

¢ Show Requests To Talk
Select this option to display Requests To Talk in the Active Calls panel.

e Show Missed Calls for
Select this option to display Missed calls in the Active Calls panel, and
specify the duration of displaying Missed Calls, in seconds.

Active Calls x
Call Types A
¥ Show Visible Channels
¥ Show Hidden Channels
v Show Requests To Talk
v Show Missed Calls for: &00 2! seconds
Corce
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The Active Calls panel is displayed in the upper part of the Dispatch Console:

Tools Help

Radio Interface

io‘lﬁ(?\@'

& B, oniine Dispatchers (1)
B administrator

- & |
L) Palice

PTT

11, Voice Dispatch

B

Recent Calls/Events

[orr I —

Session:

Free channel

[ control Station #1

[o.aso [ _ris_F]

To: Selected Channels

) Playback [l Save~ () Print | 11 Pause < Clear - i Reload | [ Filter By Radio | =

29-5ep-2016 17:01:47
29-5ep-2016 17:01:25

Control Station... Administrator  Police

Intercom Administrator Al

| @] «| Recordtof3t2 v [w|mi[ «]

Dispatcher ‘Administrator ...
Intercom Call: Dispatcher '

Date |Radio System | sender |Recpient | Message | petais | note |
29-5ep-2016 17:03:17  Control Station... Administrator  Police Dispatcher ‘Administrator ... Members: i‘
29-5ep-2016 17:02:37  Control Station... Administrator  Police Dispatcher " ... Members: Administrator
255ep-2016 17:02:23  Control Station... Administrator  Police Dispatcher Members: Administrator
= Event Viewer
29-8ep-2016 17:02:00  Control Station... Administrator  Firemen Dispatcher ator' ... Members: Administrator

Members: Administrator
Members: Administrator

5t

Recent CallsfEvents | Recentals | Radio state || Actve Tasks |

127001 By B b B | § Administrotor | [ Licen

sed to: demo Demo License

e View > Customize Hot Keys
Choose this menu item to configure hot keys for the actions on the selected

channels.

Configure HotKeys

¥ Show actions panel

HotKey

Action Caption

shift

Enter

8]

[shift] +[H]
[shift] +[0]

Wi| 4| 4| Record 5of 10

dpCreate [ShEdit X Delete

Terminate All Transmitions  Terminate all
Default PTT channels Transmit

Intercom

Repeater #1: Slot #1
Repeater #1: Slot #2
Local Brine's

Control Station #1

333334

Group 2

LA AL

Show all PTT boxes

o 0 cne |

st

= To configure hotkey PTT actions to the PTT boxes, click the
Show all PTT boxes link, double-click the desired PTT box(es) to apply the

changes, then assign a hotkey or a combination of hotkeys.

| @ active~

= To configure specific non-PTT actions to PTT boxes (for example, mute
channels or set default PTT channels), click the Create link to make the

changes:
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Action *
HotKey: |Ctr\ Configure
Caption: |Mube Mode
Action: |Mune channels ﬂ

Channels:

I¥ Intercom
[ Repeater #1: Slot #1

™ Repeater #1: Slot 22
I Local Brine's
Control Station #1

In the Action dialog box that appears, specify the following parameters:

o HotKey
Click the Configure button, and on the keyboard, press the key or key
combination you want to assign as a hot key for the selected action.
e Caption
Enter a caption that will be displayed in the Dispatch Console.
e Action
From the drop-down list, select the desired action:

v' Default PTT channel
Selected PTT box functions as a default PTT channel.

v Mute channels
This action mutes selected PTT boxes.

v Unmute channels
This action unmutes selected PTT boxes.

v" Voice from channels
This action mutes voice from all PTT boxes except for selected one(s).

v Terminate All Transmissions
This action terminates all transmissions for selected PTT boxes.

e Channels
In the list below, select PTT boxes to assign the actions specified above.

= To enable displaying the configured hot keys in the Dispatch Console,
select the Show actions panel option.

All the hot keys you have configured are displayed in the upper part of the Dispatch
Console:
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= /B, oniine Dispatcners (1)
& agministrator

= & )

L) Palice |

Radio Interface

Radio Interface | Recent Cals /Events

All Call -

Drag and Drop PTT Box here to
create new grou

Recent Calls/Events

[ Playback (el Save~ () Print | 11 Pause ¥ Clear ~ 5 Reload | " Filter By Radio | = Grouping '\ Auto Filter (0 Default Settings >

Date |Rado system | sender |Recpient | Message | Detais | mote [
295ep 2015 18:15:42  Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator ﬂ
3B 29-5ep-2016 17:53:22 Radioserver Al Connection to Contral Sta...

29-5ep-2016 17:27:01  Intercom Administrator  All Intercom Call: Dispatcher ... Members: Administrator
29-5ep-2016 17:27:00 Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator
29-5ep-2016 17:26:48 Intercom Administrator  All Intercom Call: Dispatcher '... Members: Administrator -
1| @] <] Record1of31a v [w|w <] LH

| Radostate | Actwe Tasks | ActveRoutes | User Acovity | Map | cameras |

Recent Calls/Events

127001 G5 By B B | @ Admini

e View > Add Radio

@ ‘ Fesrestimdams Boalieres

Interface Tab

neocom
/ @ software

Choose this menu item to add a new Radio Interface tab to the Radio Interface

pane.

Configure Voice Boxes X
Mame: |Rad\o Interface #1 |

Type | Mame View Mode Available Calls

Channel Intercom Normal EI
Channel Control Station #1 Normal Al

Group Group 1 Mormal Firemen

Group Group 2 Mormal Police

Channel Repeater #1: Slot #1  Mormal Al

Channel Repeater #1: Slot #2  Mormal Al

Channel Local Brine's Normal Al

Al Call Al Call Normal

[=

dpCreate [SLEdit X Delete

[0 ]/ conce

= In the Configure Voice Boxes dialog box, specify the following PTT box

parameters for th

¢ Name

e new radio interface:

Enter a name for the radio interface.

Other parameters can be configured in the same way as when Configuring

PTT Boxes.

The user can switch between Radio Interfaces by clicking on the tab bar in the upper
part of the Radio Interface pane.
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Radio Interface &
[ Rodo interface ” Radlio Interface #1[ RecentColefevents |Redos ]| |

[} & Online Dispatchers (1) Confiqure
B administrator

(e o [l e B
L oo & e o

[Jintercom [E8] 2]
Perr

Control Station #1 [

(5o [ cmas |
PTT A ——

Session:

Free chamnel

Sender:

Session:

Free channel

Sender:

Recent Calls[Events

5 Playback (el Saver () Print | 11 Pause ¥ Clear + & Reload | [ Filter By Radio | =
Date | Radio System | Ser |Recpient | Message Note |
30-5ep-2016 10:48:54  Intercom Administrator Al Intercom Cal: Dispatche. ﬂ
29-5ep-2016 18:15:42 Intercom Administrator Al Intercom Call: Dispatche... Members: Administrator
o 29-5ep-2016 17:53:22 RadioServer Al Connection to ‘Contrel S...
29-5ep-2016 17:27:01 Intercom Administrator Al Intercom Call: Dispatche. ers: Administrator
29-5ep-2016 17:27:00 Control Statio... Administrator  Police Dispatcher ‘Administrato... Administrator
29-5ep-2016 17:26:48 Intercom Administrator Al Intercom Call: Dispatche. lembers: Administrator -
| «| 4] Record1of303 v |w|mi| 4] 3
Recent CalsfEvents | Recent Cals | Radio Safe | Actve Tesks | Actve Routes. | Lser Actvity | Map | Comeras |
127001 @ | 8 Administrator | (28 Licensed to: demo Demo License | @ Active-

e View > Delete Radio Interface Tab
Choose this menu item to delete the Radio Interface tab currently selected in
the Radio Interface pane.

Note: The default Radio Interface tabs can't be deleted.

¢ View > Show Channel Selector Box
Select this menu item to display a separate PTT box that allows selecting a
channel.

(i 0\

1P Site Connect: Slot #1
1P Site Connect: Slot #2

Session:

L 1

O Sender:

Channel not selected

b S

Click the arrow of the drop-down list and select the channel for this PTT box.

e View > Show Call Type Buttons
Select this menu item to display the Call Type Buttons panel in PTT boxes.

f|]]1 Site Connect: Slot #1 | -P

Session:

Free channel

Q C—

RX T
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¢ View > Show Keypad Panel
Select this menu item to display the Keypad panel in PTT boxes.

1P Site Connect: Slot #1

[ E @)

-

/

Note: The Keypad panel will be displayed only when the Num
button is pressed in the Call Type Buttons panel.

e View > Audio Message Library

Choose this menu item to add configured Voice Messages to the Queued
Messages panel. For how to configure Voice Message settings, see Tasks,
Voice Message.

Saved Audio Files

Filename

Alarm Tone
» Bobby.mp3

Daisy.mp3

send

A Add % Remove | [ Filter | Hot Key

Description

Alarm
Information

Information Link

Severity

Visibility
Hidden
| Button

Hot Key

* In the Saved Audio Files dialog box, specify the following parameters:

Filename

The name of the message displayed in the Queued Messages panel.

Description

Enter a description for the Voice Message.

Severity

From the drop-down list, select the severity level (Information, Alarm, or

Warning).
Hot Key

Click the Hot Key button and press the key or key combination you want
to assign as a hot key for the selected Voice Message box.
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o Visibility

From the drop-down list, select how to display the selected Voice

Message box:
v Hidden

Hide the Voice Message box.

v' Button

Display the Voice Message as a button (1).

v' Link

Display the Voice Message as a link (2).

Radio Interface

Radio Interface | Recent Calls/Events

[Jintercom @A
==
PTT
Sessian:

Control Station #1

r;? Channel 4

e View > Extended PTT boxes

Select this menu item to display PTT boxes as shown:

v Control Station #1

‘Control Station #1 ‘ @@
‘Channell 4

Free channel
— |
cali: All Call o [ cneek |
R R R
— 1 —]—
L | S | |
|2 2 Pospoupoy EREN

e View > Large PTT boxes

Select this menu item to display PTT boxes as shown:

e View > Medium PTT boxes

/" Control Station #1 [E8)

Select this menu item to display PTT boxes as shown:
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Control Station #1

E 5l
annel

e View > Small PTT boxes
Select this menu item to display PTT boxes as shown:

Control Station #1 @
Free channel
alcal Channel L

e View > Custom PTT boxes >

Select Custom PTT Boxes 1 to display PTT boxes as shown:

Control Station #1

o

Channel 1

Free channel

Select Custom PTT Boxes 2 to display PTT boxes as shown:

Select Custom PTT Boxes 3 to display PTT boxes as shown:

Slot 1

Al Call @
Free channel ‘£

R fTX

e View > PTT Box Themes
Click this menu item and select the theme to be edited, or create a new theme.

To create a new theme:

Click View > PTT Box Themes > Create Theme.

In the PTT Box Theme dialog box, enter a theme name and specify
desired colors for PTT box elements in various states and for various call
types.

From the Preview list box, select the box size/type and see how it will
look like.

To set the theme as default, select the Set as default theme option
located at the bottom of the dialog box.

Click OK.
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PTT Box Theme X

Name: [polce

Voice Box States Defaults ~ Preview:

¢ MasterRadio dscornected "

Large PTT Boxes -
(T [] control Station / Channel [« \

Free channel

Recipients
Sender:

4| Q@

I

Defaults

Session:

- Group Cal

Configure Colors:

Title Fort Color:

I 33; 76; 160
[ MistyRose
I 69; 116; 159
.S %8 139
[ 200; 208; 230
] white

[ 255; 153; 51

RO
Back Color

Border Color:

Font Calor:

Fields Border Color:
Incicator Back Color:

it

Indicator Fore Color:

4

PTT Color:

|

Delete [ Set as default theme

View > Show Active Calls Panel
Select this menu item to display the Active Calls panel in the Dispatch Console.
See also Configuring Active Calls panel.

View > Show Clock Panel
Select this menu item to display the Clock panel (1) in the Dispatch Console.
View > Show Quick Commands Panel

Select this menu item to display the Quick Commands panel (2) in the
Dispatch Console. For more details, see section 6.5.6, Quick Commands.

View > Show Queued Messages Panel
Select this menu item to display the Queued Messages panel (3) in the
Dispatch Console. For more details, see section 6.5.7, Queued Messages.

View > Show Patch Panel

Select this menu item to display the Patch panel (4) in the Dispatch Console.
For more details, see section 6.5.5, Patches.

View > Telephony Tab

Select this menu item to display the Telephony tab (5) in the Radio Interface
pane.

View > Show Extended Messages Tab

Select this menu item to display the Extended Messages tab (6) in the Radio
Interface pane.

View > Show Radios Tab

Select this menu item to display the Radios tab (7) in the Radio Interface pane.

Radio Interface

Radio Interface | Telephony | Recent Calls/Events | Extended Messages

&P Telephony Intercom

m Al call

Free channel

O Sender:

RX [ TX

| = 4 Menu y -~<n
, Line 2 |y Line 3 4
b Lined oy Line5 | Lines 4

2wy

.
.
0w
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e Select Location Tracking (1) in the Navigation pane to enable Map Options:

e Click the Map menu (2).

File View
Location|

[][2]

M crowp 10

& [<)]E|

Map | Teols Help
Active Map...
Bl Save ORMmeMep Dato.
%2 Map Content.
(=% Print

crowp 11

A Geocoding.
Open New Map in Tab

Fioor plan_ X]

2 mtercom [2][«d[@]
Group 20 [n][<]
P Frivate Call [][<[@]

[1][+][2]

-0 [ Beacons
Beer

Open New Map in Window..
& Google Earth

E‘Eﬁ _ |G Delete Route on Google Earth f’L
Show Radios on Google Earth » | 5y
@ Location Tracking = !’
— O
@ Job Ticketing
Route Management
@ RFID Tracker Hospital

[] Text Messages

|F|it=r R[E]O]E)] 7 [8] showBeacons: a1
P A £ i (3 @ []] 2o Custom Object~

235

125

< | # Drawing Panel

» ¥ [ Map Objects
¥I[2] camera 1
][] Hospital

& [& poiice
& M [ Map Regions
=7/ Region 1
E-¥] [ Map Routes

o~

09.06.2017 12:38:34  Capadity Plus 1
|« 4| Record10f305 ¥ W W

Recent Calls/Events | Recent Calls | RequestToTak | Radio State

R

Active Tasks | Active Routes.

Wm Lattude: 58°56:27.63" N: Longitude: 30'1649.88" E [

E e —— Recent Calls/Events 7]

[ Playback [l Save~ () Print | 01 Pause ¥ Clear - & Reload | [ Filter By Radio | = Grouping i/ Auto Filter (> Default Settings ’j‘
@ Reports Date. Radio System Sender Redipient Message Details

4 09.06.2017 14:43:57 Server Al Connection to 'Capacity Plus 1'h. :I
Event Viewer 09.06.201712:43:30  CapacityPlus 1 Administrator 1 Dispatcher ‘Admiistrator’ calls gr... Members: Admiistrator, 125
5 09.06.2017 12:40:06  Capadity Plus 1 125 1 Radio '125 calls group '11' (00:08)  Members: 125
EEI Radio _ 09.06.2017 12:39:55 Capadity Plus 1 Administrator 11 Dispatcher ‘Administrator' calls gr... Members: Administrator

Administator  Police Dispatcher ‘Administrator’ cals ar..  Members: Adminisirator L’j

User Activity | Beacons | Beacon Events | Tag List

127001 &3 B | § Administrstor | [ Licensed to: demo

The Map menu contains the following items:

e Map > Select Active Map

| @ Active~

Click this menu item to select the map to display in the Dispatch Console.

Select Map.. X

Caption:

Avalsble Maps
Name Path State
MAPNIK oK
CYCLE OK.
TRANSPORT OK.
LANDSCAPE oK
BING_ROAD oK
BING_AREA oK
BING_HYBRID oK

acd = G

= Enter the Caption of the map that will be displayed in the Dispatch

Console.

= In the list of Available Maps, choose the map to be displayed.

Adding custom maps

You can also add an online map using its specific URL.

Click the Add button.
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Add Map X

Name: [ap 1 |

Map Type: WMS (Web Map Service) -

URL: |t /vmaps.dgs udel edu 80/ geoserver/DGS _Surficial_and_Cortact_Geology/wms |

~ v Get Capabities

Map Tite Identifier Description style

T ococ - Usoe t . emephon e s ey cfD.

US-DEDGS ... |US-DE_DGS_... | This map shows the surfical geology cont.... | DGS Geologic Statewide Map

ip: //maps.dgs.udel edu:80/geoserver/DGS_Suficial_and_Cortact_Geology/wms ZREQUEST-GETMAPSSER] (5

=

e Enter a Name for the new map.

e Map Type
From the drop-down list, select the map type: Custom Map, WMS (Web
Map Service), or WMTS (Web Map Tile Service)

e Enter the URL of the map service and click Get Capabilities.

As a result, the table in the lower part of the dialog box will get
populated with the available map layers.

e Select the check box in the left column of the table to enable the
appropriate map layer.

e Click OK.

As a result, the new map will appear in the list of available online maps.

¢ Map > Save Online Map Data
Click this menu item to save your current map region.

Tiles bulk downloader - o X
Region from: N53°57'07.92" E030°14'33.51" to N59°56'48 68" E030°19'02.27"
Expire ties days: |30
Redownload alltiss

Zoom level: 14 Tiles to download: 40

Status: Finished
Loading zoom level: 14
Loaded from the web: 0
Updated from the web: 33

Local: 1
Failed: 0

Showfies preview 7] Show tes progress

Loaded: 40 of 40 (100 %)

In the dialog box, specify the following parameters:

Expire tiles days

Enter the expiration time, in days, for the map tiles. When you download
the map, the already downloaded tiles are checked and if they are older
than this number of days, these map tiles will be re-downloaded from the

Internet.

Redownload all tiles
Select this option to re-download the map tiles before saving to your PC.

Zoom level
Move the slider from left to right to increase the detail level of the map.
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= Show tiles preview
Select this option to show how the map is divided into tiles.

= Show tiles progress
Select this option to show the progress bar while the online map is being
saved.

= Click Start and wait for the system to save the files. This may take several
minutes.

e Map > Map Content
Click this menu item to specify the folder and settings to store the map data.

Online Map - o X
Map cache

Cache folder.
D:\Temp\Maps

Update: Never v

Map Type: BING_ROAD -

Bing key: \

In the Online Map dialog box, specify the following settings:

= Cache folder
Click Change and locate the folder on the PC where you wish to store the
map data.

= Update
Select the update interval ('Never', 'Immediately’, or 'By period') for the map
data stored in the specified Cache folder.

= Map Type
From the drop-down list, select the map type. For more details on the maps
used in TRBOnet Dispatch Console, see section 6.3.3.1, Map Types
(page 111).

= <Map Provider> key
Enter the key for the selected map.

Note: To obtain the key, click the hyperlink below and follow the
instructions.

6.3.3.1 Map Types
Online maps:

= MAPNIK - free online map. For more details on OpenStreetMaps, visit the
official the website: http://www.openstreetmap.org

* Thunderforest — commercial online maps. Visit
http://www.thunderforest.com/docs/apikeys/ to get a key.

= Microsoft BING — commercial maps from Microsoft. Includes BING_ROAD,
BING_AREA, and BING_HYBRID subtypes. A user may use BING maps for 90
days and then they must get a Basic Key. Visit
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic Key.
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= Google Maps - online mapping service from Google. Visit
https://developers.google.com/maps/documentation/javascript/get-api-
key#key to get a key.

= Custom Maps - online mapping services such as TRBOnet Map Server,
WMS and WMTS services. For more details, see TRBOnet Map Server User
Guide. For more details on the WMS/WMTS services, visit
http://www.opengeospatial.org/standards/wms/introduction.

Offline Maps:

= TMap - internal map-making resource. The user can create an offline copy
of online maps for selected regions according to their needs and
requirements. The user can create a map from any picture via the TRBOnet
Map Edit application.

Click Start > All Programs > Neocom Software > TRBOnet Enterprise>
Tools> TRBOnet.MapEditor.exe

For more details on map calibration, read the following article at:
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;CategorylD=2;ltem
ID=111.

= Beacon 2D - two-dimension offline map for Indoor positioning. The user
can create indoor maps using the Indoor 2D Map Converter. See section
6.4.14.3, Indoor 2D Map Converter.

= Beacon 3D - three-dimension map for Indoor positioning. The user can use
any DirectX file as a map.

e Map > Print
Click this menu item to print the map region currently displayed in the Map
pane.

e Map > Geocoding
Click this menu item to configure geocoding servers in the Dispatch Console.

Geocoding X

Add Delete Al v
Defat Cancel

* Load data from TRBOnet Server if Geocoding services are inaccessible
from local PC
Select this option to receive location data from the TRBOnet Server PC if the
Dispatch Console is unable to resolve location data.

= For other settings, see section 5.8.1.1, Configuring Geocoding Servers
(page 26).

e Map > Open New Map in Tab
Click this menu item to add a new map tab to the Map pane.
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Select Map...

Map Type: Online maps

Caption: [y maapl

Available Maps

Name Fath
MAPNIK

cYalE

TRANSPORT

LANDSCAPE

EING_ROAD

BING_AREA
BING_HYBRID

Add

Remave

Cancd

= Map Type

From the drop-down list, select the map type.

= Caption

Enter a caption for the new map tab.

For other settings, see Selecting Active Map.

Once you have clicked OK, the new tab will appear in the Map pane

BING ROAD % My Map X]|
Gl Ol sle iz i Ef‘..o .ShUwBeacong Al
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e Map > Open New Map in Window
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# Drawing Panel ] Route~ <& Geofencing

Once you have clicked OK, the new Map window will appear
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e Map > Google Earth

Click this menu item to open the Google Earth application

Click this menu item to create a new map window with the specified map
For required settings, see Selecting Active Map
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Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click
Download.

¢ Map > Delete Routes on Google Earth
Click this menu item delete all routes from Google Earth.

e Map > Show Radios on Google Earth
Click this menu item and in the drop-down menu select which radios to
display on Google Earth.

6.3.4 Tools

The Tools menu contains the following items:

e Tools > Event Viewer in Window
Click this menu item to open the Event Viewer in a new window.

vent Viewer - o x
ter events Talk Sessions

All Messages [ Playback [ Save~ | 1l Pause -# Clear £ Reload Grouping "/ Auto Filter g
(5 Text Messages Date V| Radio System Sender Reciient .
=% trbox (i) 05-Oct-2016 15:38:45  Control Station #1 Dispatcher Al -
o sent (i) 05-0ct-2016 15:38:43  Control Statio Dispatcher Al
oy Teemetry () 05Cct-2016 15:38:41  Control Staor Dispatcher Al
g :m‘:‘"m s‘g”:‘s 040ct-2016 17:38:38  Repeater 51 1 1s Al
=Nt commencs 040Ct-2016 17:38:32  Repeater 1 23 Al
Talk Sessions
040ct-2016 17:3242  Repeater 2 Administrator Al
(& Registration in a radio network
" 040ct-2016 17:3L:55  Repeater 2 Administator Al
$* System Messages
040ct-2016 17:30:50  Repeater 115 Al
iy User messages
040ct-2016 17:30:45  Repeater 235 Al
040ct-2016 17:30:40  Repeater Administrator Al
040Ct-2016 17:28:48  Repeater 125 Al
040ct-2016 17:28:45  Repeater £1: St #1235 Al
040ct-2016 17:18:05  Repeater #L:Slot #1235 Al
0402016 17:16:01  Repeater #1 Administrator Al
040ct-2016 17:15:58  Repeater £1: St 22 Administrator Al
040ct-2016 16:56:17  Repeater £1: Sot #2  Administrator Al
03-0ct-2016 10:51:39  Control Station #1 235 Al =
6] 9| 4] Record 120f 200 ¥ w[mi| ¢ r
u Sender: 235 Date: 04-Oct-2016 17:28:45
Redpient: Al [Blplavbads [ Save [ AddNote
All call from '235' (00:07)

¢ Tools > Recent Calls/Events in Window
Click this menu item to open Recent Calls/Events in a new window.

Recent Calls - [m] X

Grouping 7 Auto Filter @ Default Settings *|

%] Playback [ Save~ (h Print | 11 Pause <# Clear + £ Reload | \[F Filter By Radio

Date Radio System | Sender Redpient. Message Details Nate
38 05-0ct-2016 1514232 Radioserver | All Connection to ‘Control St... -
[] 05-0ct-2016 15:38:95  Conwrol Stati... Dispatcher  All Al Call from dispatcher 'Di...
[ 050ct-2016 15:35:43  Control Stati... Dispatcher  All Al Call from dispatcher Di.
[] 050ct-2016 15:38:41  Control Stati... Dispatcher  All Al Call from dispatcher Di...
R 05-0ct-2016 09:99:04 Radioserver | Al Connection to ‘Repeater ...
3% 040ct-2016 17:45:38 Administrator 125 Dispatcher ‘Admiristrator' ...
3% 040ct-2016 17:43:26 Administrator 125 Dispatcher ‘Admiistrator' ...
[ 040ct-2016 17:38:38  Repeater #1.., 125 al Al Call from 125 (00:01)  Members: 125

. 235 Al Al Call from '235' (00:00)  Members: 235
Admiristrator Al Al Call from dispatcher 'A... Members: Administrator
.. Administrator Al Al Cal from dispatcher ‘A... Members: Admiristrator
125 Al All Call from '125' (00:00)  Members: 125
235 Al Al Call from '235' (00:01)  Members: 235
Admiristrator Al Al Call from dispatcher A... Members: Administrator

[J 04-0ct-2016 17:38:32
[ 04-0ct-2016 17:32:42
[ 04-0ct-2016 17:31:55
[J 04-0ct-2016 17:30:50
[ 04-0ct-2016 17:30:45
[ 040ct-2016 17:30:40

[ 04-0ct-2016 17:28:48 . 125 Al AllCall from 125 (00:01)  Members: 125
[ 04-0ct-2016 17:28:45 . 235 Al All Call from '235' (00:01)  Members: 235
3B 04-0ct-2016 17:28:40 Admiistrator 125 Dispatcher ‘Administrator' ..
() 040ct-2016 17:18:05  Repeater £1... 235 Al AllCall from '235' (00:02)  Members: 235 =
4] 1] RecordBorzar v |mlmi| (| = . : »
H Sender: 125 Date: 04-0ct-2016 17:38:38
Redpient: Al [Blplavbads [ Save [ AddNote

Al Call from'125' (00:01)

= Click Playback to play back the selected call.

= (Click Save to save the selected call as an audio file.
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In the Save As dialog box, locate the folder where you want to save the
audio file, specify the file name, and from the drop-down 'Save as type' list,
select the format (*.wav or *.tna) for the audio file.

= (Click Add Note to add a note to the selected call.

MNote =
well done ~l
Add Extension. .. oK | Cancel

e Enter the text of the note in the text box.

¢ You can extend the form of a note by clicking the Add Extension link
and adding new fields and their possible values to the form.

¢ Tools > Job Ticketing Monitoring
Click this menu item to open the window that visually represents the job
tickets created by dispatchers and assigned to radios.

------

In this window, you can perform the following actions:

= Select a time period for which to display Job Ticketing data.
= Monitor tickets created by dispatchers.

= Monitor tickets assigned to radios.

All data are shown in the form of status diagrams.

¢ Tools > Radios in Window
Click this menu item to open a new window that displays the radios present in
the system.
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Radios — [m] X
Filter: l:l Radio Groups: | All -
Statuses: | (Criine, Indoor), (Oniine, ... W Police

| Firemen =

| Cleaners
W 11
M 22
¥/| Mobile Client d
oK Cancel | |
G & | @ |

In this window, you can make radio calls, send text messages. In addition, you
can select to display radios by groups and statuses.

Tools > Telephony in Window

Click this menu item to open a new window that displays the Telephony
system present in the system.

Hold

In this window, you can make and receive telephone calls.

Tools > Telemetry Monitoring

Click this menu item to open the window that displays configured telemetry
profiles for the radios.

Telemetry 21 - [u] X

Radio « | status VIOL vI02

= From the Show drop-down list, select the Telemetry profile to display.
See also section 6.4.10, Telemetry (page 201).

Tools > Text Messages in Window
Click this menu item to open a new window to manage text messages.
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Text Messages - o x

BlEs & Y S@ |  Clear S Reload ||} Inbox [ Sent

[05-0ct-2016 17:51:13 Received from 235 to 125
His be on

& B online Dispatcners (1
& o n l05-0ct-2015 18:01:43 Received from 235 to 125
piq 2aministrator only6m
© [ Firemen B ||p5-Oct-2015 18:06:04 Received from 125 to 235
_ nog
H® s |V
= 05-0ct-2016 18:10:53 Sent from Administrator to Police
B @235 B Q|| Stop making me fool
| Police 2

Recipient: *% | Poiice | Ed send | ] AttachFile

125

In this window, you can perform the following tasks:
= View sent messages in the upper-right pane.

= Select online dispatchers and radio groups in the left pane, or by clicking
the ellipsis (...) button in the lower-right pane.

= Type messages in the text box in the lower-right pane.
= Send messages by clicking the Send button in the lower-right pane.

¢ Tools > Routes in Window
Click this menu item to open a new window to manage routes.

For more details on Route Management configuration, see section 6.8, Guard
Tour / Route Management (page 303).

¢ Tools > Camera in Window
Click this menu item to open a new window with a camera view.

® Camerat — [m| *

Camera: ICamera 1

In this window, the camera view is displayed.

= Camera
From the drop-down list, select a camera that is connected to TRBOnet
Dispatch Console.

See also section 6.4.8, IP Cameras (page 197).

e Tools > Reset All GPS Triggers
Choose this menu item to stop/start GPS triggers on all radios.
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e Tools > Terminate All Transmissions

Click this menu item to terminate all voice sessions.

This action is a "hard" request to stop all *hung" transmissions in the TRBOnet
software. If a radio communication session is not allowed to be interrupted on
a repeater or base station, it will only be stopped for the TRBOnet software.

e Tools > Phone Book

Click this menu item to open the phone book for reference and editing

purposes.

\L) Phone Book
1 Add =h Edit | % Remove | “ Filter

SIF ID
2409

2235
Yellow 2125

4| 4 | Record 1of3 » |k M4

call

, Configure &

SIF User
2409
2235
2125

Import-
Display Mame
Walt
235
125

oK Cancel

= Click the Add button to add a new record to the phone book.

= Click the first column, and from the drop-down list select a marker color.

= Double-click the second column.

Phone Number

SIP ID:
SIP User:

Display Name:

2125

2125

|John

e SIPID

Enter the SIP ID that is used by the user.

e SIP Name

Enter the SIP user name that is used by the user.

e Display Name

Enter the name that will be displayed for the user in the Dispatch

Console.

e Click OK to save the phone book.

6.3.4.1 Options

e On the Tools menu, click Options.
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Sound

Options x

Sound Map  Coverage Map Hardware Advances d Audio Alarm  Telephony

@ Configure the Sound Notification
4

ry system event , choose
use & file by default

@), Tak begin

@), Tak end

@ Line busy

@, Alarm or Emergency Cal

@), warm received

©), System error

@, alarm Tone

. Private cal from a radio Network to dispatcher

@), Request To Tak from Radio Network to dispatcher

Sound:
(Sound by default) MDD Select...
Alarm or Emergency Call duration: 5 < seconds

¢ In the Options dialog box, click the Sound tab.

Map

Use Sound Notifications
Select this option to enable sound notifications in the Dispatch Console.

Select the event in the list and specify the sound.

From the Sound drop-down list, select ether 'Sound by default' to play
default sound, or 'Disabled' to disable sound notification for the event.

Click E] to listen to the sound notification for the selected event.

Click Select and browse for the audio file on your PC.

Alarm of Emergency Call duration
Enter the time value, in seconds, for the duration of the alarm tone when
an emergency call is received.

¢ In the Options dialog box, click the Map tab.

Options x

sound {Mp % CoversgeMap Hardware Advanced Audio Alarm  Telephony
-é Configure the image parameters that are shown on the map

Map refresh interval 20 2] seconds

Show the direction of motion:

Show names of objects:

Hide overlapping names of cbjects

Shaw PTT on map: [ Radios [] Map Objects
et o B

Select the image size: 32 32 pixels hd
Select the default image type: CES ~[+[-]

The images below will be shown on the map:
Radio is tuned off:

Radio is turned on, but GPS madule does not work:

Radio i turned on and GPS module works properly:

Radio transmits an Emergency Alarm andjor Cal:

Path to Google Earth exe fle

, e®e®e

Map refresh interval
Enter the time period, in seconds, to update map data.
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Show the directions of motion
Select this option to display a direction of motion for map objects.

Show names of objects
Select this option to display object names on the map.

Hide overlapping names of objects
Select this option to hide overlapping object names.

Show PTT on map

Select this option to allow the dispatcher to make private calls by
clicking a corresponding radio icon on the map.

Default Map Filter

Select/unselect the icons for the default map filter (for a description of
the icons, see section 6.6.2.4, Filters).

Select the image size

From the drop-down list, select the size of a radio icon.

Select the default image type
From the drop-down list, select the default image type of a radio icon.

Path to Google Earth exe file

Click the ellipsis (...) button and specify the location of the Google Earth
exe file on your PC. For example, the path may look like: C:\Program
Files\Google\Google Earth Pro\client\googleearth.exe

Coverage Map

TRBOnet Dispatch Console allows displaying RSSI levels on a map. The RSSl is a
received signal strength indicator. It measures the power level of the signal at a
radio’s receiver. The RSSI maps can be used by radio system engineers to plan a
further extension of their radio networks.

¢ In the Options dialog box, click the Coverage Map tab.

Options X
sound Map  CoversgeMap Hardware Advanced Audio  Alarm  Telephony
Q) Draw in Dots
(® Draw Coverage Zone
100 E|: RsSI Zane Size (m)
Value (dB) [ Desaription | Color
3 65 Excelent o, 128,0
-81|Normal [ 255, 165, 0
-47 Satisfactory I 184, 134, 11
-113|Poor . 139, 0, 139
oo Bad B 255, 0,0
Add Delete Defal:
cancl

Draw in Dots
For a more detailed data view, choose this option to display on the map,
dots of RSSI levels representing coordinate points.
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= Draw Coverage Zone
For a less detailed view, choose this option to configure and display on the
map, RSSI zones of average RSSI levels using GPS coordinates.
e RSSI Zone Size
Enter the size of the RSSI zone within which RSSI levels will be averaged.

Etoshe  MAPQUEST =
dgoh s sl 6 JSMWI-‘ A Fite @[ Q] @) E3PuybackRonte & & \ Sesrch by Addresz 1 Geotening | ] Coverage Map | sestiig
= / s _\_-"e A [il ._".:*-\ul v\‘ Select RSS] data by period =
k., ny; Start Date: 201301-27 16:31 >
’/ H S § | 0w e Date> g
wed | [ Comed |
o
w i
e §
k3 % %
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L 4 . 5
f";nmr“"

PETERSBURG
@ CAHKT-NETERBYRN)

]
I

y G
Lattuc: 55 9475618, Longeude: 30.2354390

= (Click Add to add a new RSSI level.

e Value
Enter the minimum level for the signal range (for example, -65 means -
65 and higher).

¢ Description
Enter a name of the RSSI level to display in the system.

e Color
Pick a color for the RSSI indicator on the map.

To view RSSI Levels on the map, click the Location Tracking tab in the
Navigation pane, and on the Map pane toolbar, click Coverage Map. Then
set the Start Date and End Date to display RSSI data.

Hardware

¢ In the Options dialog box, click the Hardware tab.
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Options X

Sound Map  CoverageMap Hardnare Advanced Audio Alarm  Telephony

@J%  External hardware options. You can attach an additiond equpment to
e control PTT button (Footswitch, hand microphone, etc)

Use signaling device

Serial port:

oML v
Confiqure

Description
com3

TREONEt Mic Adapter
Wired Keyboard 600

b add B Edit X Delete

£ TREONet Microphone Adapter

FirstV s TREOnet Mediz Dock 2000
FrstT ' TREOnet Footswitch
us Ui HID
co K DirectX
| Tero

com

= Use signaling device
Select this option to use an external signaling device.

e Serial port

From the drop-down list, select the COM port the signaling device is
connected to.

= Click Configure and specify the duration of a signal and which call types to
include in signaling.

Signaling COM port x

Duration 10 3: seconds
Private Cal
Call Alert

Alarm

0K Cancel

The External Devices table displays the connected devices
(Type/Name/Description).

Click the Add link, and from the pull-down menu select the type of
TRBOnet device with a PTT button connected to the PC (Microphone
Adapter, Media Dock, or Footswitch), or the device type (HID, DirectX,
TIPRO, or COM).

In the dialog box that opens, specify the desired device parameters and
click OK.

First VolP port

Enter the number of the first VolP port for audio communications (4022,
by default). Each additional Dispatch Console will create a connection on
the next port number.

First IP Camera port

Enter the number of the first IP Camera port for video communications
(13152, by default). Each additional Dispatch Console will create a
connection on the next port number.
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e Use proxy server
Select this option to enable a Proxy Server service in TRBOnet Dispatch
Console to access the Internet.

A proxy server can be used when a user's computer cannot be

neocom
SOoftware

connected directly to the Internet, but there is another computer with
Internet access in the network.

v" Click the Configure link to specify the alternative server settings.

Advanced

¢ In the Options dialog box, click the Advanced tab.

Configuration Scope

Per machine

Configure the proxy server *

Use an alternative server

Settings

Address: [177.71.134.70
Part: 80 =
Authentication

Use authentication

Lo

Password:

el

Options X
Sound Map  CoverageMap Hardware Advance d  Audio  Alarm  Telephany
@ J%  Advanced application options

Configuration Scope )
O Per machine: al dispatchers share the same workspace
{®) Per user: a separate workspace for each Windows user account

PTT Options

[] Tone and PTT when using an external PTT device

1 use Record Mode with external PTT device

Suggest Queued Message when channel is busy or subscriber radia is offine
Enable sticky PTT

Use 'Space’ key to press PTT Configure...

[ Enable Single PTT Select mode

recording audio
Tone and FT cal

sound when starting a Tone and PTT call
[ Automatically set channel to Solo when transmitting audic
[ Automatically unmute channel when transtitting aucio
View Options
[ customize the automatic subscriber name pattern Canfiqure..
[ show extended notes
Show latest note in Unit information details
Show confirmation dialogs
[ Show incoming text messages in a pop-up windowr w

Cance!

Choose this option to store settings in a common place for all dispatchers
of the Dispatch Console.

Per user

Choose this option to store settings for each dispatcher separately if they
are using different Windows user accounts.
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PTT Options

Tone and PTT when using external PTT device
Select this option to enable Alert Tone for all subscribers on a channel when
the dispatcher presses the PTT button on an PTT external device.

Use Record Mode with external PTT device
Select this option to record all voice transmissions from external PTT
devices (Palm mics, Footswitches, and other devices).

Suggest Queued Message when channel is busy or subscriber radio is
offline

Select this option to record a Queued Voice Message when a radio channel
is busy or subscriber is offline.

Enable sticky PTT
Select this option to start and finish voice calls by a short press of the PTT
rather than holding the PTT down until the end of a voice call.

Use 'Space’ key to press PTT

Select this option to use a hot key for the PTT. Click the Configure link, and
on the keyboard, press the key you want to assign as a hot key for the PTT
button.

Enable Single PTT Select mode
Select this option so that only one PTT box can be selected at a time, that is
you can't have multiple selected PTT boxes.

Voice Options

Mute other dispatchers
Select this option to mute all other dispatchers voice transmissions.

Mute radio-to-radio private calls
Select this option to mute all private calls on the channel.

Mute all channels when transmitting audio or recording a voice
message

Select this option to mute other channels when the dispatcher transmits
audio or records a voice message.

Mute the tone when receiving a Tone and PTT call
Select this option to mute the tone when you receive a Tone and PTT call.

Play a sound when starting a Tone and PTT call
Select this option to play the tone when you start a Tone and PTT call.

Automatically set channel to Solo when transmitting audio
Select this option to mute other channels when transmitting audio.

Automatically unmute channel when transmitting audio
Select this option to automatically unmute a channel when transmitting
through this channel.
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View Options

= Customize the automatic subscriber name pattern
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Select this option and click the Configure link to set a custom alias for a
radio in the list of subscribers. Once the changes are made, selecting this
check box will cause a change to the radios in the Radio list pane (upper left

pane of the Main Interface screen).

Display Formats

Radio display name:

Example: My Radio

Allocated radio display name:

H

| #eAME % (%0WINER %) -
Example: My Radic (John Smith)
Allocated radio display name
{the owner has more than one radio):
| MNAME % (%0WINER %) -
Example: My Radio (John Smith)
Defaults Cancel

¢ Radio display name

Click the ellipsis (...) button and in the Format dialog box pick the fields

to display for a radio.

Format
YEMNAME %o (YeCHANMEL %)
Example: My Radic (Master Stetion [ Channel)
Add Field:
Radio Callsign
Radio Owner name
Radio ID
Active Channel
Plate Mumber
Make
Phone Number
Email

e Allocated radio display name

Click the ellipsis (...) button and in the Format dialog box pick the fields

to display for an allocated (taken) radio.

¢ Allocated radio display name
(the owner has more than one radio)

Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for an allocated (taken) radio in case when a user has more

than one radio.

e Click Defaults to set default settings for radio display.

Show extended notes

Select this option to enable Extended Notes in the Dispatch Console.

The Extended Notes feature is intended to add predefined Extended Notes
templates, the same as for Extended Messages, for the selected calls and

events.
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For example, a Taxi Dispatcher needs to check clients' calls response period
for the company internal monitoring of the employees. They can add a
predefined template and check the time period. All Extended Notes are
displayed in the Ext. Note column in the Recent Calls/Events tab:

Recent Calls/Events
S Playback (] Save || 11 Pause ¥ Clean ‘%3 Reload | “[f Filter By Radio | = Grouping [/ Auto Filter € Default Settings | T Details ||[] Show Notes "2 Add Note [ Extended Not«

Date V| Radio System Sender Recpient Messa Ext. Note Note
S8 7/7/2014 3:49:5 AM Radio 11 al Geofencing Alarm [Dat
S 7/7/2014 3:46:56 AM Radio 11 Al Radio left allowed region

¥ 77/20143:47:52AM  Repeater 2150t 1 Radio 105 Dispatcher Admiristrator Accept 1
38 7/7/20143:41:244M  Repeater #15bot 1 Radioserver Radio 105 Telemetry status cann. ..

=% 7/7/2014 3:90:16 A Administrator Al test

7/7/20143:39:08 M Repeater #15lot 1 Radio 105 Unknawn group: 1010 Radio Radio 105" calls .., View

S 77/2014 3:32:55 AM Admiristrator Radio 105 Dispatcher ‘Adminisira...

$B 7/7/2014 3:18:43 AM 105 Al On Buty 2

[0 7/7/2014 12:56:40 AM  Intercom Dispatcher 1 Al i

[ 7/4/2014401:354M  Intercom Dispatcher 1 Al
B e Pr—— a

rd 540f83 b | b || < »

ents | RecentCals | Radio State | Active Tasks | Active Routes  User Activity | Map

Click the Extended Notes button (1) to fill the template;
Click the View button (2) to see the Extended Note.

= Show latest note in Unit information details
Select this option to include the latest note about the radio state change in
the Radio information window (see section 6.5.1.3, Radio Pop-up Window).

= Show confirmation dialogs
Select this option to enable confirmation dialogs for dispatcher actions. For
example, when sending a configured Voice Message from the Dispatch
Console, the following confirmation dialog box will appear:

TREOnet Enterprise 5.1 / Dispatch Conscle

o Start "Voice Message'?

= Show incoming text messages in a pop-up window
Select this option so that incoming Text Messages will pop up over the
application window.

File View Map Tools Help
Volce Dispatch Radio Interface
izt & XV 650 Rodio Tntertace | Recent Cals/Pvents

Cleansrs

& [} Firemen

HOmM

x

DS 125 Pete)

£z
1o 016 1353

= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.

126 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SsOftware

Audio

Request to Talk

J 125
. The Reguest to Talk has been received.
J You must accept or reject it.

Reject Queue

Close button minimizes application
Select this option so that clicking the Close button will minimize the
Dispatch Console rather than close it.

Minimize button minimizes to Voice Bar
Select this option so that when you click the Minimize button you will see
only the Voice Bar displayed at the top of the PC's screen.

Show this number of Recent Calls/Events
Enter the number of items to display in the Recent calls/Events pane.

Measurement system
From the drop-down list, select either the Metric or the US unit system.

Coordinate system
From the drop-down list, select the coordinate system to be used.

e On Map
Select this option to display coordinates on the map.

¢ In the Options dialog box, click the Audio tab.

Options X
Seund Map  CoverageMap Hardware Advanced Audio  Alarm  Telephony
Default audio devices: Confiawre
Recorder: Primary Sound Capture Driver
Player: Primary Sound Driver
Selected channel: Defauits 4
Recorder [pefautt ~]
Player: [pefaurt =]
Speaker: [oetault ~|
External PTT: [ ~]
Indicator [ ~|
Unselected channek: Defauits
Recorder [pefautt ~]
Player: [pefaurt =]
Speaker: [oetault ~|
Indicator F ~|
System sounds: Defaiits
Player: [pefaurt =]
Speaker: [oetault ~|
[ El
Reset All audio devices to default M: Custom Modes
cancel

Default audio devices

Recorder
From the drop-down list, select the recording device the microphone is
connected to.

Player
From the drop-down list, select the audio device to play incoming voice
messages and playback voice recordings in the Dispatch Console.
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Note: If TRBOnet Dispatch Console is running on the same PC
with TRBOnet Server connected to control stations via a
programming cable and sound card, the playback and
recorder devices cannot be the same for TRBOnet Dispatch
Console and TRBOnet Server.

= Selected channel
Select the recorder, player, speaker, and external PTT device for radio
channel boxes which are selected in Dispatch Console.

= Unselected channel
Select the recorder, player, and speaker for the radio channel boxes which
are not selected in Dispatch Console.

= System sounds

Select the player and speaker for the system sounds.
For the list of system sounds, see section Sound (page 119).

= Alarm
Select the player and speaker for the alarm sounds.
= Telephony/Intercom/Private Calls
Select the recorder, player, speaker, and external PTT device for the
appropriate voice boxes.
= All Call/Groups/Slots
Select the recorder, player, speaker, external PTT device and volume level

for the appropriate voice boxes.
Alarm

¢ In the Options dialog box, click the Alarm tab.

Options X

Sound Masp  CoverageMap Hardware Advanced Audio |AlaM | Telephony
Configure display options for radios in alarm mode

Alarm Panel: [ ain Window

Ll

€all Button: [pione
Always show radio on map
[ Display c

= Alarm Panel
From the drop-down list, select where to show the alarm panel (in the main
window or in a new window), or select '‘None' to hide it.
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= Call Button
From the drop-down list, select the call destination when the PTT button is
pressed in the alarm panel (private call, group call, or all call).

@ Radios in Alarm -

®=
Geofencing Alarm

Request Location
PTT Copy Coordinates
Find on GPS map

Find on Beacon map

18 Jul 2018 17:01
Region 1
18 Jul 2018 17:01

135 x

Emergency Call
Request Location
P I I Copy Coordinates
Find on GPS map
Find on Beacon map

Beer 18 Jul 2018 16:58
GPS: 18 Jul 2018 16:57
Region: Region 1

Minimize

= Always show radio on map
Select this option so that radios in alarm mode will always be displayed on
the map regardless of the filters applied to the radio (see section 6.6.2.4,
Filters).

Note: When this option is selected, you cannot disable the display
of radios in alarm mode.

= Display camera in new window
Select this option so that when a radio is in alarm mode, a window will
open with the camera associated with the radio.

= Display radio in new window
Select this option to display a radio in alarm mode on the selected map in a
new, separate window.

e Map
This field displays the map name. Click the Select map link and specify
the map on which to display a radio in alarm mode.
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Telephony
¢ In the Options dialog box, click the Telephony tab.

Options X

Sound Map  CoverageMap Hardware Advanced Audio Alarm  Telephony

Incoming g Call | Call waiting | Held Cal

Call Priority Ringtone Action

Normal: Default b play

Emergency: Default b play

5 I
-3
=3

b play

e faul

(=

b play

= Queue all incoming telephone calls
Select this option so that when the telephone line is busy, incoming calls
will be queued rather than rejected.

= Show this number of Recent Phone Calls
Enter the number of items to display in the list of recent calls. The list of
recent phone calls appears when you click the arrow on the right of the dial
string in the Telephony box (see section 6.5.9.1, Phone Calls from/to
Dispatch Console).

Ringtone configuration

On the Incoming Call (Call Waiting) tab:

e Click a corresponding link in the Ringtone column, and from the pull-
down menu, select either Set Default, Set Custom, or Disable.
If you select Custom, in the dialog box that opens, browse for the audio
file on the local PC and click Open.
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e Click a Play link in the Action column to play back the corresponding

ringtone.
On the Held Call tab:

e Remind after

Enter the timeout, in seconds, that will be used for playing the reminder

tone when a call is on Hold.

¢ Ringtone

Specify the reminder tone to be played when a call is on Hold.

6.3.4.2 Exporting/Importing Options

A dispatcher can export custom Dispatch Console settings (Volume level, Ul view,
hotkeys configuration, and other settings) as a .config file and save it to the local PC

or to a selected external device.

¢ Click Tools > Export Options and save the file to the specified location.

If you want to apply settings from a different TRBOnet Dispatch Console:

¢ Click Tools > Import Options and browse for the .config file with the desired

settings.

6.3.4.3 Setting Language

e On the Tools menu, click Set Language

Select Language X

Language: |En

= From the drop-down list, select the desired language and click OK.

The changes will apply after you restart the Dispatch Console.

6.3.4.4 Changing Password

e On the Tools menu, click Change Password

{f\s) Change Password

Old password: | ooooo |

Mew password: | tesens |

Repeat password: |uooo. |

Change Password x

= In the Old password box, enter your current password.
= In the New password box, enter the new password.

= |n the Repeat password box, enter the new password again.

= Click OK.
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6.3.5 Help
e Help > Send Feedback
Click this menu item to send your feedback to Neocom Software, either
through E-mail, or online via the site.
e Help > Save System Logs
Click this menu item to save the logs as a .zip file. This .zip file can then be sent
to Neocom support.
e Help > About
Click this menu item to see the About dialog displaying information about
TRBOnet Enterprise (applied license, version, build date, and other relevant
information).
6.4 Administration
Click the Administration tab to set system elements and options.
Click the Administration tab (1), and see the full system information in the Server
(2) pane:
Servr BEc
P 5 s ine e OF) ()
(T TOE) (T
[rrivate cal [«[@]
\1@ Administration
Select an item in left menu to administer.
Licensed to:
Ci::;::.‘;:hhk
e
— LT
ey i o
5] Event viewer Ca%%&;%ixifﬁzla
ﬁl Radio Allocation ‘IEk::::: -
\ Service is avaiable ’
Emm —H— 1
[ 127001 &3 g | & Administrator | (8 Licensed to: demo Demo License | @ Active-
6.4.1 Database
Go to Administration (1), Database (2) to see the full overview of the database:
132
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File View Map Tools Help

Administration Database
Gome ~ | W & e free [« e o acal
[F)oatabase] Mlcow 10 [-1][<][@] B P Group 20 [2][=][@] B P Group 30
i} Radio Systems
&3t System Eridging 2 [ Jprvate cal
@, IE‘ELP""”Y o || 1 Backup | s schedute
Al vosce Dispatch u Database Information
i Server name: (local)\SQLEXPRESS
g Localionizackg, Database name: TREONEt
Backup date: 25.0ct 2016 16:28:26
& sob Ticketing Database version: Microsoft SQL Server 2014 (5P2) (KB3171021) - 12.0.5000.0 (X64)
Jun 17 2016 19:14:08
Copyright {c) Microsoft Corporaton
Route Management Express Edition (§4-bit) on Windows NT 5.3 <X64> (Build 10586: )
@ RFID Tracker Data size: 17.23M8
Audio size 2.77M8
[] Text Messages
ﬁ Voice Recording
() Reports
Event Viewer
[75] Radio Allocation 1
e
127001 £3 B | § Administrator | (28 Licensed to: demo Demo License | @ Active~

In the Database pane, the administrator can restore and back up the database and
audio recordings.

For more details on backups, see Appendix D: Backing up and Restoring Database

and Audio Recordings (page 348).
6.4.2 Radio Systems

All radio systems registered in the Server are represented on the Radio Systems

pane.

Go to Administration (1), Radio Systems (2) to see the system parameters:

File View Map Tools Help

Administration Radio e e[
due * |G e ree D OoE (CLE O]
(@ Database ¥ crow 10 [-0][+][@] J8f ¥ Group 20 [2][«][@] S P roup 30 [2][«][e]
e Radio Systems|
8 System Bridging [Jprivate call [n][<]
 rsote e
System type System ID Caption
U\l voice Dispatch |/ Intercom Intercom
+f Phone Telephony
@ Location Tracking |+ Capadty Plus Department1 CapacityPLUS
& 10b Ticketing
Route Management
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
@ Reports
Event Viewer
7] Radio Allocation / 1
., Administration o«
1 @] | Record 10F3 ¢ [ [mm] ¢ »
6127001 &3 B | $ Administrator | (8 Licensed to: demo Demo License | @ Active-

The administrator is able to see the following radio system parameters in the table:

System Type - the type of the system.

System ID - a unique System Identifier configured in TRBOnet Server
configuration for repeater or control stations in the system.

Caption — the caption of the system.

6.4.2.1 Radio System Properties

To see the radio system properties, do the following:
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e Select a radio system in the list and click the Properties button (1);
or,
double-click the radio system in the list;
or,
click the corresponding element at the bottom of the Dispatch Console
window, and choose Properties (2).

File View Map Tools Help

Administration Radio e &)

5;’?’ * | W% s ine free e Fuical Pl

o EETEENEE) () (e
w|Radio Systems
458 System Bridging [ JPrivate Call [«

&P Telephony

LF Tacke

<

T Properties

System ID Caption
Intercom

() voice Dispatch

Telephony
Department1 CapadityPLUS

Ighmdﬁmlnrhlq

ﬁ. Job Ticketing

Route Management
@ RFID Tracker

[] Text Messages

ﬁ Voice Recording
C@ Reports
Event Viewer

2

T
«| < |Record 10F3 b | |mi] <] »

127001 §3@,| & Administrstor A8 Licensed to: demo Demo License | © Active~

Reset

The administrator is able to see Active and Inactive registered systems. In case you
have more than 10 registered systems, systems are grouped and can be seen in the
drop-down list.

Common information for all system elements is listed below:
Description tab

On the Description tab, you can see the general info:

Repeater #1: Slot #1 *
Description  Channels  Transmits
System Type: IIP Site Connect
System ID: IDeparhnentl
Caption: IRepeatEr #1: Slot #1
Cancel |

e System Type
The system type for a repeater/control station (in Digital or Analogue mode).

For more details on the systems, see section 3.2, MOTOTRBO Radio Systems
(page 4).
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e System ID

The Unique System Identifier configured in TRBOnet Server for a repeater or
control stations in the system.

e Caption

Enter the system name.

Channels tab

On the Channels tab, you see the list of channels:

Repeater #1: Slot #1 X
Description  Channels  Transmits
7' Properties Control | =5 Reset
‘Name Voice
../ Repeater #1: Slot #1 RX, TX RX, T
Channel for private and phone calls:
E

e Click the Properties button to see the channel additional data:

= ID

Repeater #1: Slot #1 X
Description  Talk groups  Volume
ID: |800:3f18-a§e64b4f—b8€7—551e19deh0&b
Mame: |Repeater #1: Slot #1
Type: |MOTOTP.BO Repeater
Mode: [P site Connect
Connected
Serial Number: ‘484TMG411D
Firmware version: ‘2.6.0.7
Cancel

Default registration number (manufacturer’s number);

= Name

System element’s name in the system;

= Type

System type for a repeater/control station (in Digital or Analogue mode).

= Mode

System type for a repeater/connection mode for a control station.

For details on the control station modes, see section 5.9.6.1, Control Station
Connection Modes (page 47).
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= Connected

e Serial number
Default system element'’s serial number (manufacturer’'s number).

e Firmware Version
Current system element's firmware version.

e Click the Reset button to test the connection to the system element.

Note: For a repeater, clicking the Reset button reconnects the

repeater.
For a control station, clicking the Reset button reloads the

radio.

Talk groups tab (for repeaters only)

= On the Talk groups tab, you can see selected Talk group info:

Repeater #1: Slot #1 X

Description  Talk groups  yolume

Specify available talk groups

[ | all call
[ |Firemen
[v |Police

= Specify available Talk groups for the system element in the list of created
Talk groups.
Selected Talk groups are available on the Radio tab in the system element
box in the drop-down list:

(_D Repeater #1: Slot #2

All call E
Firemen
Police

Session:

Free channel

Sender:

I

RX T =
]

. J

Note: Close TRBOnet Server before applying the system element
settings.
Volume tab (for repeaters only)
= On the Volume tab, you can see Volume settings for the repeater:

136 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SsOftware

Repeater #1: Slot #1 *
Description  Talk groups  Volume
+ +
RX ™
Reset Reset
[ configure system volume

e Specify the RX and TX volume levels for the Repeater using a volume
control slider.

e C(lick the Reset link to set default volume level for RX or TX.

¢ Configure system volume
Select this option to save default volume settings for Voice transmissions
from the selected Repeater.

Transmits tab

e On the Transmits tab, you can see the information about audio and data
transmissions:

Repeater #1: Slot #1 %
Description  Channels  Transmits
Record Audio
[] Manage Audio by DTMF
Cance

= Record audio
Select this option to enable audio recordings for the selected repeater.

= Manage Audio by DTMF
Select this option to manage audio on the selected channel by specified
DTMF tones.

¢ Mute channel
Enter a DTMF sequence to be used to mute the selected channel.

¢ Unmute channel
Enter a DTMF sequence to be used to unmute the selected channel.
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6.4.2.2 Intercom Properties

e Select Intercom in the list and click the Properties button;

or,

double-click Intercom in the list of radio systems.

Channels tab

On the Channels tab, you see the list of Intercom channels.
These are the dispatcher groups you added in TRBOnet Dispatch Console (see
section 6.4.17, Dispatcher Groups).

Transmits tab

138

Intercom X
Description  Channels  Transmits
Record Audio
Voice Call Hang Time (ms):
Group Call: ’m
Private Call: 4000 2
T¥ Timeout: 50 EI: seconds

Record Audio
Select this option to record all audio transmissions over the Intercom
channel.

Voice Call Hang Time (ms):

Group Call

This value sets the duration of reserving the channel after the end of a
group call transmission. During this time, only members of the dispatcher
group that the channel is reserved for can transmit.

Private Call

This value sets the duration during which the private dispatcher call setup is
kept after a dispatcher releases the PTT button. This is to avoid setting up
the call again each time a dispatcher presses the PTT button to transmit.
During this time, other dispatchers can still transmit since the channel is
essentially idle.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts a voice session over the Intercom channel, transmission
will be interrupted after this TX Timeout expires.
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6.4.3 System Bridge

TRBOnet Dispatch Console provides the System Bridge function that allows
configuring the network for redirecting radio calls.

The administrator can create the following two types of system bridges:

1. System Bridge for Radio Channels — allows connecting all types of Radios
(analogue and digital radios, supports IP Site Connect, Capacity Plus, Linked
Capacity Plus and Connect Plus modes). See section 6.4.3.1, Radio Bridge.

2. System Bridge for Repeaters (Binary Patch) - allows connecting only the
repeater slots between IP Site Connect systems without encoding/decoding
voice and data. See section 6.4.3.2, Binary Patch.

To add a system bridge:
e Go to Administration (1), System Bridge (2).

5§ TRBOnet Enterprise 5.3 / Dispatch Console

o X
File View Masp Tools Help
Administration em Bridge ol
B‘S;Wi EEEEE 2 | 1: tne free " @ W ntercom [« B W [vaintenace D) (mETE [@]«]=]
(1 Database [JGroup 10 [@sEe) (WEE [20] () B N [ Jevercency crowp  [o0] (4] B [ JRecular cerowe [3)] (] [E)
) Rad
L Red Syatens [ Jsiot 1 D) EErE D) s D<) BT B2
-G Telephony 2 [ Jeroup 11 B3(@] BN [ J6roun 22 [«<[E) (WEEE [2)] B[] [ ]Private cal [« |=)}
G Tasks v
< 5 Mdrreren B<]E]
A, voice pin 5 Add|- =) Edit | [k Delete
ke blerata == B
[l Locotion Trcka Binary Patch (for IPSC Systems only)
Iy Radio Bridge Private calls
0 sob ke 4l Radio Bridge Rado Bridge
[] Text Messages
Q Voice Recording
ey
Event Viewer
EEI Radio Allocation / 1
F—
| «| 4| Record 20F 3 | m|m 4] »
[ Connected &3 B B B B | ¥ Administrator | (28 Licensed to: demo (Wa) Demo License |2 @ Active-

e Click the Add button, and from the drop-down menu, select the System
Bridge type (3).

6.4.3.1 Radio Bridge

Radio Bridge x

Name: [Fremen-poice

Work Mode [channets redirect the cals to each other ~|
PTT Button: IAMays Enabled ~|

Channels | Parameters

Channels to redrect calls

Radio System Group Mode

Control Station #1 Any Groups Always

Repeater #1: Slot #1 \;} Any Groups \ Nway]

P Add X Delete

o

* Name
Specify a name for the Radio Bridge to display in the Radio Interface pane.
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Work mode

Select the work mode from the drop-down list. For more details on System
Bridge types, see Radio Bridge Types (page 141).

PTT Button

From the drop-down list, select how to display the PTT button in the
System Bridge box. There are 3 options available:

e Enable when Bridge enabled

e Always Enabled

e Invisible

On the Channels tab, click the Add button (1) to add a channel to the list.

In the Radio System column, select a radio channel from the drop-down
list (2).

In the Group column, select available group for the radio channel (3).

In the Mode column, select a mode for the radio channel (4).

e Always

Enables the System Bridge always, regardless of the radio state
(online/offline).

e By Radio
Enables the System Bridge on a selected channel when there are online
radios capable to receive voice calls from the selected group.

On the Parameters tab, specify call types for the System Bridge:

Radio Bridge X

Name: [Fremen-poiice

Work Mode [channeis redirect the calls to each other =l

[tenisible =l

Channels | Parameters

PTT Button:

‘Specify call types for System Bridge:
¥ veice call ¥ Text Message
I chedk Radio [ Telemetry
I Enable /Disable Radio

I call Alert

¥ Location (GPS)
I user Data

¥ Emergency Alert

o

= Select call types to use in System Bridge mode.

= Click OK to add a System Bridge for the radio channels.

The System Bridge boxes are displayed on the Patch panel of the Radio

Interface pane:
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/®

Radio Interface | Recent Calls/Events

Start Voice Message

Voice Message
[Py Froc channel S
PTT
= - Drag and Drop PTT Box here to
areate new group
Group 10 ] [«
ki 2 system ori b
SUR R Administrator /] (avﬂefn ridge
pacityp.. [
— Police Area PTT
CapacityP...
Group 20 [9] [« Cleaners

Firemen - Police ||

Firemen
(-S| Administrator @ capaa

- e oy
Group 30 [ [« [@] v
Recent Calls/Events
5 Playback [ Save~ () Print | 11 Pause ¥ Clear ~ &3 Reload | [ Filter By Radio

Date |Radio System | Sender | Recpient
18-Nov-2016 17:18:52  CapactyPLUS Administrator Firemen
18-Nov-2016 17:18:52  CapadityPLUS Administrator Folice
- 18-Nov-2016 17:18:49 CapadtyPLUS Administrator All

18-Nov-2016 17:16:31  CapadtyPLUS 125 Al
] 4] Record1of672 | m[m[4]

‘Recent Calls/Events jnum=uls| RequesttoTak | Radio State | Active Tasks | Active Routes | User Actvity | Map | Cameras
127001 g3 g | § Administrotor | [ Lice | @ active~

| Message Detais | mote |
Dispatcher ‘Adk . Members: Admiistrator B
Dispatcher ‘Administra... Members: Administrator

AllCall from dispatehe... Members: Administrator

Al call from 125" (00:01) Members: 125 2

sed to: demo Demo Lice

Radio Bridge Types
1. Channels redirect the calls to each other

This is the most common type of System Bridge when data exchanges
between the channels set in the System Bridge settings. Thus, there is a
common channel for all the subscribers of the specified control stations:

To create this type of System Bridge, add a System Bridge and set the Work
Mode as Channels redirect the calls to each other.

AV Y
(% e Call via System Bridging- \\/////
\\\ ) \\/
MOTOTRBO
Capacity Plus

/ Capacity Plus

Control Station

Analogue

Radio
network
u
Control Station

Analogue

TRBOnet
System
Bridging

&
\ 5

s, % k Y
% Digital IP Site Connect ;,\\///7
A AV

Control Station Control Station
Digital Radio MOTOTRBO IP
Site Connect
network

e Call via System Bridgi

2. A channel redirects calls to many channels

~_
ice Call e g
Voice Call via System Bridging ~~___

To create this type of System Bridge, add a System Bridge and set the Work
Mode as A Channel redirects calls to many Channels.

3. Many channels redirect calls to one channel
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To create this type of System Bridge, add a System Bridge and set the Work
Mode as Many Channels redirect the calls to one Channel.

Redirect private calls
Select this mode so that private calls can be redirected between radio systems.
Redirect private calls to group calls

Select this mode so that private calls will be redirected to group calls within
one radio system or between radio systems.

6.4.3.2 Binary Patch

142

Binary Cross Patch (IPSC Systems only) x

Name: [Binary patch
Rules
Rule 10f2

Siot: Slot 1 ] voice ! Data

Allcalls Private Cals ¥/ roup cals
Groups: (All Groups)

Repeaters: (Al Repeaters)
Rule 20f 2

Slot: Slot2 Voice Data

¥ Al calls W private calls Growp Cals
Groups: (All Groups)

Repeaters: (Al Repeaters)

ik Add X Delete

Name
Specify a name for the Binary Patch to display in the Radio Interface pane.
Rules

Specify the rules for redirecting calls between IPSC systems. Click the Add link
below to add a rule.

= Slot

From the drop-down list, select the slot (Slot 1 or Slot 2) of the IPSC
systems being connected.

= Select the type of data: Voice and/or Data.
= Select the call types: All Calls, Private Calls, and/or Group Calls.
= Groups
In the drop-down list, select the group(s).
= Repeaters

In the drop-down list, select the IPSC systems to be connected via the
selected slot.

The Binary Patch boxes are displayed on the Patch panel of the Radio Interface pane:
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Radio Interface

Radio Interface| Telephony | Recent Calls/Events

a ‘R Online Dispatehe.
B administrator
O Online, Indaor (0)
Q Online, GPS Fixe
@ Online, No GPS (0)
e O Offline (2)

Control Station #1

Charnel 4

Drag and Drop PTT Box here to
oup
Patch on Repeaters
®sinary Patch

Radio Bridge

Repeater.. ()
Firemen PTT
Control St...
Any Groups

[Jeroup2 [JRepeater #1: slot #1

[[] repeater #1: Slot #2

r——j Free channel
allcal

Recent Calls/Events
I Playback el Save~ () Print | 11 Pause < Clear - i Reload | [ Filter By Radio |

[« &) Cancan

rouping "7 Auto Fiter € Defaut Settings || 47 Details 7/

Date | Radio System | sender |Recpient | message | Detais [ Wote [Ext.rvore |
170ct2016 14:21:07  Repeater #1:Sot #1 125 Al AlCall from 125 (00:01)  Members: 125 B
170ct2016 142106 Control Station #1  Dispatcher Al Al Callfrom dispateher ...
170t2016 14:21:02  Control Staton 1 Dispatcher Al Al callfrom dispatcher .,
70ct-2016 14:20:57  ControlStation #1 Dispatcher Al AllCall from dispatcher .
170ct2016 14:20:51  Repeater #1: Sot #1125 Al Al Cal from 125 (00:01)  Members: 125

AT-0re-2N1A 1420051 Crntral Statinn 21 Nisnatrhar an Al Al fram Aisnateher A
e 1
Recent CalsEuents | RecentCals | Rodio State | Actve Tasks | Actve Routes | User Actity | Map | Comeras |
127001 &3 B B B | & Administrator | [ Licensed to: demo Demo License

‘ @ Active v

Note: System Bridges can also be created by drag and drop of the
PTT boxes in the Radio Interface pane. It is a temporary
System Bridge, which will be deleted after reconnecting to
TRBOnet Server or exiting TRBOnet Dispatch Console.

6.4.4 Telephony

Click Administration (1), and then Telephony (2) to configure incoming and
outgoing SIP calls:

File View Map Tools Help

Administration Telephony

[ server

79 1: Line free ¥ ntercom

€]
[+][@] B Group 10
=

License

- (I Datebase P 0 cal e

i Radio Systems =

et B oo a
2 Configure Calls | Extensions | Rediect Calls | Allases | Profies

@ Tasks 2

212 Virtusl Modbus Devices

57 1p Cameras Radio calls configuration
[ Event/Alarm Management Allow subscribers to make outgoing calls: Yes
(8] swift Event Profiles Allow ta use DTMF: Yes

[ Telemetry
() Radio Groups Telemetry
5 Telemetry £1

Allow to use Text Messages: Yes, Prefix: 'sp:'

Play the incoming call tone on the radio: After the called party answers the call

Initishze call to radio: Start transmission

Maximum number length:

[y Rado statses Initilize call tmeout: Uniinited
(B Group Radio Statuses et Chech A before ol N
 psprafe xecute Check Radio before cal o
() GPs Profie 51 v Send Text Message if cannot establish cal Yes
Play tone when PTT changed Yes
DTMF Access code 0
DTMF Deaccess code: #
_cotgee fo—3
Incoming calls configuration
Cal to Dispatch Center: Redirect to dispatchers
Call to external number: Decine calls
Extension numbers (veice menu)
start cal autematicaly: Yes

Uniimited, Accept code: %

Number Call Description
0 Call dispatcher (any avaiiable)
<humber > Call radio with Radio D = <Mumber >

Configure |4-——_ 4

127001 g3 € | 8 Administrator | [ Licensed to: demo

6.4.4.1 Radio Calls Configuration

Click the Configure button (3) to set radio call configuration

| @ Active-

parameters:
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Radic calls configuration *

¥ allow subscribers to make outgoing calls
v Allow to use DTMF
v allow to use Text Messages

Prefix: sip:

Play the incoming call tone on the radio: |Af‘ter the called party answ... j

Initialize call to radio: |Start transmission j
Initialize call imeout: Unlimited 3: seconds

[ Execute Check Radio before call
¥ Send Text Message if cannot establish call

¥ Play tone when PTT changed

DTMF Access code: o

T

DTMF Deaccess code:

Cancel

Allow subscribers to make outgoing calls
Select this option to enable outgoing phone calls from the radio subscribers.

Allow to use DTMF
Select this option to allow radio subscribers to dial the phone number as a
sequence of DTMF tones.

Allow to use Text Messages
Select this option to allow radio subscribers to initialize phone calls via sending
TMS messages with a specified prefix to the dispatcher.

= Prefix
Enter the standard prefix for a text message.

Play the incoming call tone on the radio
Select the mode for playing the incoming call tone on the radio that initiates a
call.

= After the called party answers the call
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio after the called
party answers the call.

= Immediately
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio immediately
that is without waiting for the called party to answer the call.

Initialize call to radio
Select the option how to start a call on a radio.

= Start transmission
Select to start a call to a radio automatically.

= Send ringtone
Select to play a ringtone until the radio user presses the PTT.

Initialize call timeout
Specify a timeout that defines how long to attempt to connect to the called

party.
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o Execute Check Radio before call
Select this option to execute a Check Radio command before placing a call.

¢ Send text message if cannot establish call
Select this option to send a text message to the radio when the channel is
busy and a phone call cannot be established.

¢ Play tone when PTT changed
Select this option so that the phone will sound a tone when the remote radio’s
PTT is pressed or released.

e DTMF Access Code
Set the value to that configured for the radios as Access Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

e DTMF Deaccess Code
Set the value to that configured for the radios as Deaccess Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

6.4.4.2 Incoming Calls Configuration

Click the Configure button (4) to set incoming call configuration parameters:

Incoming calls configuration x
Call to Dispatch Center:  [Open voice menu ﬂ
Call to external number: |Use number as Internal ﬂ
Extention numbers (voice menu)

[V Start call automaticaly

Man. number length: Unlimited 3: Accept code: £ -
Number Call Description

1] Call dispatcher (any available)
<Number > Call radio with Radio ID = <Mumber =

= add 5 Edit [Sk Delete

¢ Call to Dispatch Center
Select the mode for handling incoming calls made to the dispatcher.

= Decline calls
All incoming phone calls will be declined.

= Open voice menu
When an incoming call arrives, the subscriber will hear Voice menu
commands.

= Redirect to dispatchers
All incoming voice calls will be redirected to all dispatchers of the Dispatch
center and any free dispatcher will answer the phone call.

¢ Call to external number
Select the mode for handling incoming calls made from unregistered
subscribers.
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= Decline Calls
Select this option to decline all phone calls from unregistered subscribers.

= Use number as Radio ID
Select this option so that the system will use unregistered numbers as a
Radio ID and start a Private Call.

= Use number as Internal
Select this option to allow the system to read unregistered numbers
according to Voice Menu rules.

Extension numbers (Voice menu)

¢ Start call automatically
Select this option to search for the number in the Extensions table
automatically. When this option is disabled, the subscriber must dial the
number according to the following example: 0(phone number)#. The
character # is used to search for the phone number in the table.

¢ Max. number length
Specify the maximum number of characters allowed in a phone number.

e Accept Code
Specify the character that will be used to finish dialing the number.

All available numbers are listed in the table below.

146

e Click the Add link to add a number to the table.
To add a static number

= Choose Static number.

Extension number >

{* Static number

" Dynamic number

Number: 123456

Call Type: |Ca|| Group j

Channel: |C0mm\ Station #1 j

Group: |AI\ Call j
Cancel

= Number
Enter a phone number to add to the table (contact list).

= Call Type
Select the call type from the drop-down list.

¢ Call Dispatcher
Select this type to make a phone call to the dispatcher.

e Call Radio
Select this type to make a phone call to the selected radio.

e Call Group
Select this type to make a phone call to the selected group.
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Select the channel to make a group phone call through (available for Group

Calls only).

= Dispatcher/Radio/Group
Select the dispatcher, radio, or group depending on what you have selected
in the Call Type box.

To add a dynamic number

= Choose Dynamic number.

= Prefix

Extension number x

" Static number

% Dynamic number

Prefix: | 127

Call Type: |Ca|| Radio

|AL|tD Detect

|Detacted by Radio ID

tbbb

Specify a prefix to type in on the keyboard.

= Call Type

Select the call type from the drop-down list.

e Call Radio

Select this type to make a phone call to a radio.

e Call Group
Select this type to make a phone call to a group.

e Call Phone
Select this type to make a phone call to a telephone.

= Channel

Select the channel to make a group phone call through (available for Group

Calls only).
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6.4.4.3 Adding SIP Extensions

e Click Administration (1), Telephony (2), Extensions (3), Add > SIP Phone (4)

File View Map Tools Help

Administration Telephony
5 server A~
+[A License
[ Database Configure Calls” Extensions | Redirect Calls | Aliases | Profiles |
L%- :“dt‘: 5‘::”‘5 5 Add[~ ) £dit| 2 Delete®, =S Grouping "/ Auto Filter (G Default Settings
L ystem Bridging
55 Telphony —2 6] si2 Phone SIP User Caption
L Tacks hd £ TRBOnet Mobile Client 1234 Internal PEX Server
] Radio 125 125 125
(i) Voice Dispatch B Radio 235 235 235
Location Tracking
Route Management
[] Text Messages
4|
p—
4| 4| 4 | Record 10f3 b | m M| 4 »
[ 127.00.1 &5 | § Administrator | [ Licensed to: demo Demo License @ Active -

In the Phone User dialog box, specify the following parameters:

Phone User >
SIP ID: 2403
SIP Name: |walt
Caption: |Walt
Password: | -----
Password {repeat): | ----- |
= SIPID
Enter the SIP ID that will be used by the phone user.
= SIP Name

Enter the SIP user name that will be used by the phone user.
= Caption

Enter the caption to be displayed for the phone user.
= Password

Enter the password for the phone user to be authenticated by the
telephone system.

= Password (repeat)
Enter the password again.

6.4.4.4 Redirect Calls

148

If a dispatcher doesn't take a phone call within the set period or they have changed
their status to unavailable, the call is automatically forwarded to a specified
dispatcher, radio, radio group, or phone account. This can be useful during night
shifts when no dispatcher is available.

e Click Administration (1), Telephony (2), Redirect Calls (3), Add (4).
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File VWiew Map Tools Help

Administration Telephony
-l Radio Systems -~ - _ -
|t System Bridging £ L Line fres [¢] [ Jmtercom [=/EA
L Fldisp 15 @Ee) [~EE B « =)
ections X B
8 e " Configure Calls_| Extensions” Redirect Calls | Aliases | Profiles
B pdd B Edit Delete || = GmNg /' Auto Filter & Default Settings
lfl_l_aﬂil Vaoice Dispatch
Drage @ ol g et Call N3 X
Location Tracking cllo | b
Call to:
ﬁ Job Ticketing 4 Target: & Dispatcher 1 -
: 30 =
Timeout: + | seconds
Redirect to:
[ e Type: WERadioGroup " T T T -
ﬁ Voice Recording Radio System: Slot 1 -
- Target: [} Firemen -
Event Viewer
Priority: Normal -
7] Radio Allocation 1
/ OK Cancel
I
P <
44| 44| 4 |Record Dofo v [ 4] r

Br2roo B B € Administrator | £ 21 days before your Support expires | [ Licensed to: demo. @ Active~

In the Redirect Call dialog box, specify the following parameters:

Call to

Target
From the drop-down list, select the dispatcher or dispatcher group.

Timeout
Specify the time period, in seconds, defining how long to wait until the
dispatcher answers a call.

Redirect to

Type
From the drop-down list, select one of the following:
¢ Decline

The calls will be declined.

¢ Dispatcher
The calls will be redirected to a specified dispatcher or dispatcher group.

¢ Radio unit
The calls will be redirected to a specified radio.

¢ Radio Group
The calls will be redirected to a specified radio group.

¢ Phone account
The calls will be redirected to a phone account from the phone book.

Radio System
If a radio group is selected as the redirection destination, select the radio
system over which to make a call to the specified radio group.

Target

From the drop-down list, select a particular dispatcher/dispatcher group,
radio, radio group, or phone account, depending on what you have
selected in the Type field.
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= Priority
If a radio or radio group is selected as the redirection destination, select the
priority with which the call will be made over the radio system.
6.4.4.5 Aliases

In addition to SIP extensions, the SIP aliases can also be used in your Telephony
system.

e Click Administration (1), Telephony (2), Aliases (3), Add (4)

File View Map Tools Help

Administration Telephony a
B e :

(Jl Database
5h Radio Systems
~#3 System Bridge

- Telephor

@ Tasks (\ 2

B nam b m i b
(i Vawe D

=y Cont
o4 3 <1
% Location Tracking
SIP ID: [2412

& 3ob Ticketing 4

B TRl
[ private call [21][«][@]
e

w

SIP Name: [2412

Route Management Caption: [Eugene

[ Texttessages Cencel
C% Reports
B

1
p———
4[4 4| Record 10F 1 v [ve[mm] 4] i
(127001 &3 B B | § Administrator | [ Licensed to: demo Demo License | @ active-

In the Phone Alias dialog box, specify the following parameters:

= SIPID
Enter the SIP ID that will be used by the phone user.

= SIP Name
Enter the SIP user name that will be used by the phone user.

= Caption
Enter the caption to be displayed for the phone user.
6.4.4.6 Profiles

In order to restrict incoming and outgoing calls as well as set priority for calls, SIP
profiles can be used in your Telephony system.

¢ Click Administration (1), Telephony (2), Profiles (3), Add (4).
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File View Mop Tools Help

Administration Telephony

[ server ~
1: Line free Intercom
8 License >
(0 Database Sales disp 15
il Radio Systems
g System Bridge Group 20 [2] Al cal
& TE‘EP"“"\ [private cal
@ Tads 2
%8 Modbus TCP Connections Calls_|[ Aliases
2 Virtual Modbus Devices i
57 1 cameras v Profile
a
Voice Dispatch General | pattems | Inheritance r
Name: Droite
Location Tracki
@ racieo 4 Description: Restirct dising to JeFF
@ Job Ticketing

™ Apply to Incoming Calls
C@ Reports ™ Apply to Outgoing Calls

‘2] Radio Allocation
L~ 1
< Admosirten 0 et .72 [ = .
127001 &g & B | § Administator | (8 Licensed to: demo Demo License | @ active-

In the Profile dialog box, specify the following parameters:

* Name
Enter a name for the profile.

= Description
Enter a description for the profile.

= Apply to Incoming Calls
Select this check box to apply the profile to incoming calls.

= Apply to Outgoing Calls
Select this check box to apply the profile to outgoing calls.

Click the Patterns tab.

Profile X

‘ General | Patterns | Inheritance

You can use wildcard chars in pattern:

* - any number of characters

? - one character

XXX-yyy -range of numbers from xxx to yyy

*411777 X

Call Priority: Mormal -

o

neocom
SsoOftware

= Specify the pattern that will be used to match the numbers in the dial string

or the incoming call numbers.

= Call Priority

From the drop-down list, specify the priority for the calls corresponding to

the specified patterns.
Click the Inheritance tab.
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Profile s

Call Priority Profile Mame

@ Emergency + Fedora

[ | Inherit Mals
Emergency
High
Normal
Low

Cars

On this tab, you can select the profiles to include in the profile you are
adding/editing.

= Call Priority
From the drop-down list, select the priority for the inherited profile.

6.4.5 Tasks

Go to Administration (1), Tasks (2) to see the list of the tasks created in the system:

File View Map Tools Help

: TEE
[ server "
B8 eense P intercom [][=] 5 1: Line free [+] [Jancal [n][<]
(1 Database M crow 10 [](<][@] B ¥ Group 20 [][][@] 8 I Group 30 [][«[@]
B ornmens (e TTal
s Add ~ b Edit | [k Delete
2 Task Name a
[ & Agenda
v || ] @ Dispatcher Presence Control
[] 435 Export to SWD - Location of radio
{1l voice Dispatch i [T Geafenang
vl 3 1dle Time
Ig Location Tracking ¥ G Lone Worker 1
vl (2] Mesages 1_Messages for Period
# Job Ticketing ¥l 7%, Missed GPS data loadin
¥l §3% Radio Allocation
Route Management Il [ 5MS ar il nol
E Iyl 5% Timer
@ RFID Tracker ¥ & User Actvity
) Voice Message
L] TextMessages ¥ '@ voice Message

g Voice Recording

Event Viewer 3

- 1
@ Administration Ll

it 4| 4| Record 120714 | 1| m] «| »
[t 127.001 &g & | & Administrator | [ Licensed to: demo Demo License | @ active-

Note: After you have created a task you need to enable it. Just select the
check box (3) beside the task you want to enable.

6.4.5.1 Dispatcher Presence Control

When enabled, this feature checks the presence of dispatchers and sends
notifications to interested parties if the specified dispatchers are not present in the
system.

e Click Tasks (1), and double-click Dispatcher Presence Control (2) in the Tasks
pane.
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File View Map Tools Help

nae
1J Database nEE B DR T Bl
it
gmr—1

% Virtual Modbus Devices

5k Add - 5 Edit | Ek Delete
Task Name N
| G Dispatcher Presence Control
5% Export to SWD -Loc3tieq of radio
¥l 14 Geofendng
5 1dle Tme

< >

(41 voice Dispatch

@ phese—— 55 Radio Allocation (Sprite Forms) 2
(5 SMS and Email notifications

# Job Ticketing vl {2 User Activity

Route Management

QI RFID Tracker

[] Text Messages

g Voice Recording

Event Viewer

@ Radio Allocation

i omnre

|« | 4 |Record 10f 7 » [ n[ ] < 3

[ 127001 &5 B | € Administrator | [ Licensed to: demo @ Active~

¢ In the Dispatcher Presence Control dialog box, specify the following options:

Dispatcher Presence Control >

Presence timeout 0 minutes

Reminder time 30 seconds

(@) Al Dispatchers
() Selected Dispatchers

Notifications

0K Cancel

Presence timeout
Enter the time period, in minutes, that will be used as a timeout to check for
the presence of dispatchers.

Reminder time

Enter the time period, in seconds, that will be used to show a reminder
pop-up dialog before the planned time of performing the check. When the
reminder appears on top of the screen, the dispatcher must click the round
button in the center to confirm their presence in the system.

All Dispatchers
Choose this option button so that all dispatchers will be checked for
presence.

Selected Dispatchers
Choose this option button so that only selected dispatchers will be checked
for presence.

¢ Dispatchers
In the drop-down list, select the dispatchers.

Notifications

Click this link to select who will receive the appropriate notifications. The
recipients may include dispatchers, Email groups, SMS groups, radios, and
radio groups.
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6.4.5.2 Agenda

The Agenda is used to automatically send predefined messages to the radios. It may
be used when you have any software receiving any messages but it is not able to
send them to the subscribers. In this case, TRBOnet Dispatch Console acts as an
intermediary for receiving the messages from the folder and sending them to radios.

e To add an agenda, select Tasks (1), and click Add > Agenda (2).

File View Map Tools

Administration

[ server
[ License
(J Database
154 Radio Systems
2 System Bridging
hon,

Sy
Telephony

(%] swift Event Profiles

Help

-

Tasks

gEe

((Jrivetecal B[]}
5 Add[~ 5 Edit | 5k Delete

%4 Lone Worker
7 Export Data
() Scheduled Task

(il voice Dispatch

@ Voice Message

@ Location Tracking

@ Hotsos

ﬁn Tt

) Timer
% Missed GPS data loading

T—

(1" Sign-in notification

(D) e rcker

e 5 Timer
vl g User Activity

[] Text Messages

¥ ) voice Message
¥ ) Voice Message

ﬁ Voice Recording

Event Viewer

2 st

| | 4| Record 10f 13 k[ w|m] <

P intercom [0][=] 5 1: Line free [4] [Jancal [n][«]
P crow 10 [=1](+][@] I ¥ Group 20 [1][«][@] S ¥ Group 20 [][«d[@]

[@ 127001 & @ | 8 Administrator | [ Licensed to: demo Demo License

@ Active~

¢ In the Agenda dialog box, specify the following parameters.

154

Agenda

Task name:

Settings

Outgoing folder

X

|Agenda

(on server):

|C.\0|.rlguir|g

Incoming folder

(on server):

|C:\Incoming

Wait for response(sec):

Text to corfim:

Cancel

Task name

Specify a name for the task.

Outgoing folder (on server)
Specify the outgoing folder for the text messages to be displayed in the
Dispatch Console (for example, C:\Outgoing).

Incoming folder (on server)
Specify the incoming folder for the reports (for example, C:\Incoming

files);

Wait for response
Specify the time interval, in seconds, for the response.
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Specify the text to be sent by the subscribers after they receive the

message.

6.4.5.3 Recorder

The Recorder feature allows connecting to an audio recorder via IP.

e To enable the task, select Tasks, and click Add (1) > Recorder (2):

File View Map Tools Help

Administration a

3 System Bridging ~
P Telephony
Virtual Modbus Devices

3 1: Line free [«][@] B I intercom [2][«][@]
All Call [][=] Group 20 "
3 Group 22 [ private cal [21][«][@]

E Add |~ b Edit | [ Delete

4 Lone Worker
5 ExportData
() Scheduled Task
 Voice Message
=

& Agenda

[ Import Routes

() Scheduled Report

@ Hotsos

) Timer

Z. Automatic Data Retrieval (Swift GPS)

[3% Sign-in netification

3 Group 10
2 Group 11

1D
[[«][2]
[[][2]

& Import beacon data fromaB “Firchird"

{5 Event Viewer

e

14|44 4| Record 1of7 v w4

(127001 &3 & | § Administrator |

The feature allows replicating audio recordings to the recorder:

[F4 Licensed to: demo

Settings
IP:
Port:

Audio Recorder

X

Task name: |.l\ud|c Recorder

[10.10.163.121

3054 2

Test of Channels

Cancel

e Task name

Specify a name for the task.

e IP
Enter the recorder's IP

e Port
Specify the recorder's

address.

port number.

| @ Active-

e Click Test of channels to view all available channels on the recorder.
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e Click OK to add the task.
6.4.5.4 Import Beacon Data from Firebird DB

The Import beacon data from Firebird DB option allows importing beacon data
from Firebird database to TRBOnet Dispatch Software database.

To enable the task, select Tasks, and click Add (1) > Import beacon data from DB
"Firebird” (2):

File View Map Tools Help

: AE
i ? ""’ * | B 1: Line e Intercam
8% Virtual Madbus Devices P Group 10 [0][«][@] Allcall
N (- ZTEENn) (<
A ¥ Group 22 [ Private Cal [1][«]@]
il Voice Dispatch Add |- ) Edit |k Delete

"5 Lone Worker A

Location Tracking / 5 Export Data

/ (<) Scheduled Task
W Job Ticketing. 1

€ Voice Message

& Agenda
Route Hanagement ﬂ Impert beacon data from DB "Firebird"

; ~ Import Routes

@ o races ) Scheduled Report
@ Hotsos

[ Text Messages ) Timer

=, Automatic Data Retrieval (Swift GPS) 2
ﬁ' Voice Recording [3" Sign-in notification
() Reports
{5 Event viewer
9} Radio Allocation
= v
4| 4| «|Record 10F7 ¥ m|m[ 4] »
127001 &3 &, | § Administrator | [ Licensed to: demo | © active~
Import beacon data from DB "Firebird" X
Name: Import beacon data from DB “Firebird"|
Settings | Import
Server: User:
|\ocalhcsl | |5YSDBﬂ |
Database path: Password:
| [resensess |
Part: Update {sec):
3050 $ 10 o
Test
Cancel

¢ Name
Specify a name for the task.

e Server
Specify a remote server or a server on the local PC.

o User
Type in a name of the Firebird DB user.

e Database path
Specify the Firebird DB path.

e Password
Specify a password to connect to Firebird DB (provided at logon).
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Port
Specify the port number to connect to Firebird DB.

Update (sec.)
Specify the update period for Firebird DB.

Click Test to test the connection to Firebird DB.
Click the Import tab to specify Import settings:

Import beacon data from DB "Firebird” s

MName: Import beacon data from DB "Firebird"

Seftings  Import

Import data from:
| <The Dldest Date Possible> ﬂ Import

Delete old data

Report:

Cacsl

Import data from
Specify the Firebird DB name.

Click Import to import data.

Delete old data
Select this option to delete all previously imported data from Firebird DB.

Report
In this box, an import report will be displayed.

Click OK to add the task.

6.4.5.5 Import Phone Addresses

The Import Phone Addresses option allows importing phone/address data from a
NENA database to TRBOnet database.

To perform this task:

6.4.5.6

Select Tasks, and click Add > Import Phone Addresses (NENA)

In the Import Phone Addresses (NENA) dialog box, browse for the
corresponding *.CSV file, and click OK.

Export Data

TRBOnet Dispatch Console provides the Export Data function, which allows
exporting data to an external database table.

e To add an Export Data task, select Tasks (1), and click Add > Export Data (2):
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File View Map Tools Help

Administration a (150
g feih * | I G ntercom @] WG 1: e ree e M Jaca @]
3 Database Mcow 0 ooE (VErE pEE (ErE D]
154 Radio Systems
i System Bridoing 1 [Jerivate cal [2]=[@]
@ 154 Add |- =) Edit | S Delete
242 Virtual Modbus Devices % Lone Worker a
{58, Event/Alarm Management
(%] swift Event Profiles v || &) Scheduled Task
@ Voice Message
{1l voice Dispatch & Agends
" Import Routes
@ Location Tracking () Scheduled Report 2
@ Hotsos
&F 30b Ticketing ) Timer
“ Missed GPS data loading
Route Management (5% Sign-in notification
- 2 43 Timer
@ R Ry i G user Actvity
vl @} voice Message
[ ] Text Messages ¥l @} voice Message
ﬁ Voice Recording
)] Event Viewe:
3] Radio Allocation
p—
it 4| 4] Record 10F 14 b m|m| 4| »
(127001 g3 By | & Administrtor | (28 Licensed to: demo Demo License | © Active-

¢ In the Export Data dialog box, specify the following parameters:

Export Data x
Task name: Export to database table - Location of radio |
Type: Export to database table j
Data: Location of radio j

Connection  Data  Scheduler Advanced

Server name |Gocal)\sQLEXPRESS
Database name Imaonet j
¥ Windows authentication

User name I

User password I

Cancel

Connection tab

e Task name
Specify a name for the task.

e Type
Select the type of data export from the drop-down list. TRBOnet Dispatch
Console allows exporting data for third-party systems using data export tasks.

Export to database table
Allows exporting data to MS SQL Server tables. Specify MS SQL Server
connection parameters, database, and table to export data.

Export to Versatrans
Allows exporting data to the Versatrans data collection system via IP. For
more details, visit the official website of Versatrans.

Export to Google
Allows exporting data to file (file format is KML). For more details, visit the
following website.
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= Export to NMEA
Allows exporting data to a file (text file format, export format is NMEA
0183). For more details, visit the following website.

= Export to file
Allows exporting data to a text file.

e Data
Select which data to export from the drop-down list.

¢ Default connection
Choose this option for default connection to SQL Server.

e Specified connection
Choose this option and specify the SQL Server and database name.

e Server name
Specify the SQL server name.

e Database name
Select the database from the drop-down list.

¢ Windows authentication
Select this option to use Windows authentication, or unselect it to use SQL
Server authentication (SQL Server user name and password will be required).

Data tab
Export Data x
Task name: |Export to database table - Location of radio |
Type: |Export to database table j
Data: |L0cah‘0n of radio j
Connection Data  Scheduler Advanced
Table: [Export_Locations]
Create table  Load columns list
Column mapping:
Table column Data
Date Location date -
Latitude Latitude
Longitude Longitude
Speed Speed
Direction Direction
Predision Accuracy
RardinTn Radin TN h
oK Cancel
e Table

the name of the table to be exported into external database (by default, the
name of the table is created after you have specified it in Create table dialog
box).

e Click the Load columns list link to update the columns list in case you have
made any changes to the table.

e C(lick the Create table link to add a new table for data export:
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Create table

Create new table to export data
Active database connection

Table name: Export_Locations
Column list:

Table column Data
v Date Location date
| Latitude Latitude
| Longitude Longitude
v| Speed Speed
| Direction Direction
| Predsion Accuracy
w| RadiolD Radio ID
v ID Unique radio ID
v Name Radio name
L4

ExportDate Export date

-

Cancel

= Select the data fields to add to the table.

Scheduler tab

e Days of week

In the drop-down list, select the days of the week on which to export the data.

Export Data

Task name:

|Expurt to database table - Location of radio

Type:

|Export to database table

Data:

Connection Data

|Location of radio

Scheduler  Advanced

Days of week: | (all days) j
gi=
Start time: m
Stop time: m
Repeat every: m
" Execute at particular time
Cancel

Ll

e Execute recurrently with interval

Choose this option to perform data export on a periodic basis.

= Start time

Specify the time at which to start data export.

= Stop time

Specify the time at which to stop data export.

= Repeat every

Specify a time period for periodic data exports.

¢ Execute at particular time
Choose this option and specify the times in the columns of the table below.
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Advanced tab

Export Data x

Task name: Export to database table - Location of radio |

Type: Export to database table

Ll

Data: Location of radio

Connection Data  Scheduler Advanced

Export only changed data

Export mode
(® Always add new records
() Update existing and add new records
(0) Update existing records

Cancel

e Export only changed data
Select this option to export only changed location of the radio data.

e Export mode
Choose the mode for exporting data.
6.4.5.7 Geofencing

The Geofencing feature allows controlling the location and speed of radios relative
to manually defined regions on the map.

The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply
the rules for the regions and radios.

e Click Tasks (1), and double-click Geofencing (2) in the Tasks pane.

File View Map Tools Help

Administration a (150
B e " | EZinzeon Dl[<ie] G 1= tne free oE) (W] Bl
(1 Database M crow 10 [](<][@] B ¥ Group 20 [][][@] 8 I Group 30 [][«[@]
154 Radio Systems
& System Bridaing 1 [private cal [2][=]
5 Add ~ b Edit | [k Delete
& o Task Name a
4_;55 tJA\ m Management [ & Agenda
(8] swift Event Profiles v || ] @ Dispatcher Presence Control
[ 435 Export to SWD - Location of radio
!l Voice Dispatch ¥ (i Geofenciy
vl <3 1dle Time
@ Location Tracking ¥l G Lone Worker 1
V) (5] Mesages 1 Messages for period 2.
@ Job Ticketing E
Route Management W Ghavs
- vl 5 Timer
) o Trecker K2 v sy
vl @} voice Message
e ¥l @ Voice Message
ﬂ Voice Recording
Event Viewer
apr—
1] 4] 4| Record4of 14 » | w|mi[ 4] »
[@127.001 &3 & | @ Administrator | [ Licensed to: demo Demo License | @ Active-

The administrator can add/disable/delete the rules for Geofencing as well as edit

the currently selected rules:
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Geofencing and Speed Control x

[ [General | Location] Speed] Regions| Rados| Lone Worker |
Wl Monitor Area 1

vl Monitor Area 3 \ Spedfy the general parameters of the rule and the tme window when itis active

Mame: [monitor area s J

4 Desaription: | Watch out for the workers

Activate the rule on a schedule:

Days of week: [Monday, Tuesday, Wednesday, Thursdsy, ... ]

Start time: 2:00 E|:
Stop time: 18:00 E|:

After the rule is triggered:
Reset Alarm mode when the rule conditions are no longer met

1

[renun the m\eyﬁer each rule edit, server res}ﬁ and at the start nfea/ scheduied tme window (ot recommended) (1)

7 7 7
[ addmue  [+][ osabierue * || peketeruc ¥ | Cancel

e Click the Add Rule button (1) and select the appropriate rule from the drop-
down list (Map Region, Beacons, Radios, Lone Worker) to add a rule to the
current Geofencing configuration. A new rule will be displayed in the list of
rules (4).

e C(lick the Disable rule button (2) to disable the selected rule.

e Click the Delete rule button (3) to delete the selected rule.
General tab

e Name
Specify the rule name.

e Description
Add a description of the rule.
¢ Run the rule on a schedule

Select this option and in the boxes below specify the schedule for the rule to
run.

= Days of week
In the drop-down list, select the days of the week on which to run the
Geofencing rule.

= Start time
Specify the start time to run the rule.

= Stop time
Set the time to stop running the rule.

¢ Reset Alarm mode when the rule conditions are no longer met
Select this option to reset Alarm mode after the rule is triggered.
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Location tab

Geofencing and Speed Control be

I | General[ tocaton | spesd| Regions| Radios| Lone worter|

| Moritor Area 1

¥l Monitor Area 3 Define the sul itioning conditions which wil trigger the rule and
s executed

Trigger this rule when 2 subscriber.
[] Enters the selected regions
Leaves the selected regions

For multiple nested/overlapping regions:
(@ Crosses outer border only

() Crosses any border

Perform the folloning actions:
Activate Alarm mode
[ Activate Lone Worker mode.
[[] Send Text Message to the so
[] send netification
Recpients
Send Request To Tak to the s

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (not recommended) (1)

[_addrie  [~][  osabkrie [ beketerie ok [ caneel ]

Trigger this rule when a subscriber:

e Enters the selected regions
Select this option so that the rule will be triggered as soon as a subscriber
enters the selected region.

e Leaves the selected regions
Select this option so that the rule will be triggered as soon as a subscriber
leaves the selected region.

For multiple nested/overlapping regions

Choose one of the options specifying for multiple regions whether to consider
only outer border of the group of regions, or any border of a region within the
group.

Perform the following actions:

Here you specify which actions to execute when the rule is triggered.

e Activate Alarm mode
Select this option to activate an Alarm mode in the Dispatch Console.

e Activate Lone Worker mode
Select this option to automatically activate a Lone Worker mode for the radio
in case of entering or leaving the selected region.

¢ Send Text Message to the source radio
Select this option to automatically send a text message to the radio when it
enters or leaves the selected region.

¢ Send notification
Select this option to send a notification when the radio enters or leaves the
selected region. Click the Recipients link and specify the recipients to send the
notification to.

¢ Send Request to Talk to the source radio
Select this option to automatically send a Request-to-Talk to the radio when it
enters or leaves the selected region.
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Speed tab

Geofencing and Speed Control X

[ [ General] Location| Speed | Regions| Raios| Lone Worker]
vl Monitor Area 1

vl Moritor Area 3. fon atirbutes which wil trigger the rule and choose specific actions
ecuted

Trigger this rule when a subscriber’

Moves faster than: 50 % kmh

[ Moves slower than: 10 HE
30 - | seconds
[Everywhere -

Perform the following actions:
Activate Alarm mode
[[] Send Text Message to the source radio
[ Send Call Alert to the source radio

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

]

[ AddRue DiscbleRue || DeleteRue

Trigger the rule when a subscriber:

¢ Moves faster than
Select this option and specify the maximum allowed speed for the vehicles.
The rule will be triggered when the vehicle with the radio exceeds this speed
limit.
¢ Moves slower than
Select this option and specify the minimum allowed speed for the vehicles. The
rule will be triggered when the vehicle with the radio drops below the
specified speed.
¢ Stands still for longer than
Select this option and specify the time period, in seconds, during which the
vehicle is allowed to stand still. The rule will be triggered when the vehicle with
the radio stands still for longer than this specified time period.
e Track speed in relation to regions
From the drop-down list, select where to track the speed of the vehicles: inside
or outside the selected regions, or independently of the regions.
Regions tab
Geofencing and Speed Centrol x
-EMEF Generall, Locaton| Speed] Regions | Radios] Lone Worker|
- :Z:::: ::: 32 SOE\E;; :;:gsmns where this rule can be triggered
@ Only selected regions
O My zone
O Route 1
O Route 2
[¥] Zone 2
[JRerun the rules after each rule edt, server restart and at the start of each scheduled time windaw (notrecommended) (1)
[ addrue  [-][ oiblerue || eleterue
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¢ All regions

Choose this option to apply this rule for all regions.

e Only selected regions
Choose this option to apply the rule for one or several regions.

e Select all

Click this button to select all regions in the list.

e Clear all

Click this button to unselect all regions in the list.

Radios tab

e All radios

Geofencing and Speed Cantrol

| Monitor Area 1
¥l Monitor Area 3.

Radios | Lone Worker|

General| Location| Speed| Regions

Select radios the ruie is appied for:
O Alradios

@® Only selected radios

|

1= B3 Firemen
1@ 125 (Pete) 125
@) 235 (Basi) 235
[ Police
[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)
[ _addrue  [-][  oisblerue  |[  Deleterue Cancel

Choose this option to apply this rule for all radios.

e Only selected radios
Choose this option to apply the rule for one or several radios.

e Selectall (1)

Click this button to select all radios in the list.

e Clearall (2)

Click this button to unselect all radios in the list.

e Collapse all (3)
Click this button to collapse the view of radios in the list.

e Expand all (4)

Click this button to expand the view of radios in the list.

-

3.
EH

©)
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Click this button, and from the drop-down menu, select which list to display:
Radio List, Radio Groups, or Logical Groups.
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Geofencing and Speed Control X
General| Location| Speed| Regions| Radios| Lone Worker
¥l Monitor Area 1
vl Moritor Area 3. Select the tasks to be executed when the rule s triggered
Q) Altasks
@) Only selected tasks
Lone Workers ’
] Lone Warker
e
[JRerun the ruies after each rule edit, server restart and at the start of each scheduled time window (not recommendad) (1)
I [ o e ]
e All Tasks

Choose this option to execute all Lone Worker tasks configured by the
administrator when the rule has been triggered.

¢ Only selected tasks
Choose this option, and in the list below, select the Lone Worker tasks to be
executed when the rule has been triggered.

Variable settings for Geofencing rules of event types (Map Region, Beacons, Radios
and Lone Worker) are represented in the table below:

Event type Tab Name Parameters Description

Common Settings General Name - specify the rule name;

Description — add the rule description;

Scheduler Run the rule on a schedule - select to start a scheduler
for Geofencing rules;

Days of week - select the days of the week on which to
activate the Geofencing rule;

Start time - set the time at which to start the rule;

Stop time - set the time at which to stop the rule.

Radios All radios — choose to apply this rule for all radios;

Only selected radios — choose to apply the rule for one
or several radios;

Select all - click to select all radios in the list;

Clear all - click to unselect all radios in the list.
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Event type ‘ Tab Name Parameters Description
Map Region. General Regions Control — select to enable regions control;
Allows configuring Control mode - select the control mode for regions in
rules when a the dropdown list;

radio(s) enters or
leaves the defined
map region(s).

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Regions Control rule has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Regions
Control rule has been triggered;

Activate Lone Worker if the rule has been triggered -

allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving exact region on map.

Select to enable this option.

Speed and Idle Control - select to enable speed and
idle control;

Control mode - select the control mode for speed and
idle control in the dropdown list;

Maximum Speed - set the maximum speed for radio;

Maximum Idle Time - set the maximum idle time for
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Speed and Idle Control rule has been triggered

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Speed
and Idle Control rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Reset Alarm mode if the rule is not triggered - select
to inform radio subscriber if the rule has not been

triggered.
Scheduler See above.
Regions. All regions — choose to apply this rule for all regions;
Select regions Only selected regions — choose to apply the rule for one

to apply the rule | or several regions;
Select all — click to select all regions in the list;

Clear all - click to unselect all regions in the list.

Radios See above.

Lone Worker. All Tasks — choose to apply all tasks configured by the
Enables Lone administrator when the rule has been triggered;

Worker when Only selected tasks — choose this option, and in the list
the rule has below, select the Lone Worker tasks to be executed when

been triggered the rule has been triggered.
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Event type

Beacons.

Allows configuring
rules when a radio
(s) enters or leaves
the beacon
coverage zone

‘ Tab Name

General

Parameters Description

Control mode:

Control entering beacon coverage zone - select to
enable the rule when a radio enters beacon coverage
zone;

Control leaving beacon coverage zone - select to
enable the rule when a radio leaves beacon coverage
zone;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Beacons rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control entering beacon coverage zone
is selected and the radio enters the monitored coverage
zone and then instantly leaves the zone, the alarm mode
in the Dispatch Console will be reset automatically)

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Beacons
rule has been triggered;

Activate Lone Worker if the rule has been triggered -
allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving beacon coverage
zone. Select to enable this option.

Scheduler

See above.

Radios

See above.

Beacons.

Enables the rule
for selected
beacons

All Beacons — choose to apply this rule for all beacons;

Only selected beacons — choose to apply the rule for
one or several beacons.

Lone Worker

See above.
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Event type

Radios.

Allows using
radio(s)1 as a map
region and monitor
when another
radio(s) enters or
leaves radio’s
coverage zone

‘ Tab Name

General

Parameters Description

Control mode:

Control Entering Region — select to enable the rule
when a radio enters the coverage zone associated with
another radio;

Control Leaving Region - select to enable the rule when
a radio leaves the coverage zone associated with another
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Radios rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control Entering Region is selected and
radio enters to the monitored coverage zone and then
instantly leaves the zone, alarm mode in the Dispatch
Console will be reset automatically)

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Radios
rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Minimum distance between radios - specify the
distance, in meters. When a distance is less than the
selected value, the rule will be triggered according to the
settings above.

Color of region — select the radio coverage zone color.

Scheduler

See above.

Regions

Select radio coverage zones the rule is applied for.

Radios

See above.

Lone Worker.

Allows configuring
scheduled Lone
Worker tasks

General

Days of week - select the days to activate the Lone
Worker rule;

Start time - set the time to start the rule;

Stop time - set the time to stop the rule.

Radios

See above.

Lone Worker

Select all configured by Administrator Lone Worker tasks
or several configured tasks.

When a Lone Worker task is mentioned as Disabled, the
administrator should enable the task.

Idle Time

The Idle Time feature allows monitoring vehicles idle time assigning Telemetry
Commands on selected VIOs.

e Click Tasks (1), and double-click Idle Time (2) in the Tasks pane.
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Administration a &)
i ;‘ﬁ;ﬁnsa 2 P intercom 5 1: Line free [<](@] (Al cal [][«d[@]
(3 Dotobase Mcow o VEXE) ] I B crop 20 e
154 Radio Systems
& System Bridging [Jerivate cal
@/TE‘ED'“’"" 5 Add ~ 5 Edit | [k Delete
@ Tasks — 1
542 Virtual Modbus Devices jiacktiane,
{58} Eventfalarm Management L) & Agenda
(%] swift Event Profiles v || ] @ Dispatcher Presence Control
[ §5% Export to SWD - Location of radio
!l Voice Dispatch ¥ (1 Geofencing
¥l 45 Tdle Time,
@ Location Tracking vl G, Lone Worker T
v (] Mesages 1_Messages riod
W Job Ticketing ¥l °Z, Missed GPS data loading 2
vl §5% Radio Allocation (Sprite Forms)
g otz Banagement v 5 SMS and Email notifications
& ) Timer
) RFID Tracker vl 2 User Activity
vl @} voice Message
[ Text tessages ¥l @ Voice Message
ﬁ Voice Recording
1| Event Viewer
3] Radio Allocation
. e
] 4] 4| Record 50F 14 » | wr[mi[ 4]
(127001 g3 By | & Administrtor | (28 Licensed to: demo Demo License | © Active-
Idle Time x
Start VIO: = Command: IHigh -
Stop VIO: I 13: Command: IHigh -

Start

File View Map Tools Help

|

e Specify the telemetry VIO and Command to start the Idle Time.

Stop

e Specify the telemetry VIO and Command to stop the Idle Time.

The administrator can see Idle Time reports and statistics.

Click Reports (1), and under GPS reports, click Idle Time Summary or Idle Time

detailed (2) to see a common Idle Time report:
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File View Mop Tools Help

[F) &P reports
£.T%) Location for Period
{15 Location on Date
[ staysin Region

75 Drive Actvity Details 2
1T Drive Activity Summay

[} Speed for Period

%) 1die Time SummdFy

{15 1de Tme Detals

~

GPS reports

73 1: Line free

[ Jsales

2]
= =

[
2
3
3
i
g
2
g
]

[Jaical
[Jerow 1

{1245 voice Dispatch

meimtiu

W Job Ticketing

nnn:r‘lanagunﬂn

[] Text Messages

ﬂ!ﬁ'uﬂ:mnﬁlg

Idle Time Summary

—Hot defined— -

saved Profiles:

Select data by period:

StartDate: [seimr oo <] [
End Date: [axmmdaes ] [
Filter:

Rt P
Logical Group: ,W;'

Radio ID (e.0. 22,33,40-55,88):

ey

IEI,, "

Speed: 15 kmh
™~ ~3

Generate Report save Report Profile Delete Report Profile

[ Connected &3 B B | | Administrator | [ Licensed to: demo Demo License

| @ Active -

Note: Specify the speed accuracy value in the Speed box (3).
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6.4.5.9 Lone Worker

The Lone Worker policy lets the dispatcher set a time interval the communication
with a subscriber is expected. For example, if a lone worker has not called the
dispatcher for 15 minutes, the radio receives a message and the Dispatcher receives

an alarm signal.

e To add a Lone Worker task, select Tasks (1), and click Add > Lone Worker (2).

File View Map Tools Help

Administration a & <)
(0 Database A .
L Ragio Systems P intercom [=2][«][@] Bl & 1: Line free [+](@] [ Jarcan [2][«d[e]
i3 System Bridging Mcrow 10 (<[] N ¥ crewn 20 [][s:][@] | ¥ Growp 20 [1[](@]
Jegh
? e . et oot o
Virtual Modbus Devices
Add |~ 5 Edit | [, Del
{55 Event/Alam Management B Add]- 3 et | B Deere
(6] Suift Fuent Profies v |[ 2,
h Export Data
(1) voice Dispatch (%) Scheduled Task
@ VoiceMessage
@ Lecation Tracking &l Agenda
_" Import Routes
& 3o0b Ticketing () Scheduled Report
@ Hotsos 2
Route Management ) Timer
% Missed GPS data loading
@ P - " Sign-in notification
vl <3 Timer
[ vextmessages ¥ & vser Acavy
¥l @) voice Message
g aice Recankag ¥l @} voice Message
@ Reports.
Event Viewer
E Administration
1]« 4| Record50f 14 » | w|mi[ 4] >
(127001 g5 | @ Administrtor | (8 Licensed to: demo Demo License | © Active-

In the Lone Worker dialog box that appears, specify the following parameters:

Lone Worker

Task name:

X

Lone Worker 1

Task Start  Conditions  Task Stop

] Manually by dispatcher
Automatically by receiving Text Message from a radio

Message: Start

Automatically by receiving Telemetry Command from a radio
VIC: 1 3
[ Automatically by receiving DTMF command from a radio

Command:

IAny event vl

Message:

e

[] Automatically by receiving Status from a radio

0 >

Send the following text message to the radio

Cancel

Task Start tab
¢ Manually by dispatcher

Select this option to start the Lone Worker task manually by the dispatcher.
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Automatically by receiving Text Message from a radio

Select this option so that the Lone Worker task will start after receiving a
message from a radio. If you select this option, specify a text message in the
Message box.

Automatically by receiving Telemetry Command from a radio

Select this option so that the Lone Worker task will start after receiving a
telemetry command from a radio. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the Lone Worker task will start after receiving a
predefined DTMF command, for instance, #11#. If you select this option,
specify a DTMF combination without the # characters in the Command box.

Automatically by receiving Status from a radio
Select this option so that the Lone Worker task will start after receiving a
specified status from a radio. If you select this option, specify Status.

Send the following text message to the radio
Select this option and in the Message box enter the text message that will be
sent to the radio when a Lone Worker task is started for that radio.

Conditions tab

172

Lone Worker X

Task name: Lone Worker

Task Start Conditions  Task Stop

Response time 30 2| minutes

Send notification to radio

Reminder time &0 %| seconds

(®) Send Request To Talk
(O send Text Message

[] ResetLone Worker when receiving Text Message

[[] ResetLone Worker when receiving Telemetry command

1 > Any event b

[] ResetLone Worker when the distance has been traveled

=

[] Do not trigger alarm if radio is offiine for less than

Cancel

Response time
Specify the time period, in minutes, that determines how long TRBOnet Server
waits since the last radio transmission.

Send notification to radio

Select this option so that TRBOnet Server will send a notification to the radio
before raising the alarm if the radio has not transmitted for the specified time
period.
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= Reminder time
Specify the time period before it comes to raise the alarm, to send a
notification asking the radio to respond.

= Send Request to Talk
Choose this option to send a Request-to-Talk to the radio.

= Send Text Message
Choose this option to send a text message to the radio. Specify the
message text in the Message box.

¢ Reset Lone Worker when receiving Text Message
Select this option to reset the Lone Worker task after receiving the message
specified in the Message box.

¢ Reset Lone Worker when receiving Telemetry command
Select this option to reset the Lone Worker task after receiving the telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

e Reset Lone Worker when the distance has been traveled
Select this option to reset the Lone Worker task after the distance specified in
the Distance box has been traveled.

¢ Do not trigger alarm if radio is offline for less than
Select this option so that the alarm is not triggered if the radio is offline for a
time less than the time specified in the Interval box.

Task Stop tab

Lone Worker X

Task name: |Lune Worker 1

TaskStart Conditions Task Stop

Manually (on demand of dispatcher)
[ Automatically by receiving Text Message from a radio

[ automatically by receiving Telemetry Command from a radio

Automatically by receiving DTMF command from subscriber
Command: 123 #1237
[ Automatically by receive Status from subscriber

] send Text Message to a radio

Carcel

In the Task Stop tab, you can specify how to stop the Lone Worker task. The
available options are similar to those you specified on the Task Start tab.
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Enabling Lone Worker

e To enable the Lone Worker task for a selected radio, go to Voice Dispatch (1),
right-click the selected radio (2), and choose Start Lone Worker (3):

Recent CallsEvents.

Private Call
Send Call

Request Location
Advanced » EE"

4 Find on Google Earth

‘Show Route on Google Earth

Monitoring
Specify Custom Icons.
Set Radio Channel

Set On Duty

: Slot #1 0l < 1]

3] [Jintercom

["Reveater #1: Slot #2

ree channel

l
channel

Drag and Drop PTT Bex here to
aeate new group

Patch on Repeaters
ol « =] - R
e —

-y Print | 11 Pause <f Clear - '\ Reload | “[] Filter By Radio

ouping '/ Auto Filter ©» Default Settings )

Date |RadioSystem  sender | Recpient | Message Detais | ote |Ext.Note |
21:0ct-2016 17:56:27  Repeater #1: Slo... Adminstra... Police Dispatcher ‘Adminitr... Members: Admisr... .
210ct2016 17:56:27  Repeater #1: So.... Adminstra... Poice Dispatcher ‘Adminstr... Members: Adminisr
2402016 17:56:23  Repeater #1: Slo... Administa... Al Al Call from depatch,.. Members: Adrinistr...
21-0ct-2016 17:56:17  Repeater #1:Slo.. 125 Al Al call from '125' {00... Members: 125
210ct 2016 17:56:14  Repeater #1: Sio... 235 A Al Callfrom 235' (00.... Members: 235

HAAINA TR Bonmaer 2190 776 o Bl from 35 (01 Merhre: 775 i
W 4[] Record ot 53 O Imimi<] f
et CalifEvents | RecentCale | Rado Sie ] AciveTagal]] I T I

(6127001 g5 B @ | § Administrator | [ Licensed to; demo Demo License | © Active-

e To monitor the Lone Worker task, click the Active Tasks tab:

Recent Calls Events.

e
To: Selected Channels

Drag and Drop PTT Box here to
create new group

Patch on Repeaters
Binary Patch

Enabling Lone Worker from Geofencing

1 Stop | = Grouping 7 AutoFilter ©» Defautt Settings
Task |Radio state
Lone Worker 1 125 {Pete) 125 16:55 17:25
| «|Record 1of 1 v || ¢ Bl
] I — T [ T =

127001 55 B By | & Adminisrator | (28 Licensed to: demo Deme License | © Aciive

e Click Location Tracking (1), and click the Geofencing button (2) in the Map

pane:
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Location Tracking

3 i Line free

Intercom

[[«][e]

[ Grow 10

L[]

Alcal

[[][e]

Group 20

[[+][e]
/My Map X][ Fioor plan_X|

Group 11

[][«][e]

¥ Growp 22

[][«][e]

Private Cal

[][«][e]
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=l

- [ Beacons

1 @ Beer

2,
%
L

W Job Ticketing “LO
g Route Management

) Re1D Tracker

[ RE— 1L S

g T Recent Calls /Events

X
sk, <+ Fiter | @[B[Q[B] 7 [8] showBeacons: a1

64.

Hospital

5 Playback |l Sove - () Print | 11 Pause < Clear ~ (& Reload | [} Filter By Radio | = Grouping 1/ Auto Filter (> Default Settings || Details | [ Show Notes [ Add Note | [3t Add Message ‘

0 Ruler (4 FindonMap< 4 7 Drowing Panel 7| Route| @ Geofencing] 2
o

1@ coffee
W@ Tea
¥ [ Map Objects.

(91[@] Camera 1

- [ Map Regions

o/ T

-7 [/ Map Routes

Wge 111

CB Reports Date Radio System
S 09.06.2017 14:43:57

{5 event viewer 09.06.2017 12:4%:30  Capacity Pus 1

- 09.06.2017 12:40:06  Capacity Pus 1
09.06.201712:39:55  Capacity Plus 1

09.06,2017 12:38:34  Capadity Plus 1.
W] 4[ <] Record1of305 b ||| <

Sender
Server
Admiristrator
125
Admiristrator
Adniristrator

Recipient Message
Al Connection to ‘Capacity Plus 1' has beenlost

1 Dispatcher ‘Administrator' calls group '11' (00:07)
11 Radio '125' calls group '11' (00:08)

11 Dispatcher ‘Administrator” calls group '11' {00:05)
Police Dispatcher Administrator’cals aroup Poice’ (01:00)

Recent Cals/Events | Recent Calls | RequestToTak | Radio State | ActiveTasks | ActiveRoutes | User Activity | Beacons | Beacon Events | Taglist

Details

Members: Adninistrator, 125
Members: 125

Members: Admiristrator
Members: Adniristrator

127001 & ﬂ,‘ § Administrator ‘ [ Licensed to: demo.

¢ In the Geofencing and Speed Control dialog box, click

Add Rule > Lone Wor

B TREOnet Enterprise 5.1 / Dispatch Console

File View Map Tools Help

ker (1):

| © active-

GPS Positioning
B £

Geofencing and Speed C

| W moritor Area 1

vl Moritor Area 3

=] online, GPS
@ Iv] Lone Worker 2

B GRS
B @®osE. 99

ontrol

‘General | Radios | Lone Worker|

Name:

1

/

Description:

Days of week:
Start time:

Stop time:

[Lone worker 2 |

Department 1

IMunday, Wednesday

o0 =]
0:00 3:

[IRerun the rules after afm rule edit, server restart and at the start of each scheduled tme window (not recommended) (1)

“Add Rue v\,

Disable Rule

Delete Rule

[ ===

<7 Map Region
w I

&+ ¥ [Z Beacons
L @@ seer
¥ @ Coffee
@ Tea
3+ [ Map Objects
(7] [ Abiding place
¥ [ Fre dep
(91 [] Hospital No2
i L &) police depar...
[=RE]=) Map Regions
@77 My zone
& C 4 [ Map Routes

3
) [¥] g Route 1

SR
Palsce

hiratteyskiy

18:40.14"E

Recent Calls | Radio State

["Active Tasks | Active Routes | User Activity | Beacons | Beacon Events | TagList |

lemo Demo License

| @ Active-

2 Mmnern () Beacons
@ g Radios ‘

Specify a Name for the Lone Worker rule and add a Description.

In the drop-down list, select the days of the week on which to activate the

Specify the time at which to start the rule.

= Days of week
Lone Worker rule.
= Start time

Stop time

Specify the time at which to stop the rule.

Click the Radios tab and add radios to which to apply the Lone Worker rule:
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Geofencing and Speed Control X

General[ Radios | Lone Worker |

| Moritor Area 1

¥l Moritor Area 3 Select radios the re is appled for:
vl <rule name > O Al radios

@ Only selected radios

[A@ 125 (pete) 125
1@ 235 @asi) 235

2la

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addRue  [v][  DscbleRue |  DeleteRue Cancel

= All radios
Choose to apply this rule to all radios.

= Only selected radios
Choose to apply the rule to one or several radios.

= Select all
Click to select all radios in the list.

= Clear all
Click to unselect all radios in the list.

e Click the Lone Worker tab and select the configured Lone Worker tasks:

Geofencing and Speed Control X

General| Location| Speed| Regions| Radios | Lone Worker

| Monitor Area 1

¥l Monitor Area 3. Select the tasks to be executed when the rule is triggered

O Altasks
(® Only selected tasks

Lone Workers
] Lene Worker

Select Al Deselect Al

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)

[ addrue  [-][ oiblerue || eleterue

= Choose either all configured Lone Worker tasks or several configured tasks.

Note: When a Lone Worker task is mentioned as Disabled, enable
it on the Tasks pane.

6.4.5.10 Radio Allocation (Sprite Forms)

This function is used for direct communication between the dispatcher and the
subscriber via special Tallysman Option board installed into the radio. The
dispatcher and subscriber have special form templates. The dispatcher receives Duty
ID of the subscriber with his template output form whereas the subscriber sends it
using his template input form. The radio name changes to its Duty ID.
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Note: Any activity may be decoded with its Duty ID so this is a
way to communicate for the dispatcher and subscribers

only.

e Click Tasks (1), and double-click Radio Allocation (Sprite Forms) (2) in the

Tasks pane.

File View Map Tools Help

- SEE
g el - e (5 1s ine iee T mEE Pl
(1) Database Group 10 Group 20 [][] Group 30 []
A Chmect L]
@,TE‘ED"V 5 Add - 5 Edit | [k Delete
@ Tasks
5% Virtuzl Modbus Devices v laciliape TS
1§ Agends
1=} Voice Dispatch [1 % Dispatcher Presence Control
[ {53 Export to SWD - Location of radio
Location Tracking vl [if Geofendng
¥ 55 1dle Tme:
@ Job Ticketing vl G Lone worker 1
¥l (5] Mesages 1_Messages for Period
Route Management vl “2, Missed GPS data loading
. vl ¢5% Radio Allocation fSprite Forms)
@ RFID Tracker (1 (] Scheduled Report 1™Mgssages for Period
vl 554 sMs and Email notifications’
[ ] Text Messages ¥l 5 Timer
Wl User Activity 2
ﬁ Voice Recording ¥l @ voice Message
- vl @ Voice Message
‘Event Viewer
Fp—
|« <] Record 9015 |w w4 ] »
127001 &8 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

e Load the Sprite Form (output template) and select the Field Name:

Radic Allocation (Sprite Forms) x

Form Description:

APP_VERSION1=0.14 -
IAPP_VERSION2-1

DATE_MODIFIED=12/12/2012 8:21:053.m,

FORMATTED=
0203000FB3BCOAFS02FBO04ESA20427573018000000106180500028768CEQF1
0FBOOF5025368696674206E756D62657235AD781E

IAS_ARRAY=002, (03, (00, B<OF, 0xB9, (xBC, Ox0A, OxF5, (02, OFB, Bc00, =
(Oc4E, Ox5A, (20, (xd2, (75, (73, B0, ¢80, (00, (c00, (e, (06, (18,
0x05, 000, 302, 0x87, (x68, BxCE, (xDF, Bx10, BxFEB, (00, OxF5, (x02, (53,
0x68, (69, (66, (74, (20, (6E, (75, (6D, (x62, (<65, k72, (35, (xAD,
0x78. I 1E

METADATA=0008000000000000

FORM_TITLE=NZ Bus
FORM_ID=2
FORM_REVISION=3

[Field Data #0]

Prompt="Shif number” -
Load

Field Name | shift number =]

e Click OK to add a Sprite Form.
6.4.5.11 Scheduled Task

This function allows sending scheduled messages to radios.
e To add a scheduled task, click Add (1) > Scheduled task (2):
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File View Map Tools Help

Administration a & |0
g e * | I ntercom ()@ G 1 e fiee T @EE Pl
gﬁ Database Flcon 10 ooR ETE ooE D Pllel
L Radio Systems
Jr System Erdging [ JPrivate Call [«]
@TE‘EW:”V// 1 b Add |+ =) Edit | Zk Delete
<, e 2 E
w A

=% Virtual Modbus Devices v || 4 LoneWorker

) Export Data
“ Voice Message
@ ‘Location Tracking 4 Agenda

" Import Routes

& 3ob Ticketing () Scheduled Report
@ Hotsos d
Route Management L) Timer

. Missed GPS data loading

@ RFID Tracker [2”. Sign-in notification

el 3 Timer
[] Text Messages ¥l {2 User Activity

vl @ Voice Message
Q Voice Recording ¥l @ voice Message
‘Event Viewer
. o

|| <] Record 10F 14w w4 ] »
127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

Scheduled Task s
Task name: IScheduIed Task

Command ~ Scheduler

Command: |Send Text Message Hid I

Mezsage: IAIarm

% Send to radio group

" 5end to subscribed radio
Recipient

[~ Firemen

Canel

= Task name
Specify a name for the task.

= Command
From the drop-down list, select what to send to selected radios.
Send Text Message

¢ Message
Enter the message text in this box.

Send Telemetry
Select this command to send scheduled telemetry commands to selected
radios/groups, or request telemetry states from selected radios/groups.

e VIO
Specify the VIO contact.

¢ Command
From the drop-down list, select the signal level at which to send the
telemetry command to selected radios/groups, or select 'Request state'
to receive telemetry states from selected radios/groups.
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Request Location
Select this command to receive location data from selected radios/groups.

= Send to radio group
Choose this option to send the specified command to selected radio
groups.

= Send to subscribed radio
Choose this option to send the specified command to selected radios.

= Recipient
In this list, select the radio groups/radios to send the specified command to,
or receive telemetry/location data from.

Send Voice Message
Select this command to send a voice message to selected radios/groups:

Scheduled Task X

Task name: |5|:heduled Task 1

Command  Scheduler

Command: |Send Voice Message j

|| Load from file
,ﬁrﬂ Record message
@) Playback message

Call Type Channel Call Target

Private Call Auto Detect 125
Group Call [i5h Repeater #1: Slot... Firemen
Intercom call Intercom All hd

ok Add 3 BRemove

[ Impolite channel access

Cancel

= Load from file
Click this link to load an existing file from your PC.

= Record Message
Click this link to record a new voice message.

= Play back message
Click this link to play back the voice message.

= Specify Call type, Channel, and Call Target for a voice message.
Note: To send a Voice Message to a subscriber from the phone

book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

= Impolite channel access
Select this option so that the voice message will be sent regardless of
whether the channel is busy or not.
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Scheduler tab

Scheduled Task X

Task name: |S|:heduled Task 1

Command Scheduler

Start date: |01 October 2016 ~|

Stop date: |13 October 2016 ~|

Days of week: |Munday, Tuesday, Wednesday, Thursday, Friday j

¥ Execute recurrently with interval

Start time: 15:00 3:
Stop time: 18:00 3:
Repeat every: 01:00:00 3:

" Execute at particular time

Cancel

e Start date
Select a date to start the task.

e Stop date
Select a date to stop the task.

o Days of week
In the drop-down list, select the days of the week on which to perform the
task.

e Execute recurrently with interval
Choose this option to perform the task on a periodic basis.

e Start time
Specify the time at which to start the task.

e Stop time
Specify the time at which to stop the task.

e Repeat every
Specify a time period for periodic task executions.

¢ Execute at particular time
Choose this option and specify the times in the columns of the table below.
6.4.5.12 SMS and Email Notifications
TRBOnet Dispatch Console allows managing text messages:

1. Send Text Messages from LAN to a particular radio or talk group (POP3
Server);

2. Forward all Text Messages from radios to base radio to particular email
address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and POP3
servers. For more details on SMTP or POP3 servers, ask your
System Administrator.

To enable the task, click Tasks (1), and double-click SMS and Email notifications
(2) in the Tasks pane.
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() Database
i Radio Systems

#fig# System Bridging

& Telephony

@ Tasks

=% Virtual Modbus Devices

Tasks € |
Intercom [0][<] 7 1: Line free [+] [Jarcal []
e Clx 2] I B crous 20 DEE (e Bllel

[ JPrivate Call [0][«]

=L Add ~ b Edit |
v Task Name r:y

¥ Delete

1=} Voice Dispatch

& Agenda
G Dispatcher Presence Control
55 Export to SWD - Location of radio

g Location Tracking

| (i Geofenang

@ Job Ticketing

Wl {3 Idle Time
vl G Lone Worker 1

m-neﬂammun

Wl (2] Mesages 1_Messages for Period
wl 72, Missed GPS data loading

@ RFID Tracker

| {3 Radio Alocation (Sprite Forms)
| [ SMS and Email notifications

[] Text Messages

@ & Tmer

'& Voice Recording

W @ Voice Message

Event Viewer

EE] Radio Allocation

Epe—

e[ 4| < |Record 100f 14 b | W | 4 b

127001 & & | § Ad

SMS settings tab

iministrator | [ Licensed to: demo Demo License @ Active~

SMS settings  Qutgoing Email settings (SMTP)  Incoming Email settings

Send SMS to recipients if ALARM has been activated
L1 5end MMs to recipients if ALARM has been activated

rd Text Messages to cell phone recients
put messages (from radionetwark to dispatchers)
Output messages (from dispatchers to radionetwork)

SMS Groups

Cancel

= Send SMS to recipients if ALARM has been activated

Select this option to send an SMS in case of an alarm on the radio.

= Send MMS to

recipients if ALARM has been activated

neocom
SsoOftware

Select this option to send an MMS in case of an alarm on the radio.

Forward Text Me

ssages to cell phone recipients

* Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to cell phones.

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to cell phones.

For more details on SMS settings, see section 5.15.2, Outgoing Mail Server (page 91).

A radio sends text messages to the base station. TRBOnet Server forwards all text
messages to a particular email address (for example, admin@yourcompany.com).
The administrator receives text messages from radios as regular emails.
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Outgoing Email settings (SMTP) tab

SMS and Email notifications. X
SMS settings  Outgoing Emal settings (SMTP)  Incoming Emal settings
Send Email to recients if ALARM has been activated

Forward Text Messages to email recpients
Input messages (from radienetwerk to dispatchers)
Output messages (from dispatchers to radionetwork)

Email Groups

= Send Email to recipients if ALARM has been activated
Select this option to send an Email in case of alarm.

Forward Text Messages to email recipients

* Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to Email address(es).

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to Email address(es).

Incoming Email settings tab

TRBOnet Server connects to POP3 server, reads emails and sends text messages to
radios or talk groups.

1. Create an email account on your email server.

2. Send an email to radioserver@yourcompany.com. In the Subject field, enter
Radio ID: XXX to send an email to a selected radio, or Group ID: XXX to send
an email to a selected radio group.

Note: If you don't properly specify the email Subject, or specified
a non-existing Radio ID, a corresponding notification will
appear in the Event Viewer of the Dispatch Console.

e Forward incoming emails to radio network (from email box to radios)
Select this option to forward incoming emails to radio network.
6.4.5.13 User Activity

The User Activity function allows the dispatcher to create lists of radios, to which
radios can be assigned due to their activity.

For example, if a subscriber sends an On duty message or presses an exact preset
telemetry button, this subscriber gets assigned to the On duty list in the Dispatch
Console. The dispatcher can also manually assign subscribers to lists.

e To enable the User Activity task, click Tasks (1), and double-click User Activity
(2) in the Tasks pane:
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Task Name

1=} Voice Dispatch

[ & Agends
[1 % Dispatcher Presence Control

[ {53 Export to SWD - Location of radio
vl [if Geofendng

[ 5 Ide Time
vl G Lane Worker 1

¥l (5] Mesages 1_Messages for Period
¥l 7=, Missed GPS data loading

vl % Radio Alocation (Sprite Forms)
¥l G5 SMS and Email notifications

bl 3 Timer

¥l {2 User Activity

vl @ Voice Message
I @ voice Message

[ «] < | Record 120f 14 v [ [ 4]

127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License

Lists of radios tab

User Activity X

Lists of radios ~ Advanced

‘ Name Description
@ off buty
@ onputy

@ User Activity = 1

Add [l Edt || peke |

e Click Add to add a list of radio activities:

User Activity List Settings X

General | ogical Groups

Name: [User actvity = 1 |
Description:
Background: |O Violet bl Il

Move a radio to this list if:

Manually {on demand of dispatcher)

[] automatically by receiving Text Message from a radio
Automatically by receiving Telemetry Command from a radio

Command: IHigh level 'l

[] automatically by receiving DTMF command from subscriber

e

[ automatically by receive Status from subscriber

VIO:

| @ Active~
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e Name
Specify a name for the user activity list.

e Description
Add a description for the user activity list.

e Background
Select the background color to display the radios assigned to the list.

Move a radio to this list if:

e Manually by dispatcher
Select this option to assign radios to the list manually.

e Automatically by receiving Text Message from a radio
Select this option to assign a radio to the list after receiving a text message
from the radio. If you select this option, specify a brief text message in the
Message box.

¢ Automatically by receiving Telemetry Command from a radio
Select this option to assign a radio to the list after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

e Automatically by receiving DTMF command from a radio
Select this option to assign a radio to the list after receiving a predefined
DTMF command, for instance, #11#. If you select this option, specify a DTMF
combination without the # characters in the Command box.

To assign offline radios to the default User Activity list, click the Advanced tab:

User Activity X
Lists of radios  Advanced
Automatically set the default status for offiine radios
Set the default status 10 2 minutes
Cancel

e Automatically set the default status for offline radios
Select this option to allow assigning the default status for offline radios.

e Timeout
Specify the time period, in minutes, after which the default status is set to a
radio.
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6.4.5.14 Voice Message

The Voice Message allows automatically broadcasting a predefined Voice Message
after receiving a telemetry command, a text message or a DTMF command.

e To add a Voice Message task, select Tasks (1), and click Add > Voice Message
(2).

File View Mep Tools Help

Administration a 8 [
g hetni * | I B ntercom [ B 1 e free oE @ Pl
(1) Database Group 10 [«][@] Group 20 [2][«][@] Group 30 [2][«][e]

ik Radio Systems

i System Bridging [JPrivate call <[]
& Telephony = )
B — 1 \%Add - 5 edit | [k Delete
=% Virtual Modbus Devices v || "8 LoneWorker 3
7 Export Data
1Y, Voice Dispatch © Scheduled Task
B cio
@ Location Tracking &l Agenda
* Import Routes
ﬁn Job Ticketing () Scheduled Report \
@ Hotsos " 2
Route Management L) Timer
%, Missed GPS data loading
@ e [", Sign-in notification
vl <3 Timer
[ ] Text Messages V] 2 User Activity
¥l @ voice Message
Q Voice Recording W @} Voice Message
Event Viewer
@ Administration
|« « | Record 120f 14 > [w <] »
127001 & B, | & Administrator | [8 Licensed to: dema Demo License | @ Active-

The user can have several Voice Message policies for different purposes. Specify a
name of the policy in the Task name box and set the policy's parameters.

Task Start tab

Voice Message x

Task name: Voice Message

Task Start  Task Process TaskStop Message Telemetry

Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

IHigh level - l

[ Automatically by receiving DTMF command from a radio
Automatically by receiving Emergency from a radio
Emg. Type: IAII j
() Activated by any radio
(®) Activated by spedific radios only
Radio: |125 (Pete), Walt =l

VIO: 1 +{ command:

Send the following text message to the radio

Message: | |

¢ Manually by dispatcher
Select this option to allow the dispatcher to manually start the Voice Message
task.

¢ Automatically by receiving Text Message from a radio
Select this option to start the Voice Message task after receiving a specified
text message from a radio. If you select this option, specify a brief text
message in the Message box.
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Automatically by receiving Telemetry Command from a radio

Select this option to start the Voice Message task after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to start the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Automatically by receiving Emergency from a radio
Select this option to start the Voice Message task after receiving an emergency
command from a radio.
= Emg. Type
From the drop-down list, select the type of emergency to be sent from a
radio.

Activated by any radio
Choose this option to expect receiving data from any radio in the system.

Activate by specific radios only
Choose this option to expect receiving data from selected radios.

= Radio
In the drop-down list, select the radio(s).
Send Text Message to a radio
Select this option so that a text message will be sent to the radio that activated

the Voice Message task. If you select this option, specify a brief text message
in the Message box.

Task Process tab
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Voice Message x
Task name: Voice Message 1
Task Start TaskProcess TaskStop Message Telemetry
" Send voice message once
¥ send voice message repeatable
Repeat Interval: a0 El: second(s)
¥ Repeat Count: 10 =

[ Impolite channel access

[ Delay on start: 1 =
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¢ Send Voice Message once
Choose this option to send the voice message to a selected radio (s) only
once.

¢ Send Voice Message repeatedly
Choose this option to send the voice message repeatedly.

= Repeat Interval
Specify the repeat interval, in seconds.

= Repeat Count
Select this check box and specify the number of times to repeat the voice
message.

¢ Impolite channel access
Select this option so that the voice message will be sent regardless of whether
the channel is busy or not.

e Start delay
Select this check box and specify the delay time, in seconds, for the Voice
Message task.

Task Stop tab

Note: These options are available only if you have selected the Send
Voice Message repeatedly option in the Task Process tab.

Voice Message X

Task name: Voice Message

TaskStart Task Process TaskStop Message Telemetry

] Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

VIO: 1 +{ command:

] Automatically by receiving CTMF command from a radio

e

[ send the following text message to the radio

Cancel

¢ Manually by dispatcher
Select this option to allow the dispatcher to manually stop the Voice Message
task.

¢ Automatically by receiving Text Message from a radio
Select this option to stop the Voice Message task after receiving a message
from a radio. If you select this option, specify a text message in the Message
box.
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¢ Automatically by receiving Telemetry Command from a radio

Select this option to stop the Voice Message task after receiving a telemetry
command from a radio: If you select this option, specify the VIO contact, and
from the Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to stop the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Send Text Message to a radio

Select this option so that a text message will be sent to the radio that stopped
the Voice Message task. If you select this option, specify a brief text message
in the Message box.

Message tab
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Voice Message x

Task name: Voice Message

Task Start Task Process Task Stop Message Telemetry

|| Load from file

5'; Record message

@ play back message

Call Type Channel Call Target
Private Call Auto Detect Radio 27
Group Call [ Slot 1 10

Phone Call Telephony 2410

op add 3¢ Remove
Priority: |N0rma| ﬂ

oK Cancel

Load from file
Click this link to load an existing file from your PC.

Record Message
Click this link to record a new voice message.

Play back message
Click this link to play back the voice message.

Specify Call type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Priority

From the drop-down list, select the priority with which the voice message will
be sent/queued. If this priority is higher than that of the current transmission,
which is, in turn, allowed to be interrupted, the current transmission will be
interrupted and the voice message will be sent instead.
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Telemetry tab

Task name: Voice Message 1

Task Start Task Process TaskStop Message Telemetry

Send Telemetry before starting task

VIO: 1 % Command:  |High level -

Delay after send: 0 + second(s)
Send Telemetry after stopping task

VIO: 1 3| Command: |Toagle level h

Delay befare send: a 3 second(s)
Redipient: Selected Radios: 1; Selected Radio Groups: 2 j
[] send Telemetry on every Voice Message

Cancel

¢ Send telemetry before starting task
Select this option to send a telemetry command before the voice message is
transmitted.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay after sending
Specify the time period, in seconds, to wait before sending the voice
message after the telemetry command has been sent.

¢ Send telemetry after stopping task
Select this option to send a telemetry command after the Voice Message task
is stopped.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay before sending
Specify the time period, in seconds, to wait before sending the telemetry
command after the voice message has been sent.

¢ Recipient
In the drop-down list, select the radios/groups to send the telemetry
command to.

¢ Send Telemetry on every Voice Message
Select this option to send the telemetry command to the selected
radios/groups every time the voice message is sent, provided the voice
message is repeatedly sent.

6.4.5.15 Scheduled Report

The Scheduled Report task allows reporting on selected parameters and sending
these reports to selected Email subscribers groups. The user can have several
Scheduled Report policies for different purposes.
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Note: Before configuring the task, you need to create a number
of the Email groups to send reports to. For more details on
Email groups, see section 6.4.19, Email Groups (page 231).

e To add a Scheduled Report task, select Tasks (1), and click Add > Scheduled

Report (2):

File View Map Tools Help

Administration a & |0
Gomer * | N B ntercom (5 1s ine iee T mEE Pl
(1) Database P crow 10 P Group 20 [][+][@] |8 ¥ Groun 30 [2][«[e]
i Radio Systems
# System Bridging [ Jprvate Call [+]
& Telephony 1 b Add |~ (5 Edit | [5X
“ He Ek Delete
2% Virtual Modbus Devices v || “& LoneWorker 2
T Export Data
1=} Voice Dispatch (%) Scheduled Task
“ Voice Message dio
@ ‘Location Tracking 4 Agenda
\ Import Routes
& s0b Ticketing §9] Scheduled Report
@ Hotsos d
Route Management Lo Timer
. Missed GPS data loading
@ e [2", Sign-in notification \
vl 3 Timer 2
[ ] Text Messages V] 2 User Actiity
vl @ Voice Message
Q Voice Recording ¥l @ voice Message
‘Event Viewer
@ Administration
|« < | Record 120f 14 | w w4 ] »
127001 &8 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~

e Specify a name of the policy in the Task name box and set the policy

parameters.

Scheduled Report

Task name: IMesagas 1|

Report  Scheduler

n System reports ~

-[}) Registered Radios Select data by period:

D Radio Allocation

D Radio Disabling

D Telemetry
D Radio Users by Channel
D State of Radios Summary

~{F5) Job Ticketing
-[F}) Change Job Status
D Job Ticket Assignments

D List Finished Routes
B Full Mauamant Matzie

Check

D Unregistered Radios Start Date:
- Gps status End Date:
D User Connection History

D System Bridging Activity Filter:

D Channel Change Message Type:

n Commeon reports
D Messages for Period Radio System:
-} state of Radios Private From:
D User Messages and Motes
Radio Group:

Logical Group:

19-Oct-2016 0:00 'I
<Maximum date > 'I

[Fwotdeined- ]
[iotdened- -]
[Fwotdeined— ]
[Fwotdeined— ]

Radio ID (e.g. 22,33,40-55,88):

-] Lone Worker Activity Find Text:
D CAN graphics I
CAN messages

D [~ Print notes

[ Print coordinates

[ show street names

Server j

OK Cancel

e On the Report tab, select the type of a report for the Scheduled Report task.
The report details and filter might be different.
For more details on reporting, see section 7.3.7, Reports (page 340).

e Click the Scheduler tab to configure a schedule for the report.
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Task name: |Mesages 1 ‘

Report  Scheduler

Start date: |25 October 2018 ~|
Stop date: |27 October 2015 =l
|
‘ Days of week: |Monday’, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday ﬂ
Start time: 8:00 -
‘ Statistic period: | 1i‘ |Hnurs j |
‘ Email groups: Police dep
Check 0K Cancsl

e Start date and Stop date
Select the time period over which to generate reports and send them to email

group.
Note: The start date may be any date you choose to start the task

on. The stop date must be later or the same as the current
date.

e Days of week
In the drop-down list, select the days of the week you want to generate
reports on.

e Start time
Specify the time to start generating the report at.

e Statistic period
Select the time interval (in minutes, hours, days, weeks, or months) to collect
the data.

¢ Email groups
In the list, select Email groups to send the report to.

The created scheduled report will be displayed in the Tasks pane:
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To enable the task, select the check box in front of the Scheduled Report task you
have already created.

There are three types of the Scheduled Report status icons:
e Green indicates an active task, meaning the task is enabled (checked).
e Grey indicates an inactive task, meaning the task is disabled (unchecked).
e Red indicates a disabled task, meaning the task period is up in the past.
6.4.5.16 HotSOS (Email)

The HotSOS (Email) task is used to automatically create and assign job tickets upon
receiving email messages at the address specified for the radio (Radio > Additional
> Email). In addition, you specify the email address at which to receive email
messages about changes to the created ticket status.

e Go to Administration, Tasks.
¢ In the Tasks pane, click Add > HotSOS (Email).

¢ In the HotSOS Configuration dialog box, specify the following parameters:

HotS0S Configuration *
Name: [Hots05 |
Email: |test@gmail.ccm| |
Source: |Subject j

Status | Hots0s status |
New N

Cancelled Ca

Assigned Ass

Accepted Acc

Rejected R

Completed C

In Progress InP

Cancel

= Name
Enter a name for the task.
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= Email
Enter the email address at which you want to receive notifications
concerning the status of the created tickets.

= Source

From the drop-down list, select which part of the email message, Subject or
Body, will be included in the job ticket text.

= HotSOS Status

Enter the text of the emails that will be sent as notifications upon changes
to the job ticket status.

6.4.5.17 HotSOS (Web Service)

The HotSOS (Web Service) task is used to create and assign job tickets by using the
HotSOS Web Service.

e Go to Administration, Tasks.
e In the Tasks pane, click Add > HotSOS (Web Service).

¢ In the HotSOS Configuration dialog box, specify the following parameters:

Het505 Cenfiguration x
Name: [Hets03 |
URL: ‘Hl'tps:f"frfc.\nt.hot:sos.netfap\/service.svc/soap |
Login: ‘Tester 123 |
Password ‘“‘“‘ |
Provider [MOTOTREO |
Polling Interval 15/%-| seconds
Text Messages: ™
Mezssage LTEXTEAPRIORITYYWORDER_ID%

Format:

Text Prioty Room Mame Room Number Remark
Order D Message |D

Status HotS0S Status
New N -
Cancelled Ca P
Assigned Ass
Accepted Acc
Rejectsd R [
Completed C j
Cancel
* Name
Enter a name for the task.
= URL

Enter the URL of the service.

* Login and Password
Enter the login and password of the service account.

= Provider
Enter the service provider name.

= Polling Interval
Enter the interval, in seconds, to check the service for orders (job tickets).
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= Text Messages
If you select this option, additional text messages will arrive at the
designated radios from the HotSOS server.

= Message Format
Select the fields of a message to include in the job ticket text.

* HotSOS Status
Enter the text of the messages that will be sent as notifications to the
HotSOS server upon changes to the job ticket status.

6.4.5.18 Automatic Data Retrieval

The Automatic Data Retrieval task is used to automatically retrieve missing
location data from the radio's option board.

¢ Go to Administration, Tasks (1).

¢ In the Tasks pane, click Add > Automatic Data Retrieval (Swift GPS) (2).

File View Map Tools Help

- QE
* | B % 1 Line free [<)[@ [ intercom DEE Bl
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[ Jevercency crop [][<)[@] I IReguiar Garoup  [-)][<c|[@] B[] Group 20 [l<]e]
[ Jancal [][<c][@] [ Jcreup 11 DEE EEETE [2[<l[e]
[Jerowp 1 [][<e][@] [ Jerivate cail o]
55 Add |- 5 Edit | X Delete
3 ne rker iy

ecluled Report

2d Repor
@ HotSOS (Email)
@ HotsOS (Web Service)

9] 4] Recond 1o 11 (5 [ ]oA]4] .
() Connected g3 B € | § Administrator | (8 Licensed to: demo Demo License | @ Active~

¢ In the dialog box, specify the following parameters:

Automaztic Data Retrieval (Swift GPS) *
Task name: ‘Hutomaﬁc Data Retrieval (Swit GPS)|
General Radios

Maximum number of simultaneous requests: 33

Data upload

Retrieve missing locations if the data gap exceeds: I 30 3: seconds

Do not retrieve missing locations older than: I 30 ﬁ Iminuhes j
OK Cancel

= Maximum number of simultaneous requests
Specify the maximum number of radios being requested at the same time.
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= Retrieve missing locations if the data gap exceeds
TRBOnet Server automatically checks whether the location data is
continuous. If it detects data gaps between any consecutive location data
that exceed this value, it will attempt to retrieve missing information.

= Don't retrieve missing locations older than
TRBOnet Server doesn't check location updates for consistency if they are
older than this value in seconds, minutes, or hours.

= On the Radios tab, specify the radio(s) to retrieve location data from.
In the list of tasks, activate the Automatic Data Retrieval (Swift GPS) task by
selecting the check box next to the task name.
6.4.5.19 Automatic Voice Download

The Automatic Voice Download task is used to automatically retrieve voice data
from the radio's option board when the radio is in WiFi zone.

e Go to Administration, Tasks.

¢ In the Tasks pane, click Add > Automatic Voice Download (Swift).

Automatic Voice Download (Swift) >
Mame: |Vaice Dowrload| |
General Radios
Maximum number of simuttaneous requests: 33:
Saveto: (e
%RADIO_ID%NEYEARY_MONTHE_%DAY%_%HOURYNEMINUTES_%SECOND%

Year Morth Day Hour Minute Second Call Type Source Source Type
Source ID Recipient Recipient Type Recipient 1D

ci\Radio_112018_06_06_17132_57_xxx.tna

Carcsl

¢ In the dialog box, specify the following parameters:

* Maximum number of simultaneous requests
Specify the maximum number of simultaneously requested radios.

= Save to
Specify the path where to save voice data on your PC.

= On the Radios tab, specify the radio(s) to retrieve voice data from.

In the list of tasks, activate the Automatic Voice Download (Swift) task by
selecting the check box next to the task name.

6.4.6 Modbus TCP Connections

TRBOnet Server can receive and send data from/to Modbus hardware and interact
with Modbus data according to desired scenarios. There are two connection modes
between TRBOnet Server and Modbus hardware: Master and Slave.

To connect TRBOnet Server to Modbus hardware:
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e Go to Administration (1), Modbus TCP Connections (2):

File View Map Tools Help

Administration

s Radio Systems
5 System Bridging
& Telephony

& Tasks
- JModbus TCP Connections|

2

v
>

£ Mode IP Address Port Slave ID | Behavior
Master 192.168.77.10 502
il Voice Dispatch ¥ ModBus2 \Slave 502 1 Custom

% Location Tracking

& 30b Ticketing 3
T
/5] Radio Allocation 1

K
EP——
4|4 Record 10f2 » | W |M| 4 4

[ 127000 &5 B B, B 8 Administrater | [ Licensed to: deme Demo License @ Active-

¢ In the Modbus pane, click Add (3).

Modbus Configuration X

Name: ModBus_Siave
Mode: Save -
Port 502

Slave ID: 1

Behavior: Custom =

B

= From the Mode drop-down list, select the mode of connection.

e |If the 'Slave' mode is selected, specify the Port of TRBOnet PC and the
Slave ID to assign to this PC.

Leave Behavior as Custom if this connection will be used for
Event/Alarm management.

¢ |[f the 'Master' mode is selected, specify the Remote Address, Port, and
ID of the Modbus device, which in turn will be running in the Slave
mode.

Modbus Cenfiguration be

Name ModBus_Master
Mode: Master -

Remote Address: [10.10.168.20

Port 502
D: 1
[ Parallel Requests

Cancal

v" Parallel Requests
Select this check box so that TRBOnet Server can send multiple
requests without waiting for responses from the Modbus device.

6.4.7 Virtual Modbus Devices

Once you have created the appropriate TCP connection, you can add a Modbus
device:

e Go to Administration, Virtual Modbus Devices, and click Add.
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Virtual Modbus Device X

Name. [Pect |

Description:

Corfiguration: ModBus2

Table: Disretelnputs

v Edit Filter
o

In the Virtual Modbus Device dialog box, specify the following parameters:

= Name
Enter a name of the device.

= Description
Enter a description of the device.

= Configuration
From the drop-down list, select the slave connection you previously created
for the device (that is, TRBOnet Server running in the Slave mode).

= Table
From the drop-down list, select the appropriate MODBUS data type
('Discrete Inputs', 'Coils’, 'Input Registers’, or 'Holding Registers’).
In the 'Address/Value' table, enter the appropriate register values.

6.4.8 IP Cameras

This section describes how to connect IP cameras to TRBOnet Dispatch Console.
Go to Administration, IP Cameras to manage IP cameras in the system.
¢ In the IP Cameras pane, click the Add button.

¢ In the IP Camera Configuration dialog box, specify the following parameters:

IP Camera Configuration X

Name.

Camera 1
Description:
Disposal dump

URI
[rsp/710.10.102.243:554/

Protocal

UDP hd
Authorization
e 7

= Name
Enter a name for the camera.

= Description
Enter a description for the camera.
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URI

Enter the URI for the camera. Note the use of the RTSP:// prefix and port
number 554 (also note that some cameras may have been configured to
use a different port number other than 554).

Protocol

From the drop-down list, select UDP.

Authorization

e User
Enter the user name for the authentication, if needed.

e Password
Enter the password for the authentication, if needed.

6.4.9 Event/Alarm Management

The Event/Alarm Management feature allows you to create rules for Alarms, Emails,
Notifications, Text Messages to radios, and other events. When a configured rule is
executed, the appropriate action(s) will start.

For example, an external application sends some text data, which contains the text
"alarm", to TRBOnet software. The text "Alarm" is configured as the rule to start
sending a predefined voice message (for example, "Alarm in Sector N") to selected
radios (for example, the group "firemen"). As a result, the group "firemen" are
notified about an emergency condition.

e Go to Administration (1), Event/Alarm Management (2) to configure

Event/Alarm Management:

File View Map Tools Help

Administration Event/Alarm Management
] serv | B ntercom D[« Il 1: tine free OE W
[21][«][@] I Fd Group 20 [2)][«][@] I P Group 30
54 Radio Systems
3 System Bridging

& Telephony 2

@ Tasks
23¢ Virtual Modbus Devices

{58} Event/Alarm Management

(1)) voice Dispatch

@ Location Tracking

&L 3ob Ticketing

[j Route Management

@ RFID Tracker

[] Text Messages

ﬁ Voice Recording

Event Viewer
EE! Radio Allocation 1
P 7
W4« Record2of2 ¥ w Wi| 4
[ 127001 g3 B | @ Administrator | [ Licensed to: demo Demo License @ Active~

e Click Add (3) to add a new Event/Alarm Management rule.
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Note: The administrator can also create a copy of the existing
Event/Alarm Management rule. Select a rule in the list and
click the Create a Copy button. The system will create a
copy of the rule with the same configuration parameters.
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Name
Enter a name for the rule.

¢ On the Source tab (1), click Add (2) to add a new event source for the rule.

Event Source X

Event [arm Reset [~
Alarm
p— | @ Activated by ar Alarm Reset
v o O Activated by o e

Delivery Confirmation
Dispatcher Presence Alarm
1 DTMF 3

Email

External Network Connection
Geofencing Ruies

Job Ticket Status

Modbus {master)

Modbus (slave)

PTT Event

Radio Allocation

Radio location data is outdated
Radio State

Radio Status

RFID Signal

Route Events

ScadaBvent

2 ScadaThreshold

SIP Cal
SMS
i Swift Commands
=" ] = System Events
Telemetry

Text Message |
Timer State

Event
From the drop-down list (3), select the event type to set for the rule.

For a description of the event types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: Select the event you want to enable. In case no event is
selected, all configured events are disabled by default.

Event/Alarm Management X

Name: [Wew Event ]

Source | wiorking Hours | Location | Action

Name: Desaription
W TextMessage  Active Radios: Al; Text: ;
W comport Port: COMI; Text: alarm;

gar | | odem

oK Cancel

e Click the Working Hours tab to set the time at which the rule will be valid.

All Time
Choose this option so that the rule will be valid all the time.

Selected Time
Choose this option so that the rule will be valid on the selected days of the
week at the specified time.

e Select the days of the week and specify the working hours.

e Click the Location tab to set the regions inside or outside of which the rule will
be valid.
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When a region(s) is (are) selected, the events specified in the Source tab must
take place inside/outside the selected region to start the action(s).

Note: When COM Port and/or External Network Connection
are selected as the event source, the Location rule should
not be used.

Event/Alarm Management X

N [Mew Event

ame:
Source || Working Howrs || Location | Action
2 Enable

Radio Lecation: |Inside Regions hd
O Al Regions
@ selected Regions

Region
Region 2
[liRegion_1
[ wa

Select Al Clear All
=

= Enable
Select this option to apply All Regions/Selected Regions to the rule.

= Radio Location
From the drop-down list, select whether the rule will be valid
Inside Regions or Outside Regions.

= All Regions
Choose this option to apply the rule inside/outside all map regions.

= Selected Regions
Choose this option to apply the rule only inside/outside selected regions.

e Region
In the list, select the region(s).

e C(lick the Action tab (1) to set actions for the rule.

In the Actions list, the administrator can add and configure the action types to
be started when the events configured and selected in the Source page are
triggered.

e C(lick Add (2) to add an action:
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New Event

Descriptior
Recipients|

Name:

Narn
¥ Emai

1

Beacon: Edit Properties

Beacon: Edit Properties
Camera in New Window

Dispatcher: Notification
Email

Geofencing Rules

Job Ticket

Map Object: Create New
Map Object: Delete Existing
Map Object: Edit Properties
Modbus

Phone Call Establishment
Radio: Lock

Radio: Private Call

Radio: Remote Monitor
Radio: Request Location
Radio: Set Alarm

Radio: SetLocation Profile
Radio: SetLogical Groups
RFID Signal: Emergency Contact
RFID Signal: Supervisor
Route

Scada

Send to External IP Data Source
svs

Start Lone Worker

Swift Command

System Bridging

Telemetry

Text Message

Text to Speech

Voice Message

= Action Type
From the drop-down list (3), select the action type.

neocom
SsoOftware

For a description of the action types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: After you configure the rule, enable it by selecting the

6.4.10 Telemetry

On the Telemetry page, you can configure settings for Telemetry.

check box beside it. In case when no rule is selected, the

action will not be started.

File View Map Tools Help

6.4.10.1 Radio Groups Telemetry

Administration ageme e[
B * | N Eercom [0 G 1= e fee CE) WEED Ll
é Dotabese Mo 10 moE (B ooe) EID e
i Radio Systems
s System Bridging []Private call []
@;f'i:hw =k Add 5} Edit 5] Create a Copy | Sk Delete
@ T
242 Virtual Modbus Devices ey o
{58} Event/alarm Management « ||[] MewEvent
Send DTMF
(1Y Voice Dispatch
% Location Tracking
& 30b Ticketing
Route Management
@ RFID Tracker
[] Text Messages
Q Voice Recording
Event Viewer
fp—
| «| < | Record20f2 b [m|mi] <] »
127001 & B | § Administrator | [8 Licensed to: dema Demo License | @ Active~

This is a default telemetry profile that is used to send telemetry commands to radio

groups.

¢ Click Radio Groups Telemetry in the Administration pane.

¢ In the Telemetry configuration pane, click Edit.
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File View Map Tools Help

Administration eleme S <)
Zjp Telephony ~
& Toss 3 mtercom [0][<c][@] B8 & 1: Line free [«][@] B[ Jarcal ][« (@]
=
3¢ Virtual Modbus Devices P crow 10 [=0][«][@] | B Group 20 [)][+][@] |8 ¥ Group 30 [2][«][e]
[F8 EventyAlarm Management
(8] swift Event Profiles [_]private Call
1y Telemey
Edit
Lo G Tk B
[ Telemetry =1 i
y Type:
Ul voice Dispatch Radio Groups Telemetry
Digital Outputs
E G2 VIOL: VIOL: Highlevel (High level)
(@ VIOR: VIOR: High level (High level)
@ Job Ticketing (@) VIO3: VIO3: High level {High level)
(B VIO4: VIO4: High level (High level)
VIOS: VIOS: High level (High level)
@ iigh level (High level)
Cil] RFID Tracker
[] Text Messages
ﬁ Voice Recording
‘Event Viewer
75] Radio Allocation
i —
127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~
Radio Groups Telemetry x
Telemetry Type: MOTOTREO
Profile Name: Radio Groups Telemetry
Digital Qutputs
juj Name Command
vIo1 VIOL: High level High level
VIO2 VIO2: High level High level
VIO V103: High level High level
Vo4 V104: High level High level
VIOS VI0S: High level High level
Description
D VIO1 -
Name: |
Command: High level =l
Apply
3 add [SkRemove
Cancal

= Click Add and specify ID (VIO), Name, and Command (signal level).

Note: For Radio Groups Telemetry only the Digital Outputs tab
is available.

6.4.10.2 Adding Telemetry Profile for Radios
e Go to Administration (1), Telemetry (2), and click Add (3):
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File View Map Tools Help

Administration eleme onfiguratio EE

Zjp Telephony ~

& Toss Intercom [«] 7 1: Line free [+] [Jarcal []
3¢ Virtual Modbus Devices Group 10 Group 20 [][] Group 30 [-2]
[F8 EventyAlarm Management
(8] swift Event Profiles [_]private Call [1][«][e]
CHEE > .
Add | =} Edit | Ek Delet
[ Radio Groups Telemetry E“_‘ 5 it | B Delete
[ Telemetrv =1 i
vy Type:
U2 Voice Dispatch Auto refresh inputs: Disabled
@ on Tracks Digital Inputs
o 3 © VIOL: Telemetry VK1 (High level)
& VIO2: Telemetry VK2 (High level)
w Job Ticketing (@) VIO3: Telemetry VK3 (High level)
(@ VIOS: Telemetry VK4 (High level)
@ VIOS: Telemetry VKS (High level)
Digital Outputs
@ o @ VIOS: VIOS: Low level (Low level)
RFID Tracker

[] Text Messages

ﬁ Voice Recording
‘Event Viewer

1

g =
127001 &3 @, | & Administrstor | [8 Licensed to: demo Demo License | @ Active~
Telemetry Profile ®
Telemetry type:
Profile name:

Telemetry %2

= Specify Telemetry Type for Radio groups:
¢ MOTOTRBO - telemetry from Motorola radios.

¢ Socintech Novox - telemetry from Novox devices connected to the
radio via COM port.

¢ Swift Option Board — telemetry from the option board connected to
the radio.

e Sprite — telemetry from Sprite devices.
Note: Sprite telemetry profile can be read but not written.

= Profile name
Specify a name of the profile to display in the Dispatch Console.

= Click OK.

Telemetry 21 X

Telemetry Type:  MOTOTREO

Profie Mame: Telemetry #1

Common Digital Inputs  Digital Outputs

Auto request input states
Requestinterval: 600 2 second
Trace digital inputs.
Trace analog inputs
[ Replace state event to VIO events
RFID

e
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Common tab

= Auto request input states

Select this option and in the Request interval box specify the time interval,
in seconds, to request input data.

= Trace digital inputs

Select this option to monitor digital input damages.

= Trace analog inputs

Select this option to monitor analog input damages.

= Replace state event to VIO events

Select this option to generate VIO ON/OFF event when the system
compares between the last and the current states of the VIO.

Note: Most of the policies are set to replace events, so it is
recommended to enable this option.

Digital Inputs tab

Telemetry 21 X

Telemetry Type:  MOTOTREO

Profie Mame: Telemetry #1

Common  Digital Inputs  pigital Qutputs

s} Name Event
vIo1 @ viot High level
Vo2 @ vio2 High level

[ Request location of subscriber Apply

ENY] kRemove

e Click Add to add a VIO (Virtual Input/Output) to the profile.

ID

Select the VIO to set the parameters for.

Name

Specify a name for the VIO to be displayed in the Dispatch Console.

Event

Select the signal level of VIO events from the drop-down list. When an
event with the selected signal level occurs on the selected VIO, the
telemetry will be activated. The signal level must be the same in the radio's

codeplug and in Telemetry configuration in TRBOnet. It is a programmable

option that sets the pin's voltage level to High or Low in order to trigger a
selected functionality.

Severity
Specify a severity level for the VIO event from the drop-down list.

Display as subscriber state

Select this option so that the radio will change its status after it sends the
telemetry command.
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Auto reset state

Select this option to automatically reset the telemetry VIO after the radio
sends the telemetry command.
Request location of subscriber

Select this option to request a GPS position of the radio after it sends the
telemetry command.

= Click Apply to apply settings to selected inputs.
Digital Outputs tab

Telemetry #1 X

Telemetry Type:  MOTOTRSO
Profile Name: Telemetry =1

Common  Digital Inputs.  Digital Outputs

D Name Command
ol VIOL: High level High level
vio2 VI02: Low level Low level
vio3 VIO3: High level Highlevel
Vo4 VI04: Toggle Toggle level

D: vIo3 -

Command Figh level -

Apply

= Add Sk Remove

=

e Click Add to add a VIO (Virtual Configured PIN) to the profile:

ID

Select the VIO in the dropdown list to set its parameters;

Name

Specify a name for the VIO to be displayed in the Dispatch Console.
Command

Specify a signal level for the command to send to the selected VIO.

Click Apply to apply settings to selected outputs.

6.4.11 Radio Statuses

6.4.12

In TRBOnet Dispatch Console, you can configure different profiles for the radio
statuses that are received from or sent to the radios.

Go to Administration, Radio Statuses. You can see the default Radio Status profile
settings in the Radio Statuses pane.

To add a Radio Status profile, click the Add button, and in the dialog that opens,

specify the required statuses to be received from the radios (Receive tab) and sent
to the radios (Send tab).

Location Profile

The Location Profile feature allows configuring different profiles of location update
settings for built-in GPS receiver. Location Profile overrides default location trigger
configuration in Server settings. For example, fire emergency service has a number
of departments in a city and needs to monitor current position of radio subscribers
(firemen). The administrator can create a number of separate location profiles with
different location tracking settings for each department.
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Note: The Location Profile feature is available for MOTOTRBO Generation
Il radios, firmware version 2.4 or later.

Go to Administration (1), Location Profile (2). You can see the default Location
Profile settings (3) in the Location Profile pane.

File View Map Tools Help

Administration ocation Profile € |3
L[®) swift Commands Profles : s

) Teemetry 3 1: Line free [+][@] ¥ P2 tntercom [1][«][@] SN P Maintenace [=2][=][@]

L) Radio Statuses P sales [][=[2] B P disp 15 [][«][@] | # Group 10

Mabile Cleng Profile Edcroup 20 mEE) (] oime) (L Do
¢ Tools 2 Moo 22 [][«][@] B[ rrivate ca (][]

S} Disabled Radios

I ey

5 Add [} Edit | 5k Delete

Ifl_é‘h Voice Dispatch
Profile type: MOTOTRBO
Location Tracking Manage tigger manualy: Yes
Channel type Nor-scheduled (Regular GPS over Visice or Data Revert Channel)
@ Job Ticketing Location prcrty: GPS
GPS data Latitude. Longttude. Direction, Speed. Precision
Route Management {Beacon data 1 Beacon: Maior, Minor
Fast GPS on Cannect Plus systems: No
[ ] Text Messages Periodic: Trigger: Interval 30.0 sec
(2 nerorts
Fl Event Viewer

[ samtten —t— 1

127001 &3 B B 8 Administrator | [8 Licensed to: deme Deme License | @ Active~

There is a default Location Profile that the administrator can use and edit.
The administrator can do the following:
1. Use default location profile.
2. Create a custom location profile: Add button.
3. Edit a profile: Edit button.
Note: In the default profile, the Name and Description cannot be
changed.
6.4.12.1 Adding a Location Profile
¢ In the Location Profile pane, click the Add button.

Location Profile X

profile type: MOTOTREC -
Profile name: HOACARED

FS 5000
Location Profile #4  |Extended device

e

= Profile type
Select the Profile type (MOTOTRBO, FS 500, or Extended device).

* Profile name
Enter a name of the profile.
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Name

MName: [Location Profile #4|

¥ save GPs data to database
™ Manage trigger manually

Channel type: [Non-scheculed (Regular GPs over voice or

Data Revert Channel

Location priority: [Beacon

[¥ 6PS data [ otitude, Longituce, Predsion, Direction, Speed

Leflel L] Le]

[~ Beacon data: ‘Majm Minor
1 =
[ Fast GPS on Connect Plus systems.
W Periodic trigger
Interval: 0.0 2] second

™ Distance trigger

[ Telemetry trigger

I Emergen
7 Show

Specify a name for the location profile.

Description

Add a description for the location profile.

Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

Manage trigger manually
Select this option so that GPS triggering will be started manually by the

dispatcher.
Channel type

neocom
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From the drop-down list, select a radio channel for sending location data to

TRBOnet Server:

= Non-scheduled

This is a channel with regular GPS (Enhanced GPS not supported).

= Scheduled

This channel is available when the Enhanced GPS feature is configured in

the radio system.

= Non-scheduled with CSBK data
This channel allows using CSBK (Control Signaling Block) while decoding.

= Scheduled with CSBK data
This is a channel with Enhanced GPS, which allows using CSBK (Control
Signaling Block) while decoding.

Location Priority

This option is used when beacons are placed on the maps. If the radio having a
GPS fix enters the range of a beacon placed on the map, its location tracking

will be performed according to the selected priority.

= Beacon

Location tracking will be performed based only on the GPS coordinates of
the beacons placed on the map.
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= GPS
Location tracking will be performed based only on the GPS coordinates
received from the radio.

e GPS data
Select this option to enable the user to select what GPS readings to send to
TRBOnet Server. In the drop-down list, select which GPS data to include in a
packet.

¢ iBeacon data
Select this option to enable sending iBeacon data to TRBOnet Server. In the
drop-down list, select which iBeacon data to include in a packet:

= Major, Minor (included by default and cannot be disabled)

= UUID
iBeacon's Universally Unique Identifier

= TX Power, RSSI
The strength of the beacon's signal as seen on the receiving device.

¢ Number of iBeacons
Specify the number of the most recently detected iBeacons whose data will be
included in the data packet sent to TRBOnet.

e Periodic trigger
Select this option to set a periodic location trigger on a radio. The trigger is a
request to the radio to send its GPS and/or iBeacon data at the specified time
interval.

* Interval
Specify the location update interval, in seconds.

e Distance trigger
Select this option to allow receiving location updates by a distance:

= Distance
A radio will send location updates if the travelled distance exceeds a
specified distance from the last GPS point, in meters.

= Min. interval
A radio will send location updates no more than once within this time
interval, in seconds.

e Telemetry trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
sending a Telemetry command.

e Emergency Trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
entering the emergency mode.

= Show emergency mode for Radio when Emergency GPS message is
received
Select this option if you want a Dispatch Console operator to see the
emergency status of a radio that transmitted location data.

¢ Click OK to save the location profile settings.

208 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SOftware

To apply Location Profile to a radio:

e Go to Administration (1), Radios (2), select the radio in the table, and click
Edit (3):

File View Map Tools Help

Administration Registered radio groups and radios =
~
roues erow 1 - [Jorowp2 9
~i= Logical Groups [PARepester 21: Slot =1 [FArepester =1: Siot 22 [)][«][@] [ ] an cal
) Radio Gr‘wy 2
B Rados v
" Regi Unregistered
A\l voice Dispatch Ak Add Group | =% Add MOTOTRBO Radio =) Add WAVE Radio = Add TRBOnet Mobile [Zb Edit
Callsign & Type Radio ID MDC / Sel-5... | SIP ID Radio Groups | Legical Goups | Description
@ GPS Positioning ® 125 MOTOTREQ... 125 0 2125 Firemen
@ 235 MOTOTRBO... 235 o 2235 Firemen
w Job Ticketing
Route Management 3
QI RFID Tracker
[] Text Messages
ﬁ Voice Recording
A
Event Viewer
“5] Radio Allocation 1
5., Administration -
1|40 | ¢ | Record 1of2 b | m[m] ¢ »
[ 127001 & By B | 8 Administrator | [ Licensed to: demo Demo License @ Active~
Voice Dispatch 125 X
General | Logical Groups | Additional| TP Call| Cameras |
calsign: [12s |
Radio ID: 125 4| MDC ID: o
Rado Grovps: |l ~[+]
Home Group: |cieaners ~[+]
Use icon: |@ Fortable Radios vI+=]
Location Service
Location Seurce: Built-in GPS receiver v
Location Profile: [(Default) [~]+]
\(uefault)
LCGBKHFKN #1
Telemetry Servi
TLM Source: Built-n Telemetry ~
TLM Profie: (Defalt) v
Text Messages Service
Standard ~ 4
Hd Ad anced Settings

= (Click the General tab, and from the Location Profile list select the location
profile to use for the radio.

= Select/clear the Location Enabled check box to enable/disable the location
trigger.

Note: The Location Profile is only applicable when the 'Built-in
GPS receiver' or 'Extended device' (if any) is selected in the
Location Source.

6.4.13 Mobile Client Profile

The Mobile Client Profile feature allows configuring different location profiles that
can be applied to the Mobile Client app running on a smartphone. For information
on how to register a TRBOnet Mobile app, see section 6.4.24.2, Adding TRBOnet
Mobile.

e Go to Administration, Mobile Client Profile.

You can see the default Mobile Client Profile settings in the Mobile Client
Profile pane.
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6.4.13.1 Adding a Mobile Client Profile

210

In the Mobile Client Profile pane, click the Add button.

In the Mobile Client Profile dialog box, specify the following parameters:

Mebile Client Profile #1 >

Profile Name: Mobile Client Profile #1

Use GPS location
Trigger interval: 30 %+ seconds
Use Indoor location
Trigger interval: 30 5| seconds
Number of iBeacons: 1
iBeacons filter:

iBeacon UUID
58934da6-4fa2-4e98-8024-bc5h7 1252787

gpAdd 3 Delete # Clear

o

= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send GPS location data.
= Use Indoor location
Select this option to enable sending iBeacon data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send iBeacon location data.
e Number of iBeacons
Specify the number of the most recently detected iBeacons whose data
will be included in the data packet sent to TRBOnet.

e iBeacons filter
Click the Add link and enter the UUID of the beacons that will be used
by the mobile client.

Note: If you don't specify the iBeacon UUID, the Mobile Client
app running on an iOS device won't detect any iBeacons.
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6.4.14 Tools
On the Tools page, you can find some useful tools.

6.4.14.1 Swift.Tracker Configuration Tool
Note: This tool is available only for TRBOnet Swift.Tracker v1.0

In general, a MOTOTRBO™ portable radio comes with a standard option board
factory-installed in the radio.

The Generic Option Board replaces this standard option board and newer radios (for
example, XPR 7550) are now manufactured with Generic Option Boards already
installed. Generic Option Boards can be flashed with custom firmware to provide
additional functionality: Man Down, No Movement, Crash Detect, Lone Worker and
event-driven GPS functionality.

The Event-driven GPS feature provides a method to collect GPS data more
frequently and to store and forward this GPS data by event. The feature also allows
collecting and storing GPS data while the radio is out of coverage, and, upon
request, provide the GPS data when the radio is back in coverage.

Go to Administration (1), Tools, Swift.Tracker Configuration Tool (2) to manage
Swift Tracker settings:

File View Map Tools Help

Administration Swift. Tracker Configuration Tool
LB ey 21 * | % Lt free [ intercom P2l
& P aical ][]
M crow 20 P Group 11 [][+][@]
[Jprivate cal [91][=]
isal =L Add = Edit =k Delete | [[] Clone # Export <= Import
‘*‘ES D\spatd'var Gruups MName Description Version
-2, Dispatchers || configuration 1 1
[E— N\ 3
I% Location Tracking \
42 30b Ticketing 2
Route Management
[ | Text Messages
o —
[:2] radio Allocation 1
g, Administrats -
4|4 | 4 |Record 10f 1 #[w[m 4 13
127000 &8 By | 8 Administrator | [ Licensed to: demo @ Active~

Click Add (3) to add a configuration for Swift Tracker.

¢ Name
Specify a name for the configuration to apply to a radio or a group of radios.

e Description
Add a description for the configuration.

e Set Defaults
Click this button to enable default settings.

e Import
Click this button to import the Swift Tracker configuration from a file (*.sfc).
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Export
Click this button to save the Swift Tracker configuration as a file (*.sfc) to the
PC.

On the General tab, set general settings for Swift Tracker:

Swift Configuration Tool - o x

Name: ‘Cunﬁgurahun 1 ‘

Description: | |

General | GPs Tracker Tasks
Modules
Enable GPS Tracker
Enable "Ne Movement"
Enable "Man Down”
Enable "Crash Detect”

oooor

Enable "Lone Worker”

General Report
Number of Retries 3

Retry Delay (sec) 15

Radio Settings

Network Radio D (CAI D). 13
Target Radio ID: 64250
Port 4004
Automatically Switch to Revert Channel

Set Defalts Export Import Cancel

Modules

Enable GPS Tracker

When the check box is selected, the GPS enabled radio will send its data to
TRBOnet Server according to its Generic Option Board (GOB) settings.
Enable "No Movement”

Select to enable No Movement feature.

Enable "Man Down"

Select to enable Man Down feature.

Enable "Crash Detect”

Select to enable Crash Detect feature.

Enable "Lone Worker"
Select to enable Lone Worker feature.

General Report

Number of Retries

Specify the number of additional attempts to send GPS data to TRBOnet
Server if the initial transmission fails. If the channel is busy, as data transfer is a
high priority, then the Transmit Interrupt feature will automatically be enabled.

Retry Delay
Select the time period between data transfer retries.

Radio Settings

212

Network radio ID (CAI ID)
Select the TRBOnet Server ID. ID = 13 is the default ID to route packets to
TRBOnet Server. (An ID = 12 will route packets to a control station.)
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e Target Radio ID
Select the target Radio ID for data transfer. In the case of a direct connection
to the repeater, select the TRBOnet Server ID (TRBOnet Peer ID).

e Port
Select the port number for data transfer.

e Automatically Switch to Revert Channel
Select this option to automatically transfer data via the revert channel.

Note: If the radio does not have a revert channel, this option must
be disabled.

On the GPS Tracker tab, set GPS Tracker settings:

Swift Configuration Toel - o X

Name: ‘Cunﬁgurshun 1 ‘

Desaription: | |

General GPSTracker Tasks

GOB Data Storage
Save GPS data on passing distance every () 50

Adding Data to Report

Spesd and Dirsction
Add Data to Report every {m) 250
Minimal Direction Angle () 14
Add Data To Report every (sec) 6000

Report Transmit Conditions

Report Period sec) 120
Passed Distance is mare than () 1000
Speed Exceeds fm/h) 20

Stop/Idle Time is more than {sec) 300

Set Defaults Export Import Cancel

GOB Data Storage

e Save GPS data on passing distance every (m)
Specify the distance a radio will travel before it saves its GPS data to the
Generic Option Board's memory; the data is not added to the report.

Adding Data to Report

e Speed and Direction
Select this option to add speed and direction information to the report.

e Add Data to Report every (m)
Specify the distance a radio will travel before it adds its GPS data to the report.

The report will be sent to TRBOnet Server at the selected time (see the Report
Period option).

Note: The distance traveled before adding data to the report
must exceed (greater than) the distance traveled before
saving the data to the GOB.
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Minimal Direction Angle

Select the minimum direction angle to add data to the report automatically (if
the radio reverses the direction, the current data will be added to the report
automatically, and the next data recording will be started).

Add Data to Report every (sec.)
Specify the time period for the report. When the indicated time period is
passed, the radio adds data to the report.

Report Transmit Conditions

Report period (sec.)
Select the time interval between the sending of GPS data to TRBOnet Server.

Passed distance is more than (m)

specify the distance a radio will travel before it sends its GPS data report
type in the distance. When the indicated distance is passed the Option Board
sends the report.

Note: The distance traveled before adding data to the report
must exceed (greater than) the distance traveled before
saving the data to the GOB.

Speed exceeds
Specify the maximum speed. If the current speed is greater than the specified
one, the radio will send data to TRBOnet Server.

Stop/Idle Time is more than (sec.)
Select the stop/idle time. When the stop/idle time is greater than the indicated
one, the radio sends data to TRBOnet Server.

On the Tasks tab, set Man Down, No Movement, Lone Worker, and Crash Detect
settings:
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Suift Configuration Toel - o X

Name: |configuration 1 |

Description: ‘ ‘

General | GPSTracker Tasks
General
Activate the aceelerometer on the radio swiiching on
Disable alarm by button click. [m]
“Man Down"” Settings.
Activation Angle (% 60
Fre-Alam {1) Timeout sec): 0
Pre-Alam Tone (1) RingStyleTone 1 v
“No Movement” Settings
Vibration Threshoid (%) B
Fist Pre-Alam Timeout (sec). 0
First Pre-Alam Tone: Ring Style Tone 1 v
“Lone Worker" Settings
Timeout fsecl: 1800

Pre-Alzm Tone RingStyleToned v

Second Pre-Alam Notification

Timeout fsec) 5
Pre-lam Tone TalkProhibi v
Volume Level Increase () 50
Pre-Alam Tone Duration (sec). 5
“Crash Detect” Seftings

Crash Threshold (g): 8
Movement Stop Timeout (sec). 0
No Movemert Timsout (sec). B
Emergency Call

TRBOnet Emergency tmeout (sac) 0
MOTOTRBO Emergency timeout fsec) 0
Sound notification after emergency call

Timeout isec): 0

Tone: RingStyleTone4 v

set Defaults Export Import Cancel

General

¢ Activate the accelerometer on the radio switching on
Select this option so that the accelerometer is enabled when the radio is
turned on.

e Disable alarm by button click
Select this option to enable the radio to turn off the alarm notification by
pressing any button on the radio.

"Man Down" Settings

¢ Activation angle - select activation angle to enable Man Down feature;

e Pre-Alarm (1) Timeout (sec.) - select time period preceding pre-alarm Tone
1;

e Pre-Alarm tone (1) - select pre-alarm tone. All pre-alarm tones can be found
in radio’s codeplug configuration.

"No Movement" Settings

¢ Vibration Threshold (%) - select max. vibration threshold for No Movement
feature;

e Pre-Alarm Timeout (sec.) - select time period preceding pre-alarm Tone 1;

¢ Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration.

“Lone Worker" Settings

e Timeout (sec.) — select time period to enable Lone Worker alarm;
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e Pre-alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration;

Second Pre-Alarm Notification

When pre-alarm tone (1) activates for Man Down, No Movement and Lone
Worker, and there was no user’s activity (the radio remains unchanged), the second
pre-alarm tone activates:

e Timeout (sec.) - select time period preceding pre-alarm Tone 2;

e Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in
radio’s codeplug configuration;

¢ Volume Level Increase (%) - select the percentage of the Volume Level
Increase for pre-alarm Tone 2;

e Pre-Alarm Duration (sec.) - select pre-alarm Tone 2 duration.

"Crash Detect” Settings

e Crash Threshold (g) - select acceleration changing value to enable Crash
Detect alarm notification;

¢ Movement Stop Timeout — select the time period of movement stop to
enable Crash Detect alarm notification;

¢ No Movement Timeout - select the time period of the radio without any
movement to enable Crash Detect alarm notification;

Emergency call
e TRBOnet Emergency Timeout (sec.) - select time period preceding

emergency tone to the Dispatch Console for Man Down, No Movement and
Lone Worker options;

¢ MOTOTRBO Emergency timeout (sec.) - select time period preceding
emergency tone to the Dispatch Console.

Note: MOTOTRBO Emergency Alarm should be set in radio’s
codeplug.
Sound notification after emergency call

e Timeout (sec.) — select time period to repeat the alarm notification. To stop
the alarm notification Dispatcher should disable alarm notification;

e Tone - select the notification tone. All tones can be found in radio’s codeplug
configuration.

216 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SOftware

6.4.14.2 Templates for Extended Messages
The Templates can be used for Extended Messages and Extended Notes.

The Extended Messages feature is a special function allowing users to send detailed
preconfigured templates containing necessary information to each other with the
help of the special TRBOnet Dispatch Console application.

This service has been created especially for clients who need to use more detailed
and structured messages in their work. If the standard messages are not enough to
contain all required information, you may use the Extended Messages service.

e Go to Administration (1), Templates (2) to create a new template:

File View Map Tools Help
Administration € |||
&) [Jancan [][«][e]

Swift Event Profiles ~
[ Telemetry
L) Rado Statuses rouy rou Group 30 [-0][<]

GPs Profil
SRt 2 [ Jpivaie ol ...

] Tempiates =

=L, Add From File | = Add 5b Edit (1] Save To File | Sk Delete
2} Indoar 2D Map Converter S 2 edt [ B
21 Disabled Radios Preview Name .

<

J)) Voice Dispatch
New Form

% Location Tracking

& sobTicketing

lll.ll:“anagtmcnt

@ RFID Tracker

[] Text Messages

§ Voice Recording

Event Viewer

e ]

127001 &9 By | & Administrator | [28 Licensed to: demo Demo License @ Active-

o) 4|+ |Record 10f 1 » [w[mm] « »

e Click Add From File (3) to add a template from a file.

Note: Before adding a template from a file, save the created
template to a custom directory.

Select the directory where you saved the template and click OK to add the file.
e Click Add (4) to create a new template:

Add/Edit Template - o X
i"i"‘b:"“: Template ID: | 754e575-d966-48c(-add 7-67%F1 091920 | []
e
T New Farn i
¥ @z &
& Gerein =]
(DataBindings) ~
AccessibleDescrption
Drag selected AccessibleName
CaEa Accessbleole Defautt
AlowDrop False
Template size: [ Gea fucher ot
E i Appearance Nomal
U LS AutoChedk T
Heght: 500 1= AutoElipsis False
: 3 AtoSize True
BackColor [ ControlLightLight
B || Beckguundinage [ frone)
BackgoundimageLayout  Tie
CausesValidation Tue
CheckAign MiddeLeft
Checked False
CheckState Unchecked
ContextMenuStip (none)
Cursor Def:
Dock None
Enabled Tue
FlatAppearance

Fiat Style Standard hd

Checked
Indicates whether the componert is in the checked state

oK Cancel
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= Name (1)
Specify a name for the template to display in the Dispatch Console (1).
= Elements (2)

Select elements to add to the template. Drag and drop the selected
element to the desired place on the mail template box.

= Template size (3)
Specify the template dimensions and background color.

= Click an element on the template. On the right side of the Template dialog
box, you can see the selected element properties.

For directions on how to send an extended message to a radio, see section 6.9.2.1,
Send Extended Text Message to a Radio.

6.4.14.3 Indoor 2D Map Converter

TRBOnet Dispatch Console provides the Map Converter to use custom images as
Indoor 2D Floor plans. The tool allows converting images to the BMAP format that is
supported in Indoor Positioning.

e Click Administration (1), Tools > Indoor 2D Map Converter (2).

File View Map Tools Help

Administration Indoor 2D Map Converter €]
A

Intercom e (mEED [« [e]
ou Group 30 [+l

[JPrivate call [2][«][@]

-1

P -

[ 127001 &8 B | § Administrator | [ Licensed to: demo Demo License @ Active -

¢ Name
Specify a name for the new Indoor 2D Map.

¢ Image
Click the ellipsis (...) button and locate the image file (PNG, JPG, TIFF, GIS) on
your computer.

e Directory
Click the ellipsis (...) button and locate the folder where to save the converted
Indoor 2D map on your computer.

e Click Start to convert the image.
To use the converted map

e Click Location Tracking (1). On the Map menu, click Open New Map in Tab (2):
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File View [Map | Tools Help

/®

= Save Online Map Data... =
B D E
B 5 Map Content e e DoE (B Pl
ST DEE) (EXE DEE (CEEEENDOE) [
.ur’* Geocoding.. ][] I E2Private ca BEE) ] @ Beer
B open NewMapin Tebu g g Coffee
® e ol [ Ficor plan_ x| 7@ Tea
en New Map in Window- 4
o [ Poille — i - Fiter | @[ D] D] @] 7 [@] show Beacons: a1 ~ [# DravingPanel] % & 5 Mep Otects
Aﬁ@ﬂﬁrl\gc = ][] Camera 1
ustom ject -
_||@d Delete Route on Google Earth = > . (][] Hospital
U voice Z z [ poice
Show Radios on Google Earth » 2 2 i
0 W1 [ Map Regions
A tocatontrackng o |
LS
Camera 151l yevskdy , o [ Map Routes
ﬁ Job Ticketing @3 111
Route Management
@ RFID Tracker 1
/o
[ 60m Lattue: 59°5629,53 : Longiuge: 30°1652.71"E ||
ﬁ _ Recent Calls/Events ™= |
[ Playback [l Save- (D Print | 11 Pause < Clear - i Reload | ‘[ Filter By Radio | = Grouping "\/ Auto Fiter (> Defautt Settings ’j‘
@ Reports Date Radio System Sender Recpient Message Details
3% 09.06.2017 14:43:57 Server Al Connection to 'Capadity Plus 1'h... i‘
Event Viewer 09.06.201712:43:30  CapadtyPlus1  Administrator 1 Dispatcher ‘Administrator' calls gr... Members: Administratar, 125
5 09.06.2017 12:40:06  Capacity Plus 1 125 1 Radio 125 calls group '11 (00:08)  Members: 125
EEI dio All - 09.06.2017 12:39:55 Capadity Plus 1 Administr ator 11 Dispatcher *Administrator’ calls or... Members: Administrator
4 09.06.2017 12:38:34 Capacity Plus 1 Administr ator Police Dispatcher *Administrator’ calls ar... Members: Administrator A
14| 4| Record 10305 b [m[m[« »
——
IE Recent Calls/Events  RecentCalls  RequestToTak Radio State  ActiveTasks  Active Routes User Activity Beacons BeaconEvents  Taglist

617001 g3 B | @ Administrator | [ Licensed to: demo

| @ active~

Select Map...

Map Type: Beacon2D

Caption: |

Available Maps

Name Path

Floorplan 1

D:\Images'\Bmaps‘Floorplan 1.bmap

Add Edit

Remove

Cancel

e From the Map Type list box, select '‘Beacon 2D'.

e Click Add to and browse for the map you have converted.

e Click OK to open the Indoor map in the Map pane.

6.4.15 Schedulers

neocom
software

The dispatcher can create pre-defined schedules to be used as event sources in

Event/Alarm management, for database backup, and in job ticket templates.
e Go to Administration (1), Schedulers (2).
¢ In the Schedulers pane, click Add (3).
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File View Map Tools Help

Administration Scheduler

57 1 cameras ~

[ Eventfalarm
[ Telemetry
[ Radio Statuses
[ Location Profile
LFy Mobile Cient Profile
A Tools

(© schedulers,

(&) Disabled g 2 " Recurrence Pattern

1 Dispatcher Groups

|2 Dispatchers ~

Scheduler

Name: |Database backup

%' Days of week

E B
\ " | ¢ monthly [ Mondsy [ Tuesday [ Wednesday E
Name

jice Dispatch Fn | |  OneTime ; z:;s:yay [v Friday I” saturday }ue o

* Periodically
@ Location Tracking

ﬁ Job Ticketing
Route Management
Recurrence Range

[] Text Messages Starts 5/21/2018 1200AM ¥

Stop <Maximum Date> -

G Voice Recording

(5 Reports Carce

1

/

@Muﬁm i

| ea] <[ ][4

[@ Connect ted &3 B B BY B | § Administrator | [ Licensed to: demo Demo License @ Active~

In the Scheduler dialog box, specify the following parameters:
= Name
Enter a name of the scheduler.

Recurrence Pattern

Choose one of the recurrence patterns for the scheduler:
= Days of Week
Specify the time and select the day(s) of the week.
= Monthly
Specify one of the following options:
¢ Specific Day
Specify the ordinal day of the month (in the range 1-31, or select Last).
e Day of Week

Specify the week number in a month (in the range 1-4, or Last) and
select the day of the week.

= One time
Specify the date and time.

= Periodically
Specify the time interval, the repetition period (in seconds/minutes/hours),
and select the day(s) of the week.

Recurrence Range

= Start
Specify the start date/time.

= Stop
Specify the stop date/time.

6.4.16 Disabled Radios

TRBOnet Dispatch Console provides the Disable function that allows disabling a
radio even when the radio is offline. The system will disable an offline radio as soon
as it gets available.
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Note: The dispatcher can disable a radio when they have relevant
Access Rights (for more details on adding and editing
dispatchers, see section 6.4.18, Dispatchers on page 225).

¢ Go to Administration (1), Disabled Radios (2) to disable selected radio:

File View Map Tools Help

Administration Disabled Radio

(8] Swift Event Profiles 2
: Intercom

Telemetry
LCf) Radio Statuses Fcrow 10 [][«][@] 8 P &roun 20
[ ]Private Call [2][«]

[1][«][@] B & 1: Line free

[2][«][e]

[Jarcal

Group 30

(5 &Ps Profile

# Tools

) Disable Radio "' Enale Radio | 1 Kill Radio

(4} Disabled Radio:
S, Dispatcher Gr:;\
& pispatchers

Email Groups

Radio
& 125
5 238

2

<

4 | Disable date Reason
21-Nov-2016 12:30
21-Nov-2016 12:30

(1) Voice Dispatch

@merradr’nj

@ Job Ticketing

umterhmemmt

@ RFID Tracker

[ Text Messages

73] Radio Allocation / 1
04| 40| 4| Record 20F2 ¢ [m|mi| 4] »

127001 g3 B | @ Administrator | [ License: | @ active~

IEMniistrﬂtim o

d to: demo Demo License

e Click Disable Radio (3) and in the dialog box that appears:

Lock H
% Disable Radio

Radio:

|@ 235 (Basil) 235
INo aute unlocking

Ll

Unlock:

Reason:
Tesﬂ

Cancel

= Radio
Select a radio from the drop-down list.

= Unlock
Select the time period after which the radio will be unlocked.

= Reason
Enter the reason for disabling the radio.

= (Click OK to disable the radio.
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Message 1 of 3 X
235
Repester #1; Slot #£1
Disabling
The command has been executed. 01-Nov-2016 17:48

Radio has been disabled

[] Do not show this message next time Show on map
Request Location

The Radio is added to the Disabled Radios list and is marked as Disabled in the
Voice Dispatch pane:

Voice Dispatch

EBl=t & 7 03

S| & Online Dispatchers (1)
R Administrator

= | Firemen ’
(€% 175 (Pete) 125 [S]<]

‘_q‘ 235 (Basil) 235 [=JCS

|}, Police =]~

f
d

e (lick Enable Radio (4) to enable selected radio.
e Select a radio from the drop-down list and specify the reason to enable.
e Click OK to enable the radio.

6.4.16.1 Kill Radio

The Kill Radio feature is available only when a Capacity Max system is used.

Note: This operation is not reversible. If you kill a radio unit, it will be
impossible to recover it.

6.4.17 Dispatcher Groups

The administrator can add, edit, and delete dispatcher groups in the system.
Go to Administration (1), Dispatcher Groups (2) to work with dispatcher groups:

File View Map Tools Help

Administration Registered Dispatche &)
& Radio Status
% R Stases * |5 Titne free (<] I Bintercon oEE (VBT Fille]
3 Tooks 3 i call [][=[@] B Ecroup 20 MG 1t [2][«][@]
Disabled Radios
|8, Dispatcher Groups Pcouwp 22 [[«[@] I Bdrrivate cal [[<][@] B F maintenace [«][e]
Bomowret~ 5 |MEHs= Pl
A, voice bi (5% Add| ) Edit | =k Delete | = Grouping 7 Auto Filter (&> Default Settings
Name & Radio ID SIP ID Desaription
% son Track Maintenace 50400 60400
Sales 60500 60500
@ Job Ticketing
Route Management 3
@ RFID Tracker
[] Text Messages
g voice Recording
Event Viewer
EEI Radio Allocation 1
"
o
|| < |Record 10f2 ¥ ||| 4] »
127001 &3 B | @ Administrotor | [ Licensed to: demo | @ active~
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e Click Add (3) to add a dispatcher group.

Dispatcher Group X

General  Call Group RequestTo Talk

MName: |Maintenace

Description: |

Cancel

On the General tab, specify general parameters for the new dispatcher group.

e Display Name
Specify a name for the dispatcher group to display in the Dispatch Console.

e Description
Add a description for the dispatcher group.

On the Call Group tab, specify the following parameters:

Dispatcher Group %
General Call Group  RequestTo Tak
Radio ID: 50400
Phone Call
SIP ID: [so<00 |
SIP Mame: |Maintenance |
Password: | ““““ il |
Cancel
e Radio ID
Specify the Radio ID of the dispatcher group.
Phone Call
e SIPID

Enter the SIP ID that will be used by the dispatcher group.
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SIP Name
Enter the SIP user name that will be used by the dispatcher group.

Password
Enter the password for the dispatcher group to be authenticated by the
telephone system.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher group:

Dispatcher Group X
General Call Group RequestTo Talk

Automatically by receiving Text Message from a radio
Message: 60400 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: Any event -
Automatically by receiving DTMF command from a radio
Command:  |50400| #60400%

[ automatically by receiving Status from a radio

Cancel

Automatically by receiving Text Message from a radio

Select this option to request a call from the dispatcher group when a radio
sends a predefined text message. If you select this option, specify a brief text
message in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to request a call from the dispatcher group when a radio
sends a predefined telemetry command. If you select this option, specify the
VIO contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to request a call from the dispatcher group when a radio
sends the specified DTMF tones. If you select this option, specify a DTMF
combination without the # characters in the Command box.

Automatically by receiving Status from a radio

Select this option to request a call from the dispatcher group when a radio
sends the specified Status to TRBOnet Server, for instance, 1. If you select this
option, specify the Status.

Once you have added the dispatcher group to the system, the appropriate PTT box
will appear in the Radio Interface pane.
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The administrator can add, edit, and delete dispatchers in the system.

Go to Administration (1), Dispatchers (2) to work with dispatchers:

File View Map Tools Help

Administration

18} Indoor 2D Map Convert a
© schedulers

8 Dispa s
i

Email smuns‘\

5= svs Groups

Logical Groups

Registered Dispatchers

EIEm[e]

[ JReguiar GGROUP

/" Dis Roles
5 Add|-| = Edit | X Delete | = Grouping " Auto Filter @ Defoult Settings

S Radin Grane
< >

11, voice Dispatch

@ Location Tracking

4 30b Ticketing

RﬂltzM-li;zllBlt

[] Text Messages

@' Voice Recording
C‘@ Reports

Fyre—

User Name' 2 Role

A Disp 1 Dispatcher

A Disp 2 Dispatcher

R wan Dispatcher
3

| —1

1] | < |Record 10F3 ¥ [ w[wm] ¢

Display Name
Dispatcher 1
Dispatcher 2

Radio ID
50100
50200
5

SIPID
60100
50200

[ Connected &3 B B b T € | @ Administrator | [ Licensed to: demo Demo License

e Click Add (3) to add a dispatcher.

| @ active-

Dispatcher

Authentication:
User Name:
Password :
Repeat password:
Display Name:

Description:

Dispatcher Role:

General Dispatcher Rights Radio Systems  Radio Groups  Dispatcher Grov| *

[ 1nvisible to all other users
[ 1nvisible to &l except the assigned aroups

[ Allow multiple simultaneous logons

TRECnet Authentication ~
|Dispau:her 1 |
= |
= |
|Dispau:her 1 |
Dispatcher j
Carcel

¢ On the General tab, specify general parameters for the new dispatcher.

= Authenticat

ion

Select the Authentication method from the drop-down list.
Select TRBOnet Authentication to log on as a user registered in TRBOnet

Dispatch Console users list.

Select Windows Authentication to log on using the PC name. The system
automatically shows the PC name as User Name.

Note: The password is not required when Windows
Authentication is used.
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Note: For more details on user access to Allocation Console,
section see section 6.4.21, Users (page 233).

= User Name
Specify a user name for the dispatcher registered in TRBOnet Dispatch
Software users list.

= Password
Specify a password for the dispatcher.
Display Name
Specify a name for the dispatcher to display in the Dispatch Console.
Description
Add a description for the dispatcher.

Dispatcher Role
Form the drop-down list, select the role of the dispatcher in the system
(Administrator or Dispatcher).

Note: In addition to the Administrator and Dispatcher roles, you
can also create custom dispatcher roles. For this, in the
Dispatchers pane, click the Roles tab, and then click Add.

Invisible to all other users
Select this option to make the dispatcher invisible to other users.

Invisible to all except the assigned groups
Select this option to make the dispatcher invisible to other users except for
users belonging to the same group of dispatchers.

Allow multiple simultaneous logons
Select this option to allow the dispatcher to use multiple instances of Dispatch
Console simultaneously.

On the Dispatcher Rights tab, select the available modules and specify the available
access rights for the dispatcher.
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Dispatcher X

General Dispatcher Rights Radio Systems Radio Groups  Dispatcher Grou 4 | *

Available Modules: |(AII Modes) j &
Voice Dispatch Functionality
Use the Voice Dispatch module
Intercom calls
Telephone calls via the SIP 2.0 phone interconnect
Initialize Private calls
Play back the recorded voice communications
[ view all other voice calls in addition to assigned groups
Change control station channels
Configure audio
Tone and PTT
Allow to send audio records
Save and export recorded voice communications
View System Bridge/Patch
Enable/disable System Bridge/Patch
[] Enable/disable encryption
Allow Call Preemption Mode for: 30 = minutes
Application w

Cancel
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On the Radio Systems tab, specify the radio system(s) that will be available for the
dispatcher.

Dispatcher X
General Dispatcher Rights Radio Systems  Radio Groups  Logical Groups |4 | *

(O Al Radio Systems available
(® Only selected Radio Systems avallable

Radio System X
Bl Contral Station #1

[ |Repeater #1: Slot #1 v
¥ |Repeater #1: Slot #2 W

Chedk Al Uncheck Al

Cancel

¢ All Radio Systems are available
Choose this option to make all radio systems available for the dispatcher to
transmit and receive Voice and Data.

e Only selected Radio Systems are available
Choose this option and specify which radio systems will be available to the
dispatcher.

= Select the check box in the left column to add the corresponding radio
system to the Radio Interface for the dispatcher.

= Select the check box in the TX column to allow the dispatcher to make
Voice calls using the corresponding radio system. When the check box is
cleared in the TX column, the dispatcher cannot use the corresponding
radio system to transmit voice and data.

On the Radio Groups tab, specify the radio groups that will be available for the
dispatcher.
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Dispatcher X
General Dispatcher Rights Radio Systems Radio Groups  ogical Groups |4 | *

() All groups are avalable

(® Only selected groups are avaiable
All call

Firemen

O

Chedk Al Uncheck Al

Cancel

¢ All groups are available
Choose this option to make all groups in the system available for the
dispatcher.

e Only selected groups are available

Choose this option and specify which radio groups will be available to the
dispatcher.

= In the list, select the groups to make them available for the dispatcher.

On the Logical Groups tab, select the logical groups that will be available for the
dispatcher.

Dispatcher X
Radio Systems Radio Groups  Dispatcher Groups  Logical Groups  Dispatch| * | *

() All groups are avalable

(® Only selected groups are available

Name Desdription
=H E—ﬂ Cleaning
by EI] Cleaning 1 Cleaning in Department 1
L *ri'_,] Cleaning 2
=H ﬂ'—ﬂ Security Groups for Security
il ) Security 1
[ security 2

Select Al Deselect All

Carcel

On the Dispatcher Groups tab, select the dispatcher group(s) the dispatcher will
belong to:
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Dispatcher X

Dispatcher Rights Radio Systems Radio Groups Dispatcher Groups [ ogic| 4 | *

() All groups are avalable
(® Only selected groups are avaiable

Group 1B

Maintenace
v |Sales W

Chedk Al Uncheck Al

Cancel

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the
dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports

Radio ID: 60100 3:

Phone Number: | 1234567 |

Email: |bi||y @gmail.com |
Phone Call
SIP ID: |s0100 |
SIP User: |s0100 |
Password: |oo|ooolooo |
SIP Profile: | v |

Cancel

e Radio ID
Specify the Radio ID of the dispatcher.

¢ Phone number
Specify the dispatcher's phone number (additional data).

e Email
Specify the dispatcher's Email (additional data).

Phone Call

e SIPID
Enter the SIP ID that will be used by the dispatcher.

e SIP Name
Enter the SIP user name that will be used by the dispatcher.
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Password

Enter the password for the dispatcher to be authenticated by the telephone
system.

SIP Profile

From the drop-down list, select the SIP profile to use.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports i I

Automatically by receiving Text Message from a radio

Message: 60100 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: High level -
Automatically by receiving DTMF command from a radio
Command: 60100 #60100%

[ automatically by receiving Status from a radio

Cancel

Automatically by receiving Text Message from a radio

Select this option to request a call from the dispatcher when a radio sends a
predefined text message. If you select this option, specify a brief text message
in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to request a call from the dispatcher when a radio sends a
predefined telemetry command. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to request a call from the dispatcher when a radio sends the
specified DTMF tones. If you select this option, specify a DTMF combination
without the # characters in the Command box.

Automatically by receiving Status from a radio

Select this option to request a call from the dispatcher when a radio sends the
specified Status to TRBOnet Server, for instance, 1. If you select this option,
specify the Status.

On the Reports tab, specify the reports that will be available to the dispatcher.
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Dispatcher

Radio Groups  Logical Groups  Dispatch Call Request to Talk Reports

() all reports are available
(® Only selected reports are avalable

E.. Queries

: |:| U Lost Devices
m System reports

A
] D Unregistered Radios
-4 ) 6Ps status
-] D User Connection History
D System Bridging Activity
.7 [} Channel Change
m Common reports
. ] ) Messages for Period
] D State of Radios

|:| U User Messages and Motes
-] D Radio Allocation
-.[ ] ) Radio Disabling
] D Telemetry

Chedk Al Uncheck Al

X
4 ¢
A
v
Cancel

¢ All reports are available
Choose this option so that all the reports will be available to the dispatcher.

e Only selected reports are available
Choose this option and in the list below select/unselect the reports to

include/exclude.
6.4.19 Email Groups

neocom
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Email Groups are used in Event/Alarm Management and Job Tickets configuration to
send emails to dedicated recipient groups.

Go to Administration (1), Email Groups (2) to add/edit/delete email groups in the

system:

File View Map

Gy Telemetry
Radio Statuses
(5 &S Profile
W Tools
(5 Disabled Radios
) D\suatmer Groups
3, Dispatchers

Tools Help

Administration

~

[ mtercom [][«] & L: Line free

[«][2]

1G]

[Jancar [4]

Group 10
[ JPrivate call

[2][«][e]
[2][«][e]

Bcon e

=Y Add =) Edit | =k Delete | = Grouping 7 AutoFilter ©» Default Settings

Boor» e

& Jonol crows e A Desaription EmailList
= 55 Groups v querty @gmail.
Region 1Termnal 1
A1, Voice Dispatch

%merradr’nj

@ Job Ticketing

Route Management

@ RFID Tracker

[] Text Messages

g Voice Recording

Event Viewer

1

P

e

4l

|« | 4| Record 10F2 ¥ [m|mi[ <]

4@trbonet.com, 65@trbonet.com, 56@urbonet.com

com, asdf@gmail.com

127001 &3 B | @ Administrator | [ License:

d to: demo Demo License

e Click Add (3) to create an email group.

| @ active~
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Add/Edit Email Groups *
Name: Terminal 1
Description: Region 1 Terminal 1]
Emai list: 64@trbonet.com

65@trbonet.com
66@trbonet.com

Add

o
i3
2

Ok Cancel

* Name
Specify a name for the email group.

= Description
Add a description for the email group.

= Email list
Click Add to add an email address to the Email list.

6.4.20 SMS Groups

SMS Groups are used in Event/Alarm Management configuration to send SMS to
dedicated SMS recipient groups.

Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups in the
system:

file View Map Tools Help

Administration &)

Pt ~ | FEginereom (3 [[] Jl & e fee OE) EEE ()
A Beow s nEE oo TR Tl<lo
Disabled Radios

8% Dispatcher Groups [Jprivate Cal el

E:Z:::z:; =N Add 5 Edit | =k Delete | = Grouping "\ Auto Filter @ Default Settings

= \ Group Nane 4/ Desaiption Phene Numbers
B wsers 2 + || Deparbyent 2. Regio 1 Depariment 2 79117384561, 79217894561

.. Departméqt 3 Region 1Department 3 792112374567, 79111234567

(1)) Voice Dispatch

3

u:mﬁmrmdﬁug

@ Job Ticketing

an:z}‘lanagumvt

@ RFID Tracker

[] Text Messages

gmm
{5 Event viewer
[ Radio Allocation 1

|

| ] 4| Record 20F2_» [ w|mhi] < | >

Emm istratic e

127001 &3 B | @ Administrator | [8 Licensed to: demo Demo License | @ active~

e Click Add to create a new SMS group:
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Add/Edit SM5 Groups X
MName: Department 3
Description: Region 1 Department 3

Phone Numbers: 792112374567
79111234587

oK Cancel

= Name
Specify a name for the SMS group.

= Description
Add a description for the SMS group;

= Phone Numbers
Click Add to add a phone number to the SMS group.

6.4.21 Users
Go to Administration (1), Users (2) to add/edit/delete users in the system:

File View Map Tools Help

Administration e & |4
) Disabled Racios ~

2 copetne o Brercon DEE) R OB EEE Lo
% Dipatchers EF EE [ E2PE] Plxle)
Email Groups

= 55 Groups [«][e]

B ppeen =k Add (5} Edit | T Delete | = Grouping 7 Auto Filter > Default Settings
3= Logical Groups

% R:dm G,WD: 2 Login A Dispiay Name SPID | Description
B Radios o |[Bast Basil

Pete Pete 2401

[ JPrivate call

(1} voice Dispatch

L-zti-.rr_ﬁ-g 3

W Job Ticketing

MM—W

@ RFID Tracker

[ Text Messages

gmﬁzn:mni-g

Evuntviener

EEI Radio Allocation 1
|| | Record 10F2 » [m|mm]| | 3
127001 &5 B | & Administrator | (28 Licensed to: demo Demo License | © Active-

[I— o

e Click Add (3) to add a new user to the system:

¢ On the General tab, set general parameters for the user:
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Add/Edit User X

General Radios Advanced User Call Logical Groups

‘% Specify user information
Login: |BaS|I |
Password : | """" |
Repeat password: | ““““ |
Display Mame: |Basi| |
Max radios count: 1 =
Description:

Cancel
.
* Login

Specify the login for the user.

= Password
Type in the individual password for the user.

= Display Name
Specify a name for the user to display in the Dispatch Console.

= Max radios count
Select a number of radios that will be available for the user.

= Description
Add a description for the user.

¢ On the Radios tab, specify the radios that will be available to the user.

Add/Edit User X
General Radios  Advanced User Call  Logical Groups
Specify radios that the user can take
" Allow all radios
¥ Only selected radios
Callsign Group
! ® 111 Police, Firemen
v @ 125 Firemen
® 222 Police, Firemen
@ 235 Firemen
W4 | 4 | Record 2of4 b | M M| 4 »
Cancel

= Allow all radios
Choose this option to allow using all radios in the system.
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= Only selected radios

Choose this option and specify which radios will be available to the user.

e On the Advanced tab, specify settings related to taking/returning radios:

Add/Edit User X

General Radios Advanced User Call Logical Groups

I Lock radio on return

¥ Allow DTMF management

Take radio: 1234 #1234
Return radio: 5678 #5673

¥ allow Text Messages management

Take radio: 3214

Return radio: 5678

I Allow Sign In / Sign Out management

—

[ Send notification to radio after itis taken/returned

Canc

Lock radio on return
Select this option so that a radio will be disabled after the users returns it.

Allow DTMF management
Select this option to allow taking/returning radios by sending the specified
DTMF tones.

e Take radio
Specify DTMF tones to be sent by the user to take a radio.

¢ Return radio
Specify DTMF tones to be sent by the user to return a radio.

Allow Text Messages management
Select this option to allow taking/returning radios by sending specified text
messages.

e Take radio
Specify the text of the message to be sent by the user to take a radio.

e Return radio
Specify the text of the message to be sent by the user to return a radio.

Allow Sign In / Sign Out management

Select this option to allow taking radios when the user signs in.

e Sign-in ID
Specify the password that the user enters to sign in when they take a
radio.

Send notification to radio after it is taken/returned
Select this option so that a notification is sent to a radio every time the user
takes/returns it.

¢ On the User Call tab, specify SIP Call settings for the user:
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Add/Edit User *
General Radios Advanced User Call  Logical Groups
Phone Number: 79211234567 |
Email: |24D L@gmail.com |
SIP Call
sIP D [2901
SIP Name: [2901

Password: | |

SIP Profile: | ™

[ Block incoming calls
[ Block outgeing calls

Cancel

Phone number
Specify the user's phone number (additional data).

Email
Specify the user's email address (additional data).

SIP Call

SIPID
Enter the SIP ID that will be used by the user.

SIP Name
Enter the SIP user name that will be used by the user.

Password

Enter the password for the user to be authenticated by the telephone
system

SIP Profile

From the drop-down list, select the SIP profile to use.

Block incoming calls
Select this option to block all incoming SIP calls for the user.

Block outgoing calls
Select this option to block all outgoing SIP calls for the user.

6.4.22 Logical Groups

TRBOnet Dispatch Console allows adding custom logical groups in addition to radio
groups. You can create groups and subgroups and then assign
radios/users/dispatchers to these groups.

Go to Administration (1), Logical groups (2) to work with Logical Groups:
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File View Map Tools Help
Administration ogica & |5
% ;::‘;::mm * | I B mtercom (5 1 Uine free CJaica @]
&, pispatchers P croun 10 M croun 20 [=0][«][@] | B Group 30 [2][«][@]
Email Groups
55 s Groups [ ]Private Call
g’ Users B =
C 5 Add |- 5} Edit | 5k Delete
J@ Radio Growps =L AddasaChid | 2] Deseription
8 Rados 2 v || Z Addasa Root
B [Eaning Cleaning in Department 1
S ] Cleaning 2
Voice Dispatch
& =1} seaurity Groups for Security.
E ) ) L] Security 1
Location Tracking L Security 2
& 3ob Ticketing 3
Route Management
@ RFID Tracker
[ Text Messages
g Voice Recording
Event Viewer
[753] Radio Allocation 1
o v -
127001 &3 & | @ Administrotor | [ Licensed to: demo Demo License | © active~

e Click Add (3) to add a logical group.

= Select Add as a Root to add a logical group as a root folder.

= Select Add as a Child to add a logical group as a child folder.

X

Group properties
Name: Cleaning 1
Description: Cleaning in Department 1

Cancel

= Specify a Name and Description for the logical group.

= Click OK to add the logical group.

To display logical groups, enable the Logical Group view:
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Voice Dispatch

BEk& XY 95 S
O

8 B} onlimeorspaenerst)

& administrator
& T cleaning
© T} Cleaning 1
(#)® 125 (Pete) 125
F} cleaning2
& F) security
© T} securty1
[O)C) 235
T} secunty2

Y} voice Dispatch

a
A0040 4040

]

Jp—

&E 30b Ticketing

Route Management
nﬂnlmdn

[] Text Messages

Ev.i.zaunﬁ-g

Ty—

All created logical groups are displayed in the list of radios.

6.4.23 Radio Groups

Go to Administration (1), Radio Group (2) to add/edit/delete Radio Groups in the

system.

File View Map Tools Help

Administration EGIT & [
(&) Disabled Radios ~ =
fosvina ol e T o
& Dispatchers Fcrow 10 ¥ Group 30 [][«][@]
Email Groups
5 55 Growps [ JPrivate call
@E Users (5% Add| =) Edit | =k Delete | = Grouping I AutoFilter @ Default Settings
£= Logical ups.
= Name | A Radio D [ MDC / Sel-5 (Hex) | Desariprion

v Cleaners! 30 5 Cleaning group
Firemen 0 o
Police pU o

Location Tracking

& b reterm 3

Route Management

RFID Tracker

[] Text Messages

g Voice Recording

Radio Allocation / 1

T— -

4]« | « | Record 103 » [m|m] <] >
127001 &9 @| € Administrator \ =4 Licensed to: demo Demo License \ @ Active-

e Click Add (3) to add a radio group to the system:
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Group Properties X

Name:; Cleaners

Group ID: 30

Ak 4

MDC (Sel-5: |5 (Hex)

Description: Cleaning group

Use custom Call Tone
|| Load from file
@ playback message

oK Cancel

* Name
Specify a name for the radio group in the system.

= Group ID
Specify the Radio ID for the radio group used to identify messages to/from
the radio group.

= MDC / Select-5 / Quick Call 1 / Quick Call I
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending
on the call type. Or, select Quick Call I / Quick Call Il signaling system and
specify the appropriate parameters.

= Description
Add a description for the radio group.

= Use custom Call Tone
Select this option and browse for the audio file (WAV, MP3) that will be
used as a custom tone when a group call is started by clicking the Tone and
PTT button in the group's PTT box (see section 6.5.2, PTT Boxes).

239



neocom
sOoftware

6.4.24 Radios

The administrator can add/edit/delete radios in the system.

Go to Administration (1), Radios (2).

File View Map Tools Help

Administrafi Radios

& DS

127001 45 € | | Administrator | [ Licensed to: demo

188, Dispatcher Groups
1: Line fr = Inter
ook 5 simiee =
Email Groups [Jprivate cal [-][+][Z) B[ Jsroup 10
[JGroup 20 Dae) (MEKED
Unregistered
. 4F Add Group | b Add Digital Radio H = Add WAVE Radio =, Add TRBOnet Mobile =% AddRange
< > Radio Name & | Type Radio ID MDC ID SIPID Radio Gro... | Logical Gr. Description
@ 125 MOTOTRBO Radio %25 0 125 11; Firemen  Cleaning, ...
Y, voice pispateh ® 13 MOTOTREO Radio 1. 0 Al
@ 235 MOTOTREQ Radie 235 0 235 Firemen; P... Cleaning
i 3333 TRBONet Mobil 3333 0 3333 11; 22
4., Location Tracking @® net Mobie ;
@ 555 MOTOTREO Radio 555 0 Al
ﬁ 3Job Ticketing (@ Radio 300  MOTOTREO Radio 300 Al
g Route Management
|0]| RFID Tracker
[] Text Messages
Q Voice Recording
{=| Event Viewer
* 2] Radio Allocation 1
@ Administration gl
1] 4] 4| Record 10f 5 b [ w|mm] 4| »
| @ Active~

e Click Add Digital Radio (3) to add a new radio.
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On the General tab, specify general settings for the radio:

Voice Dispatch 125 >
General ILogiaI Groups' addiﬁonall SIP Calll Camerasl
Radio Name: 125 |
Radio ID: 125 +| MDCID: 0 =
Radio Groups: |AII v |
Home Group: |C|eaners | |
Use icon: |_ Portable Radios ~E = |
Extended Device: ,None—V| Test | ~
Location Service
Location Source: |Eu\|t—in GPS receiver ~ ‘
Location Profile: |(Default) R ‘
Location Enabled
Telemetry Service
TLM Source: |Euw|t—in Telemetry - ‘
TLM Profile: |(Default) LAk ] ‘
Text Messages Service
TME Tunar [2tandard vl v
Hide Advanced Settings
Cancel

Radio Name

Enter a descriptive name for the radio to display in the Dispatch Console.

Radio ID

Enter a Radio ID for the radio. This ID is used by other calling radios when
addressing the radio, for instance, when making a private call or sending a text

message.
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MDC / Select-5 / Quick Call I / Quick Call 1l

Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending on
the call type. Or, select Quick Call I / Quick Call Il signaling system and specify
the appropriate parameters.

Radio Groups
In the drop-down list, select a radio group(s) to which to assign the radio.

Home Group
In the drop-down list, select a home group for the radio.

Use icon
From the drop-down list, select an icon for the radio.

Extended Device
From the drop-down list, select the option board type the radio is equipped
with.

Location Service

Location Source

= Built-in GPS receiver
Select if the radio has its own built-in GPS receiver to send GPS data.

= Not equipped with GPS receiver
Select if the radio cannot send GPS data.

Location Profile

From the drop-down list, select the default or preconfigured Location Profile.
For more details on Location Profiles, see section 6.4.12, Location Profile
(page 205).

* Location Enabled
Select/clear this check box to enable/disable the location trigger.

Telemetry Service

TLM Source

= Not equipped with Telemetry
Select if the radio cannot send Telemetry data.

* Built-in Telemetry
Select if the radio has its own built-in Telemetry.

= Extended device
Select if the radio is equipped with an extended device.

TLM Profile

From the drop-down list, select the default or preconfigured Telemetry Profile.
For more details on Telemetry Profiles, see section 6.4.10, Telemetry

(page 201).

Text Messages Service

TMS Type
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None
Select if the radio is not equipped with a display.

MSI Proprietary
Select if the radio is equipped with a display and supports the new Text
Messaging service.

Standard

Select if the radio is equipped with a display and supports DMR Compatible
text messages.

Job Tickets Service

e JTS Type

None
Select if the radio is not equipped with a display.

MSI Proprietary
Select if the radio is equipped with a display and supports the Enhanced
Job Ticket protocol.

Text Messages
Select if the radio is equipped with a display and supports the legacy Job
Ticket protocol.

Radio Status Service

RS Profile
From the drop-down list, select the default or preconfigured Radio Status
profile.

For more details on Radio Status profiles, see section 6.4.11, Radio Statuses
(page 205).

On the Logical Groups tab, specify logical groups for the radio:

Voice Dispatch 125 X

General Logical Groups | adcitional | SIP Call| Cameras |
MName
=& Cleaning
wilZr Cleaning 1
= Cleaning 2
Z S Security
i[5 Security 1
L[l Security 2

Description

Cleaning in Department 1

Groups for Security

Cancel

e Select a logical group in the list of available groups.
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e For more information about logical groups, see section 6.4.22, Logical Groups
(page 236).

On the Additional tab, specify additional information about the radio subscriber:

Voice Dispatch 233 s

General] Logical Groups  Additional ISIP Call] Cameras]

Mame;
[Radio 235

Description:

Testradio

Make: | |
Plate Number: | |
Phone Number: [+7 811 1234567 |
Email: |besber@gmai\.com |
Mayx speed: ’ﬁ
Route Color: [JProwder... +

oK Cancel

¢ Name
Specify a name for the radio subscriber.

e Description
Add a description for the radio subscriber.

e C(lick the Load Image button and browse for the photo or image to assign to
the radio subscriber.

e Make
Specify a make of the vehicle as additional information.

e Plate number
Specify a plate number of the vehicle as additional information.

¢ Phone number
Add a telephone number for the radio subscriber.

e Email
Add an email address for the radio subscriber. This email address can then be
used to create and assign job tickets to the radio (see section 6.4.5.16, HotSOS
(Email)).

e Max speed
Specify the maximum speed allowed for the vehicle, in kilometers per hour or
in miles per hour, depending on the measurement system specified in
TRBOnet server.

¢ Route Color
Specify a color to display the route passed by the radio on the map.
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On the SIP Call tab, specify SIP Call settings for the radio:

Voice Dispatch 125 X

General | Logical Groups} Additional SIP Call ]Cameras]

SIP ID: 2125 |
SIP Name: 2125 |
Password: [seseersaee |
SIP Profile: s 1 ~]

[ Block incoming calls
[ Block outgaing calls

Cancel
e SIPID
Enter the SIP ID that will be used by the radio.
e SIP Name

Enter the SIP user name that will be used by the radio.

e Password
Enter the password for the authentication.

e SIP Profile
From the drop-down list, select the SIP profile to use for the radio.

¢ Block incoming calls
Select this option to block all incoming SIP calls for the radio.

¢ Block outgoing calls
Select this option to block all outgoing SIP calls for the radio.
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On the Cameras tab, select the check box beside the camera that will be associated
with the radio:

Voice Dispatch 125

General] Logical Groups] Addmcnal] SIPCall Cameras l

MName

G
Camera 2

Cancel

6.4.24.1 Importing Radios
The administrator can also import radios from an Excel file (*.xls).

Notes: The Excel file you are importing from must contain at least two
columns (Radio ID and Radio Name). Also note that the first non-
empty row in the table will be considered as a header row.

e Click the arrow on the right of the Add Digital Radio button and choose
Import from File.

# Import Radios

- m} x
Radio ID Radio Name Home Group GPS ™S
10 10 | |
11 1 | |
220 220 | |

Total: 3

T Import Cancel

In the Import Radios dialog box:
= C(lick Load > Excel.

= In the Open dialog box, locate the desired file and click Open.
= Click Import.

As a result, imported radios will be added to the list of registered radios.
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6.4.24.2 Adding TRBOnet Mobile

In addition to digital radios, you can create accounts for TRBOnet Mobile Clients that
can connect to your radio systems.

e (Click Add TRBOnet Mobile.

Voice Dispatch 3333 x

General |ogical Groups  Additional Cameras

Radio Name: |3333 |

Radio ID: 3333

Radio Groups: |FirEmer| L |

Home Group: |FirEl‘nEI‘| v |

Dispatcher Groupsy Al for |
¥
Profile: Mobile Client Profile #1 vl |

Use icon: |® Portable Radios ~ |

SIP ID: [3333 |

SIP User: [3333

Password: | oooooooooo |

Password {repeat): | ----------

[ Elock incoming phone calls

Cance

In addition to digital radio parameters, TRBOnet Mobile has two more parameters:
Dispatcher Groups and Profile.

e Dispatcher Groups
In the drop-down list, select a dispatcher group(s) which to assign to the
mobile client.

¢ Profile
In the drop-down list, select the profile for the mobile client.
Or, click the plus button on the right to create a profile.

Note: For directions on how to create/edit a Mobile Client Profile,
see section 6.4.13.1, Adding a Mobile Client Profile.

6.4.24.3 Adding WAVE Radio

If the WAVE controller is connected, you can add WAVE radios to your radio
systems.

e Click Add WAVE Radio.
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In addition to Radio ID, the WAVE radio has the Wave ID parameter.

= Radio ID

WAVE Radio

General ILngiaI Groups} Addiﬁunal] SIP Ca\ll Camerasl

Radio Name: |Wave 145 |

@o D: 145 2 waveID: |145 !
Radio Groups: |Firemen o | w
Home Group: |Firemen |+ |
Use icon: |® Portable Radios |- |
ExtendedDevice: [None 0] Test | ~
Location Service
Location Source: |Euiltﬁn GPS receiver ~ |
Location Profile: |(Defau\t} e |

Location Enabled
Telemetry Service

| |

| |
Text Messages Service

] v
Hide Advanced Settings
Cancel
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Specify a Radio ID for the WAVE radio. This ID is used by other calling
radios when addressing the radio, for instance, when making a private call
or sending a text message.

= WAVEID

Enter the Wave ID that corresponds to the user registered in the WAVE
server's user database.

When on the Voice Dispatch tab is selected, the dispatcher can make radio and
phone calls, send text messages to radios and phone numbers, monitor recent calls
and events, radio state, active tasks and routes and view selected map.

6.5 Voice Dispatch
6.5.1 Radio List
6.5.1.1 View Options

The toolbar in the upper part of the Radio List pane provides buttons to change the

appearance of the list:

Voice Dispatch

& [, onine Dispatehers (1) B
9 Dispatcher 1

® 3‘3. Group1

B |y Firemen (=]
(&) 111 29

=

— T

e Click to view radios by radio groups.

e Click to view radios by radio list.

e Click to view radios by logical groups.
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e Click to view radios by their states.

248

= Yellow
A radio is online and enters the beacon coverage zone; has Indoor
positioning lock.

Note: When GPS location is available and the radio enters the
beacon coverage zone, the state will turn yellow from
green.

= Blue
A radio is online; GPS data is not available.

= Green
A radio is online; GPS data is available. This state is shown if the Server has
received GPS data during the last 10 minutes (the time interval is set in the
server configuration).

= Grey
A radio is offline.

Click Fa to open the Settings dialog box to specify which quick buttons to
display in the Radio List pane.

Hide/Show quick buttons

Dispatcher Buttons

] send Message ] Request To Talk

Radio Buttons
[¥] Find on Map @] Frivate Cal
[ Find on Google Earth [¥] Send Message
[ show Route
[ shew Route on Google Earth
I Google Strest View
[F] Set Device Location [ Pre

¥ OnfOff Location Trigger] 7 Remote Monitor

I Request To Tak
[F] Blocking Onfoff
7] Monitoring Radio
esence in Network

Radio Group Buttons
[¥] Send Message
¥ Request To Tak

[T Reset Location Trigger

Logical Group Buttons
(¥ Send Message

Additional Options

[ Show checkboxes [F] how Location trigger state

By

review:
& 2 onine pipathers

8 oy

© | radio Group S A
%) Radio1 Zmaew
@ rado2 maew

Dispatcher Buttons
In this group, select the quick buttons to be displayed in the Radio List for
dispatchers.

Radio Buttons
In this group, select the quick buttons to be displayed in the Radio List for
radios.

Radio Groups Buttons

In this group, select the quick buttons to be displayed in the Radio List for
radio groups.

Logical Group Buttons

In this group, select the quick buttons to be displayed in the Radio List for for
logical groups.
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Note: For the preview, see the lower part of the Settings dialog
box.

e Additional Options

Show checkboxes

Select this option to display check boxes next to each radio and radio
group. Selecting/clearing a check box will display/hide the corresponding
radio/radio group on the map.

Show Location trigger state
Select this option to display the Location trigger state for a radio in the
Radio List pane.

(®(®)235 (Basil)
(% |(DIRadio 200
1% Radin 201

¢ Grey
A radio is offline.

¢ Blue + white dish
A radio sent ARS but didn't send GPS packets.

e Blue + red dish
A radio sent ARS and GPS packets without GPS data, that is the radio is
out of GPS coverage.

e Green
A radio is fully online (has a GPS fix).

Filter the Radio List

e Click 4 , and select which radio list elements to display in the Radio List pane.

Voice Dispatch

gliEt & KN

Radio, Radio Group, Online, GPS Fixed -

Type:
7|Rzdo

V| Radio Group

| Logical Group
State:

| Online, Indoor

¥ Online, GPS Fixed 3

| Online, Mo GPS

| Offfine

e Click the arrow button (1).
e Select the object types and the radio states (2) to filter radios.
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For example, you may select to display only radios and radio groups that are
online and have fixed GPS signal.

e Click OK (3) to apply filter settings.
Refresh the Radio List

e C(Click S to reload the Radio List contents.
6.5.1.2 Quick Filter

Type in Radio ID or Radio name to filter the Radio List. Search results are displayed
in the Radio List pane:

Voice Dispatch
Bili=& & XV @ I &
":.:|

& Online Dispatchers (1)

(=] I_u Firemen (=]
® R T= T

6.5.1.3 Radio Pop-up Window

The dispatcher can see the last received radio data in the Radio pop-up window.
Select a radio in the Radio List and hover the mouse pointer over it:

R 155
@E®
Capacity Plus #1 1

Online by AR5 2
(i) Battery: 60% 3
(i)onDuty 4
Lone Worker 5

12:44 PM 12:45PM
Cty Mal ©

Accepted #A09152 7
Accepted #A09155

GPS: 7/12/2018 6:24:35 PM
Speed: 1.9 km/h

Altitude: Unknown 8
Region: Mo

Latitude: 59°56'27.85" N
Longitude:  30°16'47.71"E

7 Liniya Vasil'yevskogo Ostrova,
36, Sankt-Peterburg, Russia,
199178

The following information on the radio is displayed in this pop-up window:
1. The current channel/radio system the radio is on.

2. The note about the radio state (displayed only if the Show latest note in Unit
information details option is selected in the Advanced tab of the Options
dialog).

3. The current battery state, in percent (displayed only if the radio is equipped
with an option board).

4. The User Activity list the radio is assigned to, if a User Activity task is activated.

5. The Lone Worker policy's state, if a Lone Worker task is activated.
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6. The route assigned to the selected radio, if a Route Management task is
activated for the selected radio.

7. The associated job tickets.
8. The current GPS data and current location data.
9. The current location resolved to address.
While this pop-up window is open, the dispatcher can do the following:
e Click 2 to request the presence of the radio in the radio network.
e Click = to send a text message to the radio.
e Click &= to request the radio’s location.
6.5.1.4 Radio Shortcut Menu
To open the radio's shortcut menu, right-click a radio in the Radio List pane:
This shortcut menu contains the following items:

e Presence in Network
Choose this menu item to send a Check Radio command. If the radio is online
and is located in the coverage area, the dispatcher will see a message like this:

Message 1 of 1 X
125
Repester £1: Slot £1
Checking Presence in Network
The command has been executed. 14-Nov-2016 17:43
Radio is present in the network:
Agent: Radio Networks
Radio System: Repeater #1: Slot #1 [ Peer 1002
[] Do not show this message next time Show on map
Request Location

e Private Call
Choose this menu item to initiate a Private Call to the selected radio.

e Request to Talk
Choose this menu item to send a talk request to the selected radio.

¢ Request Location
Choose this menu item to request the location of the selected radio (for radios
with GPS module only).

¢ Send Message
Choose this menu item to send a text message to the selected radio (for radios
with display only).

e Advanced > Remote Monitor (Open mic)
Choose this menu item to activate the radio microphone in hidden mode
(remote monitor duration — 30 sec.)

e Advanced > Reset Location Trigger
Choose this menu item to customize the Location Update settings. When you
reconnect to the Server or reassign a Location Profile to the radio, temporary
settings will be updated to the Location Profile settings.

251



neocom
sofFtware

Reset Location Trigger x

3, Reset Location Trigger
100
@ Reset location trigger
() Stop location trigger
() Start location triager

[] change periodic interval

= Reset/Stop/Start location trigger
Choose which command to send to the radio.

= Change periodic interval
Select this option and specify the new location update interval.
e Advanced > Enable Radio
Choose this menu item to enable the selected radio.

¢ Advanced > Disable Radio
Choose this menu item to disable the selected radio.

e Advanced > Send Audio Record
Choose this menu item to send an audio record to the selected radio.

Record audio

Convert Text to Speech
|:_, Start ‘|i_| Cancel | | Load |‘|

= Click Start and start talking to the microphone.

Record audio

00:34

oo ‘ l\'. ?"""‘1’\“ P A

Convert Text to Speech
Lu send \|L| Cancel | | Load |‘|

= Click Send to send the recorded message to the radio.

= You can also load your message from file, or from Saved Audio Files. Just
click the Load button.

= Or, you can send a text message converted to speech. Just click the
Convert Text to Speech link.

Convert Text to Speech x

Text:

Pete, get back at work j
=
Listen Cancel
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e Advanced > Hot Key - Private Call

Advanced > Send Coordinates To
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Choose this menu item to send the coordinates of the selected radio to

selected recipients.

[ .131 Orline Dispatchers

I Send copy by Email
I Send copy by 5MS
I Send to offfine radios

Hide Advanced Opticns

Send Text Message X
Target: |235 (Basil}; ‘
Templates: ~| B
Text: 125 (Pete) Latitude: 59°56'25.69"N; Longitude:
I1E47.91E
66
Mtachments: 0 Add File
Select Radios and Groups
Fitter: | 235
¥ # 235 (Basi)

SEND Cancsl

= In the dialog box that appears, specify the radio/radio group/dispatcher to

send the coordinates to.

Advanced > Send Email

Choose this menu item to send an Email message to the selected radio

mailbox.

Choose this menu item to assign a hot key that will be used to make a private
call to the selected radio. When the prompt appears, press the desired key or

key combination.

Hot Key

-?i r]. Click for the combination to specify
LA W the Hot Key or Esc to reset

X

Find on Google Earth

Choose this menu item to display the selected radio location on Google Earth.

Show Route on Google Earth

Choose this menu item to display a route traveled by the selected radio on
Google Earth for the specified time period.
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Show Route X
Radio: 125 (Pete) R
From: | 15-Nov-2016 0:00 ~|
To: |<Last known location:> ﬂ
Color: [ B 105, 105, 105 ~|

Optimize Route (group all nearest points)

Cancel

Monitoring > Monitoring in New Window
Choose this menu item to open a new Map window for the selected radio.

Monitoring > Google Street View
Choose this menu item to open Google Street View with the latest location
and direction of the selected radio.

Monitoring > Yandex Street View
Choose this menu item to open Yandex Panorama with the latest location and
direction of the selected radio.

Set Location Profile
Click this menu item and select the location profile that will be associated with
the radio.

Specify State Colors
Choose this menu item to select to set individual parameters for the radio
icons.

State Colors X

State Color

N @ s ST o
Online, Mo GPS @ oniine, No cPS M
Online, GPS Fixed (@) online, GPS Fixed - -
Online, Indoor @ Online, Indoor A
Alzrm O Alarm v o =

Reset

Preview

Cffline Online Online (GPS) Online (Beacon) Alarm

® ® ® ® e

OK Cancel

= In the State Colors dialog box, you can specify icons for the states of the
selected radio. Select icons from the drop-down list. To set a custom color
for the radio state icon, click the + button and select a color in the uniform
color palette. Click the — button to delete a custom color.

= In the lower part of the dialog box, you can see the preview of the icons.
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= To set default icons for the selected radio, click the Reset button.

e Set Radio Channel > Radio Active
Select/unselect this menu item to make the selected radio active/inactive.
¢ Set Radio Channel > Channel
Select the radio channel over which to make calls to the selected radio.
¢ Cameras >
Click this menu item and select a camera associated with the radio. As a result,
a new window with the camera view will open.
e Set On Duty

Choose this menu item to assign the selected radio to the On Duty list.
See also section 6.4.5.13, User Activity (page 182).

6.5.2 PTT Boxes

The dispatcher can make voice calls from the Dispatch Console by using PTT boxes:

f Control Station #1 (%]
Channel 1
Al call [~]

Session:

Free channel

Sender:

RX [T

- J

The following options are available for the PTT box:
e Click the E4 button to make the channel the default PTT channel.
e Click the [=2] (Tone and PTT) button to start transmitting after a tone sound.
e (lick the [« (Solo) button to mute all channels except this one.

e Click the (Mute) button to mute this channel.
Right-click on the selected PTT box to display the shortcut menu which contains the
following commands:
e Default PTT channel
Select this menu item to make the channel the default PTT channel.
¢ Specify Hot Key
Choose this menu item to assign a hot key that will be used to transmit on this
radio channel. When the prompt appears, press the desired key.
¢ Specify External PTT
Select the external PTT device that will be associated with this PTT box.

¢ Specify External Indicator
Select the external PTT indicator that will be associated with this PTT box.
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Add to New Group

Choose this menu item to add the channel/group associated with the selected
PTT box to the Patch box. When two or more channels/groups are added to
the Patch box, the dispatcher can click the Create link to create a patch group
for the selected channels/groups.

Tone and PTT
Click this menu item to start transmitting after playing a tone sound.

Mute this channel
Click to mute the selected channel.

Mute all channels except this
Click to mute all channels except the selected one.

Volume
Move the slider to specify the speaker volume level on the selected
channel/group.

Microphone
Move the slider to specify the microphone volume level on the selected
channel/group.

Configure channel
Click this menu item and in the dialog box that opens specify the recorder,
player, speaker, external PTT device, etc.

Slot 1

x

o
)
ol

=
3

Recorder: |Dafau|t j
Flayer: |Dafau|t j
Speaker: |Dafau|t j
Volume: = +
External PTT: |Footswiu:h {Footswitch PTT) j
Indicator: |Footswiu:h {RTS) j
Theme: |Default j
Cancel

Private Call Mode
Select this mode to allow making private calls from the PTT box.

Select By Radio ID Mode
Select this mode to allow making calls by entering radio IDs from the PTT box.

Recipient
Select the call recipient for the PTT box.

Terminate Transmission
Click this menu item to terminate the current transmission.

Note: The incoming transmission can also be interrupted and
terminated by clicking the Interrupt button in the PTT box.
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’f Slot 1 [«] [3_\
All call ||

—
’?D Sf"ff"i\‘@

Security

Sender:
@ Rady 125

Reset
Click this menu item to reset connection to the selected channel/group.

Minimize/Restore
Click to minimize/restore the PTT box size.

6.5.3 Voice Calls

6.5.3.1

The dispatcher can make the following types of calls:

Private Call
This is an individual call from the Dispatch Console to a radio via the radio
channel.

All Call
This is a call from the Dispatch Console to all radio groups registered in the
system.

Group Call
This is a call from the Dispatch Console to a selected radio group registered in
the system.

Intercom Call
This is a call from the Dispatch Console to other dispatchers. There are three
types of Intercom Call:

= Intercom Call to all dispatchers
= Group Intercom Call to a group of dispatchers
= Private Intercom Call to a selected dispatcher

Phone Call
This is a call from the Dispatch Console to a selected phone number.

In addition, the dispatcher can send voice mails to offline radios.

Private calls

The dispatcher can make a call to any online radio registered in the system. To make
an individual call from the Dispatch Console to a selected radio via the radio,
channel do the following:

Or:

Select the radio in the Radio List.

Click the button on the right.

Right-click the radio in the Radio List.

On the drop-down menu, click Private Call.
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To terminate a private call, do the following:
e Click the PTT button on the PTT box.

Or:
£
e Click the button in the Radio list.

Note: You can also create a special PTT box for Private Calls. For more
details, see View > Configure PTT Boxes on page 97.

6.5.3.2 All calls
The dispatcher can make a call to all online radios registered in the system (for
example, in the case of alarm). To make a call from the Dispatch Console to all radios

registered in the system, do the following:
e From the drop-down list, select All Call.

(_D Repeater #1: Slot #2

All call E
All Call

Firemen

Police

Session:

Free channel

Sender:

L ]

RX [T =
5]

. J

e Click the PTT button.

6.5.3.3 Group calls
To make a call from the Dispatch Console to a selected radio group registered in the

system, do the following:
e From the drop-down list, select a group.

(_ 1P Site Connect: Slot #1 (=

All call E
All Call
Cleaners

RX JTX =

e Click the PTT button.

Note: You can also create a special PTT box for Group Calls. For more
details, see View > Configure PTT Boxes on page 97.

6.5.3.4 Intercom calls
The dispatcher can make calls to all dispatchers or to selected dispatchers in the
system. To make an Intercom Call to dispatchers, do the following:
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e On the Intercom PTT box, from the drop-down list, select either All Call, or a
group of dispatchers, or an individual dispatcher.

(B tercom

@ Offline: Dispatcher 2

O Sender:

RX JTX

" J

e Click the PTT button.
6.5.4 Predefined Voice Messages

The dispatcher can send predefined voice messages (recorded or voice messages, or
audio files) to a radio or a selected radio group:

File View Map Tools Help

Voice Dispatch Radio Interface
i % RT @g@

() Radio 204 mg e
(%) Radio 205

© | ) Firemen

[ Repeater #1: Slot #2 [ [« @

@ All call

ssssss

B Repeater #1: Slot #1 [ =@

Al cal
@@ 25@asi)  HR
(%) Radio 200 e YW sesson

QD Radio 201
Patch on Repeaters
% Location Tracking Esnary patch
System Bridge
W pablicketing Repeater #1: Slot #2 ==l
—— Recent Calls/Events ™ |
Playback (] Saver Reload Filter By Radio oupins Auto Filter € Default Settings || 7' Details )
5 Playback (s -8 | B y ping 7 G g z
| Gj] RFID Tracker Date | Recipient | Message | Details | Note. |
—_ o 15-Nov-2016 15:43:52  Repeater #1: Sl.. D\SDEMEY 1 125 Private Call: Dispatcher Dispat... Members: Dispatcher 1, 125
Text Messages S5 15-Nov-2016 13:28:52 235 Al Reset Geofencing Alarm
? 15-Nov-2016 13:28:48 235 Al The Geofendng - Monitor Area.
i s s—"— BB 15-Nov-2016 13:28:48 235 Al Radio left allowed region My ...
L= S 15ov-2016 13:28:48 235 Al Radio left allowed reaion 'Mv z. hd
— | «| | Record 1ofs78 > |wmi| <]
:F Event Viewer Recent CallyEvents | RecentCals | Request toTak | Radio state | Actve Tasis | acti | User actvity | Map | Cameras
E‘)mom@@@‘ﬁnpth 1| (28 Licensed to: demo Demo Lic | © Active-

¢ In the Queued Messages panel, click the Voice Message button.

¢ In the confirmation dialog box, click Yes.
6.5.5 Patches

6.5.5.1 Predefined Patch

The Patch function allows configuring the network to redirect calls. A predefined
Patch can be created by the administrator only and a dispatcher cannot configure it.
A predefined Patch is displayed in the Patch panel by default. The Patch feature is
intended to combine different radio channels in a single group to make voice calls
from a dispatcher to radios and from radios to a dispatcher (for example, to connect
a dispatcher with the firemen and police).
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@ & Radio 203
()& Radio 204
()& Radio 205
© [ Firemen [ Repeater #1: Slot #1 [ E@ [ Repeater #1: Slot #2 @
€210 125 Pete) = PTT PTT
B @222
@@ 235 (Basil)
=

Drag and Brop PTT Box here to create new group

Group Call Group Call Patch on Repeaters
] — Y CR— oo

T el
@ Dispatcher 1 @ Dispatcher 1 Firemen - Police ]

(@ repeater #1: Slot #2

Voice

=1
)

Police
RX/TX RXfTX =
Fr—— 5 o) || e
v Firemen v
[ ——

Playback (& Save~ (2 Print | 11 Pause Clear + & Reload Filter By Radio | = Grouping "/ Auto Filter > Default Settin: £ Details
yt y ping g

Date | Radio System | Sender | Redipient | Message | Note. |
15Nov-2016 17:35:17  Repeater #1:Sl... 125 Firemen Radio'125' calls group Fir -
Text Messages 15N0v-2016 17:35:17  Repeater #1:S... 125 Police Radi 125" calls group ol
15Nov-2016 17:35:09  Repeater #1:Sl... 235 Police Radio'235' calls group Pol

15Nov-2016 17:35:08  Repeater #1: Sl... 235 Firemen Radio 235" calls group ‘Fireme...  Members: 235
15-Nov-2016 17:34:37 All Call from '235' (00:01) Members: 235 f
3

~
¥ e Repeater #1: 5.
= Recen Calsrens [ Recent ol Request Tk | adoStte | acoveTools | aca | user acouty | vap | camers

(6127001 g3 By B | Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

z

6.5.5.2 Custom Patch

The dispatcher can create a custom Patch to connect selected PTT boxes (for
example, the Emergency and Firemen radio groups). In addition, you can connect
analogue and digital radios via a Patch.

Radio Interface

Radio Interface| Recent Cals/Events

(%) (© Rauio 204 Hee

®Oramzn B oo HE m
© | Firemen To: Selected Channels

®e

B 222 - Voice Message

(®) @ 235 @asil)

(#) (D Radio 200 v

iremen
(#) (D Radio 201 X Cleaners 1
— Create Clear
e O (] [« (F2tch on Repeaters
- . chans chani [I8inary Patch

[] Firemen - Police X
nﬂfi[emr #1:Slot #2 PTT

Firemen Cleaners

Recent Calls/Events
Playback (gl Save~ (=) Print | 11 Pause <¥ Clear » ‘& Reload Filter By Radio | = Groupin Auto Filter © Default Settings Details
yl y ping 9

Date | Radio System | Sender | Recipient | Message | Details | Note.
15Nov-2016 18:03:01  Repeater #1:Sl... Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1 calls .. Members: Dispatcher 1 ﬂ
1500v-2016 17:58:21  Repeater #1: ... Dispatcher 1 Firemen Dispatcher Dispatcher ' calls ... Members: Dispatcher 1
15Nov-2016 17:58:21  Repeater #1:S... Dispatcher 1 Cleaners Dispatcher Dispatcher 1 cals ... Members: Dispatcher 1
15Nov-2016 17:55:01  Repeater #1:Sl... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher 1'calls .. Members: Dispatcher 1

15-Noy-2016 17:55:01  Repeater #1: 5l... Dispatcher 1 Cleaners Disoatcher ‘Dispatcher 1' calls Members: Disoatcher 1 A
| «| «| Record 10f875 »ﬁ» wd »

Recent CalEvents | Recent alls | Reauest o Tak: [ Radiostate | Acte Tasks [ Actve Routes | User actwity [ 1ap [ cameras |
127001 83 B B | § Dispatcher1 | [ License

demo Demo License | @ Active-

1. In the Radio Interface pane, select the PTT boxes you want to combine in a
group. Drag and drop them to the empty Patch box (1).

2. Click the Create link (2) to create a custom Patch.

Note: Until you click the Create link, this patch will remain as a
temporary patch that will be deleted after you reconnect to
TRBOnet Server or restart TRBOnet Dispatch Console.

As a result, the new patch will be added to the Patch panel. Select the check box to
activate the patch.
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adio Interface

Radio Interface| Recent Cals/Events

(%) (® Rauio 203

(%) (© Rauio 204 oe e
(%) (© Rauio 205

© | Firemen Drag and Brop PTT Box here to create new group
HEm

® S . o Patch on Repeaters
@0 o [I8inary Patch
() ® 235 (Basil) N

(#) (D Radio 200 Group
(#) (D Radio 201 meQ Sépeilér #1:Slot #2

eeeeee

Repeater #1: Slot #1
Firemen

[ Firemen - police
Repeater #1: Slot #2 (e
Police

Repeater #1: Slot #1

Firemen

Recent Calls/Events
Playback [z Save = () Print | 11 Pause < Clear » '3 Reload | [ Filter By Radio | = Grouping ‘[ Auto Filter > Default Settings || 5 Details
yt y ping g

Date | Radio System | Sender | Recipient | Message | Details | Note. |
15Nov-2016 18:06:05  Repeater =1:Sl... Dispatcher L Firemen Dispatcher Dispatcher 1 calls... Members: Dispatcher 1 -
T —— 1500v-2016 18:06:05  Repeater #1: ... Dispatcher 1 Firemen Dispatcher Dispatcher ' calls ... Members: Dispatcher 1

15Nov-2016 18:03:06  Repeater #1: Sl... Dispatcher 1 Cleaners Dispatcher Dispatcher ' cals ... Members: Dispatcher 1

15-N0v-2016 19:03:01  Repester =1:Si... Dispatcher 1 Firemen Dispatcher Dispatcher 1'cals ... Members: Dispatcher 1
15Noy-2016 17:58:21  Repeater #1: 5. Disoatcher 1 Firemen Dispatcher ‘Disnatcher 1' calls Members: Dispatcher 1 hs
T ——| i AT :
= Recent CalsfEvents | Recent Cals | Request to Tak | Rado state | Acve Tasks | ActveRoutes | User Actwity | vap | cameras. |

(127001 g3 & € | § Dispatcher 1 | [ Licensed to: demo Demo License | @ Active-

6.5.6 Quick Commands

The dispatcher can create Quick Commands (Text Messages, Send Telemetry,
Request Location, Send Voice Message, and some other commands) and display the
Quick Commands panel in the Radio Interface pane. With these commands, the
dispatcher can quickly send Text Message, Telemetry, Location Request, Voice
Message, and some other commands to a radio by clicking the appropriate Quick
Command button.

To configure the Quick Commands panel, do the following:

¢ Make sure Show Quick Commands Panel (2) is selected under the View
menu.

¢ On the Quick Commands panel, click the Configure link (3).

Show Navigation
Show Modules

Cenfigure PTT Boxes.

Configure Active Calls Panel.
Customize Hot Keys...
Add Radio Interface Page...

Delete Raio Inteface Page — [LResrc ]l e P

To: Selected Channels

Show Channel Selector Box

Audio Message Library...
Extended PTT Boxes
Large PTT Boxes
Medium PTT Boxes
Small PTT Boxes

Custom PTT Bbxes r P Free channel

— Cleaners

Free channel

Voice M
Firemen olce Message

Drag and Drop PTT Box here to
create new group

Recent Calls/Events
) Playback [ Save~ (b Print | 11 Pause < Clear + 'S Reload | [ Filter By Radio | = Grouping '/ Auto Fitter

Date |Radio Syst... Sender  |Redpient | Message | Details | Note |
% 16-Nov-2016 10:22:05 Server all Connection to ‘Repeat. .. -
15Mov-2016 18:26:36  Repeater... Dispatcher 1 Firemen Dispatcher Dispatcher... Members: Dispatcher 1
15-Noy-2016 18:26:28  Repeater ... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher... Members: Dispatcher 1

Show Telephony Tab
Show Extended Messages Tab
Show Radios Tab

15-Nov-2016 18:26:21  Repeater ... Dispatcher 1 Firemen Dispatcher ‘Dispatcher... Members: Dispatcher 1
15-Nov-2016 18:06:12 Repeater ,..  Disoatcher 1 Cleaners Dispatcher 'Disoatcher... Members: Dispatcher 1 h
|4 4| Record 10767 »Ti w4| 3
Recent CallfEvents | Recent Cals | Requestto Tak: | Redio state | Actve Tasks | Actve Routes | User Actvity | Mep | Cameras |
B 127001 &3 B, B, | 8 Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

¢ In the Configure Quick Commands dialog box, click the Create link.

* Name
Specify a name for the quick command. This name will be displayed as the
button name in the Quick Commands panel.
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6.5.6.1 Send Text Message

Cuick Command X
Name: |Test
Command
Command: |Sand Text Message ﬂ
Message: |This is a test]

" Send to Radio Group
{+ Send to Radio

Recipient:

® 13 -
M@ 125
M@ 235

@ 555

® 3333

® +42

(#) 5555 =
Selected: 2

EllE EE

= Command
From the drop-down list, select Send Text Message.

= Message
Enter the text of the message.

= Send to Radio Group
Choose this option to send the text message to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send a predefined text message to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.2 Send Telemetry

Cuick Command X

MName: |Test

Command

Command: |Send Telemetry j

VIO: VIO 1 | Command: High level -

" send to Radio Group
{* Send to Radio

Redipient:

® 13 -
M@ 125
W@ 235

@ 555

® 3333

@ 2442

(#) 5555 =
Selected: 2

=] LEEE

= Command
From the drop-down list, select Send Telemetry.
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= VIO
Specify a VIO to which to send a telemetry command.

= Command
From the drop-down list, select a telemetry command for the selected VIO.

= Send to Radio Group
Choose this option to send the telemetry command to radio groups
registered in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the telemetry command to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.3 Request Location

Quick Command X

Mame: |Locaﬁon of 125 and 235

Command

Command: |Request Location ﬂ

Recipient

® 13
W@ 125
W@ 235

@ 555

@ 3333

® 2

@ 5555

® Rradio 300

(&) Radio 333

(® Radio 3862

Selected: 2

@ a 7|+ =(~

= Command
From the drop-down list, select Request Location.

= Recipient
Select radios to which to send a location request.
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6.5.6.4 Send Voice Message

264

Cuick Command X

MName: |We are on fire|

Command

Command: |Sand Voice Message ﬂ

|| Load from file
,}a Record message
) play back messane

Channel Call Target

5} Capacity Plus #1

Call Type

Group Call Firemen -

op Add ¥ Remove

|Norma| ﬂ

Priority:

Command
From the drop-down list, select Send Voice Message.

Load from file
Click this link and locate the audio file on your PC.

Record Message
Click this link to record a new voice message.

Play back message
Click this link to play back the voice message.

Specify Call Type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Priority

From the drop-down list, select the priority with which the voice message
will be sent/queued. If this priority is higher than that of the current
transmission, which is, in turn, allowed to be interrupted, the current
transmission will be interrupted and the voice message will be sent instead.
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6.5.6.5 Send Signaling

CQuick Command X
Mame: ISlgnaI 1
Command
Command: ISend Signaling j
Radio System: ICaDacit\r Plus #1 j
Target: IFiremen j
Type: [custom |

Freq.1 (Hz) Freq.2 (Hz) Duration {ms) Pause (ms)

o Add ¢ Delete # MoveUp ¢ Move Down
Cancel

Command
From the drop-down list, select Send Signaling.

Radio System
From the drop-down list, select the radio system.

Target

From the drop-down list, select the target group to which the signal will be
sent.

Type

From the drop-down list, select the signaling system type (Quick Call I,
Quick Call Il, DTMF, or Custom).

If the Custom type is selected, specify the Frequency 1, Frequency 2,
Duration, and Pause for the signal to be sent.

6.5.6.6 Send Command to Control Station

Quick Command X

Name: ICummand to Control Station

Command

Command: ISend command to Control Station j

Control Station Command |

-

PINS SET OM
PING SET OFF
PING PULSE

o Add ¢ Delete

ancel
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= Command
From the drop-down list, select Send command to Control Station.

= Click Add

e Control Station
From the drop-down list, select the Swift Agent connected to
TRBOnet Server.

e Command
From the drop-down list, select the PIN number and its value.

6.5.6.7 Request To Talk

Cuick Command x

MName: |R'I'I' 1

Command

Command: ‘Request To Tak j

" send to Radio Group
¥ Send to Radio

Recipient:

® 13
W@ 125

® 235

@ 555

@ 3333

(®) 444

® 5555

@ Rradio 300

-G
Selected: 1

& |- |:=|-

= Command
From the drop-down list, select Request To Talk.

= Send to Radio Group
Choose this option to send the request to talk to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the request to talk to individual radios
registered in the system. In the Recipient box, select target radios.
6.5.6.8 Custom Event

= Command
From the drop-down list, select Custom Event.

= Event ID
Specify the event ID.
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6.5.6.9 Send Swift Command

Cuick Command X

MName: |5'N|f't 1

Command

Command: ‘Send Swift Command

ENREY

Swift Command: ‘Swiﬁ: Command 1

0=

0=

¥ send to Radio Group
" Send to Radio

Recipient:

System Group
Capadty Plus #1 Firemen |
o Add % Delete

oK Cancel

= Command
From the drop-down list, select Send Swift Command.

= Swift Command
From the drop-down list, select the appropriate Swift command.
Enter the required parameters, if any.

* Send to Radio Group

Choose this option to send the Swift command to radio groups registered
in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the Swift command to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.7 Queued Messages

This feature enables dispatchers to send audio messages even if the channel is
currently busy. The dispatcher records a message to be sent to a busy channel and
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then TRBOnet automatically forwards this message as soon as the channel becomes
available:

File View Map Teols Help

Radio Interface

a ‘R Online Dispatehers
D pispatcher 1

& Group

© ) Cleaners
(%) Radio 200
(£)(D Radio 201

Drag and Drop PTT Box here to
create new group

Cleaners

5 Playback [ Save~ (2 Print |11 Pause < Clear - & Reload | [ Filter By Radio | = Grouping |7 Aute Filter

Date | Radio Syst... | Sender |Recpient | Message | Detais. | Note |

15hov-2016 18:26:23  Repester... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher... Members: Dispatcher 1
15Nov-2015 18:26:35  Repeater... Dispatcher 1 Firemen Dispatcher ‘Dispatcher... Members: Dispatcher 1
S 16-Nov-2016 10:22:05 Server Al Connection to Repeat.,

|« | < | Record 679 of 679 b [ w| i < | »
Recent Calls/Events | Recent Calls | Request to Takk | Radio State | Active Tasks || Active Routes | User Actvity | Map | Cameras

6127001 &3 B & | © Dispatcher 1 | (8 Licensed to: demo Dema License | @ Active~

To queue an audio message for delivery to the selected recipients, first record a
message by clicking the Record button. Alternatively, you can select an MP3 or WAV
audio file from any storage location, or select a prerecorded message from the
library.

6.5.7.1 Select Audio File
e Click File > Open Audio File and browse for the audio file on the local PC.

Open Audio File...
Audio Message Library
= . ]

Voice Message

6.5.7.2 Audio Message Library
You can select an audio file from the Voice Message templates.

e Click File > Audio Message Library.

Saved Audio Files X

GF Add % Remove | \? Filter | Hot Key

Filename Description Severity Hot Key Visibility
Alarm Tone Alarm Hidden
» | Bobby.mp3 Information ]

Daisy.mp3 Information Link

sed_| cance_|
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Select an audio file in the list and click OK to use this file as a queued Voice
Message.

6.5.7.3 Record Audio File

You can record a voice message that can be sent to selected radios.

Click Record > Record audio to open the recording tool:

Record audic

Convert Text to Speech

d

= Click Start and start talking to the microphone.

Record audio

00:17

""‘lll""‘l"""""\""'\iI‘l"1L'l]ﬁ\|,FIb"|k""1"l"-."f'1l"' ‘tu,,.___.____._.__.___._

Convert Text to Speech

= Click Stop to stop recording the message.

Convert Text to Speech
|u Send HL] Cancel | |H Save |‘|

= Click Send to send the recorded message immediately.

= (Click Save > Save as file to save the recorded file as an audio file on the
PC.

Or:

= (Click Save > Save as Saved Audio File to add the recorded file to a list of
the Saved Audio Files.

6.5.8 Activity Monitor Panel

While in this panel, the dispatcher can perform a wide range of tasks, including:

Monitoring and listening to recent calls and viewing system events
Monitoring selected radio state

Monitoring active tasks for selected radio

Monitoring active routes for selected radio

Enabling and disabling User Activity monitoring

Displaying selected map in a compact view mode

Monitoring cameras connected to Dispatch Console
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6.5.8.1 Recent Calls/Events

In the Recent Calls/Events tab, the dispatcher can monitor recent Server events,
view and listen to recent calls.

File View Map Tools Help
Voice Dispatch
EBl=t & RV a8

Radio Interface |&]9)
- Radio Interface|_Recent Cals/Events
~ Quick Commands ~
: @ @@1 o

5o Eo<p Cooe )
() ® 125 Pete) Eev Queued Messages  [X]

epeater
ree chann
alcal

{R:n:at:r #1: Slot #2 [ @l

)@ 222 N
(#)(® 235 Basi) oe v

£)( Radio 200
#)(2) Radio 201

o: Selected Channels

Voice Message

Free channel
Al cal

A1, Voice Dispatch hd
“cecent CallsfEvents »
g Location Tracking [ Playback |l Save~ () Print | 11 Pause <7 Clear + i Reload | “[fj Filter By Radio | = Grouping |7 Auto Filter
Date Radi System Sender Recpient | Message Detziis Note
@ Job Ticketing -
D 16-Nov-2016 15:22:16 Repeater #1: Slot #2  Administrator Al All Call from dispat. Members: Administrator
[j Route Management [ 16-Nov-2015 15:22:15 Repeater #1: Slot 1 Administrator Al All Call from dispat... Members: Administrator
- D 16-Nov-2016 15:22:15 Intercom Administrator Al Intercom Call: Disp... Members: Administrator
0] RFID Tracker 16-Nov-2016 15:22:12 Repeater #1: Slot #2  Administrator Cleaners Dispatcher ‘Adminis... Members: Administrator
16-Nov-2016 15:22:12 Repeater #1: Slot ¥1  Administrator Firemen Dispatcher ‘Adminis... Members: Administrator
[=] Text Messages (£ 16-Nov-2015 15:22:07 Repea jot 1 Administrator al AllCall from dispat... Members: Administrator
D 16-Nov-2016 15:22:07 Repeater #1: Slot #2  Administrator Al All Call from dispat. Members: Administrator
ﬁ ” D 16-Nov-2016 15:22:06 Intercom Administrator Al Intercom Call: Disp... Members: Administrator
SB16-Nov-2016 13:33:09 235 Al Reset Geofendna A
= |« 4| RecordSofess b | m|mi| « S
e Qecenlcal\s/&/enﬁ RecentCalls | ReuesttoTak | RadoState | AchveTasks | ActiveRoutes | User Activity | Map | Cameras Y,
[@ 127001 &3 B B | & Dispatcher 1 | [ Licensed to: demo Demo License @ Active -

Voice Recording
Play back selected call(s)

e Select the voice call recording you want to play back and click the E5) Playback

button on the left of the toolbar.

The Audio player box will appear.

[ Audio player H

Duration:
Left:

Position

T Pause 1| Player re Open
All Call from dispatcher ‘Administrator’ (00:03)
Clear

= Click the Play button to play back the recording.
Click the Pause button to make a pause.
Click the Stop button to finish playing back the recording.
Click the Open button to select a new audio file to play back.

Note: You can play back multiple recordings in a row. Use the CTRL
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and/or SHIFT keys to select multiple recordings you want to play
back. Then click the =0 Playback| b o,
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Save selected call(s)

e Select the voice call recording (or multiple recordings, with the help of
CTRL/SHIFT keys) you want to save as an audio file.

¢ Click Save > Save Selection as Individual Files to save selected recordings in
separate files.
Or

e C(lick Save > Save Selection as Single File to save selected recordings in a
single file.

¢ In the Save As or Browse For Folder dialog box, browse for the folder where
you want to save the file(s).

Recent Calls/Events Toolbar

% Playback (=l Saver () Print | 11 Pause <# Clear 54 Reload | “[J Filter By Radie | = Grouping | 7 Aute Filter @ Default Settings | 7 Details | [7] Show Notes [ Add Note Add Message
Click the Pause button to pause updating the Recent Calls/Events log.

Click the Clear button to clear the Recent Calls/Events log records.

Click the Reload button to reload all log records.

Click the Filter By Radio button to filter log records by a selected radio/radio group.
In the Radio List pane (the upper-left-pane of the main window), select a radio or

radio group. The Recent Calls and Events for a selected radio will only be displayed
in the Recent Calls/Events pane.

Click the Grouping button to group log records. Select the column you want to
group log records by. Drag and drop the selected column header to the Grouping
field.

Click the Auto Filter button to set a filter for the recent calls and events. You can
filter the Recent Calls/Events list by any parameter. For example, to filter the list by a
selected Sender, select the Sender column (1), and start typing the sender name (2).

[ Playback [ Save~ () Print | 10 Pause <# Clear ~ i Reload | [ Filter By Radio | = Grouping|| 17 Auto Fitter || Details | ["] Show Notes

»)
Date Radio System /Sender ¥ Recpient Message
d B

T6-Nov-2016 16:54i16 Repeater #1:slot =1 | Dispatcher Dispatcher T calls group ..
[£] 16+0v-2016 16:5%09 Repeater #1: Slot 22 Dispatcher 1 Al Call from dispatcher ‘Dispatcher ..,
16-ov-3015 16:53:57 Repe: ot =2 Dispatcher 1 oiice Dispatcher Dispatcher 1 cals group "
16-Nov-2016 16:53:57 Repe: ot #1 Dispatcher 1 Dispatcher ‘Dispatcher 1" calls group "

1 Dispatcher 1 AllCall from dispatcher Dispateher 1.,
1 Dispatcher 1 Allcall from dispatcher ‘Dispatcher 1.,
i Dispatcher Dispatcher 1 calls gr

7] 15-Hov-2016 18:26:36 Rp

m «]4] Re(urdquEU STw] »

=le - it Fiter

Recent Calls/Events | RecentCalls | RequesttoTak | RadioState | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

Click the Default Settings button to apply default settings to all log records.

Click the Details button to see the talk session participants:

[ Playback [ Sove~ (2 Print | 11 Pause <# Clear - '&i Reload | [ Filter By Radio | = Grouping '\ Auto Filter ||| Details | [ Show Notes

Date Radio oSy Sender ¥ Recpient Message Detais
. 16-Nov-2016 16:54:16 Repe: Jot =1 Dispatcher 1 Firemen Dispatcher Dispat r ' ... JMembers: Dispatcher 1 -
[ 16-4ov-2016 16:5%03 Repe: lot £2 Dispatcher 1 Al Al Call from dispatcher ‘Dis... [Members: Dispatcher 1
16-ov-2016 16:53:57 Repe: lot £2 Dispatcher 1 Police Dispatcher Dispatcher 1'c... [Members: Dispatcher 1
16-Nov-2016 16:53:57 Repe: Jot #1 Dispatcher 1 Firemen Dispatcher Dispatcher I'c... [Members: Dispatcher 1
D 16-Nov-2016 15:35:23 Repes 1 Dispatcher 1 Al All Call from dispatcher Dis... [Members: Dispatcher 1
D 16-Nov-2016 15:35:16 Repe: #1 Dispatcher 1 Al All Call from dispatcher ‘Dis.... [Members: Dispatcher 1
15-ov-2016 18:26:36 Repe: lot #1 Dispatcher 1 Firemen Dispatcher Dispatcher 1'c... [Members: Dispatcher 1
15-Nov-2016 18:26:28 Repeater lot #2 Dispatcher 1 Cleaners Dispatcher Dispatcher I'c... [Members: Dispatcher 1
] 15-Hov-2015 18:26:21 Repeater #1: Slot #1 Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1" c... mhers: Disnatrher 1 A
LIk ord 0 LIRS 3
B - Eciit Fiter

Recent CallsEvents  RecentCalls  RequesttoTak  RadioState | Active Tasks | ActiveRoutes | User Activity | Map | Cameras
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Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the recent calls and events will be shown in the
Notes column. So, you can mark recent calls and events to later find them by notes.

Click the Add Note button to add a note for the selected recording and/or event.
The notes will be displayed in the Recent Calls/Events log if the Show Notes mode
enabled:

Click the Add Message button to add a message for dispatchers to the Recent
Calls/Events log.

Add user message X
Recipient: | Al j
Severity: ® Information -

Message: Test| j
=

= Recipient
Select either All or an individual dispatcher if you want to see the message.

= Severity
Select the severity level to inform dispatchers about the level of importance.

= Message
Enter the message text.

= Click OK.
As a result, the message will be added an event to the Recent Calls/Events
pane.

6.5.8.2 Recent Calls
On the Recent Calls tab, the dispatcher can see and configure the latest Voice calls,

including Private, Group, and Intercom calls:

Recent Calls

Types: | & Private | &b Group OAII Call | <3 Clear 7 Filter

aller Call Mumber Actions

Most Recent Call

-] 27.04.2017 12:1 1 3 5 13L&
d All call Group Call Private Call
4 1 calls:1 1 2 Calls: 3 Calls:1
4 27.04.2017 12:19 27.04.2017 12:18 27.04.2017 12:18

7] 27.04.2017 12:03 235 1 121K |

Recent CallsfEvents | RecentCalls  RequestToTalk  Radio State | Active Tasks | Active Routes  User Activity = Map =~ Cameras

e Click the Private button (1) to display the latest Private calls.
e Click the Group button (2) to display the latest Group calls.
¢ Click the All Call button (3) to display all call types, including Intercom calls.

In a Call Box, you can see the number of calls and the last call date and time:

LS4~ | Allcall
2 A calls:1
S 2014-07-07 14:02:47
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6.5.8.3

Click the IS/ button to start a Private call to the Sender-Radio (Radio is displayed in
the Sender column).

Click the V] button to mark the calls as viewed.
Click the [#%/ button to clear the recent call history.

Request to Talk

On the Request to Talk tab, the dispatcher can see Missed Calls and Requests to
Talk:

Reguest To Talk [ ]
Types: | '@ Missed Call | J Request ToTalk | View: | [ Table 52 Cards | < Clear Y/ Filter | [5b Options
Most Recent Call Caller Accepted/Queued Call Type Call Mumber Actions
18.04.2017 17:30 @® 125 Dispatcher 1 A RequestToT... LS
W4 | 4 |Record 1of 1 » | |m|4 »

Recent Calls/Events | RecentCalls = RequestToTalk Radio State | Active Tasks | User Activity =Map = Cameras

e Click the Missed Call button to display Missed calls.

e Click the Request to Talk button to display Requests to talk.
e Click the Table button to display the calls in a table view.

e Click the Cards button to display the calls as a set of cards.

e Click the Clear button to clear all the records.

e Click the Filter button to set a filter for the records. You can filter the records
by any parameter. For example, to filter by the caller select the Caller column,
click in the empty row and start typing the caller name.

¢ Click the Options button to specify options related to Request to Talk:

Request To Talk *
Dispatcher! | Notifications

¥ Enable Request To Talk workflow
¥ Show RTT notifications in @ pop-up window
I¥ after dicking Accept, starta return call
¥ Play a sound when RTT notifications arrive
¥ show notification in the Windows tray
I¥ Synchronize with other dispatchers
v automatically delete Request To Talk record after responding
Iv wait for response from caller

I¥ Enable Responses to a Radio Group

Talk Group: Home Radio Group j

Cancel

= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.
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Request to Talk

J 125
. The Reguest to Talk has been received.
d) You must accept or reject it.

Reject Queue

o After clicking Accept, start a return call
Select this option so that a return call will start as soon as the Accept
button is clicked.

Play a sound when RTT notifications arrive
Select this option so that an alert tone will sound when a Request to Talk
arrives.

Display notification in the Windows tray
Select this option so that a notification will be displayed in the Windows
tray when a Request to Talk arrives.

Synchronize with other dispatchers
Select this option so that a Request to Talk sent to one dispatcher will
automatically be forwarded to all dispatchers.

Automatically delete Request to Talk record after responding
Select this option to automatically delete the corresponding record after
the Request to Talk call is responded.

Wait for response from caller
Select this option so that a Request to Talk will be considered responded
only if the radio has answered to the return call.

Enable Responses to a Radio Group
Select this option so that a response to a Request to Talk will be made to
the selected radio group.

e Talk Group
From the drop-down list, select the radio group.

Note: If the Home Radio Group is selected, and the Home Group
is not specified for the radio that initiated a Request to Talk,
then the response to this Request to Talk will be made as
an All Call.
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On the Notifications tab, specify the following parameters:

Request To Talk X

Dispatcher 1

¥ Send notifications to caller
¥ Autodetect notification type
" Send Text Message

" Send Audio Message
Notification texts:

Queued: |Ca|| queued

Rejected: |Ca|| rejected

Not Available: |Dispatcher is not available

Cancel

= Send notifications to caller
Select this check box to notify the radio when a request is rejected, queued,
or the dispatcher is unavailable.

e Choose one of the option buttons below to specify the way the radio is

notified.

v Autodetect notification type
Choose this option button so that the type of notification will be
selected automatically depending on whether or not the Text
Messages Service is enabled on the radio.

v Send Text Message
Choose this option button to send text notifications to the radio.

v Send Audio Message
Choose this option button to send voice notifications to the radio.

¢ In the Notification texts boxes, enter the corresponding notification

texts. These texts will be used when sending text notifications to the
radio.

6.5.8.4 Radio State

On the Radio State tab, the dispatcher can see the log of radio states for the radio
selected in the Radio List pane (the upper-left-pane of the main window):

125 (Pete)

@=@

Show Notes Add Note Add Message

Date Dispatcher 4/smEte
5”;;'”;1 Set #2 17-Nov-2016 11:35:22 Reset Geofencing Alarm -
S 7oy IuTE s | T Mev2us 113515 Geofendng e: 17-Nov-2016 11:35:15; Latitude: 59°56'27. 78°N; Longitud...
spead:  D.4km 17-Nov-2016 11:35:15 Radio left oute 1
Atude:  Unknown 17-Nov-2016 11:35:15 Radio left allowed region Route 1'
Lofitude:  59°5627.78°N 16-4N0y-2016 10:34:20 Radio Online
Longitude:  30°16'47.08°N 15-Nov-2016 18:47:22 Radio Offine
15-Nov-2016 14:01:27 Radi Oniine
15-Nov-2016 14:00:25 Radio Online
15-Nov-2016 11:25:26 Radio Online

RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

In the Radio State pane, the dispatcher can do the following:
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6.5.8.5

6.5.8.6

276

Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the radio state records will be shown in the Notes
column. So, you can mark radio state records to later find them by notes.

Click the Add Note button to add a note for the selected radio state record. The

notes will be displayed in the Recent Calls/Events log if the Show Notes mode
enabled:

Click the Add Message button to add a message for dispatchers to the Radio State
log.
Active Tasks

On the Active Tasks tab, the dispatcher can monitor all active tasks for the selected
radio (for example, Lone Worker, Active Routes, and other tasks).

il Stop | = Grouping ' Auto Filter (» Default Settings

Task Radio State
Lone Worker 1 125 (Pete) R0 = 12:31

Timer 235 (Basi) 0.00:29:15 - Timer started.

id| 4] 4| Record 102 b [ wr[mi[ ¢

Recent Calls/Events | Recent Calls | RequesttoTalk | Radio State | Active Tasks  ActiveRoutes | User Activity | Map | Cameras

The dispatcher can manage active tasks as follows:
Click the Stop button to stop executing the selected task.

Click the Grouping button to group the tasks. Select the column you want to group
tasks by. Drag and drop the selected column header to the Grouping field.

Click the Auto Filter button to set a filter for the active tasks. You can filter the tasks

by any parameter. For example, to filter by selected radio select the Radio column,
and start typing the radio name.

Click the Default Settings button to apply default settings to all active tasks.
Active Routes

On the Active Routes tab, the dispatcher can monitor all active routes.

b start | 1l Pause Ml stop | =} Edit @) Export~| = Grouping '/ Auto Filter ©» Default Settings
Name Route
b Route 1 00:01 12:21 1231 10:00 10:40

(¢
17-Nov-2016 12:20 Pointi o

#|«| <« Record1of1 » | » M <
RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras

The dispatcher can manually set statuses for route checkpoints. To do this, right-
click a route point and from the drop-down menu, select the desired status.

= Waiting
The checkpoint is waiting to be attended.
= Attended
The checkpoint has been attended on time.
= Unattended
The checkpoint hasn't been attended on time.
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= Alarm
The checkpoint is in Alarm mode.

= Note
Click this item to add a note to the selected checkpoint. The note will be
displayed in the pop-up window that appears when hovering the mouse
pointer over the checkpoint.

6.5.8.7 User Activity

e Click the User Activity tab to monitor the activity of radio users:

. Disable the User Activity monitoring | <> Configure.

Off Duty Al mime [ On Duty A Tme | User Activity #1 4| Time

% 111 B @ 235 13:15:01 @ 125 13:15:09
(&) Radio 200

(@ Rado 201

(@ Radio 202

(@ Radio 203 ==

Radio 204
@retom: =

RecentCals/Events | RecentCalls | RequesttoTalk | Radio State | Active Tasks | ActiveRoutes | User Activity | Map || Cameras.

¢ Click the Configure button to configure the User Activity list:
6.5.8.8 Map

On the Map tab of the Activity Monitor panel, you can monitor location of radios on
the map and simultaneously perform all available actions in the Radio Interface
pane (make voice calls, send messages, disable and enable selected radios, and
other actions):

) 0L iy | Fites @] @[ Q@] 17 | Show Beacons: 41 + | Ruler 4 FindonMop~ 4, & Drowing Panel (| Route» <& Geofencing ] Coverage Map | | Select Map i} Gongle Earth
o S
‘Lg)/
.
?’L
¥
‘0
N9
&
5 o
Walt %, o
235 (Basil) 3 % ;o)
5, Lathude: 58°56:27.56N: Longtude: 3071631 91°E

125 (Pete)
Recent Calls/Events  Recent Calls REG)ESttﬂTEk Radio State ~ Active Tasks ~ Active Routes ~ User Activity Map  Cameras

For more details on map options, see section 6.6, Location Tracking (page 280).

6.5.8.9 Cameras

On the Cameras tab of the Activity Monitor panel, you can monitor cameras
connected to Dispatch Console.

ff Add -

[camera 1 ~|

7-2017 YTB 15:22:02
3 —

1

Close Close

Recent Calls/Events | RecentCalls | RequestTo Talk | Radio State | Active Tasks | Active Routes  User Activity = Map = Cameras
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e Click the Add button and select a camera to be displayed on the tab.

Note: You can add up to four cameras to the Cameras tab view.

6.5.9 Phone Calls

The Telephony function allows making calls from telephones to radios and vice
versa.

The phone system must be previously configured by your TRBOnet administrator.

6.5.9.1 Phone Calls from/to Dispatch Console

To make a phone call from the Dispatch Console:

[@ Telephony E‘
/ 2

[irel: 2400 ¥ -
s Jpred] =
Jotinet || ez 4| Lnes

|
1/\ tine 4 | Line 5 4| Lnes
T

!

|

|

3
===
e 7 ) [
‘. = #

o|lew e |m

>,

¢ In the Telephony box, select the Line (1), enter the phone number (2) and click
the I *™ (3) button.

Terminate a phone call

e In the Telephony box, click the |i| button.
Open a phone book

¢ In the Telephony box, click the ellipsis (...) button (2) or click Menu > Phone
Book (2):

@ Telephony 2 \ E‘
i |

b [ Menn || =
Hold Call

-Linel

| Forward Call...

IlJ] Phone Book |
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Answer an incoming call

@Telephunv E
[wair -]
S e

[Lune1 ]| ne2 | tnes |

j tine4 || tines 4| Lines |

=

\" E :j

¢ In the Telephony box, click the E (3) button.

Forwarding Phone Call to a Radio

¢ While in a call, click Menu > Forward Call.

@ Telephony

[Tel: 2400 - ]

Menu “I’ - 1|

-
E Hold Call
| Forward Call... |
pLine 4

u Phone Book
|

SR i | |

R

7 e s Ao

i |

/

Forward Call H
AH + Specify text to searh
i =

- 125 (Pete)

g Dispatcher é 235 (Basil)

Radio — 1

Radio Group 2
Q Phone
4 3

Conference Forward | Cancel

e Click the Radio tab (1), select the radio (2) and click Forward (3).
Add call participant(s)

e C(lick Conference (4).

Note: Only one radio or radio group can participate in a conference call.
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6.5.9.2 Making Telephone Calls from Radios

6.6

280

Make a DTMF call

Note: Only 1.07.02 and higher firmware version for all radios equipped
with dialing keyboard support DTMF.
To make a DTMF call, do the following:

=  Press the PTT button on a portable radio and hold it.

= While holding the PTT button, dial a phone number and press # (For example,
0079521112233#).

= Release the PTT button. The server will automatically initiate a phone call.

Call by sending Text Message
To make a phone call, send a text message with the text PrefixN where:
e Prefix — is a short text to define the special text message (for example, sip:);
¢ N - the phone number.
For example, to initiate a call to a phone subscriber "123 456 7890", the following
text message must be sent to TRBOnet Server: "sip:1234567890".
Terminate a call

To terminate the call, press the PTT button and then press # twice on the radio.
Location Tracking

In the Location Tracking tab, the dispatcher can monitor selected radio location on
supported maps, open different maps in separate tabs and toggle between map
tabs:

File View Map Tools Help

®DRado204 QBW

& [} Firemen o
BH@m

BING_ROAD'
0 1 | Fier| @[ @) [0 @] 17 | showBeacons: a1 ~ | & Ruler (4 FindonMap- 2| ¥ L Mep Opects
(=] % o 4 [ Abiding place
B D222 % 2 JE\ % 2 [ Fire dep
| () (S 235 (Basil) (©) . K %, ¥ [#] Hospital No2
- Hospital No2 %
o i 12 [ Police department ...
(&) Radio 200 » Fire dep Z i
= g © G54l [ Map Regions
% e < @ +7 vy zone
(1Y voice Dispatch & o -] [ Map Routes
?’0\\4“ [ g Route 1
% Location Tracking = e
s g :
5
% 100m 235 (Basil) ¥
P
;] Route Hanagement 5, & Latitude: 59°5623.96"N: Longituds: 3071634 85°E
@ Recent Calls/Events ™
RFID Tracker X — 5
I Playback [l Save~ (G Print | 10 Pause <3 Clear - i Reload | [ Filter By Radio | = Grouping 7 Auto Filter @ Default Settings
[~ it Hcssages Date Radio System | Sender Redpient. Message Detals Note
[ i8-Nov-2016 10:41:45  CapacityPLUS  Server 235 The Route 1 is finished ﬂ
17-Nov-2016 20:51:23  Cz PLUS 345 125 Private Call: Dispatcher '34. Membe 345, 125
g‘ ~ [1] ov- apadityf rivate Cal: Dispal Er‘ eeeee
o 17-Nov-2016 20:51:16  CapacityPLUS 125 345 Private Call: Subscriber '125... Members: 125
o 17-Nov-2016 20:50:44  CapacityPLUS 456 125 Private Call: Dispatcher *45... Members: 456, 125
F o 17-Nov-2016 20:50:32  CapadityPLUS 456 125 Private Call: Dispatcher *45... Members: 456, 125 -
6| 4] «| Record 10f392 b [ |m] 4 3
] Radio Allocation Recent CalsfEvents | RecentCals | RequesttoTak | Radio State | Active Tasks || Active Routes | User Activity | Beacons | Beacon Events | TagList
fE

127001 &3 B | § 35 | (8 Licensed to: demo Der

The main user interface elements are as follows:
1. Radio List pane

2. Voice panel
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3. Map panel

4. Objects panel

5. Activity Monitor panel

While in the Activity Monitor panel, the dispatcher can perform a wide range
of tasks, including:

6.6.1 Objects

Monitoring and listening to recent calls and viewing system events
Monitoring selected radio state

Monitoring active tasks for selected radio

Monitoring active routes for selected radio

Enabling and disabling User Activity monitoring

Monitor beacons and beacon events.

On the Objects panel, the dispatcher can view and enable/disable the following

objects:

e Beacons - all beacons connected to the system.

e Map Objects — all manually created map objects and predefined objects
created with the Map Drawing toolbar.

e Map Regions — all map regions created with the Map Drawing toolbar (use
the Add Polygon tool to create a map region).

¢ Map Routes — all map routes created with the Map Drawing toolbar (use the
Draw Route tool to create a map route).

6.6.1.1 Beacons

TRBOnet Dispatch Software provides the Indoor Positioning feature to monitor the
location of radios inside a building where no GPS signal is available. This feature
requires additional hardware (the beacons spread around the building and the
option boards in radios). A radio user will be displayed on the indoor floor plan
when the radio enters the beacon coverage area. The beacon icon on the map
displays the amount of radios that are currently in the beacon coverage area.

File View Map Tools Help

Location Tracking Map |8 |<0]EB] oviects |
=k &V 4 BING ROAD X/ scheme X] . E
5;) [i§ Teo ~ | Show Beacons: Al + | Show Info:
B -4 5]
@ | ) Firemen
L H 21 Beer
® ® @ B (coftee 2
R E——— e R n [Beer o] o foom 1 J-[] [ Map Obiects
Lo 2 O[] camera 1
fish Vowe Disatch ; . I 7 = N | o, (%] Hospital
s S ™~ \ I [ Police
% Location Tracking —p ‘ [ & Map Regions
il ‘ \'\b@_yMspnues
@ Job Ticketing - I s @30 111
- el \ /
Ej Route Management e | 4 o NP,
‘ I[Coffee 1 v
0l] RFID Tracke: X @z}s \ !
o3| /
RS Beasons g
ﬁ Vo Show: |Al v | | 7 Auto Filter @» Default Settings
Name Desaription Radios Previous Detection
(a Reports i Tea 08.06.2017 14:53:58
S
() Coffee 235 08.06.2017 14:55:18
15 event viewer {9 Beer Beer tap 08.06.2017 14:53:34
el e v [m]m] 4 3
| Radio Atlocation Recent CalsfEvents | Recent Calls | RequestToTalk || Radio State | Active Tasks | Active Routes | User Activity Beacons | BeaconEvents | TaglList
127001 &3 & | § Administrator | [28 Licensed to: demo @ Active-
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6.6.1.2

6.6.1.3

282

Beacons are displayed on the building floor plan (1) and in the list of beacons (2) in
the Objects panel. When a radio comes into the range of a beacon, they both are
highlighted in yellow on the floor plan/map (3).

For more details on beacons, see section 6.13, Beacons (page 321)
Map Objects

The dispatcher can create custom and predefined map objects using the Drawing
Panel. The dispatcher can attach 2D or 3D floor plans for Indoor Positioning.

For more details on creating map objects, see section 6.6.2.7, Drawing Panel
(page 285).

In addition, the dispatcher can import and export map objects.

Importing map objects
¢ In the Objects panel, right-click the Map Objects folder and choose Import.
In the Import Map Objects dialog box:
= Click Load and select on the drop-down menu select the file format (Excel,
CSV, or KML/KMZ).

Note: The Excel file you are importing from must contain at least
three columns (Name, Lat and Lon). Also note that the first
non-empty row in the table will be considered as a header
row. The .CSV file must contain 8 comma-separated values
in each row.

= In the Open dialog box, locate the desired file and click Open.
= Click Import.

As a result, imported map objects will be added to the list of map objects.

Exporting map objects
¢ In the Objects panel, right-click the Map Objects folder and choose Export.
In the Export Map Objects dialog box:
= Select the required objects by checking their check boxes.
= Click Export and from the drop-down menu select the file format (Excel or
Csv).
= |n the Save As dialog box, locate the folder where you want to save the file,
type a filename, and click Save.
Map Regions

The dispatcher can create map regions that can be used for Geofencing rules. The
map Regions can be created manually on the map (click any point on the map to
select it as a region border) or, the dispatcher can add map points by GPS
coordinates to create a region.

For more details on creating map regions, see section Draw a Map Region
(page 285).

In addition, the dispatcher can import and export map regions.
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Importing map regions
¢ In the Objects panel, right-click the Map Regions folder and choose Import.
In the Import Map Regions dialog box:
= Click Load > Excel.
Note: The Excel file you are importing from must contain at least

two columns (Name and Points) and at least three points
in the second column. Also note that the first non-empty
row in the table will be considered as a header row.

= In the Open dialog box, locate the desired file and click Open.

= Click Import.

As a result, imported map regions will be added to the list of map regions.

Exporting map regions
¢ In the Objects panel, right-click the Map Regions folder and choose Export.
In the Export Map Regions dialog box:
= Select the required regions by checking their check boxes.
= Click Export > Excel.

= In the Save As dialog box, locate the folder where you want to save the file,
type a filename, and click Save.

6.6.1.4 Map Routes
The dispatcher can create routes on the map that can be used for Geofencing rules.
For more details on creating map routes, see section Draw a Route (page 288).
6.6.2 Map Tools
The Map toolbar is located in the upper part of the Map pane:

/"BING_ROAD

% iz fites @] @] Q 7 Show Beacons: Al ~ | & Ruler X Find on Map~ 4, | # Drawing Panel | Gl Route~ <& Geofencing il] CoverageMap | | SelectMap A% Google Earth
5 =, & % %
* % ) ‘e %
% % =} ) >
3 : ;
o A8 Z
R Police 5N 3 2
¥ A % 2 % 98
o % % A £
%, g | s o
o % 's
() % K L
'S % % Os?
& o Tea (0) 5 - a1 %
s S L.ﬂ 5 %
& o« @ o . >
el Hospital e % %
g " / 5 evskiy Islan b %

2

% 40 . ‘o
% o
= o il Latitude: 59°5630.58" N: Longtude: 30°1650.72" E

6.6.2.1 Zoom in/out
e Click to zoom in a map.
e Click to zoom out a map.
6.6.2.2 Bookmarks

e Click to put a bookmark on the map.

e Click Save as Bookmark to save the map region as a bookmark.
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6.6.2.3

6.6.2.4

6.6.2.5

6.6.2.6

284

Save as Bookmark X

Name: Prince garden

Cancel

e The dispatcher can create any number of the bookmarks. To open a bookmark,
click and select the bookmark in the list.

Default View

e Click and choose Save as Default View to save current map view as a
default view. The dispatcher can save only one default view.

To open the default view, click and choose Show Default View.

Filters

Select the filters to display radios on the map:
- radio is online, beacons are detected;
- radio is online, GPS data is received:;
@I - radio is online, no GPS data is received;

- radio is off, no GPS data is received.

All filters are enabled by default. Click the selected icon to disable selected radios on
the map.

Click the button and select the visibility of the radios having On Duty and/or
Off Duty states.

Click the button and select which radios to hide according to the radio groups
and/or logical groups they belong to, and the map regions they are currently in.

Click the button to toggle showing object names on the map.

Ruler

e Click to enable the tool to measure distances on the map.

e Left-click a point on the map to start measuring. Left-click intermediate points
and see the distance displayed at the mouse pointer.

Search by Address

The dispatcher can search map objects by their address.

Note: For online maps, Internet access is required!

. CIick|0h Find en Map | g choose Address to find an address on the map.
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Search by Address (BING_ROAD) x

Broadway 18 5

18 Broadway, Tamytown, NY 10591, USA
18 Broadway, S MA 021 5.
18 Broad:

18 Broadway, Denver, CO 80203, USA

Close

e Click the address in the list to display it on the map.

File View Map Tools Help

G 1 Lne free
3 cal
¥ (@ Beer
v
e v viap [ Foorpr_ ] DG
e BNE ~ | Filter: Show Beac Al [/ Map Objects
& [ ) Poiice GOk | e [P[OIQ @ [2] 20z 18 Broadway. Somervile, MA 02145, USA 9] canera 1
18 Broadway, Tamylown, NY 10531, USA
e Di 18 Broadway, Lawrence, MA 01240, USA ) [##] Hospital
(i Voice Dispatch . 18 Broadway, Park Ridge, NJ 07656, USA 9 [ polce
%) e [/ Map Regions
% Location Tracking & X 18 Broad i -7 Region 1
L & Z 18 Broadway, Bayorme, NJ 07002, USA [ v Routes
oy, & S 18 Broadway, Newport, R 02340, USA
ﬁ Job Ticketing oy 18 Broadway, Denville, NJ 07834, USA WI$e 111
_ | (140
(58
e (18 g &
8
e 5
i _ Recent Calls/Events
= Playbeck [l Seve~ & Print | 11 Pause ¥ Clear + & Reload | T Filer 8 };wls | [ Show Notes |
@ Reports Date | Radio System | Sender | Recipient [Message [Detale |
S 09.08.2017 14:43:57 Server Al Connection to ‘Capadity Plus 1 has been... -
F oo 09.06.2017 12:43:30  Capadty Plus 1 Administrator 11 Dispatcher 'Administrator’ calls group '11... Members: Administrator, 125
09.05.2017 12:40:06  Capacity Plus 1 125 11 Radio '125' calls group '11' {00:08) Members: 125
ﬁa g 09.06.2017 12:39:55 Capadty Plus 1 Administrator 11 Dispatcher 'Administrator’ calls group '11... Members: Administrator
09.06.2017 12:38:34 Capadty Plus 1 Administrator Police Dispatcher 'Administrator’ calls group 'Po... Members: Administrator A
|4 4| Record1of305 »|w[mi[ 4] »
@ Recent Calls/Events | Recent Calls | RequestToTalk | Radio State | Actve Tasks | || user actuity | geacons | | raguest |

127001 &3 € | 8 Administrstor | [ Licensed to: demo

6.6.2.7 Drawing Panel

e Click | Drawing Panel to display the Drawing toolbar:

Vasil'yevskiy Island
Saint
Andrew's
2. Cathedral

o

‘ Latitude: 59°56'31.82" N; Longitude: 30716'46.55" E

Draw a Map Region

Draw a region manually
e Click and choose Draw on the map.
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e Left-click points on the map to create a new map region.

ERES \‘,j {aia ‘ Fniter _ J |.‘ Show Beacons: Al - ‘ & Ruler ‘ # Drawing Panel | ff] Coverage Map =
T8O PO O ® 0 R | 2 Custom Object-

Draw a polygonal region Save  Cancel
Click on the map to mark corners of a polygonal region. If you make a mistake, right-dick to delete the last placed corner point. The first and the last points
will be autoconnected to form a dosed polygon. When you are done, dick Save and spedfy additional properties of the region.

Abiding place

Lot
&
o

Vasileostrovskaya &

Z

E)
rA
©
Hosplml No2 5
Fire dep
100 m e“"\
\,9‘1 Latitude: 59°5635.54"N; Longitude: 30°1653.25"E

e Click the Save link to add a new polygon region.

"/\

\A\‘E‘

Object on Map X

General Region  Logical Groups

Mame:; Zone 2

Description: Fecrete area

Cancel

= Name
Specify a name for the new map region.

= Description
Enter a description for the map region.
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Region tab

Object on Map X

General Region  Logical Groups

Color: I 0, 0, 255 ﬂ

Fill region area

Transparency: |30 + %

Cancel

= Color

Select a color to display the region on the map.
= Fill region area

Select this check box to fill in the region area on the map.
= Transparency

Specify the transparency level (in percent) for the fill color.

Draw a region by coordinates

e Click @ and choose Specify coordinates.

Create Region by Coordinates X

Latitude Longitude G )] o=

59,0000000  25,0000000 Tamnn - ——.__
58,5000000  27,0000000 :

53,0000000  25,0000000

Eesti

70 km

Latitude: 59,2827203; Longitude: 25,9437070 |

@ add [EbEdt X Delete | Selectmap

e C(lick the Add link to add a point.
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Coordinates input - [m| X

Coordinate system: Decimal Degrees =
Coordinates

Lattude 59.9419768|"
Longtude: 302874584

0K Cancel

= Coordinate system
From the drop-down list, select the convenient format (for example,
Decimal Degrees) for the coordinates.

= Latitude/Longitude
Enter the coordinates of the point.

= Click OK to add the point.

Click the Edit link to edit the selected point.
Click the Delete link to delete the selected point.
Click the Save button to add a region.

Draw a Route

288

Click and then set route points one after another by clicking on the map.

BING_ROAD X|
o §% - Rt [B]@[Q] @] 7 Show Beacons: Al ~ | 2 Ruler (4 Find onMap~ 4. |7 Drawing Panel| A Route - ] Coversge Map

0] O B A @ @ G @[22 Custom Object~
Save Cancel
Click to place the route waypoints on the map. Right-dlick to delete the last waypoint. When you are done, diick Save and provide additional route properties.
‘ When adding waypeints, follow the actual road trajectory and de not place the waypeints farther than 5 km apart ‘
Zayachy e T
Island
MO Morskoy Letnty
d

ky sat
Adriralteyskiy
MO Dvortsoviy okrug
Mo

e

235 (Basil)

MO Nomwalt
125 (Pete)

= P Police departmentNo 1 2.

Vasiryevskiy Island

=
Lattude: 59°5705.60"N; Longitude: 30°1206.21"E

Once you have finished drawing a route, click the Save link.

In the Object on Map dialog box, specify a name and description for the
route.

Click the Route tab.
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Object on Map X

General Route  Logical Groups

Color:

[ 255; 0; 255 -

Fill region area

Transparency: |30

Ak Ak
=

Tolerance zone (m):  |100

Caeel

= Color
Select the color in which to display the route on the map.

= Fill region area
Select this check box to display a transparent edge around the route line.
The edge width is specified by the value of the Tolerance zone parameter.

e Transparency
Specify the transparency, in percent, for the line edge.

* Tolerance zone
Specify the corridor width, in meters. If a radio will pass out of this tolerance
zone, the dispatcher will receive an alarm signal.

Add a Beacon

e Click @I and choose Place on the map.
e Click on the map where you want to place a beacon.
e Click the Save link.

The Beacon properties dialog box will appear.

¢ On the General tab, specify the following parameters:
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Type:
Name:
Major 1D:
Minor 1D:

Description:

Beacon properties

General | |ogical Groups  Cameras

iBeacon -

|Coﬁea

1
1

Coffee shop at the comer

Cancel

= Type

Select the beacon type from the drop-down list.

= Name

Specify a name for the beacon.

= Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon

device.

= Description

Add a description for the beacon.

On the Logical Groups tab, select logical groups that will be associated with

the beacon.

On the Cameras tab, select the check box beside the camera that will be
associated with the beacon.

Note: You can also place a beacon by specifying its coordinates. To do
this, click @ and choose Specify coordinates.

Add a Point of Interest

e Click and choose Place on the map.

e Click on the map where you want to place a POI.

e Click the Save link.

The Object on Map dialog box will appear.
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Object on Map X
"ﬁ| Beacon Map  Logical Groups — Cameras

Mame: School dep

ID: 2 0

Description: Look after

Bind to PTT
System: |Capacity Plus 1 j
Group: |Firemen j

Cancel

= Name
Specify a name for the new map region.

= Description
Enter a description for the map region.

= Bind to PTT
Select this option to connect the POI to a radio group in your radio system.
Clicking the object's icon on the map will start a call on the selected radio

group.
e System
From the drop-down list, select the radio system.

e Group
From the drop-down list, select the radio group.

On the Logical Groups tab, select logical groups that will be associated with
the object.

On the Cameras tab, select the check box beside the camera that will be
associated with the object.

Note: You can also place a POI by specifying its coordinates. To do this,
click and choose Specify coordinates.

Note: Similarly, you can place other objects with predefined icons, such
as Warning points, Police departments, Emergence departments,
Fire departments, Houses, and Cameras. To do this, click one of the

following icons on the toolbar: AR = RERT B .
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Create a Custom Object

In addition to objects with predefined icons, you can create your own objects to be
then placed on the map.

C|iCk| 29| Custom Object ~

and choose Add Custom Object.

Custom Object on Map x
Name: Clown’s nook |
Select image
D:\Images"Popov2 jpg ‘ x
Preview

16x 16 24x24 I2x32 48x 45

%

Cancel

OK

Advanced mode

= Name
Specify a name for the object.

= Select image
Click the Browse button and locate the image file you want to use as an
icon for the object.

Note: You can also assign different images for different icon sizes.
Click the Advanced mode link and select images for
different sizes (16x16, 24x24, 32x32, 48x48).

After you create a custom object, the corresponding con will appear on the Drawing
Panel.

e To delete a custom object, cIick| 22| Custom ije‘:t'| and choose Delete Custom
Object.

6.6.2.8 Route

Show Route
e C(Click and choose Show Route.
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Show Reute X
@ [ LimeGreen E
V(@ 125 (Pete) B 105, 105, 105
@ 222 [ RoyalBlue
¥ (&) 235 (Basi) [ Aqua
I~ @ Radio 200 [ skyslue
I~ (®) Racio 201 [ DarkGray
[~ @ Radio 202 [ DeepskyBlue
[~(®) Radio 203 I DaricSlateBlue
[~ @ Racio 204 [LightGreen
I~ @ Radio 240 mobie: [ Lime: |
& =l
Route Type:  [Static |

48 E|: Hi ~

From |22:00v-2016 0:00 ~|
To: |<Last known location> ~|
Route Style. [Dots and lines with direction -

Optimize Route (group all nearest points)

[ Automatic comsct GPS erors

Configure
Show Events telemetry. alams and etc)
[ Shaw Canlog Events
oK Cancel
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= In the list of radios, select a radio and the color with which to display the
route for the radio.

= Route Type
Select the route type, either Static or Dynamic.

= Show Route for Last
If the Dynamic route type is selected, specify the time period, in hours, for
which to show the route.

* From/To
If the Static route type is selected, specify the start and end dates of the
time period for which to show the route.

= Route Style
Select the style in which to display the route on the map.

= Optimize Route (group all nearest points)
Select this option to group all points in a 100-meter radius.

= Automatic error correction
Select this option to detect and correct invalid GPS data. Click the
Configure link and select the maximum possible speed for your vehicles.

= Show events
Select this option to display TRBOnet server events (telemetry, alarms, and
other events).

= Show CanlLog events
Select this option to display events that occurred in a vehicle (door
opening, and other events).
Export Route
You can export the routes travelled by radio users in a GPX or KML files. To do this,
after you have performed a Show Route command, click and choose
Export Route > Export to GPX file/ Export to KML file.

Play Back Route
e Click and choose Play Back Route.

Playback Route X

Radio Date a GPS Data Speed | Events
125 22:-Nov-2016 10:17:17 Latitude: 59°56'25,88°N; Longitude: 30°1... 0.5km/h
125 22-Nov-2016 10:18:17 Latitude: 59°56'25,86'; Longitude: 30°1..,
125 22-Nov-2016 10:18:47 Latitude: 59°56'25, 16'N; Longitude:
125 22-Nov-2016 10:19:17 Latitude: 53°56'25. 38N; Long
125 23-Nov-2016 10:19:47 Latitude: 5°56'25.27°N; Long
125 22-Nov-2016 10:20:17 Latitude: 59°56'25, 37°N; Lang
125 22410v-2016 10:20:47 Latitude: 59°5625.371; Lnr\g\tude 30°L., 0.8km/h

eeceoeoos

Total: 660

Q @ @ Export [v Load
From: [22-ov-2015 0:00 =l

To: [ <tastknown location> |

L] optimize Route (group all nearest points)
Automatic correct GPS errors

Configure
Show Events (telemetry, alarms and etc)
Show CanLog Events

Radio 4| Color

=]
3

111 [ LimeGreen

125 (Pete) [ 105, 105, 105

222 I RoyalBlue

235 (Basil) [ Aqua

Radio 200 0 SkyBiue

Radio 201 [ Darkray ~

Select Al Unselect Al

00008 a
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In the list of radios, select the radio and the color with which to display the

route for the radio.

From/To

Specify the start and end dates of the time period for which to show the

route.
Click the Load button.

Once you have loaded the route points, click the Play button to play back

the route on the map.

v Iy [ll«]]
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o [tivonn baatons B
[0 optmaze Route (group st mearest painis)
2 Automatc correct GPS errors.
ntars
2] Shaw Events (telemetry, slarms and ¢t)
fe] Show Cantog Events.

R
7 125 )
| =

235 (pasl) = A

Roko 200 [SEE
Rao 1 = oarvcray

seectal Unselect &1
35

Private Cal: Depatcher Diepatcher ... Menbers: Depatcher 1, 235

tCols | RequestioTek | RadoState | ActveTasks | ActveRoues | User Actity | Descons | Besconvents | Taglist

127001 & th | @ Dspatcher | (8 Lcensed o derno DernoLicense

6.6.2.9 Geofencing
The Geofencing feature allows controlling the location and speed of radios relative

to manually defined regions on the map.

© Actre-

The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply
the rules for the regions and radios.

6.6.2.10 Coverage Map

The Coverage Map option allows to see RSSI levels on the map.

294

e On the Map toolbar, click .

The administrator can add/disable/delete the rules for Geofencing as well as
edit the currently selected rules:

For more details on configuring Geofencing rules, see section 6.4.5.7,
Geofencing.

To enable Geofencing rules, go to Administration, Tasks, and in the Tasks
pane, select the check box next to Geofencing.

e On the Map toolbar, click M,
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iee [ @] B[O @] 17 [ @] show seacons 4 ~ | Ruler | # DrawingPanelof] Coverage Map| 7

Select 55| data by prriod

5

Ston Dt

235 (Basi)

o walt
lsumeqw 2 125 (Pete)
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For more details on configuring the Coverage Maps, see section Coverage Map

(page 120).
6.6.2.11 Select Map

e On the Map toolbar, click _

Select Map... x
Map Type: Online maps R
Caption: [y Mol
Available Maps

Name Path State
MAPNIK oK
creLe oK
TRANSPORT oK
LANDSCAPE oK
BING_ROAD oK
BING_AREA oK
BING_HYBRID oK
Add Edit Remave Cancel

= Enter the Caption of the map that will be displayed in the active tab.
= In the list of Available Maps, choose the map to be displayed.

Note: For more details on available map types, see section Map

Types (page 111).

6.6.2.12 Google Earth
To open the Google Earth application:

-
e On the Map toolbar, click | GeegleEarth|

Note: Google Earth must be previously installed on the PC. To

download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click
Download.
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6.7

6.7.1
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Job Ticketing

TRBOnet Dispatch Console provides the Job Ticketing feature — the integrated
ticketing system that allows dispatchers to create, assign, and track job tickets
through the radio network.

Note: Before using the feature, make sure that your TRBOnet
Dispatch Software license includes Job Ticketing.

e Click the Job Ticketing tab, and manage Job Tickets in the Job Ticketing

pane.

File View Map Tools Help
Job Ticketing

Job Ticketing

—

{5 eventviewer

127001 & B | § Administrator | [ Licensed to: demo

Adding Statuses for Job Ticketing

" Job Ticketing | Statuses | Custom Fields | Templates
(5 Add (F2) ~ 5] Edit (F4) - Assign (F5) | = Grouping 7 Auto Filter @ Default Settings
Status | ID Text ... | Specified End Time City
# New #AD0006 Check the pipe in ... v 07.06.2017 15:40:00 Mo...
2% New #AD0007 Medium, Check the. St.
| 4| 4| Record 10f2 b | |mH[ 1] »
Processing tasks:
Status D ... Start Time End Time Specified|
+ Accepted #A00008
= Assigned £A00009
| «| «|Record 20f2 »[ e |m] «] | »
| @ Adive-

¢ In the Job Ticketing pane, click the Statuses tab to see the statuses available
for job tickets.

Job Ticketing Stat

5 Add|E) Edit = Del

uir Custom Fields | Templates |

Name Action Dedcription
New \ New \
Cancelled Cancel
Assigned Assign
Accepted Accept
Rejected Reject
Completed  Complete

In Progress

In Progress

/4| «|Recordaof7 v |m|m| <

Status

T New

X Canceled
= Assigned
+ Accepted
— Rejected
¥ Completed

O InProgress

Click the Add button to add a Job Ticket status.

Job Ticket Status X
Name |Accemed
Description Accept
Action (CPS): [Accept |
Status [+ Accented [+
+ Completed
¢ InProgress
— Rejected
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6.7.2

* Name

Specify a Job Ticket status name to display in the system.
= Description

Add a description for the job ticket status.
= Action (CPS)

Enter the action name as specified in MOTOTRBO CPS.

Note: The Action (CPS) value must match the value of the
corresponding Action/Response field configured for a radio
in MOTOTRBO CPS, Job Tickets.

= Status
From the drop-down list, select the Job Ticket status (Accepted, Completed,
In Progress, or Rejected).

Adding Custom Fields for Job Ticketing

In addition to the default fields (Priority, Deadline, etc.), you can add custom fields
with pre-defined values to be used in tickets/ticket templates.

¢ In the Job Ticketing pane, click the Custom Fields tab to see the list of
custom fields available for job tickets.

Job Ticketing Tsmmsev ‘Custom FleklsTTempIabes ]
=, Add| =) Edi
= = it :} Delete

Name Values

Town Kotka;Hamina;Loviisa
Quality High;Low;Middle
|| 4 |Record 10f2 ¥ |k M|+ r

e Click the Add button.

Job Ticket Customn Field s

Name: Town |

Values
Kotka
Hamina

Loviisa

Total: 3

4 Add X Delete

oK Cancel

In the Job Ticket Custom Field dialog box, specify the following:

= Name
Enter a name for the field.

= Values
Click the Add link and enter a pre-defined value for the field.
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6.7.3 Creating a Job Ticket

¢ In the Job Ticketing pane, click the Job Ticketing tab to see the list of

created job tickets.

Job Ticketing T Statuses r Custom Fields r Templates ]

Edit (F4)
Text

= add (F2) |+ 2

W 4| 4 | Record20f2 b |k |M| 4
Processing tasks:

Status I e
+ Accepted FAODDOE o e e
= Assigned #A00009

4|4 | 4| Record 10f2 b | bk |M| 4

Medium, Chedk the pi...

Start Time

= Assign (F3) = Grouping 7 Auto Filter :z Default Settings

.. |Cr... | Spedfied End Time
07...
07...

.. | End Time

e Click the Add button to create a job ticket.

298

Status Colors

Created By Prio... |Ceue |woe |Qu...
Administrator  Medi...
Administrator  Medi.... ... High

.. | Specified End Time

Note: To create a ticket from a template, click the arrow on the
right of the Add button to select from the available ticket
templates. For directions on how to create templates, see

section 6.7 4.

lob Ticket
Ticket 1D:
Priority:
Deadline:

Tead:

Wariables:

Comment:

Predefined Texts:

Hide Advanced Opticns

x
[#AD000D |
Medium ~
|21.04.2017 11:54 -
45min  +10min  +30min  +1hour
| || +|-
Check the pipe
111
Priority Due Date Due Time
] Motify on status changes
] Motify if ticket is not accepted by
[21.04.2017 11:49 |
Notfication List
Cancel

In the Job Ticket dialog box, specify the following parameters:

= Ticket ID

This value will be set automatically once the ticket has been created.

= Priority

From the drop-down list, select the task priority.

= Deadline

Select this option and in the box to the right, enter a due date and time for

the task.
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* Predefined Texts
From the drop-down list, select a predefined text for the Job Ticket.

e Click the B button to edit the predefined text.

Predifined Text Editing X

Text
Check the pipeling|
Check the toll fare

Total: 2

#_d ¥ Delete Prioity Due Date Due Time

0K Cancel

e Click the Add link and type the text in the line that appears.
In addition, you can also add to this text:
v" Priority
Click this link to add the ticket priority to the text.
v Due date
Click this link to add the ticket due date to the text.

v" Due time
Click this link to add the ticket due time to the text.

= Text
Enter the text message in this box.

= Notify on status changes
Select this option to send notifications to Dispatchers, Email and/or SMS
groups when a Job Ticket status changes.

= Notify if ticket is not accepted by
Select this option to send notifications to dispatchers, Email and/or SMS
groups if a radio does not accept the Job Ticket at the time specified in the
box below.

= Notification List
Click this link and choose the recipients of selected notifications.

Netification List x

Dispatchers || Email | 5MS || Radios

Notify Dispatchers

Administrator
¥ Dispatcher 1

[] Dispatcher 2

OK Cancel
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You can notify dispatchers with the help of notifications in the Dispatch
Console (on the Dispatchers tab, check Notify Dispatchers, and select
dispatchers), Email groups by sending Emails to dedicated Email groups
(click the Email tab, check Notify by Email, and select Email groups) and
phone users by sending SMS to dedicated SMS groups (clcik the SMS tab,
check Notify by SMS, and select SMS groups).

= Comment
Add a comment for the ticket.

6.7.4 Creating a Ticket Template

6.7.5

300

You can create ticket templates in advance to then use them when creating tickets.

Job Ticketing TStab.lses T Custom Field;/YTemplates]
%Add _—} Edit -y Binding =" Default Template Delete | = Grouping 7 Auto Filter A Default Settings

MName Priarity Text Specified End Time Comment Bin...
Towns Medium %PRIORITY % in %City %o
Cleaning Medium Do deaning in %Town%

|| 4 | Record 1of2 k| WM 4 3

e Click the Templates tab to see the list of templates available for job tickets.
e Click the Add button to create a ticket template.
¢ In the Job Ticket Template dialog box, fill in the desired fields, and click OK.

Note: For information about the fields, see section 6.7.3, Creating
a Job Ticket.

In addition, you can enable automatic creation of the template-based tickets by
using a scheduler. For this, go to Create Automatically by Scheduler, click the
arrow down button and select the corresponding scheduler. Or, click the plus button
on the right, and create a new scheduler.

Selecting Ticket Status Color

You can also color tickets based on their statuses.
e Click the Job Ticketing tab, and on the toolbar, click the Status Colors

button.
Job Ticketing T Statuses T Custom Fields TTempIabes ]
=k Add (F2) - =} Edit (F4) . Assign (FS) | = Grouping "/ Auto Filter 2 Status Colors
Status jin] Text Al Spedfied End Time /|| . Town
1 New #A00010 Medium ¥eCity %o T T s Kotka
£ Mew #A00007 Medium, Chedk ... e e St.Peter.

In the Select Job Status Color dialog box that opens:
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Select Job Status Color X

Status Color
New [ vellowGreen |+
Cancelled Custom | Web | System
Assigned =1 Darkkhaki N
Accepted [ Beige
Rejected [ LightGoldenrodyellow
Completed = Olive
N 3 Yellow
rogress [ Lightvellow

B [ Ivory
Expiring Job Ticket B CliveDrab

Time to complete Job Ticket {minute) == YellowGreen

B DarkQliveGreen

3 GreenYellow

3 Chartreuse =

Default

Color:

0K Cancel

e Click the arrow on the right, and from the drop-down list, pick the color for the
selected status.

6.7.6 Assigning a Job Ticket

e Select a job ticket in the list, and click the Assign button.
Or, right-click the job ticket and choose Assign.

Job Ticketing T Statuses r Custom Fields T Templates ]

=L Add (F2) = =L Edit (F4) - Assign (FS) | = Grouping "/ Auto Filter (7 Default Settings .= Status Colors >
Status | ID Text Pe... |Cr... | Spedified End Time Created By Prio... |C... | v | Qu...
$E New #A0000F Medii T =i Administrator  Medi...
:
5 Mew #A00010 Medil % Lt 1 Administrator  Medi... ... High
I
Cancel
#|4|4|Record 10f2 ¥ |m -3‘ Archive v
Processing tasks: S Create Based on...
Resend . —
Statu D .. | End Tii — ¥ End Ti
= _% Change Status 2 e peche e
+ Accepted #A0DOOB 0 T |
=, Add
= Assigned #A0000 Sé Add 0
4| 4| Record 1of2 » |k M| 4 2
In the Assign Job Ticket dialog box that appears:
Assign Job Ticket X
\.\ Assign Job Ticket
-
Radio: \
M@ 125 .
@ 235
® 3333
V@ 4
@ 5555
(# Radio 25 -
Selected: 2
o) 7|-[:=]-
0K Cancel

e In the list, select a radio or multiple radios, radio group(s), or logical group(s)
to which to assign the job ticket. To switch between the Radio List, Radio

Groups, and Logical Groups, click the “= 7 button and select the desired list.
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e Click OK to assign the ticket to the selected radio(s)/radio group(s)/logical
group(s).

As a result, the selected radio(s)/radio group(s)/logical group(s) will receive the
job ticket.

Note: When you assign the job ticket to multiple radios and the first
radio accepts the ticket, the behavior of other radios depends on
the Job Ticketing Service type configured for these radios.

If the Text Messages type is configured for the radios, all other
radios will receive a corresponding text notification.

If the MSI Proprietary type is configured for the radios (or Mobile
Client is used as a radio), the ticket will be cancelled on all other
radios (Mobile Clients).

6.7.7 Viewing Job Ticketing Statistics

e On the main menu, select Tools, then click Job Ticketing Monitoring to see
the Job Ticketing statistic diagram:

5 Iob Tecketng Mandorng o x

show:  froawy  [-] s

Depaide: Creted sdets

Rado [s——— Status diagram
» | acstratcr 7| » | Unassigned

S, -, “, -, “, L =, =, =, =, K = =, =, =,
5 * % 4 % o v & - % i % * o

For more details on the statistics, see Job Ticketing Monitoring.

6.7.8 Viewing Job Ticketing Reports

e To view a job ticketing report, go to Reports (1), and select Common Reports
(2) — Job Ticketing (3).

¢ On the Common reports pane, click the Query parameters tab, and specify
the appropriate parameters and then click Generate Report.

e Click the Job Ticketing tab to see the generated report.
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File View Map Tools Help

Reports
£.[5) Channel Change
T Common reports

Common reports

[

[[«][@] B & 1: Line free [Jancal [2][«]@]

1) Messages for Period
£ State of Radios
) User Messages and Notes

2 Group 20

Query parameters

VErE) el N[ rivate cal Pl

Job Ticks

neocom
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Mo 10 [[«][]

1T Radio Alocation

) Radio Disabling

[ Telemetry

1.7 Radio Users by Channel

[ state of Radios Summary

£ Lone Worker Activity
) can graphics

) can messages

<

L5 JobTicketing 4" 3 .
= o
{1l voice Dispatch
%PRIORITY%% 07-Nov-2016 07-Nov-2016
B . #A00000 N Administrator Med
|l Location Tracking FRICRITV e 140631 141300 ministrator Medlum =
07-Nov-2016 07-Nov-2016
. #600001  %PRIORITY% Acoepted Administrator Medium
& s0b Ticketing ¢ 1408:58 14:49:55
I 07-Nov-2016 07-Hov-2016
#0002 %DATE% assigned |10 e Administrator Medium
07-Nov-2016 07-Nov-2015
HADDODZ  BTIME% Accepted o o Administrator Medium
5] RFID Tracker 142525 15:00:35
#A00004  jkg assigneg 07 MOw-2018 07-Mov-2016 Administrator Medium
[] Text Messages 15:01:59 1517:57
BANODOS  Abc Asslgned D/ MNow-2016 U7-Mov-2016 Administrator Medium
ﬂ Voice Recording 15:18:13 15:21:07
1 feoooos 123 L25{Cleaning Completed WN?V'ZMS DH\J?V'ZD” Administrator Medium
@ Reports — 1) 15:23:19 15:35:02
- #ANODOT 456 New 2;’?;;;“6 Administrator Medium
Event Viewer .
07-Now-2016 07-Now-2016 07-Nov-2016
#AD0008 Visit mortre completed | e Administrator Medium
Durationl: 02:19:41
5], Admistot Duration2: 00:00:28

o]

3127001 g3 B | @ Administrotor | [ Licensed to: deme Demo License

6.8 Guard Tour / Route Ma

nagement

| @ Active-

The Guard Tour / Route Management feature allows the user to create routes and

assign them to selected radio

File Viev Map Tools Help

Route Management

subscribers or dispatchers.

Route Management

[] Text Messages

g\mﬁzm
() Reports
Evullvi:w:r

[ 1] Tetemetry

2 o | Ut ey i 1: Line free [«][@] | M ntercom M Group 10
Seron P (v B [=][<][e@] [ Group 11
31.05.2017 14:58 . == E D —

/! Monitoring

b start | (reate\é Edit =}, Copy @ Export - | [k Delete | = Grouping 7" Auto Filter > Default Settings
(41, Voice Dispatch Name Route

Route 1. 15:00 15:15 1530 1600

Tesroune
4., Location Tracking & 2 & 8
@ Job Ticketing

2
Route
1

@ 'RFID Tracker

4] 4] 4 | Record 10F 1 k|1 mi] 4|

Active Routes

b Start | 11 Pause Ml Stop | [5b Edit @ Export~ | = Grouping "/ Auto Filter @ Default Settings

Name. Route
b Route 1 00:00 15:00 15:45  15:30 1E
31.05.2017 14:58 Coffee Hospral  Tes  Poikce

1] @] | Record tof 1 v | [mi] 4]

(127001 g5 g | G Administrator | (A Licensed to: dema

e Click the Route Management tab (1).

6.8.1 Creating a Route

| © nctive-

¢ In the Route Management pane on the right, select the Management tab,
then click the Create button (2) to create a new route.
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Route X
Name: [Route 1
Description: [restroute
Rule: a0 chediints, strict order, strict schedule ]
StartjStop Kilks! | Route Points | Chedpoint Statuses | Notfications | Tags | Logical Groups
‘Start Route 2
Manualy by dispatcher
Automatically by recelving Text Message from a radio
Message 2 ]
[ Automatically by receiving Telemetry Command from a radio
1 E [ryevent =]
Automatically by recelving DTMF command from a radio
Command: ~ [123 #123%
[ Automatically by receivin g Status from a radio
[ wait for confirmation from a radio
Pause Route ¥
Resume Route ¥
Finish Route %
Manually by dispatcher
[ Automatically by receiving Text Message from a radio
[ Autematically by receiving Telemetry Command from a radio
L : Any event -
[ Automatically by receivin g DTMF command from a radio
[ Autematically by receiving Status from a radie
[ Autematically after all points have been attended
e Name

Specify a name for the route to display in the route list.

e Description
Add a description for the route.

¢ Rule
Select the type of the rule from the drop-down-list:

= All checkpoints, strict order, strict schedule
Checkpoints are to be attended in the specified order, each within a
specified time range.

= All checkpoints, strict order, loose schedule
Checkpoints are to be attended in the specified order. The time for
attending each checkpoint is not limited.

= All checkpoints, loose order, loose schedule
Checkpoints can be attended in any order, each at any time.

e Click the Start/Stop Rules tab.

Start Route
Specify the rules to start the route.

= Manually by dispatcher
This option is enabled by default and cannot be edited. This option enables
the dispatcher to start the route by clicking the Start button in the Route
Management tab or in the Active Routes pane.

= Automatically by receiving Text Message from a radio
The route starts when the radio sends a specific text message to TRBOnet
Server. If you select this option, then specify the text message the radio will
send in the Message box.
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= Automatically by receiving Telemetry Command from a radio
The route starts when the user presses a preconfigured button on the radio
and TRBOnet Server receives a telemetry command from the user's radio. If
you select this option, specify the VIO contact, and from the Command
drop-down list, select the signal level at which the user's radio should send
the telemetry command.

= Automatically by receiving DTMF command from a radio
The route starts when the user sends a specific DTMF command to TRBOnet
Server, for instance, #11#. If you select this option, specify a DTMF
combination without the # characters in the Command box.

= Automatically by receiving Status from a radio
The route starts when the user sends a specific Status to TRBOnet Server,
for instance, 1. If you select this option, specify the Status.

= Wait for confirmation from a radio
Select this option to start the route after the TRBOnet Server receives a
confirmation from the radio. In this case, the route is assigned to the radio
or user and paused. The route will be resumed after a confirmation is
received.

Pause Route
Specify the rules to pause the route.

Resume Route
Specify the rules to resume the route.

Finish Route
Specify the rules to finish or stop the route.

= Automatically when all points have been attended
Select this option so that the route is finished automatically when all
checkpoints have been attended.

= Limit route processing time
Select this option, and specify the maximum allowed time in the Max. Time
box. If the time is exceeded, the route will stop automatically. All
unattended checkpoints automatically change their statuses from ‘Waiting'
to 'Not Attended'.

¢ In the Route dialog box, click the Route Points tab.

Route X
Name: [Route 1
Description: [restroute
Rule: a0 checkpoints, strict order, strict schedule =l
Start/Stop Rules Route Points | Chedpoint Statuses | Notifications | Tags | Logical Graups |
QO [k Tine: [Specified tme of day -
yZ o _ [ Name [Tme
o o % [Point 1 9:00
W Bz Point 2 9:30
NN Z g Coffee 100
” 9:30 ‘a‘ Fire dep 10:40
©
Point 1 ¥
2:00 5
Fird dep
10:40
Sy |La\nd SESSEEBSNLugnd 3Dwsasw:EL
[Bepsponts (@ seacons [ map obiects: A creste Sbedt X pelete
o2 3
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= Click the GPS Points link (1) to add points to the selected map:

Select Map... X
Map Type: Online maps >
Caption: |My Map]|
Available Maps

Name Path State
MAPNIK oK
CYCLE oK
TRANSPORT QK
LAMNDSCAPE QK
BING_ROAD 0K
BING_AREA QK
BING_HYERID QK
Add Remove Cancel

Select the map. For more details on map types, see section Map Types
(page 111).

Click the Create link or double-click a selected point on the map to create a

new route point:

Point properties X
Name: [Bank
Location [Fattude: 53°56'35.20; Longitude: 30°16'4.. ~|
Radius: 10 =] meters
I” Intermediate way point (ot served)
Time: 15:00 =
Time delta: 5 =] minutes

Name
Specify a name for new point to display on the map.

Location
This box displays the current GPS coordinates of new point.

Radius
Specify the radius within which to consider the point as attended.

Intermediate way point (not served)

Select this option to exclude the point from being used as a checkpoint.
Time

Specify the time the point is to be attended at.

Time delta
Specify the time accuracy to attend the point.

Click OK to add the new point.
Click the Beacons link (2) to add a beacon as a checkpoint.

Note: To enable the Indoor feature, make sure your license
includes Indoor Positioning (see section 5.1 License
Information on page 11) and Indoor Service is selected in
the list of available services (see section 5.9.2 Services on
page 30).
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Route

Name:
Description:

Rule:

[Route 1

[Test route

[a1 checipaints, strct order, strct schedule

Start/Stop Rules  Reute Points |Checkpo|n( Statuses | Notifications | Tags | Logical Groups |

i@ Beer Time: [specified time of day |
G Coffee Name Time |
@Tea Point L 9:00

Point 2 9:30

Coffee 10:00

Fire dep 10:40

[@epspoints (@ seacons [ map obiects

A crezte Ehedc X pelete

= (Click the Create link and then click a beacon in the list.

Point properties

Name:
Beacon:

Radius:

Time:

Time delta:

[Soffes
[@ coffee =l
3: meters

I Intermediate way point (not served)

10:00

5 3: minutes
e

= Click the Map Objects link to add a map object as a checkpoint.

Route

Name:
Description:

Rule:

[Route 1

[rest route

|m\ checkpaints, strict order, sirict schedule

Start/Stop Rules Route Points | checkpoint Statuses | Notifications | Tags | Logical Groups|

(@ sbidng place Time: [specified tme of day -]
DlFre cep Name Time |
[de]Hospitai o2 Point 1 5:00
[Epoice cepartment o 1 Pontz @m0

Coffee 10:00

Fire dep 0 |

[E@eps points (@ Beacons [P Map Objects

o Create [EbEdit X Delete

= Click the Create link and then click an object in the list.

’—me properties

Name:
Map Object:

Radiss:

I Intermediate way paint (not served)

Time:

Time delta:

[Fire deo
[@rreder |
10 3: meters

10:40 =
5 3: minutes

ores

¢ In the Route dialog box, click the Checkpoint Statuses tab.

neocom
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307



&

neocom
sofFtware

308

Route X
Name: [Route 1
Description: [Test route
Rule: [AT checkmomnts, sirict order, strict schedui =l
Start/Stop Rules| Route Points Checkpeint Statuses | Notficatons | Tags | Logical Groups
Set status to Attended:
€ When racio enters the point area
% By condition when radio s in the point area
Automatically by r ing Text Message from a radio
Message: | Yes
O Automatically by r metry Command from a radio
[] Automatically by receiving DTMF command from a radio
[ Autematically by receiving Status from a radio
Statuses that can be set by dispatcher:  |Waiting, Attended, U... ~
Set status to Alarm:
[] Automatically by receiving Text Message from a radio
[ Automatically by receiving Telemetry Command from a radio
1
Automatically by receiving
Command: ~ [5 #5
Automatically by receiving Emergency from a radio
Emg. Type:  [Emergency Alarm ~|
[ Autematically by receiving Status from a radio

Select this option so that TRBOnet Server will change the checkpoint status to
‘Attended' based on the information from the radio.

= When the radio enters the point area
Choose this option so that the radio detects the closest beacon and sends
location data to TRBOnet Server. The respective checkpoint changes its

status to 'Attended ' automatically.

= By condition when the radio is in the point area
If this option is chosen, the radio sends a preconfigured command to
TRBOnet Server. The last detected checkpoint changes its status to
‘Attended ' by this command. Configure the preferred command(s):

¢ Automatically by receiving Text Message from a radio

Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific text message from the radio. If
you select this option, then specify the text message the radio will send
in the Message box.

Automatically by receiving Telemetry Command from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific telemetry command from the
radio. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific DTMF command from the radio,
for instance, #11#. If you select this option, specify a DTMF combination
without the # characters in the Command box.
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¢ Automatically by receiving Status from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific Status from the radio. If you select
this option, specify the Status.

e Statuses that can be set by dispatcher
Select this option to allow the Dispatch Control operator to manually change
the status of checkpoints in the Active Routes panel.
In the drop-down list, select the checkpoint statuses to be available for the
operator: Waiting, Attended, Unattended, and Alarm.

e Set status to Alarm
Select this option to allow the radio to set an alarm on the attended
checkpoint. Configure the command(s) that can set the checkpoint status to
‘Alarm'.

Automatically by receiving Text Message from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific text message from the radio. If you select this option,
then specify the text message the radio will send in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific telemetry command from the radio. If you select this
option, specify the VIO contact, and from the Command drop-down list,
select the signal level at which the user's radio should send the telemetry
command.

Automatically by receiving DTMF command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific DTMF command from the radio. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

Automatically by receiving Emergency from a radio
Select this option to set the point to alarm mode after the dispatcher
receives an Emergency from the radio.

e Emg. Type
Select the Emergency type from the drop-down list.

Automatically by receiving Status from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific Status from the radio. If you select this option, specify the
Status.

¢ In the Route dialog box, click the Notifications tab to manage notifications to
a radio.
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Rule: [a1 checkpoints, strict arder, stict schedule |

Start/Stop Rules| Route Points | Checkpoint Statuses NHHEaH57]| rags | Logical Groups |

Vou can use variables i fext message:
{RouteName}, (Pointame), {PointTime}, {NextrointName}, {NextPomtTime)

[V Send a Text Message on route assign to radio

‘Text Message: [fassion {Routename)

[V Send a Text Message on

Text Message: {RouteName}

[V Send a Text Message on route suspend

Text Message: [he {Routename} is suspended

[ send a Text Message on route resume

Text Message; [he Routename} is resumed

[V send a Text Message on route finish

Text Message; [he {Routeniame} is frished

¥ Send a Text Messag

ien approaching attendance tme

|5 =] minutes

Text Message: [serve (Pointiiame) at (PointTime}

Time before attend:

[V Send a Text Message after point s at

Text Message: [he 4 rved. Nextis {NextPointhame} at {

For the last point: [rhe 4

[ Send a Text Message if point is not.
Text Message: ¢

[V Send a Text Message

Text Message:

Note: To enable an option, select the check box. The Text
Message boxes already include text. If necessary, replace
the text with your own text, using variables as placeholders
that will be substituted with actual data.

= Send a Text Message on route assign
Select this option to inform a radio holder that the route is assigned to.

= Send a Text Message on route start
Select this option to inform a radio holder that the route started.

= Send a Text Message on route suspend
Select this option to inform a radio holder that the route is suspended.

= Send a Text Message on route resume
Select this option to inform a radio holder that the route is resumed.

= Send a Text Message on route finish
Select this option to inform a radio holder that the route is finished.

= Send a Text Message when approaching attendance time
Select this option to inform a radio holder that the next checkpoint is
expected in the time interval specified in the Time before attendance box.
This message is only available for routes with the specified attendance time.

= Send a Text Message after point is attended
Select this option to confirm attending a checkpoint.

= Send a Text Message if point is not attended
Select this option to notify a radio holder if the point was not attended.

= Send a Text Message if point is in alarm mode
Select this option to notify radio holder if the point is in alarm mode.

¢ In the Route dialog box, click the Logical Groups tab.
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Route X
Name: [Route 1
Description: [restroute
Rule: A checkpoints, strict order, stict schedule |

Start/Stop Rules | Route Foints | Checkpoint Statuses | Notifications | Tags Logical Groups

Name | Desaription
=i Cleaning
Wl Cleaning 1 Cleaning in Department 1
[ Cleaning 2
=S security Groups for Security
o
[y security 2

I Assign Logical Groups to a radio when the route starts

= Select a logical group(s) in the list of available groups.

= Assign Logical Groups to a radio when the route starts
Select this check box so that when the route is assigned to a radio, the
selected logical group(s) will automatically be assigned to the radio.

Note: For more information about logical groups, see section

6.4.22, Logical Groups (page 236).

Click OK to save settings.
The new route is now added to the route list (1):

6.8.2 Starting a Route

File View Map Tools Help

Route Management Route Management

BT

b start 01 Pause Wl Stop i L Lne free Fintercom [=2][«][@] B ¥ Group 10 ][]
» Route 1 poey | (L] [+)][<:] (@] | B Group 20 oEE VEam @
Et
31052017 14:58 = [_JPrivate cal [][«][@]

31.05.2017 14:58 Coffee  Hospial  Tea  Poie

< 2] Radio Allocation

1] @] 4 | Record 1of 1 ¥ | [mi[ 4]

i04] 44| 4 | Record 1of 1 _» [ r[mi] 4 »
g Voice Recording Active Routes

b start| 1 Pause M stop | 5 Edit 49 Export~| = Grouping 7 Auto Filter @ Defautt Settings
@ Reports Name Route

b Route 1 00:07 15:00 1515 15:30  16:00
|| Event Viewer ) @ R

(127001 g3 & | § Administrator | [A Licensed to: demo

Click the Start button (2) to start the route:

Start Route X

Mame: IRoutE 1

StartDate:  |14-0ct-2015 10:58 =

Route: IRoutE 1 j
Create Route | Modify |

Radio: |® 125 (Pete) 125 |

Radio Owner: I j

Dispatcher: [ail vI

Carce

| @ active-
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In the Start Route dialog box, specify the following parameters:

= Name
Enter a name for the route to be started. This name will be displayed in the
Active Routes pane.

= Start Date
Select a date to start the route on.

* Route
From the drop-down list, select the route to start. Click the Create Route
button to create a new route based on the selected route. Click the Modify
button to modify selected route parameters.

= Radio
From the drop-down list, select the radio to assign the route to.

= Radio Owner
From the drop-down list, select the Users to assign the route to.

Note: Select only one of the two (Radio or Radio Owner) to
prevent an incorrect route.

= Dispatcher
From the drop-down list, select the dispatcher to monitor the route.
= Click OK to start the route.

The active route appears (1) in the Active Routes panel.

File View Map Tools Help

Route Management Route Management €]

» Start 1l Pause |l Stop

b Route 1 00:37

31.05.2017 14:58

/ Monitoring

b start | 5} Create = Edit =}, Copy @ Export - | [k Delete | = Grouping ‘\7 Auto Filter 3> Default Settings
{2l voice Dispatch Name Route
Route 1 1500 1515 1530 16:00
Tast e
E—— % 8 @ O

Hospial  Tes  Poice

& 30b Ticketing

anl‘hlﬂqement

@ RFID Tracker

[] Text Messages

| 4 4 |Record 10f1 »
O nctwe voutes

b start | 11 Pays€ Wl stop | =} Edit € Export~| = Grouping 'L/ Auto Filter (> Default Settings

@ Reports
e

25 2 2 :
31.05.2017 14:58 Coffeey,  Haspital Tea Poiice

e \ 5 \
3

@ Radio Allocation

Name
p Route 1

Route
00:37 1508 1515 1530 16:00

wet|«| «|Record 1of 1k [w[wm[ <

C & Administrator icensed to: demo ctive v
® 127004 Ad [5.{% d to: d A

If a route point is attended in time, it is displayed in green (2)
If a route point is not attended in time, it is displayed in red (3).

For more operations with checkpoints, see section 6.5.8.6, Active Routes
(page 276).

6.8.3 Tracing Active Route on Map

¢ In the Route Management pane, click the Monitoring tab (1).
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6.8.4

6.8.5

File View Mop Tools Help

Route Management Route Management
lanagement

p Start 1l Pause Wl Stop

EEE

~ | & Ruler &3 Findon Map~
NN

J Route 2 2 00:28 |f

125
05.06.2017 16:26

b Route 1 00:23 | oo
25 N1

05.06.2017 16:31

(1Y voice Dispatch

Location Tracking

3 R .
® 2 ’ 3
L; 25\ Vg |
43 30b Ticketing 3 =
S\ \ @ B
s \
Route Management w0 '\ Hospia )

= . =\ 3
0| RFID Tracker 28 . \\\' » 3
7 26 =
7 125
[] TextMessages i = \\
.
i N \\ X "
ﬁ' Voice Recording = L RN 77
22 NG
2%
2% =
Q e L SN P N
S = 2 A 22| Lettude: 59'5629.02" N: Longitude: 30°1642.45' E |
= P 0 \o© =
Event Viewer Il Pause Ml stop | 5 Edit @ Export-
Name Route
‘3] Radio Allocation b Route 1 00:23 1631 1651 16:00 17:00
235 @ @
@M inistration 05.06.2017 16:31 Hospieal  Tes Polce  Coffes
127001 & B | € Administrator | [28 Licensed to: demo @ Active~

e In the upper-left pane, select the route (2) to be traced on the map.
Stopping a Route

Depending on the route configuration settings, a route/guard tour can be stopped
automatically:

e by a command sent from the radio;
e when all checkpoints are attended;
e when the route time is elapsed.

To manually stop the route:

e Click the Stop button to stop the route. Once the route is stopped, it will
disappear from the Active Routes panel.

After the route is stopped, the checkpoint statuses cannot be modified neither
automatically, nor manually.

Generating Route Reports

The administrator can generate reports on the finished routes.

e Click the Reports (1) tab, and in the Reports pane select Common reports >
Completed Routes (2):
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File View Mop Tools Help

) Lone Worker Activities A

) can Graphics 3 1: Line free <
-.[F) CANMessages [Jsales =

) Job Ticketing 2

T 3ob Status Change [Jemereency crour [)][+] [Jreguiar GGROLP
g Job Ticket Assigngfents [Jancal [«

T Full Movement Details [ Jorow 1 [Jerivatecal
T seaurity reports

/" Report Settings
[5) Management
[ Indoor reports Completed Routes
) Movement Details v
SavedProfles: ot defined— -
< >
Y, Voice Dispatch Select data by period:

Start Date: 10/10/2016 12:00 AM -] [
@ o End Date <Maximum date> =] B
Filter:
&5 30b Ticketing
Racio: [Err———
i et Logical Groups ot defined— 5

Radio ID (e.0. 22,33,40-55,88):

[] Text Messages

ﬁ User: Mot defined— hd
Voice Recording
Dispatcher ot defined - -
Ge Route Name:
- (]
i \ T Show routes with exceptions only
I Frint detailed data

Radio Allocation 1
IE o _ Generate Report Save Report Profile Delete Report Profile

Administration
[ Connected 43 B B | § Administrator | [ Licensed to: demo Demo License | @ active -

6.9 Text Messages

In the Text Messages tab, the dispatcher can review and send text messages to other
dispatchers, individual radio subscribers and radio groups:

File View Map Tools Help
Text Messages Text Messages

£ i & i B tercom [))[<e][@] BN 1 ine free R WOk
ETTE EE B e 4 e
e gg Online Dispatchers (1) B
& Dispatener 1 % Y fste e [<]e]
O Online, Indoor (0) " Simple [ Extended

& (1) Cnline, GPS Fixed (2) ¥ Clear (£ Reload |[% inbox | sent

[T 125 (Pete) BN The Pont 1is not served -

(®® 238 Basi) 15-Hoy-2015 14:05:10 Sent from Server to 125
The Point 2is not served

21-Nov-2016 11:08:18 Sent from Server to 125

U} Voice Dispatch The Paint 1is served
21-40v-2016 11:08:18 Sent from Server to 125

% Location Tracking The Paint 215 served
21-0ov-2016 12:30:04 Sent from Server to 125

S8} 30b Ticketing The Route 1is finshed e
22.10v-2016 17:20:44 Sent from Server to 125

Route M Call 5678: Cannot detect channel to execute this operation

22-Nov-2016 17:21:03 Sent from Server to 125
= Call 5673: Cannot detect channel to execute this operation

22-Nov-2016 17:21:15 Sent from Server to 125
Call 5678: Cannot detect channel to execute this operation

Text Messages.

[22-Nov-2015 17:

30 Sent from Server to 125

21l 5478 Carrint Aatart channel tn =xer e Hic anecafion
ﬁ' M) Recipient: | 125 (Pete) | 3 Send | I Attach File
pete, youre |
G‘e Reports
Event Viewer
113
3127001 £3 B | G Dispatcher 1 | [ Licensed to: demo Demo License | @ active~

1. Radio List
displays dispatchers and radio subscribers available for text communication.

Note: Radios must be equipped with a display to receive Text
Messages.

2. Text Messages panel
displays the latest messages transmitted via a radio channel.

3. New Message panel
provides you with text sending options.

4. Calls Panel in compact mode
allows making voice calls.
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Sending Text Messages

The dispatcher can send a text message to:

Selected Radio
Selected Radio Group
Selected Logical Group
Selected Dispatcher

All Online Dispatchers or a group of dispatchers

The dispatcher can send a text message to selected subscribers from:

New Message panel
Radio List

6.9.1.1 New Message panel

/®

neocom
software

In the New Message panel, click the ellipsis (...) button.

xl ssaes S Text Messages =

sy & & 7 a

e [ F\rerfnen

() ® 235 (Basil)
(%) Rado200 Sl | B ey 5
e vk ek 2] -
e ]

@mﬁmrnﬂmy 1 ’;:PWI\(E

@ Job Ticketing 21y i 2207 te)

Fr— e

) w0 Tk el P

e =t e -

g Voice Recording ! Cancs|

R r::::fin ﬁrjh [ send | ) Attach File

Event Viewer

[1] Tetemetry

EEI Radio Allocation 106

(127001 £y By | @ Dispatcher 1 | [ Licensed to: dema Demo License | © Active-
In the Select Recipient dialog box, select the radio, radio group or dispatcher
and click OK.
Type the text message you want to send.

Note: The size of a text message is restricted to 125 characters.

Click the Attach File button if you want to attach a file to the message being

sent.
Click the Send button.

The text message will be displayed in the Text Messages panel.

The message details highlighted in red indicates that the message recipient is offline
and the message will be delivered as soon as the recipient gets back online again.

The message details in grey indicates that the message has been delivered.
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6.9.1.2 Radio List

316

On the Radio List, right-click the radio/radio group/dispatcher you want to
send a text message to, and choose Send Message.

SR Firemen

- Send Message...
)21 i 3
= Advanced 3

4

\gy'@ Specify Status Colors...
&2 —
— VIO1: High level h
@y’@ 2 VIND: Hink lewel L

In the Send Text Message dialog box that appears, specify the following
parameters:

Send Text Message X
Target: Firemen; Police; Orline Dispatchers; ‘
Templates: ~| B
Tent: Shack # 1is onfire
105
Attachments: @ Add File
Select Radios and Groups
Fitter: | |
¥ #5 Firemen -
] 2% Mobile Client
W %% Police =]

W] .aﬁ Online Dispatchers
=2 [F EIJ Cleaning
=18 e
I™ Send copy by Email
I send copy by 5M5
I Send to offine radios
™ Confirmed Group Text

SEND Cancel

Hide Advanced Opticns

= Target
This box displays the target for the message.

= In the Text box, type the message text. You can also insert a template text

from the Templates list box. Note that the size of a text message is
restricted to 125 characters.

= In the Target list, add recipients by selecting radios/radio groups/logical
groups/dispatchers.

= Send to offline radios
Select this option to store the message on the server if a radio is offline,
and to send it as soon as the radio becomes online.

= (Click Send.
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6.9.2

Extended Messages

The Extended Messages service is a special function allowing users to send/receive
detailed preconfigured templates containing necessary information.

This service was created especially for clients who need to use more detailed and
structured messages in their work. If the standard messages are not enough to
contain all the information you need to send, you may use the Extended Messages
service. Also note that an extended message can only be viewed on a Dispatch

Console.

6.9.2.1 Send Extended Text Message to a Radio

File [View | Map Tools Help

Show Navigation

B Show Medules >

Show Voice Panel

Text Messages

[e [0l

Large PTT Boxes

5 1: Line free [«](@] [ Jarcal [« (@]
F Group 20 [=2][«][@] |} ¥ Group 30 [22][«[e]

e
- 125 M
E‘Eﬁ Voice Dispatch p Send to Radio |
~
2L, Location Tracking
New Form
@ Job Ticketing 5
Route Management 3
, v
Cll] RFID Tracker 7 o
1 =) u -
[ Textm | — ) Playback el Save- () Print Pause «f Clear
Date v | Mes. Details N...
,& jice R di 4 [ 21Nov-2016 11:13:21  C... 235 Al AlC... Mem... B
D 21Nov-2016 11:13:12 C... 125 Al AllC... Mem...
/ [ 2tMov-2016 1:13:08  C.. 125 Al AIC... Mem...
4 "  2140v-2016 11:08:19 ... 5. 125 The
Inbox (0} o 2100v-2016 11:08:18 ... 5. 125 The
t" %] Radio Allocation = 5 21-Nov-2016 10:56:55 235 Al Rese
% 21-Nov-2016 10:56:42 235 Al The
Administration AT e ee amar am e e e P hd
P New Message.. Rlali] Reriiorer PR f
127001 &3 €| & Administrator | [ Licensed to: demo Demo License | @ Active~

e Click Text Messages (1)

e Click the View menu, and select Show Extended Messages Tab (2)

¢ In the Text Messages pane, click the Extended tab (3), and New message (4).

New Message...

New Form

AN

1

| SendtoRado

et [ ] \

[ Growp 1

< >

[ Playback I Save- () Print | 11 Pause <# Clear - ’_"

Inbox (0)

Outbox (0)

0| 9] 4| Record 1oF9 ' [w[m[ <[

e Select the template in the list (1).

Date  feeefeeefeee Me... |De... ... |Ext.Note

01-ov-2016 13:48:37 Dis... Me... -
01-Nov-2016 13:48:37
[ 01-Nov-2016 13:48:34
(2 01-vov-2016 13:48:27
(7 01-Nov-2016 13:48:23
[ 01-Nov-2016 13:48:13
[ 01-Nov-2016 13:48:16

e From the drop-down list (2), select the radio to which to send the extended

message.

e Click Send to Radio (3) to send the extended message to the radio.
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6.10 Voice Recording

On the Voice Recording tab, the dispatcher can display the list of calls according to
certain criteria, listen to the calls and save them to file.

File View Map Tools Help

() Playback il Save~ ) Print | = Grouping '/ Auto Filter > Default Settings || 47 Details | [ Show Notes
Seect data by period: Date Radio Recpent | Message Detais Note
© 174iov2Dig 5:37:28 Capacty initr.... 235 Private Cal: Dispat... Members: Adni. -]
Start Date: 16-Nov-2016 0:00 Tf Ll || €@ 17Nov-2018N8:47:41  Capadity... Tel: 2409 125 Private Cal: Dispat... Members: Tel: 24...
End Date: IW[ o | || €@ 17-Nov-2016 19\59:46  Capadity... Administr... Radio24... Private Call: Dispat... Members: Adminis.
© 17-0v-2016 13:5%;, Capadty... Administr.. Radio24... Private Cal: Dispat.., Members: Adminis...
Filter: © 171002016 20 wz Capacty... 345 125 Private Calls Dispat.... Members: 345, 125
Call Type: Frivate Call ] [ 1702016 20:30:42  Copacity... 256 25 Private Cal: Dispat... Members: 456, 235
Redosysem: [ =] ||@ Te0is sz Capacty.. 125 45 Private Call: Subsar... Members: 125
© 170/-2016 20:32%6  Capadty... 456 235 Private Calls Dispati.. Members: 456, 235
Menbers: Al T || @ 17nov-2016 20:32:54  copecity... 235 256 Private Cal: Subscr.. Members: 235
Radio Group: [soecteditams: 1 =] || @ 1740v-2016 03505 Capacity... 345 25 Private Call: Dispat... Members: 345, 235
gcdGom [ <1 || @ 7oy 203318 capacy... 395 25 Private Call: Dispat... Members: 345, 235
© 1740/-2016 203455 Capaaty... 456 25 Private Call: Dispat... Members: 456, 235
Racio 1D (e.g. 22,33,40-55,88): © 1702016 2053700 Capadty.. 35 235 Private Calls Dispat.. Members: 345, 235
© 171i0v-2016 2037112 Capadty... 345 235 Private Call: Dispat... Members: 345, 235
Find Text: © 170,216 20:33:23  Capacity... 456 25 Private Call: Dispat... Members: 456, 235
| @ 1740v-2016 20:40: 16 Capadty... 235 456 Private Cal: Subscr... Members: 235
I Hide z2ro sesson audo messzge € 17410v-2016 4050 Capaaty.., 235 56 Private Call Subscr,, il
2 @ 17N0v-2016 20:42:05  Capacty... 345 125 Private Call: Dispat... Me
Load Data © 17N0v-2016 20:42 1L Capacity... 456 25 Private Cal: Dispat... Me 3
© 17110/-2016 20:4400  Capaaty... 125 45 Private Call: Subsar... Members: 125
(i) voice Dispatch © 17002016 20:44:16  Capadity... 125 456 Private Call: Subscr.... Members: 125
© 17002016 444 Capadty... 125 256 Private Cal: Subscr.. Members: 125
e © oo mies0r  copsaty.. 125 4 povate Cali b
© 17N0v-2016 :48:46  Capacty... 125 56 private Cal: Subser, :
0 308 ket © 1740,-2016 4505 Capaaty... 125 45 Private Call: Subsar... Members: 125
© 170,216 204914 Capadty... 125 35 Private Call Subsar... Members: 125
e et © 174002016 204930 Capadty... 125 345 Private Cal: Subsr,
“ O 174l0v-2016 20:45:43  Capaci 125 456 Private Call: Subsar. ©
- el €T Recrdaers > w41 o
| ) RFID Tracker
u Date: 17-110v-2016 19:59:56
[ ] TextMessages Reciient: Radio 240 mobile EBiplavbock [ save.
) 2l the radio Radio 240 moblle’ (00: 10)
§' voice Recording i
T

127001 &8 ﬁi| & Dispatcher 1 ‘ljh:en;edm‘ demo Demo License ‘ @ Active-

e Click the Voice Recording tab (1).

¢ In the Voice Recording panel, specify the criteria according to which you want
to display call records, and click Load Data (2).

¢ In the right pane, you will see the list of calls according to the criteria you have
specified.

e To play back a record, select it in the list and click Playback (3).

Note: For more actions available in the Voice Recording panel, see
section 6.5.8.1, Recent Calls/Events, Voice Recording.

6.11 Reports

The Reports tool provides you with various printing forms with monitored radio
network activity data.

e Click the Reports tab (1).

File View Map Tools Help

B queries 2
T LostDevices

T Systemreports
) Registered Radios
T Unregistered Radios
T Radio Status

Waitenace

Ul votoe Dispatch . Report Settings |

System reports

|45\ Location Tracking
) Recistered Radios

& r0b Ticketing 17 Unrecistersd Radios
T Radio Statue

= D s ot
B tvite

[] Text Messages T Channel changes

r

[AEe—
e

o —

e

[ Connected 53 B B | & Administrator | [23 Licensed to: demo Demo License | © Active-
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6.11.1 Report Types

TRBOnet Dispatch Console supports the following report types:

Queries — reports for a selected time period with information on Voice
Recording and Messages displayed as an event log (non-printable format).

System reports — reports for a selected time period with information related
to the radio system activities, in a print-ready format.

Common Reports — reports for a selected time period with information on
Messages, Radio States, User Messages and Notes, Allocated Radios, Disabled
Radios, Job Ticketing, Completed Routes etc., in a print-ready format.

Security Reports - reports for a selected time period with information on
radio activities in selected regions, in a print-ready format.

Indoor reports - reports for a selected time period for movement details for
Indoor Positioning, in a print-ready format.

GPS reports - reports for a selected time period with information on radios
location and speed, in a print-ready format.

Data export - a report for a selected time period with information on
extended notes, generated in Excel or XML formats.

6.11.2 Main Report Parameters

To generate a report, go to Reports section and select a report type you want to
generate.

When generating a report, you might need to specify the parameters listed below:

Start Date
Date from which to start reporting.

End Date
Date on which to finish reporting.

Message Type
Select available message types from the drop-down list (All Messages, Talk
Sessions, Text Messages, and other message types).

Radio System
In the drop-down list, select the system(s) to include in a report.

Radio
In the drop-down list, select the radio(s) to include in a report.

Radio Group
In the drop-down list, select the radio group(s) to include in a report.

Logical Group
In the drop-down list, select the logical group(s) to include in a report.

Dispatcher
In the drop-down list, select the dispatcher(s) to include in a report.

Radio ID
Enter a Radio ID or multiple Radio IDs.
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e Find Text
Enter the text to filter by.

6.12 Radio Allocation

The radio can be assigned to a selected employee registered in the system.

All available radios are disabled and an employee will need to type in a username

and password to take and enable the selected radio. When an employee returns the
allocated radio, it gets disabled again.

e Click the Radio Allocation tab (1) to assign radios to users:

File View Map Tools Help

Radio Allocation
= &RV a3

£ 1: Line free [«][] 8 P intercom [=0][«][@] I ¥ i cal [=2][«][@]
25 (Palo) | [ B Growe 10 [1][«][@] B8 ¥ Group 20 [=1][«][@] I ¥ Group 30 [][«][@]
5 (Pete
22 =
35 (Basil)y

Radio Allocation &

He)
®

[private call [][«d[@]

|| =L Take/Retun Radio | ), Add Missed Data - rouping '\ Auto Filter € Default Settings

Callsign | Taken by User Group Vehidle Make Plate Number Drivers

{1l voice Dispatch ® 111 Firemen, Folice
@ 125 Firemen

% Location Tracking @ 222 Firemen, Poice
@ 235 Firemen

W Job Ticketing @ radio 200 Al
@ Racio 201 Al

Route Management @ Radio 202 Al

- (@ Radio 203 Al

@ RFID Tracker @ Radio 204 Al

[] Text Messages

@ Voice Recording
@ Reports
Event Viewer

@mnlnmﬁm ~—— 1

@ Administration

4| 4| ¢ | Record20fg | m|mi| ¢
@ 127001 &3 B | & Administrator | [ Licensed to: demo Demo License

e Select the radio in the list and click the Take/Return Radio button (2):

Take Radie X
Radio: [125
User: |Pete ﬂ
Password: | “““ 4
I Take Radio Cancel

= Radio
This box displays the selected radio.

= User
From the drop-down list, select the user to allocate the radio to.

= Password
Enter the password for the selected user.

Note: For more details on user access to Allocation Console, see
section 6.4.21 Users (page 233).
e Click the Take Radio button to assign the radio to the selected user.
The administrator can generate reports on the allocated radios.

e Click the Reports (1) tab, and in the Reports pane, select Common reports >
Radio Allocation (2):
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TRBOnet Dispatch Console / @

File View Mep Tools Help

Common reports

= 73 L Line free [+]
[} State of Radios [sales [0][=]

2
T Raci by Channel 2 [ Jeroup 1 [][«][e]

s
5] state of Radios Summary =

= e v ||~ Report Settings
Allocated Radios

saved Profiles: |—Not defined-—- -

(1)) voice Dispatch

@ Location Tracking

Select data by period:

ﬁ Job Ticketing Start Date: 4/26/2017 12:00 AM =]

End Date <Maximum date> =] L
Route Management

[] Text Messages

Filter:

Radio: [-Not defined-- -
Logical Group: |—Not defined-—- -

ﬂ‘ Voice Recording Radio ID {e.g. 22,33,40-55,88 ):

(@ Reports =

User: 4ot defined- ~
Event Viewer Grouping:
Group by By radios ~
*'4} Radio Allocation 1
E Administration Generate Report. Save Report Profile. Delete Report Profile
[ Connected &3 Y B | € Administrator | (8 Licensed to: demo Demo License @ Active-

6.13 Beacons

TRBOnet Dispatch Console provides the Indoor Positioning feature to monitor the
location of radios inside a building where GPS signals are not present. The feature
requires additional hardware (beacons located around the building and Bluetooth
modules/option boards installed in radios). A radio unit will be displayed on the
indoor floor plan at the beacon location as soon as the radio enters the beacon's
coverage area. A beacon icon on the map will provide a count of the number of
radios that are currently in this beacon's coverage area (for example, Room 1(3) -
there are 3 radios in Room 1).

Note: To enable the Indoor Location Tracking feature, your license
must include Indoor Positioning (see section 5.1, License
Information) and Indoor Service is selected in the list of available
services (see section 5.9.2, Services).

To enable the Indoor Location Tracking feature, your license must include Indoor
Positioning (see License information page) and Indoor Service is selected in the list
of available services (see Services).

6.13.1 Adding a Floorplan

e Click the Location Tracking tab (1), then click Map (2) and choose Open New
Map in Tab:

321



neocom
sOoftware

Intercom

[[«Jfe]

3 41 Cal @]
2/} Firemen B VEE []+][2] EESEEE o @  Beacons
2 @@= 98 2 Group 20 [1][«][@] B8 ¥ Group 11 [2][«][e]
&
TR BT [][«][@] B B2 erivate cal Pl
LT = wee e
11, Voice Dispatch O 9 {3 -] Fite: [ @[@[Q] @] 17 [ @] show Beacans: | 4 Drawing Panel
Select Map.. %
Location Tracking [0 [ Map Regions
= 1 MepType: |BeaconaD X & ggjp Routes
i 1
G sob Ticketing A coptos \
Avalable Maps
Name Path State
@ RFID Tracker ==
3
[] Text Messages b
4 ol 4 5 L
@ Reports Recent Calls/Events F " |
- [ Playback (] Sav \ uto Filter ’j‘
fEvent Viewer Date 4 7 Details
09.06.2017 10:39 o — o = = lembers: 235 B
(7] Radio Allocation 09.06,2017 10:38: o S o] [ et embers: 125 -
wi| 4| «| Record 10f 289 v [m ]« _"J
E Administration Recent CallsfE... RecentCals | RequestToTak | RadioState | ActiveTasks | Active Routes | User Activity | Beacons | Beacon Events | Taglist
(127001 g3 g | § Administrtor | [ Licensed to: demo | @ active-

= Map Type
From the drop-down list, select 'Beacon 2D' to enable 2D floor plan, or
'‘Beacon 3D' to enable 3D floor plan (3).

= Click Add (4), and browse for the required map on your PC.
= Click OK (5) to add the map.

6.13.1.1 Floor Plan Toolbar

The Floor Plan pane's toolbar is located in the upper part of the Floor Plan pane:
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)| Shownfo: (Name, Rados ) | Images: (Default + (A Route )| Overview )| Select Map
» 4
5 6 7 8 9_|7

Zone E —
Training Room 4 v
t N _\“._ N
[l Cl (I B B f [ i
— < -—q‘
. | I: "
w nMRe ‘
. . \

. Zoom in/out

Click the Zoom buttons to zoom in/out the floor plan.
Default View

Click the arrow beside and choose Save as Default View to save current
floor plan as a default view. The dispatcher can save only one default view.

To open the default view, click the arrow beside and choose Show
Default View.

Set Location
Click the Set Location button to manually set a beacon on the floor plan.
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4. Available beacons drop-down list
Select a beacon from the list and click the Set Location button to put the
selected beacon on the floor plan. If you are going to add a new beacon,
select 'New Beacon' from the drop-down list and click the Set Location button

to add a new beacon to the floor plan.

5. Show Beacons
The dispatcher can select which beacon types to display on the floor plan.

All - all beacons are displayed on the map.

/®
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With Radios — beacons with attached radios are displayed on the map.

Without Radios — beacons without radios are displayed on the map.

In Alarm - beacons in Alarm mode are displayed on the map.

No - all beacons are hidden on the map.

6. Show Info
From the drop-down list, select which information to display for beacons.

7. Images

From the drop-down list, select an image size for beacon icons.

8. Route

= Click Route > Show Route to display a route traveled by the radio for the

selected time period.

Show Route

Radio:

From:

To:

Color:

125 (Pete)

*

| 15-Nov-2016 0:00

|<Last known location =

Lef Lol Lo

[ B 105, 105, 105

Optimize Route (group all nearest points)

Cancel

e Radio

Select the radio to display the route for.

e From/To

Specify the time period to show the route for.

e Color

Select a color to display the route with.

e Click OK to show the route for the selected radio.

= Click Route > Play Back Route.
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Playback Route

Radio
Radio 240 mobile
Radio 240 mobile

Date
21-Mov-2016 15:16:48
21-Mov-2016 15:16:54

Beacon

Tea

Radio 240 mobile Coffes 21-Mov-2016 15:16:54
Radio 240 mobile Tea 21-Nov-2016 15:16:58
Radio 240 mobile Beer 21-Nov-2016 15:17:03

CNOROXC]

State

Detected

Lost
Lost

Detected

From:  |21-hov-2016 0:00

To: |<Last known location

|| Radio 201

|| Radio 202

|| Radio 203

|| Radio 204

[w| Radio 240 mobile
[ walt

Select Al Unselect Al

Led Lo

Load

1%l

Select the time period to request data for.

Select the radio(s) to request data for. Click Select All to display history
for all radios registered in the system. Click Clear All to cancel radio

selection.
Click Load to load the history.

9. Overview
Click this button to view the entire floor plan.

10. Select Map
Click this button to change the map in the current tab.

6.13.2 Adding a Beacon to the Floor Plan

e Click the Set Location button (1) and then click on the map to point the

location of a physical beacon on the floor.

¢ In the dialog box that appears (2), specify the beacon properties.
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File View Map Teols Help

Location Tracking

k& 74

© [ Firemen
B ®1s
® 235

Map

73 1: Line free

Fintercom [][«][@]

3 Group 10 P aical [M][«][e]
erties

enersl  |ogical Groups  Cameras

e T

Name: [coffes |
Lah tocation rackng Maior ID i

Minor ID i

Description: Coffes shop {2nd floor)

n Area ,
-

Recent Calls/Events
FF Playback =l Save~ () Print
Date.

Radio 5|
09.06.2017 10:33:00  Capacit|

nnnnnn

() 09.06.2017 10:38:54  Capacit|

ol w| (| Record1ofzms b |m

Cancel

aaaaa
p Re
ap Aol
Bge 111
= o
Filter ’j‘
Jers: 235 -]
ers: 125 .
;IJ

e

Recent Calls/E... | RecentCalls | RequestToTalk | Radio State | ActiveTasks | ActiveRoutes | User Activity | Beacons | BeaconEvents  TagList

®127001 &3 B | 8 Administrstor | (8 Licensed to: demo
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Select the beacon type from the drop-down list (K-Term or iBeacon).

Name
Specify a name for the beacon.

Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon
device.

Or, if a K-Term beacon is being added:

Beacon ID

Enter the beacon’s ID exactly as specified on the K-Term device.
Description

Add a description for the beacon.

6.13.3 Editing Beacon Parameters

e Select a beacon in the Objects panel and double-click to edit its parameters.

File View Map

e Q Online, GPS Fixed (2) E
€10 125 (Pete) BENE
() ® 235 Basil) Qe v

e @ Online, No GPS (1) -

(1) voice Dispatch

Tools  Help

&+ [ Map Objects

) [ Abiding piace

¥ [ Fire dep

][] Hospital No2

¥ [E Police department No 1

BING_ROAD

@) 6| [ newse + Show Bescons: Al B

A Route~ | Ovenview || Select Map

(=)
| [ ‘ ‘
[ r |

% Location Tracking &+ [ Map Regions

fEpe—

s i ] [ 17 My zone
# Job Ticketing " P e MQ;D Routes
[ g Route 1
| Coffee(0) Teal0) \
Route Management |
- o Comman Rsom
2] RFID Tracker | ]
1 i =
s Sl “ NN
Recent Calls/Events a3
ﬁ e Reaiay ) Playback el Save~ () Print | 11 Pause < Clear - &4 Reload | “[§ Filter By Radio | = Grouping ’j‘
. Date RadioSy... Sender | Recpient | Message Detais Note
4 (2 2tNov-2016 11:13:21  Capadity... 235 Al AlCall from '235' (... Members: 235 ﬂ
i (D) 2tov-2016 14:13:12  Capadity... 125 Al AlCall from'125' (... Members: 125
EE! Radio Allocation [ 2t4iov-2015 14:13:08  Capadity... 125 Al Al Call from '125' (... Members: 125

|| ¢| Record1of617 k| w | ¢

RecentC... Recent... | Request... RadioSt.. | ActiveT.. | ActveR.. UserAc.. | Beacons | Beacon..

e

Tag List

127001 85 By | & Administrator | (8 Licensed to: demo Deme License

‘ @ Active~

¢ In the Beacon properties dialog box that appears, edit the desired properties.

Note: For more details on K-Term beacons, see the following

article at
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;Ite

mID=36.
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6.13.4 Importing Beacons
The administrator can also import beacons from an Excel file (*.xls).

Notes: If the Excel file you are importing from contains two columns
(Name, Hardware ID), the beacons being added will be
considered as K-Term beacons. If the Excel file contains three
columns (Name, Major ID, and Minor ID), the beacons will be
considered as iBeacon beacons. Also note that the first non-empty
row in the table will be considered as a header row.

¢ In the Objects panel, right-click the Beacons folder, and on the shortcut menu
choose Import.

# Import Beacons - m} X
Mame 4 Hardware ID Type
Bar counter Major: 80, Minor: 100 iBeacon
Gate Major: 90, Minor: 200 iBeacon
Waiters' Major: 90, Minor: 300 iBeacon

Total: 3

fload i~ Import Cancel

In the Import Beacons dialog box:
= C(lick Load > Excel.

= In the Open dialog box, locate the desired file and click Open.
= Click Import.

As a result, imported beacons will be added to the list of registered
beacons.

6.13.5 Unregistered Beacons

If the radio detects an unregistered beacon, this beacon will appear in the
Unregistered Beacons folder at the top of the Objects pane.

o
b

‘_‘7‘"\_—| |5 Unregistered Beacons

BmE = Maior: 91: Minor: 2222
& [ Beat Configure geofencing
&9 [ Map
‘-*;"-L\Zl [ Map
&+ [ Map Hide all objects on map

Add Beacon

P 5

% Delete object

Show all objects on the map

“f Properties

|

To add an unregistered beacon to the Dispatch Console, right-click it and choose
Add Beacon on the shortcut menu.
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7.1

TRBOnet Web Console

TRBOnet Web Console is a special online application. It is an extension for TRBOnet
Dispatch Software which allows dispatchers to get access to the system via a Web
browser. The Web Console is the best solution for carriers, operators and systems
with a huge number of users.

This application allows you to monitor your system without any special software

installed on your computer.

Installing Web Console

e Click Start>Control Panel>Programs and Features.

e Click the Turn Windows features on or off link.

FEN > Control Panel > All Control Panel ltems > Programs and Features

Install a program from the
network

Uninstall or change a program

tall o program,

Organize ~  Uninstall/Change
Name

Y TREOnet Enterprise 5.1

(D TRBORetWatch 2.3

) Unity Web Player

2 Unlocker 1.0.2

[ Visual Studio 2010 Prerequisites - English

& Windows Driver Package - Google, Inc. (WinUSB) An.

er Package - Motorola Solutions, Inc. (f...
... Motorola Solutions, Inc.

ect it from the list and then

click Uninstall, Change, or Repair.

Publisher
Neocom Software
Neocom Seftware
Unity Technologies ApS
Cedrick Collomb
Microsoft Corporation
Google, Inc

Motorola Solutions, Inc.

cyDr... Nokia

Riverbed Technology, Inc
The Wireshark developer cor

Gougelet Pierre-e
Mail Ru

139 Rawikosoi naver Microsoft Visual Studio 2010 Tools 4.

<

%ﬂ Motorola Solutions, Inc. Product version:

)

Microsoft Corporation

12/16/2013 03.06.00.00

mm,

(Mic.

Installed On ~ Size
21-0ct-2016
02-Sep-2016
25-Aug-20.
00-Dec-2015
23-Nov-20..
22-Dec-2015
18-Nov-20.
18-Nov-20..
25-Aug-20..
12-Sep-2016
15-Sep-2016
07-Sep-2015
12-Sep-2016
25-Nov-20.
03-Nov-20.,

(7]
~
H
1
124

41,

17
16

37
My
>

¢ In the Windows Features dialog box, expand Internet Information Services:

[ Windows Features - o be
Turn Windows features on or off e
To tum a feature on, select its check box. To turn a feature off, clear its
check box. Afilled box means that only part of the feature is tumed on.

= @] Internet Information Services ~
[ FTP Server
= @ | Web Management Tools
[ | 1S 6 Management Compatibility
1S Mansgement Console
O | 1S Management Scripts and Teols
[ 1sManagement Service
= [®] | World Wide Web Services
= [ Application Development Features
NET Extensibility 3.5
WNET Extensibility 4.7
Application Ini
Asp
ASPNET 3.5
ASPNET 4.7
6l
ISAPI Extensions
ISAPI Filters
Server-Side Includes
WebSocket Protocol
& [E] T Common FTTP Feat
Default Document it
[ Directory Browsing
[] | HTTP Erers
O  wrTe Red\re(tmn/
Static Content
]| WebDAV Publishing ~
Cancel

Expand Web Management Tools and make sure that
1IS Management Console is selected.

Go to World Wide Web Services>Application Development Features
and make sure all of them are selected.

In addition, expand Common HTTP Features and make sure that
Static Content is selected.
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e Restart your PC.
e Click Start>All Programs>Accessories>Command Prompt.

e For 32-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft. NET > Framework >
v4.0.30319/aspnet_regiis.
For 64-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft.NET >
Framework64 > v4.0.30319/aspnet_regiis.

e Drag the aspnet_regiis file into the Command Prompt then press the space
bar and add the -i key. Then press the Enter key:

e Go to Control Panel > Administrative Tools.

e Double-click the Internet Information Services (1IS) Manager shortcut and
double-click ISAPI and CGI Restrictions.
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3 intermet Information Services (15} Manages o x
c W s FEEYC T
Fle vVew Help
Connections Actions
@) 50142 Home
i Fiter ¥ Go =Gy ShowAll | Groupby: Ares N=0 Manage Server
ASPNET ~ < t
4 0 = k
L @m e ‘iJ 7 s .
N NThwor | NT DTt Apphcstion Comectio
Avhorkan. Compioton Pages Gebdlaaton L ccmngs Sy
- =
’ ) ]
Machine ey Pagecand  Providers Session State SMTR E-mai
Gontols °
5 @
) o Ui
s & @ &
29 Authentic ) o Fascol
Setings

]
ISAPIFiers MIMETypes  Modules  Output
Caching

e |n the Restriction column, set Allowed in all lines.
25 s e R
Qe “i. ISAPI and CGI Restrictions Actben
— ;

e Copy the Web Site archive WebConsole to Computer > Local Disc (C:)
>inetpub to create a folder for the Web Console.

e Go to Application Pools (1). Double-click DefaultAppPool (2) and check the
.Net CLR Version (3):

[=
- 3+ S0 » Asplction Pooks FEEYCE
e
Connections Actions.
- “‘il Application Pools .
P b
o 8 sies Edit Applcation Pos! EE
v Q) Detoult Yeb 5ae
| sspnd clent
| o
1 i = Post
NET CLR Version vA030313
Mansged pipeline mode:
Itegutea 7]
[ Start appiication pool immediately 3

e Click Sites (1), right-click Default Web Site (2) and choose View Applications

(3):
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G nternet nformation Services (15) Manager o x

fe W v o2 b Sites r WL e

Fle View Help

“’Jl Sites

Filter: - ¥ Go - G ShowAll | Group by: No Grouping

=
=
L]

= -
e Click the Add Application link.

L

72 @+ 02 b Stes b Defauk Wes Site » [N

f““m 0 Applications :m«

Thispage i L elaut
iter « ¥ Go - Goshowan |Groupby: NoGrowing o
Virtual Path Physical Path Site. Application Pt

1 Festures View (3 Content View

e Specify the Alias and Physical path for the application:

Add Application ? X

Site name:  Default Web Site

Path: /
Alias: Application pook:
[TRBOnet o | [pefauitappPoot ] Select..

Bample: sales

Physical path:
[cAwebConsole | E\
Pass-through authentication

Connect as... Test Settings...

[ Enable Preload

oK Cancel

e Browse for the folder with unarchived Web Console.
e Click OK.

e Select Application Pools (1) and click the Set Application Pool Defaults link
(2):
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9

€ 31 S0+ Applcaton Pooks
Fle Vw Help

Connections

e <9

o3 50142 (N

|« ie page|
3 oot .

ication Pol Defau
v
o dtferrtd | e sions
v @ Detautt WSt
SRECVCLERN Fiter
1 -
) = v

lloadBal setto Hitpl is
“topped, HTTP.sys will return an HTTP 503 arrcs. I set o TepLevel, HTTP.

ok Cancel

e Set Enable 32-Bit Applications to True (3).

The Web Console will be added as an application to under the Default Web
Site:

Ry Internt ntormation Semaces (15) Mansger 0 x
@75 |5 012 » Stes » Defouk WebSite » TREOnet » [CR
Fle View Help

Connections. Axtions

r &) /TRBOnet Home
55“““1‘“5\*‘""“"'5”“’1 “l Firer « % Go - (FShowall | Groupby: Ases

& ASPNET ~ X

e Manage Rpplication

NET
Authorizat.. Complati Browse Application

5

NET Tt NET Uses  Applicat
Levels e

nnnnn o
=
® !
Providers  ScssionState SMTP E-mil
Festures View | (.3 Content View
Ready h |

Note: Make sure your account has sysadmin privileges (for more
details, see Appendix B: Configuring SQL Server 2012 for
Local System Account on page 343, and Appendix C:
Granting Sysadmin Role to Local System in SQL Server 2012
on page 346) and the database connection is successful
(see section 5.2, TRBOnet Server Database on page 13).

To open Web Console, right-click your application, choose Manage Application >
Browse.

[ — 0 x
@70 |5, 5012 + Sies » Defack WebSite » TRBOnet » W@

File View Help

Connections | Actions.

~ & /TRBONEt Home .

R b

5 53‘“‘”5““"“""“"‘“” Al Fies % Go - (FyShow All | Groupby: Ases

L3 s RPN - -~

@ Defoult Web Sae ; @ %

NET WNET Prefile  .NET Roles e
atast

Ready. %4

TRBOnet Web Console is now ready for operation.
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7.2  Configuring Web Console

e If TRBOnet Server is not installed on your PC, select the application and click
Application Settings:

Gy iternet eformation Senaces 15) Manager 0 x

70 5 s s st v DefautWebSie » TREONE GRS

Actions.
& /TRBONEt Home
Fier: = % 6o« Eshowil | Group by: Aren -@- B e
RSoNET B
& . .
NET
Authorizat. Manage Application
" Browse Application
v ® s ttp
NET Tt =
et
@
&

Providers  Scision State SMTP E-mail

Festures View .3 Content View

<
Ready.

e Specify the IP address and Port of the PC with installed TRBOnet Server:

' lnternet Information Services (15) Manager 0 x
@ 0 5+ 142 » Stes v DefaumWebSite + TREONS b RS-
fle View elp
Commectons. - Actom:
- & Application Settings
el - e :
" X &
Geoup by No Grouping
MName Velue Entry Type = @ 1
Faie Loaal
Local
Local
Goagy Local
) Lol
5 To10T009 )
MoSpecdOnRoue 120 Local
a Lot
Locel
Locat o

Features Vi

Configuration: Default Vieh Sae/ TREGnet’ weh.config

¢ Right click TRBOnet Web Console and choose Edit Permissions.

6] Internet nformation Senaces 015) Manager o x

70 5 5o+ st b DefaumwebSite » TREONS k@

File View Help

Conmections . Action.
r & /TRBONet Home
] { B
o 21| | A « % 6o~ EShowAll | Groupby: Aren 3
ASPINET A A =
Manage Application

te SMTP E-mail

I3 Swildhto Content View  fntent View

Ready

e Click the Security tab and then click the Edit button to edit permissions:
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WebConsole Properties

General Sharng Securty Previous Versions  Customize

Object name:  C:\WebClgsale

Group or user names:

B2 Authenticated Users N

S8 5YSTEM

SR Administrators (S0142\Administrators)
SR Users (S0142\Users)

Users Allow Deny

To change permissions, click Edit. W
Pemissions for Authenticated

Full cortral &

Maodify

Read & execute
List folder contents
Read

Write v

For special permissions or advanced settings,
click Advanced. Advanced

QK Cancel Apphy

e Select User in the Users list. In the Allow column, select Write:

e Click Apply.
e Click OK.

Permissions for WebConsole
Security
Object name:  C:\WebConsale

Group or user names:

SR Autherticated Users

BR.5YSTEM

B2 Administrators (50142\Administrators)
BR Users (50142\Users]

Add... Remaove

Pemissions for MNonesosatent Allow

Deny
Read & execute |
List folder contents O
O
O

Read \

Witte

Special pemissions w

Cancel Aoly

neocom
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7.3
7.3.1

Using Web Console
Connecting to TRBOnet Server

Launch the browser.

In the browser's address bar, enter the IP address of the PC with the installed
TRBOnet Web Console, and the path (for example, 70.70.100.99/TRBOnet).

Note: For the path, see section 7.1, Installing Web Console,

IIS Manager>Add Application>Alias

As a result, the TRBOnet Login page will open:

B TRBORet WebConsole X+ — (m) X
&« = 0 ‘1010mu.sg,mfo-et;;«cmb,o;ma;pr>RatL'r-Jr\saLF%E:nazazf 5“(‘ = ¥ O -
Build 5.3.5.1869
Web Interface A
Login Password
Connect
25850

Login

Enter the User Name registered in the TRBOnet Dispatch Console Users list.

Password
Enter the user password.

Click Connect.

Once you have connected to TRBOnet Server, you will see a window like this.
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B3 TRBOnet WebConsole X+

« > 0

TH B on et o Web Console

‘ 10.10.100.99/TRBonet

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout
N j . . 7~ \\ Bloom 2
~ (© onine, Indoor =77 \a\
£~ @ Online, GPS fixed Hospital = - A\
< @ Radio 25 75 % 6
[~ @ Online, No GPS 2
v @125 @
v @235 ﬁm % Radio 332
< @ Radio27 %
=« @ Offtine O p
@1 Radio 25 5
v @333 b . N . =2 a
< @ 4444 N - |
< B e Radio 3662
(®) 5555 . e .
(& Radio 300 A \\WW N
\ k by,
| @ Radio 333 o 3 = Text Messages o
| (@ Radio 3662 Q| A|eos| 22 N "\ Hacran -

[<] send Text
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7.3.2 Radio List

The Radio List pane is located on the left and contains the list of radios. From this
pane, you can perform the following tasks.

Click the “* button to see the selected radio in the center of the map.

Click the #* button to button to display a route traveled by the selected radio on
the map.

Show Route: ®

- @125

From: 24-Nov-2016 0:00

To: 24-Nov-2016 18:41

[ Optimize Route (group all nearest
points)

Load | Cancel

Specify the From and To date and time. Select the Optimize Route option to group
all points in a 100 meter radius.

Click the “" button to request a location of the selected radio.

Message 1 of 1

Close

Click the o button to display the selected radio properties.

Callsign: 123
Talk Group: Firemen
Radio ID: 125
MDC ID: 0
Equipped with Display: V]

Equipped with GPS Module: /]
Cancel

7.3.3 Locking a radio
To disable a radio:
¢ Right-click the desired radio in the Radio List pane.
¢ In the shortcut menu that opens, click Lock.

e Enter the Lock reason and click OK.

Note: The dispatcher can disable a radio when they have relevant Access
Rights.
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7.3.4 Map
7.3.4.1 Map Layers

Click the small plus button on the right of the Map pane.
Choose the map layer to display in the Map pane.
In the Overlays list, select whether to display Regions, Map Objects and Radios

on the map. Just select/clear the corresponding check box.

5 TRBONet WebConsale X+

)

TB B an e t ! Web Console

Reports Messages Job Ticketing

‘ 10.10.100.99/TRBonet

Map

Radios

(O Online, Indoor
[ @ Online, GPS fixed

| @ Radio 25 Q| A s LF \
[~ @ Online, No GPS fiw
v @125 Q| A s | LF ) R
> I
v @ 235 Q A s | LF o \ %
< @ Radio 27 Q| o] 28 ]2 % £
oo oy -

2 Hospital
i

Targeaansian

cmyoun’ i
X E
S

& ==
33 \BI2VEGAN
* SHOP,

35

34

Radio 27

Radio 25
Bloom . 235

1 Text Messages

e vl

7.3.4.2 Zoom In/Out

e Click the large plus button on the left of the Map pane to zoom in the map.

e Click the large minus button on the
Or:

left of the Map pane to zoom out the map.

e Use the mouse wheel to zoom in/out the map.

7.3.4.3 Radio Coordinates and Address

¢ In the Map pane, click the radio you want to inspect.

As a result, a window will appear displaying the coordinates and address of the

inspected radio.

) TRBOnet WebConsole X =+ - o X
e > O 01010099, x| =12 8 -
TRBOnet™
Inet” web console <] send Text
Map Reports Messages  Job Ticketing © Dispaicher 1 Logout
Radios HEY) E Q | regior: NI 3% + W ©
2 2 :

+ (O Online, Indoer

(@ Orline, GPS fixed

7

School number 21 g

Spices & Joy UWikona Ne 21 =
235
Date 25-Nov-2016 13:40:12 o I:L”Jii
Latitude: 59°56'26.40"N £
Longitude: 30°16'47.89°E i
Altitude: Unknown :
T-ya liniya, 34, Sankt-Peterburg, Russia, 199034 ola

1090 4y

froro
pest.

Vasilenstravsk
e

@125 Q A ors G
@ Qs 2
1=« @ Online, No GPS
@Radio2dom... O A ors L}
E v @ Offline
@111 Q Ao 1}
@22 Q A o v
(@ Radio 200 Q A es 2_’
® Radio 201 Q| ers| L4 A L
@ Radio 202 Q A o L3 Google
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7.3.4.4 Filter Radios

You can filter the display of radios on the map. To do this, use the colored car
buttons at the top of the Map pane.

e Click to remove radios that are online and have a detected beacon
position from the map view. Click this button again to bring them back to be
displayed.

e Click H to remove radios that are online and have a detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click E to remove radios that are online and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click to remove radios that are offline and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click and select the visibility of the radios having On Duty and/or Off Duty
states.

7.3.4.5 Search by address
¢ In the Find Address box, enter the address you want to locate on the map.
e Click the lens button on the right.

¢ In the Found addresses window, click the address to locate it on the map.

TRBOnet " web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout

= &
v o Online, Indoor . 18 Broadway, Tarrytown, NY 10591, USA fon Caf
lon Cafe
B~ @ Online, GPS fixed il 18 Broadway, Somerville, MA 02145, USA i
v @125 Q A ors L} — 18 Broadway, Denver, CO 80209, USA
r 18 Broadway, Denver, CO 80203, USA nited
v @235 s
GV Q& L 18 Broadway, Bayonne, NJ 07002, USA
£ @ Oniline, No GPS I 18 Broadway, Brooklyn, NY 11249, USA ige
@Radio2dom... O A ors L}
= v @ Offline
@ 111 Q A s O3
& 222 Q A o L
® Radio 200 Q R es £
® Radio 201 Q A s L
(® Radio 202 QA o ‘ Goog 0] W
. All= -

7.3.5 Text Messages

With TRBOnet Web Console, you can send text messages to radios/radio
groups/dispatchers.

e Click the Messages tab at the top of the window.
e Click the Send Text button.
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[ TREOnet WebConsole X =

P O N RSP Ty n—

TRBOnet ™ web console <] send Text

b3
"
o
0 o

Map Reports Messages  Job Ticketing © Dispaicher 1 Logout
235 All Send Text Message: 25Now-2016
G Text E i
o See you e

- 5 15
gS-PAII ™ 2 m 18 Nw‘gui;
151 = | s
1 = 3 Radio 200 | =

[] 2 Radio 201

[] 2 Radio 202

- a ndieman

Send to Offline

Send | Cancel

In the Send Text Message window that appears:
= Enter the text of the message.
= Select the radios/radio groups/dispatchers to send the message to.

= Select the Send to Offline option to send the message to offline radios.
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7.3.6 Job Ticketing

With TRBOnet Web Console, you can create, assign, and track job tickets through

the radio network.

e Click the Job Ticketing tab at the top of the window.

) TREOnst webConsole X | - o =x
& = O | wowosyme x| = @& -
™
TRBOnet ™ wes consote <] send Text
Map Reports Messages Job Ticketing © Dispatcher 1 Logout
[Badd |[Feae [ v Assion || Seavchie | |
- Status D T Text Performer Creation Time Start Time End Time Spe
Q Q Q Q Q Q Q Q
New #A00017 Gel out of there 25-Nov-2016 14:10:25
ErlEES %) Assign || % Resend |[ Bk Archive || @ cancel |
Status D T Text Performer Creation Time Start Time End Time Spe
Q Q Q Q Q Q Q
Assigned #AD0D07 456 07-Nov-2016 15:38:32
Assigned #A000T0 Stop smoking 07-Nov-2016 15:42:27
Rejected #A00014 To be done on %DATC% 07-Nov-2016 16:36:00 07-Nov-2016 16:36:33

In the upper pane, you see the list of created job tickets. In the lower pane, there are

assigned job tickets.

7.3.6.1 Add a Job Ticket
e Click the Add button.

e TicketID

Job Ticket - Microsoft Edge

10.10.100.99/ 752

Ticket 1D:
Text:

End Time:
Prlariy:

Comment:

Check the pipe

Enable Deadline
25-Nov-2016 14 [
Medium

Cancel

This value will be set automatically once the ticket has been created.

e Text

Enter the text message in this box.

e Enable Deadline

Select this option and in the End Time box, specify a due date and time for

the task.
e Priority

From the drop-down list, select the task priority level.

¢ Comment

Enter a comment for the ticket.

e Click OK.
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Once you have added a ticket, it will appear in the list of tickets in the upper pane.
7.3.6.2 Assign a Job Ticket
Select the job ticket in the upper pane, and click the Assign button.

[ Cleaners
[l Firemen
I Folice
@ m

< @125
@222

v @25
(@ Radio 200
(@ Radio 201
(@ Radio 202
(® Radio 203
(® Radio 204
@ Radio 240 mobile

@ Walt

oK Cancel

¢ In the list, select a radio(s), radio or logical group to which to assign the job
ticket.

e Click OK to assign the task to selected radio(s).

As a result, the selected radio will receive the job ticket. The assigned job ticket
will appear in the upper pane.

7.3.7 Reports

e Click the Reports tab at the top of the window.

[ TRBOnet WebConsole X =

]
ol |
© g

& > ) 101010093 TREOnsTszowebConsole *

TRBOnet " web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout

%) GPS Reports Location for period
T Location for Period

T7) Drive Activity Detailed Select data by period:

T Staying in a region Start Date: 18-Nov-2016 11:21 M

T 1dle time detailed End Date: 25-Nov-2016 11:21 B
T Commen Reports Filter:

T%) Messages for Period Radios Al
6% Export Min.Interval; 0 s Seconds n

T Location for Period =
Show street names
T Drive Activity Detailed

Staying in a region —
[ Staying ina g . Generate Report -

¢ In the right pane, select report parameters and click Generate Report.

Once the report is generated, you will see it in a separate tab of your Web
browser.
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B TREOnet WebConsole.
SR )

10.10.100.99/ T REOnET

D) tocation forperiod X |

Location for period
from 18-Nov-2016 11:21 1o 25-Nov-2016 11:21

:20C0nsole/Reports/G¥

SByFiter/GPsEyF

owStreetNiames - alse&unit=T&STartDate= 18

11:21:29
18-Nov-2016
11:22:29
18-Nov-2016
11:22:59
18-Nov-2016
il 9
18-Nov-2016
11:23:59
18-Nov-2016
11:24:29
18-Nov-2016
11:25:01
18-Nov-2016
11:25:29
18-Nov-2016

Radio: 125 (Cleaning 1)
Coordinates
18-Nov-2016 Latitude: 59°56'25.95"N

Longitude: 30°16'47.96"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.91"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.90"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.89"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.89"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.89"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.89"E
Latitude: 59°56'25.96"N
Longitude: 30°16'47.89"E
Latitude: 59°56'26.23"N

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Unknown

Altitude | Accuracy
(meter) | (meter)
37

Bl

46

37

37

37

37

37

0.0

0.0

0.2

0.2

0.2

0.2

0.2

0.2

wenzmecone [ % | = B &

You can print the report, save it as a file, and so forth.
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Appendix A: SQL Server Edition Considerations

How to select SQL Server ‘

0 - 200 subscriber units 200 + subscriber units
Windows 7, Windows Server 2008 MS SQL 2008 Express MS SQL 2008 Standard
Windows 8, Windows Server 2012 MS SQL 2012 Express MS SQL 2012 Standard
Windows 10, Windows Server 2016 MS SQL 2016 Express MS SQL 2016 Standard
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Appendix B: Configuring SQL Server 2012 for Local System
Account

During installation of MS SQL Server 2012, you can grant the required role to
Windows Local System account in advance. On the configuration setup, click
Database Engine Configuration:

5 QU Server 2012 Setup (=5 Eon ==
Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules [ Server Configuration 1. Data Directories | User Instances | FILESTREAM |

Feature Selection

aaolloteas: Fulcs Specify the authentication mode and administrators for the Database Engine.

Instance Configuration Authentication Mode

Disk Space Requirements @ Windows authentication mode
Server Configuration

| Database Engine Configuration |
Error Reporting Specify the password for the SQL Server system administrator (s3] account.

Mixed Mode [SQL Server authentication and Windows authentication)

Installation Configuration Rules
Installation Progress

Enter password:
ey Confirm password

Specify SQL Server administratars

VM_WIN7_002\admin (admin | 5QL Server administrators

have unrestricted access
Add Current User | M

to the Database Engine.
<Back |[ MNext> cancel | [ Help

Windows Authentication mode

e Click Add to add an additional account to MS SQL Server administrators.

¢ In the Select Users or Groups dialog box, click the Advanced button in the
Enter the object names to select box to find a required user name.

Select Users or Groups
Select this object type:
Users, Groups, or Built-in securty principals Ohbject Types...
From this location:
Erter the object names to select {examples):

| Checlc Names

OK

i

e Click the Find button and select SYSTEM account. Click OK to add the user
and close the window.

343



neocom

sOoftware

344

Select Users or Groups

Select this object type:

IUsers. Groups, or Builtin security principals

From this location:

Common Queries |

Hame; [stats wih =] I

Description: IStarts with j I

I | Disatied acoounts
I | Nom expiring password

Object Types... |
IM\TYA Locations... |
Calumtis.. |

Find Now |
Stop |

21xl

Diays since last logon: I 'l

Search results:

57
Cancel

Name (RDN)

| In Folder

]

=]
|

8% 15_IUSRS

£ INTERACTIVE
P

MITYA

A2 NETWORK SERVICE

H OWNER RIGHTS

4% REMOTE INTERACTIVE LOGON
83 restore
HE SERVICE
%so LServer20055QLBrowserlser-SMITYA

MITYA

MITYA

|

[~

Select NT AUTHORITY\LOCAL SERVICE (LOCAL SERVICE):

5 SQL Server 2012 Setup

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules
Feature Selection

Installation Rules

Instance Configuration Authentication Mode
Disk Space Requirements ® Windows authentication mode
Server Configuration _
) Mixed Mode (SQL Server authentication and Windows authentication)
Database Engine Configuration
Error Reporting Specify the password for the SQL Server system administrator (sa) account.

Installation Configuration Rules
Installation Progress
Complete

Server Configurstion | Data Directories | User Instances | FILESTREAM |

=5 Bl =

s for the Database Engine.

Specify the authenticati

Enter password:
Confirm password:

Specify SQL Server administrators

mode and admini

VM_WINT_002\admin (admin)

INT AUTHORITY\LOCAL SERVICE (LOCAL SERVICE)

SQL Server administrators
have unrestricted access
to the Database Engine.

Add Current User | I Add... ] Remove ] /

< Back [ MNext > Cancel [ Help

¢ Click Next and follow the prompts to finish the installation.
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Mixed Authentication mode

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules

Setup Role

Feature Selection

Installation Rules

Tnstance Configuration

Disk Space Requirements
Server Corfiguration

Database Engine Configuration
Error Reporting

Installstion Configuration Rules
Ready to Install

Installation Progress

Complete

Server Configuration | Data Directories | FILESTREAM

Specify the authentication mods and administrators for the Database Engine.

Authentication Mode
=) Windows authentication mode

( @ Mixed Mode (SQL Server authentication and Windows authenticati nni’

Specity the password for the SQL Server system administrator (sa) account.

Enter password:

Confitm password:

Specify SQL Server adminsirators

TREOnet-PC\Adminuser SOL Server administrators
have unrestricted access

to the Database Engine.

[ Acdcurentuser | | agd.. | [ Remove |

7
/

| < Back Il Mext = ” Cancel | Help |

e Click Mixed Mode (SQL Server authentication and Windows authentication).

e Enter and confirm the password for SA SQL user in the Enter password and
Confirm password boxes.

e Click the Add Current User button (unless it is already there).

Note: Once you have added the SA account, you'll be able to use this SA
account to connect to SQL Server with administrator privileges as
an alternative to a Windows user account.
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Appendix C: Granting Sysadmin Role to Local System in SQL
Server 2012

If you have already installed MS SQL 2012, you need to grant sysadmin role to
Local System account in MS SQL Server 2012.

e Run SQL Server Management Studio from the Start menu.

| Microsoft SQL Server 2012 Music
|&| Download Microsoft SQL Server Compac
f:] Import and Export Data (32-bit) Erri
waimte arid port Dats 04 hi
!,_.:5 sS0L Ser'-;'e Management Studio Control E
E
, Integration Services Devices ;
| Motorola
Mntarala Salitinns Mafziil+ €

e Connect to your database instance where TRBOnet database is created.

¢ Go to Security node and select Logins.

Dbyect Exploves -8 X
Conmect 8¢ 3] = J
[Py e wing ooz iLEXPRESS (5GL

(34 Logins

#2hi5_PolicyEveraProcessin
o, =M PolicyTsglExecutionL
| BURLTIN Lsers
& NT ALUTHORITY\SYSTEM
B AT Service\ MSSOLESOLEXRH

& NT SERVICE L rier
8 NT SERVICEWTrengmt
b u
& VM_WINT_D0Fuadmin
7 [ Server Rioles
i [ Credentials
3| 3 Server Objects
3 @ Replication
3 3 Management

e Right-click NT AUTHORITY\SYSTEM login and choose Properties.

¢ In the Login Properties window, select Server Roles and select the sysadmin
check box.
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P Genenl ot ~ Db

H

Server e i used to grant server-wide security pmvileges
** Secursbles
)

fy ok ][ comed ]

e Click OK to add sysadmin privileges to the selected user
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Appendix D: Backing up and Restoring Database and Audio
Recordings

Configure Backup

TRBOnet Dispatch Software has an automatic mechanism for database and audio

recordings backup. Initially, it defaults to two paths to store database and audio
recordings.

For TRBOnet Enterprise:

%ProgrambData%\Neocom Software\TRBOnet.Enterprise\Backups and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Audio.

For TRBOnet Plus:

%ProgrambData%\Neocom Software\TRBOnet.Plus\Backups and
%ProgramData%\Neocom Software\TRBOnet.Plus\Audio.

For your convenience, the default paths can be changed:

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration Service

* B A
G Network The TRBOnet Server service is installed
& Redundancy
Database Status: ° Service started
I}) Reports Stop service
LF Service Management X
32 dvanced setings «M@k
)\ Geocoding Servers
.| Radio Networks Uninstall Service
) Digital Systems
L} Services
.ol Repeater 21

- Advanced setti
" Privacy
Slot #1
Slot #2
i..L17 Local Slots
-fligh Control Station #1

E:Viev.' Log Entries Export Configuration Import Configuration

< >

Set Defaults Apply oK Cancel

e To customize these backup folders, on the Configuration pane, select
Database, then select the Specify the path for database archives and Use
custom folder for audio files options. Next, enter the new (custom) folder for
the backup database (for example, C:\TRBOnet\Backup\DB) and custom
folder for the audio files (for example, C:\TRBOnet\Backup\Audio). The
database and audio backups will be stored in the selected directories.

348 TRBOnet Enterprise — User Manual



Appendix D: Backing up and Restoring Database and Audio Recordings

neocom
software

Configuration Database
& Service ~
G Netwark SOL Server: (local)\SQLEXPRESS -
i Redundancy Database: TREORet M
== Database X
ra Reports Authentication: Windows M
{} Service Management Login:

X Advanced settings
)\ Geocoding Servers
I:I Radio Networks

) Digital Systems

Password:

Specify the path for database archives

L} Services Path: C:\TRECnet\Backup\DE

3 Repeater %1 Use custom folder for audio files

L2 Advanced sett

Path: iC:\TREOnet\Backup\Audio
Privacy : = Faceell .______.-—-="'
I Slot #1
a0 slot %2 Test Connection
LI Local Slots Uparade Database -
-fligh Control Station #1
Create Database -
< >

Set Defaults Apply oK Cancel

e Save your changes and restart the service.

Back up Database and Audio Recordings

To back up the database and audio recordings, do the following:

¢ In the Dispatch Console go to Administration (1), and select Database (2) in

the Navigation tree.
e Click the Backup (3) button:

File View Map Tools Help

Administration Database

[ server

{8 License % 1: Line free

2 1ntercom Al Call

&)
[2][«][e]

i
.45} Radio Systems
A5 System Bridging 2
-Ep Telephany

(25 Tacke

Moo

[ ]Private Call

[2][<][]
[][][e]

o || % Backup | “ Schedule

10w 20

Group 30

[»][+][e]

Database Information

L2, tocation Tracking

Server name: (local) \SQLEXPRESS

TREONet

25:00t-2016 16:28:26

MR SQL Sarer 014 (°2) (@3171021) - 120.5000.0 064
Jun 172016 18:1-

Capyright () Mot Corporation

Express Edition (64-bit) on Windows NT 6.3 <X64> (Build 10586: )

Databise name:
3 sadap date:

G 30b Ticketing

Database version:

] Route Management

Data size: 17.23v8

2.77M8

@ RFID Tracker
Audio size:

[] Text Messages

@' Voice Recording
() Reports

{5 Event viewer

[1%] Radio Atlocation 1

/

Fry— -

(127001 &3 @, | § Administrator | [ Licensed to: demo Demo License.

e Specify the backup details:

Database maintenance X

|\_!y Remove old data and shrink database

Path:
C:\ProgramDataNeocom Software \TREOnet. Enterprise\Backups

Backup data

Backup audio

Remave
Remove all data older than date:
Audio files
Data

IlO*JUI*ZO].G - I

Cancel

| @ active-
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= Backup audio
Select to back up audio recordings.

= Remove
Select to remove audio files and data from the database.

= Remove all data older than date
Specify the date to remove data older than that specified date.

= Audio Files
Select to remove audio files.

= Data
Select to remove data.

= Click OK to run the backup procedure.
The Backup progress bar will be displayed in the lower-right corner.
1. In a while, a ZIP archive will be created in two possible directories:
For TRBOnet Enterprise:

e The default directory is %ProgrambData%\Neocom
Software\TRBOnet.Enterprise\Audio for Audio files and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Backups
for backup files.

e The custom directory is specified in TRBOnet Server settings.
For TRBOnet Plus:

e The default directory is %ProgramData%\Neocom
Software\TRBOnet.Plus\Audio for Audio files and
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups for
backup files.

e The custom directory is specified in TRBOnet Server settings.

2. The archive includes the database backup file and audio recordings files. The
archive name contains the date of backup. New backup files will be placed in
the same directory.

» Comguter » Local Disk &) » ProgamData » Meocom Software » TESOret Enterprise »

eganize = Include in kbeary ¥ Share with = Mew folde - I

Ml Deskicg B TREOnet Enterprise 21,

i Network
ER Control Panel
& Recycle Bin

o5 8040
| G-

Impartant docs
Pies

SA5Plenet_1 2080
[PR—

|
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For TRBOnet.Plus:

GO

———— . —

. » Computer » Local Disk (C:) » ProgramData » Meocom Software » TRBOnet Plus » Backups »

J| NAT

b

=) Recent Places

B Desktop
4 Libraries
@ Documents
Jﬁ Music
[ Pictures
BE Videos
A A Roman Lapin
M Computer
€ Network
I [E3 Control Panel

Organize = Include in library « Share with + New folder

P Name ’ Date modified Type Size
Bl Desktop | 4) TREOnet Plus_20140528.zip 5/28/2014 7:36 PM Compressed (zipp...
& Downloads
%23 Dropbox

& Recycle Bin

2 100 level 2D map
J 585 roman

| Config_Pics

. CP5.8.0.410

| Dispatcher Actior
Elastix

. Elastix 2.2.0 x86 (t
Floor

| Impertant docs
. Jenkins

| Licences

1item

Restore Database

To restore the database

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration Service
] A
& Metwork The TRBOnet Server service is installed
@& Redundancy
= Database Status: ° Service started

re Reports Stop service
Service Management
;z Advanced settings + Save changes and restart service

------ )\ Geocoding Servers
El Radio Networks Uninstall Service

..4Z) Digital Systems
-4} Services
3 Repeater #1

X Advanced setti
':' Privacy

1 Local Slots

iy Control Station #1 ,

|z View Log Entries Export Configuration Import Canfiguration
> =

Set Defaults Apply oK Cancel

e Unzip the backup archive and open the folder:

neocom
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Favortes
M Desinep

& Downicads

& Recent Places

B Desinop

Audio
Infetot
TREDe Entefarise bk

LT (pn——

fied: 113 109PM

e Run SQL Server Management Studio Express with sufficient rights to

manage databases.

Geoghe Caroma
Googhe fath
HTMIL Help Wodcshop
Hytern ROR

KT

Frte Codee Pack:

Corfgaration Tools
Mactarola
Wil Formes
s Sattwan
Hoiia PC Suite
POF Edits
Pl sty Pro
Sosom Recarder

4 S0L Server la ruggemesi Studis Exp

o a
inwe whare prevn

Sl

L

e Select Database in the navigation tree (for example, TRBOnet):

Ble [ Yo Dong Tech Bnfow Hep

58

ol | ] ey (5 15 S| 4 S

¢ Right-click the selected database, and go to Tasks/Restore/Database:
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-----

mmmmmm

Comnection

e el
O AN 007 s

imw comnaction gropanin
Progen

Raady
Mty Backup Med

Canesl Help

Select Database backup properties:

¢ In the Destination group, type in or select Database name to back up to from
the drop-down list (for example, TRBOnet).

¢ In the Source group, click Device.

e Click the ellipsis (...) button to select the directory with database backup:

e Click Add and select the directory to which you unarchived the database
backup (for example, C:\TRBOnet\Backup\DB).

3 Select backup devices = ==

“\

([ox J[ coce |[ nee |

Speciy the backup media and &3 location for your restare aperation

Backup media type: Fie -
Backup media

Note: Select the *.bak file type.

e Click OK to add the directory.
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Mz Aestore Durase - TRBCnet S|[@®
D b backupsst selected to be restared
Sedeta e saipt - | I Hep
2 Genal
# e i
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Dotsbase
W Dpice: =
Dataase -
Destiation
[ TREDNE!
Betaeta
S — = |
[ A ——
poweion R
e "
[emm—
E¥ProptirDatINestan SarvareiTISOnetEntera s Be0: | [
s
Connaction [ ot ]
7 VMMM I SQUEPIESS
[VWLWINT 097 e
‘e comestian peapeties /
Proge Il —
Reasy .
Canca Hep

e Click OK.
The database is added to the list of restored databases.

45 Restare Dotshese - TRBOnct S B ==
A fay
Selecta prge Lo - Cyep
= Genenl
o Fles Seurce
# options
[
# Dypice:
Dtabase THBEnet
[R—
Detaiese TREOnet
Bestore e The a2 bachup ok (e, Augst 06, 13112127 | Zmetne.
Raston plan
[ ——
- 5 i
Fvg Datatone il SONSQUEPRESS  TRiGnet 1 MRANT

\

Cormecctin

27 VM_WINT 002\ SOLEXFRESS
VMW D0z\adrin]

Yiew conneclion proserte
Prgria .
/) -
v | st e hlnla,
o Cancai Help

e Select the check box and click OK to restore the database.
¢ In the Configuration pane, select Database.

e From the Database drop-down list, select the restored database.

Configuration Database
@ Service -
G MNetwork SOL Server: |{|oG|}\SQLExPRESS ,|
Database Database: -
£F Service Management
) Authentication: i
X Advanced settings TREONet Test
w Map Servers for Geocoding Login: TREOnet_Testl
|:| Local Agent e il TREOnet_Test1l
= TRBOnet222
TREOnet22222
| Spedify the path foy
pedfy the Path o o oneta20222 -
P Clsersy . lapin, No\Deskiop \IMportant docs
Use custom folder for audio files
L0 Siot #2
i L1 Local Slots -
L...[] Analog Control Stations ‘I Test Connection ||
E Remote Agents ‘| Upgrade Database ||

E Friendly Servers ‘
@8 Internal PEX Server !
PR External PBX Server ke

Set Defaults 1 || Apply || || 0K || || Cancel ||

Create Database ||

e Click Test Connection to check the connection to the database.
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¢ Click Upgrade Database to upgrade the database if the current database was
restored from the database version lower than current.

e Click the Save changes and restart service link.

Configuration
Pl service
0 Network.

& Redundancy

Database

i'a Reports

LF Service Management
)f Advanced settings

N Geocoding Servers
Radio Netwarks
D) Digital Systems
Services
Repeaber #1
. Advanced setti
Privacy

H 1.0 Audio Paths

B Analog Control Station:
5= Remote Agents

[ Friendly Servers

‘IR Telephony
< >

Set Defaults

Restore Audio Recordings

To restore the audio file:

Service

The TREOnet Server service is installed

Status: o Service started

Stop service

+ Save changes and restart service

Uninstall Service

lj—,_j:\l’iev.' Log Entries Export Confiquration Import Configuration

Apply OK Cancel

e Launch TRBOnet Server and stop the TRBOnet Server service.

Configuration

# B A

G Network
@& Redundancy
Database
(@ Reports
L} Service Management
/ Advanced settings
)\ Geocoding Servers
-| Radio Networks
..{Z) Digital Systems
L} Services
lﬂ Repeater #1
4 hdvanced sett
Privacy
I Slot #1
L[ Slot #2
: Local Slots
- Control Station #1 ,

< >

Set Defaults

Service

The TRBOnet Server service is installed

Status: ° Service started

Stop service
+” Save changes m

Uninstall Service

E.ﬂ:\fiev.' Log Entries Export Configuration Import Configuration

Apply 0K Cancel

e Go to Database section in the navigation tree and specify custom directory for

audio files (for example, for TRBOnet Enterprise

C:\TRBOnet.Enterprise\Backup\Audio; for TRBOnet Plus:
C:\TRBOnet.Plus\Backup\Audio).
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Configuration Database
§ Service
G Network SOL Server: (local)\SQLEXPRESS -
# Redundancy Database: TRECnet -
E)Database
Authentication: Windows h
@ Reports
ﬂ Service Management Login:
X Advanced settings Ermsrris

)‘\ Geocoding Servers
Radio Networks
E Remote Agents
E Friendly Servers

M Specify the path for database archives

Path: D:\Temp{TRBOnet

78 Telephony ! Use custom folder for audio files
" Data Sources
: D:{Templaudia
$ Modbus TCP Path \rempia
24 Email
) sMs ‘ Test Connection |
[ vicense

| Set Defaults |

‘ Upgrade Database

‘ Create Database

OK | | Cancel |

e Go to the directory you specified to store backup audio files.

e Unzip the backup archive:

|- Computer » Locel Disk [C:)

+ ProgramDats + Nescom Scltware » TREOret.Enterprive b Backups b =4 | seo

Organice = g Open

7 Favoribes

M Deskicp
& Devnieud
i Recent Places

B Desttop
i Libraries
| Documents
ot Muie
o Pictures =
B videes
B Roman Lapn
1 Computer
S Hetweork:
I Control Parel
& Recycls Bin
CPS.B.0.410
Elastix
 Inpoetant docs
. Pics
b SASPlanet_1 2060
e s Bart ™
}l Audic  Dabemodfied S%/2013
Nl Freroider

Include in leary =

L Budia
| infocbt {i
| TRBOnet Entefarise bak
TR TREDret Ere

[T r—— = -
Type
File:talder
Test Document 1KB
Bk File 1509 kB
rRAR T archive

s 2011205007

109 PM

e Copy unarchived audio fil

es to the folder specified in TRBOnet Server settings

(for example, C:\ProgramData\TRBOnet Dispatch Software \Audio):

| v Compuar ¢ Lecal Dk f) ¢ Progumbts » Hescamichwn b TRBOnetEmmpsm + Ao + iyl Sareh v
T ——— = L@
8 Donivack : [F—— &
% Acoem Py
o P § oz
J mzm 28
. h“u:"’ FUET
i Libraries
Y Do o 200z 010 .
T o 200z 018 |
_- o 200z 018
— TR
:v“‘" b mz0e 0017
p c.." = A 0z 020345
- :"" A 0020003 15
L8 3
B0 Contrel Panal e
H Mucycis Bin
b PR
k fincte
[ue——
b i
I SasPtanet 120801
b Womssen My
b o
j &7 tams l

e Click the Save changes and restart service link.
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Configuration Service
o B A
G Network The TREOnet Server service is installed
& Redundancy
Database Status: ° Service started
(2 Reports Stop service
{} Service Management X
34 Advanced settings + Save changes and restart service
)\ Geocoding Servers
D Radio Networks Uninstall Service
Q) Digital Systems

{} Services
Repeater %1
Advanced setti
Privacy
i L. Audio Paths
a Analog Control Station:
52 remote Agents
E Friendly Servers

? Telephony e View Log Entries Export Configuration Import Configuration

Set Defaults Apply OK Cancel

Thus, the audio files will be restored.

Schedule Backups

To set a scheduled backup for the database and audio recordings, do the following:

¢ In the Dispatch Console, go to Administration section and select Database in
the Navigation tree:

e Click the Schedule button:

File View Map Tools Help

Administration Database €4

o e " | W% st free W intercom el Acal Dol
I oatabas: P crou 10 [)][<][@] S Ecrovp 20 [0][«][@] ¥ ¥ Group 20 [][«][@]
g Rado Systems
7 System Bridging [ Jerivat= cal [0][<]
2 Teepnony o || & Backup | S Schedule |
EE‘ Voice Dispatch u Database Iniformation
Server name: (ocal) SQLEXPRESS
tocation racking ot e —
Backup date: 25-Oct-2016 16:28:26
& 2o Ticketng Datzbase version: o SaL Server 2044 692) (93171020 - 2059000 (69)
In 372036 1
Copyright (4 )
] Route Management Evovese Edton (450 on Fivema T 6.3 x> (Buid 10585: )
[Blpme Data sz 2w
Audio size: 22.77MB
[] Text Messages
(2 Reports
Event Viewer
papre—
(127001 &3 B | @ Adminisretor | [ Licensed to; demo Demo License | @ Active-

¢ In the dialog box that appears, specify the Backup details:
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Schedule Database Backup X
I é Configure the database backup scheduler
Iv Enable scheduler
Scheduler: |Database Backup AR
[m] (select Al
Backup data [ acf
; [ ahs
[ Backup audio Dty
|:| Remove |:| qwa
§ ] awerty
B = 0-o=cecacon
oK Cancel

e Enable scheduler
Check to enable the database backup scheduler.

e Scheduler
Click the arrow button on the right, and on the drop-down list select the
required scheduler(s). Or, click the plus button on the right, and create a new
scheduler.
For directions on how to create schedulers, see section 6.4.15, Schedulers.

e Backup data
Check to back up data.

e Backup audio
Check to back up audio recording.

¢ Remove
Check to remove audio files and data from the database.

= Remove all data older than [X] days
Select the number of days to remove all data.

= Audio Files
Check to remove audio files.

= Data
Check to remove data.

e Click OK to run the backup procedure.
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Appendix E: SIP Setup for Motorola Phone System

The native MOTOTRBO phone system is supported in the case of a direct IP

connection to the repeater. MOTOTRBO Phone system is recommended for IP Site
Connect mode.

Note: No extra license per repeater is required for Digital Phone Patch
from Motorola.

TRBOnet Software and Repeaters

TRBOnet Server requires a specific setup for a repeater in the IP Site Connect mode
as well as for SIP in order to make the phone system work properly.

Note: MOTOTRBO Phone System is available for repeaters in IP Site
Connect mode. For a system based on the control stations, use
TRBOnet Phone System.

Launch MOTOTRBO CPS and go to Repeater's General Settings page:

[ MOTOTRAC Customer Programming Software - (Samgle DR3000.cth] T )
[J Fe Em Vew Duie Fasus Rerce Wedw lem s

_ax
0 Lo b M M /] i .
Gy et | Sewrn | Rewt Wb Coes | Bumontn
- © b e — |
General Settings |
n

=
(Gerers Seargs e vew o

The Radio ID of actual repeaters in CPS must differ from the TRBOnet Peer ID.
TRBOnet Dispatch Console acts as another virtual peer repeater with Peer ID (for
example, IPSC network consists of 1 master and 3 peers. The repeaters' IDs (Radio
IDs in CPS codeplugs for repeaters) in this case would be 1, 2, 3, 4. The TRBOnet
Peer ID must differ from all the repeaters (the master and all peers, otherwise a

conflict will happen in the network as peers have the same ID). The TRBOnet Radio
ID is 64250.

e Open TRBOnet Dispatch Console. Go to Administration (1), Telephony (2),
Radio calls configuration (3) — Configure (4) and set DTMF Access and
DTMF Deaccess codes (5) to 0 and #, respectively:
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File View Maop Tools Help

Administration Telephony

i (] Database
il Radio Systems
i System Bridging

Virtual Mocbus Devices
Event/Alarm Management

Repeater #1: Slot #2

" Configure Calls | Extensions | RedrectCals [ Aliases [ Profiles

HEE

Alow subseribers to make outgoi

ks Allow to use DTMF:

Allow to use Text Messages:

Radio calls configuration +——— 3

ing calls: Yes

Yes, Prefix: 'sip:’

Backward call to radio:

Initialize call to radio:
Initialize call tmeout:

Execute Check Radio before cal
Send Text Message if cannot ef

Play tone when PTT changed:
DTMF Access code:

DTMF Deaccess code:

| Configure

Incoming calls configuratio

Call to Dispatch Center:
Call to external number:

Extension numbers (voice

Radio calls configuration

IV fliow subscribers to make outgong cais;
[V Allow to use DTMF
[V Allow to use Text Messages
Prefix:
Play the incoming call tone on the radio:
Tnitialize call to radio:
Initialize call tmeout:
[~ Execute Check Radio before call
|¥ Send Text Message if camnot establish call

|¥ Play tone when PTT changed

nlirited = seconds

Start call automaticaly:

DTIF Access code:

= Maximum number length:
: Dumber DTVF Deaccess code: =
0
(4 1 <unber> Lo | co |
@ Administration | Cenfigure

127007 B B @| & Administrator ‘ [ Licensed to: demo Demo License

Programming Radios
A special setup is required for radios in MOTOTRBO CPS.

e Read a subscriber's radio in CPS and go to Phone > System (1):

B MOTOTRBO Customer Programming Software - [Untitled1] - O X
File Edit View Device Features Remote  Window  Help -8 %
F & @ ¥ | & B Q

RM | Open Save

= b 192.168.11.1 -
Cut Copy Paste | Search | Read Wrte Clone | Bluetooth
B @8 Signaling Systems

~
il User Defined 5 To Sys L

Reports | Delste

B8 5Tone Too  DIME
..... il sy
- @ Moc Gateway 1D lﬂ'\
- Sy 2
B & Quik-Cal Il Access Cose o
e 3= e
El- @ Digital Emergency
-----
E)- @8 Capacty Puus Eme
- ) es tg3 Pretime (ms) lﬂ
= ﬁ Pl(;?n;,s1 4——-"” 1 TX Tone Duration (ms) 129 3:
O 8 Enceder -
D seus TX Tone Interval (ms) lﬂ
B @8 Sequences Pause Duration (ms) m
..... asa Seq1 .
< >

[ o]

|Expert view |

e Make sure that Gateway ID (2) is equal to repeater Slot IDs in TRBOnet Server
as well as to TRBOnet Peer ID in TRBOnet Server.

e Set DTMF Access Code to 0 and DTMF Deaccess Code to #, respectively (3).
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[ Fm EM Vew Devce  Fasme  Reschs  Wdow  Hey
w d 3 % 2
Com Sevn | Facors | Dawie | G Comy Paaie
Search enfanced

A SPECIALOPS
n§ SOFFICERA
n§ SOFFICERE

e

Dusl Capaciy Diewci Mase [~

Channel1
m B I8

woice Breunceret e [ 1 |

ST | Il
smmoem et fiom o]
amsan [0
= e | 2
RepetecTime skt [7
Pone Sysien -
A [Dmamed -

Eshanced GPS [
= "

Phone System

. Seiecing

Motes

mhmwmwwﬂmwm anly.
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¢ Go to Repeater/Channels (1) and specify the phone system you have set up

(2):
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Appendix F: NAI VOICE & DATA Support
TRBOnet Dispatch Software supports MOTOTRBO Network Application Interface
(NAI) VOICE and DATA.

NAI protocol allows operating with MOTOTRBO Capacity Plus and MOTOTRBO
Linked Capacity Plus repeaters over IP (Wireline Dispatch Console).

Voice Repeaters must have NAI VOICE and NAI DATA license activated. Data Revert
repeaters must have NAI DATA license activated. A repeater must have 32 Mb
memory.

Software Requirements

Server Computer ‘ Dispatch Computer ‘

TRBOnet Server installed

MOTOTRBO Network Interface Service (MNIS)

MOTOTRBO Device Discovery and Mobility Service TRBOnet Dispatch Console installed
(DDMS)

MS SQL Server 2008 R2 or higher
(can be installed on remote server)

Hardware Requirements

Server Computer Dispatch Computer
CPU Intel Core i7 or higher Intel Core i5 or higher
Memory 3GB 3GB
Multi-channel Sound Card required.
Recommended:
Sound Card — 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Windows 7/8.x/10

Supported OS Windows Server 2008/2012/2016

Windows 7/8.x/10

Additional devices | — Microphone and speaker (headset)

Note: It is possible to use a virtual machine as a Server computer.
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Voice and Data Flow 1

TRBOnet Voice and Data flow for NAl is represented on the following scheme:

TRBOnet Server PC

Voice only

MS SQL Server

L0

TRBOnet
Server

Dispatcher

MNIS
(Data
Geteway)

DDMS
(Presence
Notifier)

Voice and Data Flow 2

MNIS is responsible for sending/receiving Data Packages and forwarding them to
TRBOnet Server.

DDMS (aka Presence Notifier) is responsible for ARS and notifies TRBOnet Server
when a radio is turned on/off. For more details, see NAI_RM_Training_v02.pdf.

All the repeaters in all sites should be available for TRBOnet Server, which normally
requires Port Forwarding rules on routers. For more details, see MOTOTRBO Linked
Capacity Plus (LCP) - HP MSR 20-20 Router Configuration Guide.

Single PC Installation

TRBOnet Server and Dispatch Console can be installed on the same computer.

LCP/Cap+ System

LT

Client and Server
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Client-Server Installation

364

For the systems with 2 and more dispatch positions, it is recommended to have a
dedicated server computer (could be a virtual machine).

Dispatcher 1

LCP/Cap+ System

TRBOnet
Server

Dispatcher N

TRBOnet Server and all the LCP sites must be in different networks, behind their
corresponding routers:

Site 1, Network 1

Site 2, Network 2

TRBOnet
Server
Network 0

Site 3, Network 3

Use the recommended Routers only.
Notes:
e One TRBOnet Server computer is for one LCP System.
e |tis possible to connect two or more LCP systems (System Bridging).
e TRBOnet System Bridging supports Group and Individual Calls.
e |tis possible to use a Virtual machine as a Server.
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LCP/Cap+ System 1

/—\—/ TRBOnet

Server
for System 1

Swift.Agent
for System 2

Dispatcher

LCP/Cap+ System 2

Limitations
¢ Logging of Radio-to-Radio TEXT is NOT SUPPORTED.

e Phone Interconnect available with some limitations. For more details, see the
following article at
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ltem|D=53.

e Local Talk Group IDs must be unique per system.

Radio Subscriber Configuration

Network Settings
= 8 i
S
@ Accessones Too RadioNetwork Services ControlStation [PSite
EE Butons

i Bluetooth Bluetooth Serial Port Profile Data Routing USB HIC
ST ———
f —_ RS Radio ID |54250 a

ARSIP 130250250

ARSUDPPort [ag05 =

TMS Radio 1D |g4250

TMSIP 130260250

TMSUDPPort [agor =

' sys User Defines UDF Port | [Disabiea =

H- @ Digital Em

Lt gy User Defined UDP Port 2 ||:,‘,,m‘1 3'
= C["']""“’" User Defined UDP Port 3 [abiea =

e I Sys”
>

[ -

[~ 8 Encoder
Voice Only [~

() status o
£ @ Sequence (m.s mentorngiD [ = )
i i 209 S‘q

ARS Monitoring IP0.0.0.0
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Personality Settings - 1

E:_hc:mpoa

&3 Voice_Rep_1
e 0 Data_Rep_Siot_

I @' Data_Rep_Siot_
7@ Sean
5 @ R
S @ Capacty Pus
- &8 Voics
[ LB Lt
5@ Dats
B st

L =

Personality Settings - 2

SIN
LRy Can

366

A Personality_1

Top RX IX
\ioice Announcement File |,.J,;,“e :l
(ARS |on systemsite Crangs | )
Privacy [
Privacy Alias Im
RAS Mias | None -
Option Board [
Lone Worker [

Messaging Delay (ms) |5,;|. S_

@umprﬁsed UDF Dats Hesder ¥ _)

Auto Roam ¥

Site List | List1 -

(oo )
(e B H )
vox [©
Pover Level [rign ]
ToT e [0

TOT Rekey Delay (sec) |D H.

Mow interrupion [

TX Intesruptible Frequencies [

(Mﬂm |cotor Code Fres j

In Cal Crteris. {Fotow At Critzria |

RSS! Threshold (d8m) g0

Private Call Confirned [~

Data Call Confirmed [~
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MNIS and DDMS Settings

General Settings

MOTOTRBO Network Interface Service Configuration Utility — MNIS Restart Required =3 N [= | 1]
Configuration  View Edit Service Hep
H©CO® |
@ LCP_Test
- B Generd
S epund Sy Oporon ode
LBt (NS Applcaton D [522%0 = )
B - Conventional
i . 2B Domain 1
- §8: Capacty Ps
[ ¢“# Linked Capacty Plus
DL lBses (MN‘SlFMdrm 192.168.10.76 )
[ @ Advanced Tunnel IP Address  152.168.10.77
- 2 Network
ng Rules Subnet Mask  255.255.255.0
Application Ovem

Talk Group Settings

MOTOTRBO Network Interface Service Configuration Utility - MNIS Restart Required = NS [=] 17|

Configuration  View Edit Service Help

HOCO®

Group List Type ICaDacity Plus/LCP 'I
( Al Groups p )

e B

'-'_sm [ | First Call ID | Last Cal ID
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Master Repeater Settings

LCP Sites Settings

Advanced Settings

368

MOTOTRBO Network Interface Service Configuration Utility - MNIS Restart Reg

Configuration  View Edit Senice Help

NDLHCO O

Master |P Address IIIJ.II]955

(MauerUDPPm o o )

MNIS LE Pot | % Automatically Assigned

' Manualy Assigned [None =

Authentication Key

MOTOTRBO Network Interface Service Configuration Utility -- MNIS Restart Res = 2' = |I:I|5|

Configuration  View Edit Service Help

NrHOCO O

@ LCP_Test
- B General
- @ Secuiy Add

Privacy Setting INW—H

= @ Group List

00 Lat1 4 Ste Id Group List

Zac
2 Doman1 2 L=t

- @ Capacty Pus
=] «4®: Linked Capacty Plus
om
= @ Advanced
- s Network

[Ep Forwarding Rules

Application Ovesic

MOTOTRBO Network Interface Service Configuration Utility — MNIS Restart Reguire: -(3| =10/ x|

Configuration  View Edit  Service Help

N L H OO0

O LCP_Test
ISt Data Cal Cerfimed [
| e
= & Conventional
| L% Doman 1 Battery Saver Preamble ¥
©: Capaciy Pie Indvidual Datato Registered Ste [~
= <@ Linked Capacity Plus
R T Proambie Duraton fne) [720 =]
= o [
-l Network Conventional Channel Access [T B
- [ Forwarding Rules
- ER Application Overic
MNISLEID | & \icc uNiS 1D
' Manually Assigned fhece =
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Network Settings

% MOTOTRBO Network Interface Service Canfiguration Utility * - a x

Configuration  View  Edit Service Help

D LbkHd OO @

= @ Untitled
. General
@ Securty CAlNetwork [12 [£
£ ) Group List
- B Listi CAl Group MNetwork (225 |2

B @ Convertional
& Domain 1

: q‘ Capacity Plus ARSUDPPot [ap05  |=
[ ;4@ Linked Capacity Plus
5 @ Advanced TMSUDPPot [2007 =

- [N

~ [ Forwarding Rules
Application Oven

Telemetry UDF Port 4008

Location Server UDP Port (4001

D

Battery Managemert UDP Port 4012 =
User Defined UDP Port 1 Disabled |5
User Defined UDP Port 2 Disabled |5
User Defined UDP Port 3 Disabled |3

XCMP Enable [
XCMP Server UDF Port  [4004 =

ARS Moritor [

ARS Monitor ID [Nene =

({_Server Address ) |127.0.0.1
on

DDMS Settings

The DeviceRefreshTime parameter defines how often radios should send ARS to
TRBOnet Dispatch Software. The value depends on the number of radios and
channels.

of i

Fle  Acbon Help
. .El iR | bl
EIARSSdﬁlp
l_'rlerfams PotSU 4005
5| Walcher Settings
£ Loggng z
Parsistenca TO 12000
' DeviceRefreshTime
Devics Regisiration durafion in minutes, rounded up to the nearest 30
| minute nterval Range: (- 64°60 (Dforever)
Settings for ARS/SU nterface
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ARS TRBOnet Settings

Configuration

d’: Service

0 MNetwork

@ Redundancy

Database

,I; Reports

L} Service Management
\){ Advanced settings
N Geocoding Servers
@ Radio Networks

[l Remote Agents

[l Friendly Servers

ﬁ Telephony

l Data Sources

74 Email

B8 sMs

a License

Set Defaults

Service Management

Presence service

Auto request presence timeout: 5 : minutes

ARS refresh interval: 1440 : minutes
Ignore unregistered Radios

Location service

GPS restart by inactivity timeout: | 5 : minutes

Dispatch Console update interval: |1 S seconds

i Automatic error correction
Configure
Send the latest GPS dats to dispatchers on alert

For the last:
GPS points:

Telemetry service

Request for the status of GPIO when a radio unitis powered on
Text Messaging service
Text Message Format: Sender and Text

140 + chars

Max. message length:
Split long message into multiple messages

Indoor service

W Remove offine radio from beacon

Ignore beacon position on alarm if GPS is fixed (only K-TERM)

Apply Ok

e Auto request presence timeout

Set this parameter to the value of the DeviceRefreshTime parameter in

MOTOTRBO DDMS.

ARS refresh interval

Version: 5.3.0.1661

Cancel

Set this parameter to the value of the PersistenceTO parameter in

MOTOTRBO DDMS.

LCP Repeater Settings

Configuration

U Service

0 Network.

& Redundancy

Database

i'a Reports

LF Service Management

)f Advanced settings
N Geocoding Servers
.| Radio Networks

(J) Digital Systems

¥ Services
8 Repeater #1
/’: Advanced setti
"L Privacy
[0 Audio Paths
=| Analog Control Station:
5= Remote Agents

[ Friendly Servers

‘& Telephony
< >

Set Defaults

Special settings:

Repeater #1

System Name: Repeater 71
TRECnet Peer ID: 100 2
TRBCnet Radio ID: 64250 :
TRECnet Local Port: 50000 2
Master Repeater Connection Info:
Master IP Address: 10.10.102.131 -
Master LDP Port: 50011 I Test
Authentication Key: 99999
System Type: iLinked Capacity Plus P
System Identifier:

Use MAI Voice

Use MAI Data (MNIS and DDMS)

Use RCM for control radio activity

Apply 0K Cancel

e TRBOnet Peer ID - any unique value.

TRBOnet Radio ID - the default TRBOnet ID.

¢ TRBOnet Local Port — any free port on the PC.
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/®

Audio Paths

Configuration Audio Paths
G Network.
& Redundancy Load Graups Map
= Database Call Type Group ID Site ID
(@ Reports M| Group call 10 Wide
£F Service Management M Group Call 20 Wide
X Advanced settings W Private cal
)f\ Geocoding Servers m Al call
I:I Radio Networks
() Digital Systems
L} Services
.ol TP Site Connect
X Advanced setti
" Privacy
{:} DDMS service
~LF MNIS data sen,
] X Advanced |
[ Audio Path:
~ieh Control Staon £1 o, Add Delete Configure
< >
Set Defaults Apply OK Cancel

Special settings

e Load Groups from Master Repeater;

e Add Local Groups manually.

neocom
software
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Appendix G: Redundant Server

The TRBOnet Server supports a backup configuration which allows seamless
switching from the primary to redundant server in the case of failure of the primary
server. The Dispatch Console operation will not be interrupted.

Redundant configuration overview

372

\
TRBOnet Dispatcher |
I
/
/
/
I
|
- j Heartbeat ti D ——
‘/N = ] eartbeat connection = ]vﬂ
—_— LAY PUEEEE SN —_—
MS SQL TRBOnet TRBOnet MS SQL
Database 1 Primary Server Redundant Server Database 2

e Primary and Redundant Servers are configured identically.

e Redundant Server is operating in PASSIVE mode.

e Redundant Server is monitoring Primary Server status.

e Dispatch Console is connected to Primary Server.

¢ In case of Primary Server failure:
= Dispatch Console connects to Redundant Server automatically.
= Redundant Server becomes ACTIVE.

e Once failed Primary Server is back online, Dispatch Console automatically
reconnects to Primary Server.

e Primary and Redundant Servers do not exchange any data.
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TRBOnet Redundant Server Configuration

¢ In the Configuration pane, select Redundancy.

Configuration Redundancy
q Service
0 Network W] Redundant server mode
@ Redundancy Mode: Passive -
Database _
( _|>‘ Reports Main servers:
L} Service Management [P Address Part
)’ Advanced settings 1 M 10.10.234.162 4021

...... N Geocoding Servers
@ Radio Networks

F5:| Remote Agents

=l Friendly Servers

ﬁ Telephony
i}’ Data Sources
212 Modbus TCP
4 Email
[} 5MS
E License
Add Edit Delete Test A |V
Set Defaults Apply oK Cancel

¢ In the Redundancy pane, select Redundant server mode.

¢ Redundancy Mode
Select the mode for a redundant server from the drop-down list.

e To add a primary server, click Add.

Server Properties >

IP Address: | 10.10.234.152|

Port: 4021 s

OK Cancel Test

e |IP Address
Type the IP address of the primary server.

e Port
Enter the same port number as specified for the Command port.

Passive Mode

In the Passive mode, the Dispatch Console is connected to the primary server. In
case the primary server crashes, the redundant server gets connected to the radio
system and then starts recording to the database (Database 2). The Dispatch
Console automatically connects to the redundant server. After the primary server is
recovered, the Dispatch Console will disconnect from the redundant server and
reconnect to the primary server.

Active Mode
Alternatively, in the Active mode, the redundant server is always connected to the

radio system and records to its database, thus duplicating the primary server's
database (Database 1).

The Active mode has some limitations that are outlined in another section (see
section Restrictions for Active Reserve Mode on page 374).
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Restrictions for Active Reserve Mode

e Go to repeater settings and make sure that TRBOnet Peer ID of the
redundant server differs from the one set for the primary server. Each TRBOnet
Server must have a unique peer ID in the radio system:

Configuration Repeater #1
o service 2
G Network System Name: Repeater #1
@ Redundancy TRBOnet Peer ID: 100 =
Database -
e Reports TREOnet Radio ID: 64250 -
re
-

{} Service Management TREOnet 50000
X Advanced settings

N Geocoding Servers
I:I Radio Networks

er Repeater Connection Info:

Master IP Address: 10.10.102.131 hd

0 Digital Systems Master UDP Port: 50011 -
{:} Services Authentication Key: 99999
p
Al System Type: IP Site Connect A
Advandli] settings
System Identifier: Departmentl

2| Privacy
I Slot #1
LI Slot #2
1 Local Slots
- gigy Control Station #1
@ Analog Control Stations
E Remote Agents
E Friendly Servers W

Use MAI Voice
Use MAI Data (MNIS and DDMS)

Set Defaults Apply 0K Cancel

Dispatch Console Configuration

To add a server to the list of servers:

e Launch TRBOnet Dispatch Console to open the Connect to TRBOnet Server
dialog box, or on the File menu, click Connect to TRBOnet Server.

Connect to TREOnet Server X
Connect to:
Address: 127.0.0.1 v|
Port: 4021 = Configure
Authentication:
Method: TRBOnet Authentication ~
User Name: |admin ’ ‘
Password: | “““““ ‘
D Connect on startup
Cancel

e Click Configure to register the new primary server:
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S Add = Edit | S Delete ‘

Server Label Server Address Port

Servel 10.10.164.45 4021

Server Register TRBOnet Server x
Label: |Server 3
Address:  [127.0.0.1
Port: 4021 S

Redundant servers:
| | Address Port

Delete i
Cancel

= (Click Add to add a new TRBOnet Server:

Label — enter a name for the new primary server.
Address — enter the primary server's IP Address.
Port — specify the command port of the primary server.

Add - click and specify the IP address and port of the redundant
(backup) server for the primary server being registered.

Click OK to save settings and close the dialog box.

Console Connection to Primary and Redundant Servers

¢ Go to File > Connect to TRBOnet Server, and from the drop-down list select
the primary server you created:

Connect to TRECnet Server X
Connect to:
Address: |m |u
Serverl
iz Server2
Authentication:
Method: TRBOnet Authentication ~

User Name: |admin |

Password: | ========== |

[] connect on startup

e Click OK to connect to the primary server.

Now you are connected to the primary server. In case of a lost connection to
the primary server, the Console will try to restore the connection within 30
seconds. After 30 seconds have passed, the console will change connection to
the redundant server automatically. When the primary server is restored, the
Dispatch Console will reconnect to the primary server automatically.
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